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capiTuLO 1

Introducdo do curso

1.1

Prefacio

Welcome to our course! We will be showing you how to use QGIS easily and efficiently. If you are new to GIS,
we will tell you what you need to get started. If you are an experienced user, you will see how QGIS fulfills all the
functions you expect from a GIS program, and more!

1.1.1 Why QGIS?

As information becomes increasingly spatially aware, there is no shortage of tools able to fulfill some or all commonly
used GIS functions. Why should anyone be using QGIS over some other GIS software package?

Here are only some of the reasons:

It’s free, as in lunch. Installing and using the QGIS program costs you a grand total of zero money. No initial
fee, no recurring fee, nothing.

It’s free, as in liberty. If you need extra functionality in QGIS, you can do more than just hope it will be included
in the next release. You can sponsor the development of a feature, or add it yourself if you are familiar with
programming.

It’s constantly developing. Because anyone can add new features and improve on existing ones, QGIS never
stagnates. The development of a new tool can happen as quickly as you need it to.

Extensive help and documentation is available. If you're stuck with anything, you can turn to the extensive
documentation, your fellow QGIS users, or even the developers.

Cross-platform. QGIS can be installed on macOS, Windows and Linux.

Now that you know why you want to use QGIS, these exercises will make you know how.
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1.1.2 Enquadramento

In 2008 we launched the Gentle Introduction to GIS, a completely free, open content resource for people who want to
learn about GIS without being overloaded with jargon and new terminology. It was sponsored by the South African
government and has been a phenomenal success, with people all over the world writing to us to tell us how they are
using the materials to run University Training Courses, teach themselves GIS and so on. The Gentle Introduction is not
a software tutorial, but rather aims to be a generic text (although we used QGIS in all examples) for someone learning
about GIS. There is also the QGIS manual which provides a detailed functional overview of the QGIS application.
However, it is not structured as a tutorial, but rather as a reference guide. At Linfiniti Consulting CC. we frequently
run training courses and have realised that a third resource is needed - one that leads the reader sequentially through
learning the key aspects of QGIS in a trainer-trainee format - which prompted us to produce this work.

This training manual is intended to provide all the materials needed to run a 5 day course on QGIS, PostgreSQL and
PostGIS. The course is structured with content to suit novice, intermediate and advanced users alike and has many
exercises complete with annotated answers throughout the text.

1.1.3 Licenca

@060

The Free Quantum GIS Training Manual by Linfiniti Consulting CC. is based on an earlier version from Linfiniti and
is licensed under a Creative Commons Attribution 4.0 International. Permissions beyond the scope of this license
may be available at below.

We have published this QGIS training manual under a liberal license that allows you to freely copy, modify and
redistribute this work. A complete copy of the license is available at the end of this document. In simple terms, the
usage guidelines are as follows:

* You may not represent this work as your own work, or remove any authorship text or credits from this work.

* You may not redistribute this work under more restrictive permissions than those under which it was provided
to you.

« If you add a substantive portion to the work and contribute it back to the project (at least one complete module)
you may add your name to the end of the authors list for this document (which will appear on the front page)

* If you contribute minor changes and corrections you may add yourself to the contributors list below.

* If you translate this document in its entirety, you may add your name to the authors list in the form «Translated
by Joe Bloggs».

* If you sponsor a module or lesson, you may request the author to include an acknowledgement in the beginning
of each lesson contributed, e.g.:

Nota: Esta licdo € patrocinada pela MegaCorp.

e Se ndo tem certeza sobre o que estd abrangido por esta licenca, por favor contacte-nos através de
office @linfiniti.com e daremos apoio sobre o que quer fazer € aceitvel.

* If you publish this work under a self publishing site such as https://www.lulu.com we request that you donate
the profits to the QGIS project.

* You may not commercialise this work, except with the expressed permission of the authors. To be clear, by
commercialisation we mean that you may not sell for profit, create commercial derivative works (e.g. selling
content for use as articles in a magazine). The exception to this is if all the profits are given to the QGIS project.
You may (and we encourage you to do so) use this work as a text book when conducting training courses, even
if the course itself is commercial in nature. In other words, you are welcome to make money by running a
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training course that uses this work as a text book, but you may not profit off the sales of the book itself - all
such profits should be contributed back to QGIS.

1.1.4 Capitulos Patrocinados
This work is by no means a complete treatise on all the things you can do with QGIS and we encourage others to add
new materials to fill any gaps. Linfiniti Consulting CC. can also create additional materials for you as a commercial

service, with the understanding that all such works produced should become part of the core content and be published
under the same license.

1.1.5 Autores

¢ Riidiger Thiede - Rudi has written the QGIS instructional materials and parts of the PostGIS materials.

e Tim Sutton (tim@kartoza.com) - Tim has overseen and guided the project and co-authored the PostgreSQL
and PostGIS parts. Tim also authored the custom sphinx theme used for this manual.

» Horst Diister (horst.duester@kappasys.ch ) - Horst co-autor de partes do PostgreSQL e PostGIS

¢ Marcelle Sutton - Marcelle provided proof-reading and editorial advice during the creation of this work.

1.1.6 Contribuidores Individuais

O seu nome aqui!

1.1.7 Patrocinadores

* Universidade de Tecnologia da Peninsula do Cabo

1.1.8 Source files and Issue reports

The source of this document is available at GitHub QGIS Documentation repository. Consult GitHub.com for
instructions on how to use the git version control system.

Despite our efforts, you could find some errors or miss some information while following this training. Please report
them at https://github.com/qgis/QGIS-Documentation/issues.

1.1.9 Ultima Versao

You can always obtain the latest version of this document by visiting the online version which is part of the QGIS
documentation website (https://docs.qgis.org).

Nota: The documentation website contains links to both online and PDF versions of the Training manual and other
parts of the QGIS documentation.
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1.2 About the exercises

Now that you know why you want to use QGIS, we can show you how.

Aviso: This course includes instructions on adding, deleting and altering GIS datasets. We have provided training
datasets for this purpose. Before using the techniques described here on your own data, always ensure you have
proper backups!

1.2.1 How to use this tutorial

Any text that looks like this refers to something that you can see in the QGIS user interface.
Text that looks » like » this directs you through menus.

This kind of text refers to something you can type, such as a command.
This/kind/of.text refers to a path or filename.

This+That refers to a keyboard shortcut comprised of two buttons.

1.2.2 Tiered course objectives

This course caters to different user experience levels. Depending on which category you consider yourself to be in,
you can expect a different set of course outcomes. Each category contains information that is essential for the next
one, so it’s important to do all exercises that are at or below your level of experience.

Basic
In this category, the course assumes that you have little or no prior experience with theoretical GIS knowledge or the
operation of GIS software.

Limited theoretical background will be provided to explain the purpose of an action you will be performing in the
program, but the emphasis is on learning by doing.

When you complete the course, you will have a better concept of the possibilities of GIS, and how to harness their
power via QGIS.

Intermediate

In this category, it is assumed that you have working knowledge and experience of the everyday uses of GIS software.

Building on the instructions for the beginner level will provide you with familiar ground, as well as to make you aware
of the cases where QGIS does things slightly differently from other software you may be used to. You will also learn
how to use analysis functions in QGIS.

When you complete the course, you should be comfortable with using QGIS for all of the functions you usually need
for everyday use.
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Advanced
In this category, the assumption is that you are experienced with GIS software, have knowledge of and experience
with spatial databases, using data on a remote server, perhaps writing scripts for analysis purposes, etc.

Building on the instructions for the other two levels will familiarize you with the approach that the QGIS interface
follows, and will ensure that you know how to access the basic functions that you need. You will also be shown how
to make use of the QGIS plugin system, database access, and so on.

When you complete the course, you should be well-acquainted with the everyday operation of QGIS, as well as its
more advanced functions.

1.2.3 Data

The sample data that accompanies this resource is freely available and comes from the following sources:
« Streets and Places datasets from OpenStreetMap (https://www.openstreetmap.org/)
* Property boundaries (urban and rural), water bodies from NGI (https://ngi.dalrrd.gov.za/)
¢ SRTM DEM from the CGIAR-CGI (http://srtm.csi.cgiar.org/)

Download the prepared dataset from the Training data repository and unzip the file. All the necessary data are
provided in the exercise_data folder.

If you are an instructor, and would like to use more relevant data, you will find instructions for creating local data in
the A preparar os dados do exercicio appendix.

1.2. About the exercises 7
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CAPITULO 2

Module: Criando e explorando um mapa simples

Neste mddulo, ird criar um mapa simples que serd usado mais tarde como base para demonstrar outras funcionalidades
do QGIS.

2.1 Lesson: Uma visao geral sobre a interface

We will explore the QGIS user interface so that you are familiar with the menus, toolbars, map canvas and layers list
that form the basic structure of the interface.

The goal for this lesson: To understand the basics of the QGIS user interface.
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2.1.1 Try Yourself: The Basics

*Basic Map - QGIS 0c62abed96 [tm]

Project Edit View Layer Settings Plugins Vector Raster Database Web Progessing Help

BRERR @epresn AABRE R e SR ME %= 9
- Muesvse @ B

Layers EE)
vAeTE AL
d

BNSDHS

Layers Erﬂ@
Type to locate (Ctrl+K |]\egendentnesmmﬂved Coordinate 20.3420.-33.9989 | % Scale 1:32869 |~ | @ Magnifier| 100% < Rotation |0.0° % v Render @ EPSG:4326 @

The elements identified in the figure above are:
1. Layers List / Browser Panel

Barras de Ferramentas

Map canvas

Status bar

Side Toolbar

AN

Locator bar

The Layers List

In the Layers list, you can see a list, at any time, of all the layers available to you.

Expanding collapsed items (by clicking the arrow or plus symbol beside them) will provide you with more information
on the layer’s current appearance.

Hovering over the layer will give you some basic information: layer name, type of geometry, coordinate reference
system and the complete path of the location on your device.

Right-clicking on a layer will give you a menu with lots of extra options. You will be using some of them before long,
so take a look around!

Nota: A vector layer is a dataset, usually of a specific kind of object, such as roads, trees, etc. A vector layer can
consist of either points, lines or polygons.
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The Browser Panel

The QGIS Browser is a panel in QGIS that lets you easily navigate in your database. You can have access to common
vector files (e.g. ESRI Shapefile or Maplnfo files), databases (e.g. PostGIS, Oracle, SpatiaLite, GeoPackage or MS
SQL Server) and WMS/WFS connections. You can also view your GRASS data.

If you have saved a project, the Browser Panel will also give you quick access to all the layers stored in the same path
of the project file under in the * Project Home item.
Moreover, you can set one or more folder as Favorites: search under your path and once you have found the folder,

right click on it and click on Add as a Favorite. Youshould then be able to see your folder in the Favorites
item.

Dica: It can happen that the folders added to Favorite item have a really long name: don’t worry right-click on the
path and choose Rename Favorite. .. toset another name.

Toolbars

Your most often used sets of tools can be turned into toolbars for basic access. For example, the Project toolbar
allows you to save, load, print, and start a new project. You can easily customize the interface to see only the tools
you use most often, adding or removing toolbars as necessary via the View » Toolbars menu.

Even if they are not visible in a toolbar, all of your tools will remain accessible via the menus. For example, if you
remove the Project toolbar (which contains the Save button), you can still save your map by clicking on the Project
menu and then clicking on Save.

The Map Canvas
This is where the map itself is displayed and where layers are loaded. In the map canvas you can interact with the

visible layers: zoom in/out, move the map, select features and many other operations that we will deeply see in the
next sections.

The Status Bar

Shows you information about the current map. Also allows you to adjust the map scale, the map rotation and see the
mouse cursor’s coordinates on the map.

The Side Toolbar

By default the Side toolbar contains the buttons to load the layer and all the buttons to create a new layer. But
remember that you can move all the toolbars wherever it is more comfortable for you.

The Locator Bar

Within this bar you can access to almost all the objects of QGIS: layers, layer features, algorithms, spatial bookmarks,
etc. Check all the different options in the locator_options section of the QGIS User Manual.

Dica: With the shortcut Ct r1+X you can easily access the bar.

2.1. Lesson: Uma visao geral sobre a interface 11
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2.1.2 Try Yourself 1

Try to identify the four elements listed above on your own screen, without referring to the diagram above. See if you
can identify their names and functions. You will become more familiar with these elements as you use them in the
coming days.

Answer

Refer back to the image showing the interface layout and check that you remember the names and functions of the
screen elements.

2.1.3 Try Yourself 2

Try to find each of these tools on your screen. What is their purpose?

=]
1. I=F3

2 B
3. B
4. iRender

5. mm

Nota: If any of these tools is not visible on the screen, try enabling some toolbars that are currently hidden. Also
keep in mind that if there isn’t enough space on the screen, a toolbar may be shortened by hiding some of its tools.
You can see the hidden tools by clicking on the double right arrow button in any such collapsed toolbar. You can see
a tooltip with the name of any tool by holding your mouse over the tool for a while.

Answer

1. Save as
Zoom to layer(s)
Invert selection

Rendering on/off

A

Measure line

2.1.4 What’s Next?

Now that you are familiar with the basics of the QGIS interface, in the next lesson we will see how to load some
common data types.
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2.2 Lesson: Adding your first layers

We will start the application, and create a basic map to use for examples and exercises.

The goal for this lesson: To get started with an example map.

Nota: Before starting this exercise, QGIS must be installed on your computer. Also, you should have downloaded
the sample data to use.

Launch QGIS from its desktop shortcut, menu item, etc., depending on how you configured its installation.

Nota: The screenshots for this course were taken in QGIS 3.4 running on Linux. Depending on your setup, the
screens you encounter may well appear somewhat different. However, all the same buttons will still be available, and
the instructions will work on any OS. You will need QGIS 3.4 (the latest version at time of writing) to use this course.

Let’s get started right away!

2.2.1 Follow Along: Prepare a map

1. Open QGIS. You will have a new, blank map.

Untitled Project - QGIS [new]
Project Edit View Layer Settings Plugins Vector Raster Database Web Progessing Help

DhEBREERE O 2p "HP s I 00 &
BEV

Browser “® Recent Projects
Lev®*e
Favorites
» [a Home
» O
@ GeoPackage
/ SpatiaLite
@ Postals
P mssQL
@ pB2
@ WMS/WMTS
» @ XvZTiles
@ wcs
@ WFs
© ows
& ArcGisMapServer
& ArcGisFeatureServer
sk GeoNode

g
Al
o

Layers 2®
< @ ® T |: 3= e

L Type to locate (Ctrl+K) Ready Coordinate ¥ scale 11 ~ | @ Magnifier| 100% | Rotation | 0,0° | v/ Render & EpsGi326 @

2. The Data Source Manager dialog allows you to choose the data to load depending on the data type. We'll use
it to load our dataset: click the ‘5 Open Data Source Manager y;ttop

If you can’t find the icon, check that the Data Source Manager toolbar is enabled in the View » Toolbars menu.
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Untitled Project - QGIS [new]

Project Edit View Layer Settings Plugins Vector Raster Database Web Progessing Help

DEBRRRY Uapp  HD GO B #* 2 m-00 00
Yol W Ed ® 2

Browsy ©®  Recent Projects

Data Source Manager | Browser
Browser
QYo
~ ¢ Favorites

» [1 /media/TRAVAIL/2019/Controle
(a1 Home

- ¢ Vector

® WMS/WMTS
Raster
» @ xvzTiles - ’
Y/ =)
A% Mesh
* » @ GeoPackage

© ows ¢ Delimited Text /7 spatiaLite
@ ArcGisMapServer @ Postals
@ ArcGisFeatureserver 4 Geopackage » mssqQL
st GeoNode @ pB2
#,, SpatiaLite » @ WMS/WMTS
» @ XYZTiles
4 PostaresQL
e MSSQL » @
8 @ ArcGisMapServer
s DB2 @ ArcGisFeatureServer
i GeoNode
Layers o WA virtual Layer *
« il . T |2 = v =
& wms/wmts
& wes
a WFS
&
g ArcGIS Map Server
/2 ArcGIS Feature
Server
4 GeoNode
Q Type to locate (Ctrl+K) Ready Coordinate ¥ scale 11

3. Load the protected_areas. shp vector dataset:

1. Click on the Vector tab.

2. Enable the - ® File source type.

3. Press the ... button next to Vector Datasel(s).

Rotation [0,0°

2V Render @ EpsGus2s @

4. Select the exercise_data/shapefile/protected_areas.shp file in your training

directory.

5. Click Open. You will see the original dialog, with the file path filled in.
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B Browser

Vector

* Raster

</
_A_+ Mesh

* Delimited Text

"d GeoPackage

ey SpatialLite
* PostgreSQL
4 MSSQL

DB2
% DB2

m Virtual Layer

ﬁ WMS/WMTS
5@; WCs
g WFS
@ ArcGIS Map
# Server

ArcGIS Feature

Server

Data Source Manager | Vector
Source Type
(@ File ( Directory (' Database (' Protocol: HTTP(S), cloud, etc.
Encoding System -

Source

Vector Dataset(s) exercise_data/shapefile/protected_areas.shp

@Help < Add # Close

6. Click Add here as well. The data you specified will now load: you can see a protected_areas item
in the Layers panel (bottom left) with its features shown in the main map canvas.

*Untitled Project - QGIS [new]

Project Edit View Layer Settings Plugins Vector Raster Database Web Progessing Help

DEBRERRY UeLL /i BPPRPRA RN &0 -5-8-5,58#% I =-0-

LA AN A TN

Browser B®
GRTHO
Favorites
» (6] Home
y [0/
@ GeoPackage
/# spatiaLite
@ Postals
» MmssQL
I pB2
@ WMS/WMTS
» @ XYZTiles
@ wcs
@ WFS
© ows
& ArcGisMapServer
& ArcGisFeatureServer
s§¢ GeoNode

Layers B®
Qe TEFAL
1 protected areas

Q Type to locate (CErl+K) Ready

an
= o ® -
Coordinate|20.3631,33.8948 | 9 Scale 1:76050 ~ | & Magnifier | 100% | Rotation |0,0° 5 V| Render & EPsc4326 @
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Congratulations! You now have a basic map. Now would be a good time to save your work.

1. Click on the Save As button: i3

2. Save the map under a solution folder next to exercise_data andcallit basic_map.ggz.

2.2.2 Try Yourself

Repeat the steps above to add the places.shp and rivers.shp layers from the same folder
(exercise_data/shapefile) to the map.

Answer

In the main area of the dialog you should see many shapes with different colors. Each shape belongs to a layer you
can identify by its color in the left panel (your colors may be different from the ones in Fig.2.1 below):

basic_map - QGIS
Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help

D DE? @‘:‘ﬁ‘?‘ﬁﬁﬂﬁ;’; & ! El;: a@ %'D'g{‘éézﬁ'o e
WSV, % #/BGR- 4@ =00 “aEwzsee @ 2 X

Layers (=]
« B® T &vAF A
rivers

v/ * places
v [ ] protected_areas

Layers | Browser O

L Type to locate (Ctrl+K) Coordinate | 20.4061,33.8952 | 9§ Scale| 1:108708 ~ | @ Magnifier| 100% | Rotation |0.0° +||v| Render @ EPSCi4326 @

Figura2.1: A basic map

2.2.3 Follow Along: Loading vector data from a GeoPackage Database

Databases allow you to store a large volume of associated data in one file. You may already be familiar with a
database management system (DBMS) such as Libreoffice Base or MS Access. GIS applications can also make use
of databases. GIS-specific DBMSes (such as PostGIS) have extra functions, because they need to handle spatial data.

The GeoPackage open format is a container that allows you to store GIS data (layers) in a single file. Unlike the ESRI
Shapefile format (e.g. the protected_areas.shp dataset you loaded earlier), a single GeoPackage file can
contain various data (both vector and raster data) in different coordinate reference systems, as well as tables without
spatial information; all these features allow you to share data easily and avoid file duplication.

In order to load a layer from a GeoPackage, you will first need to create the connection to it:
1. Click on the ‘5 Open Data Source Manager ;o

2. On the left click on the @ GeoPackage tab.

3. Click on the New button and browse to the training_data.gpkg file in the exercise_data folder
you downloaded before.
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4. Select the file and press Open. The file path is now added to the Geopackage connections list, and appears in
the drop-down menu.

You are now ready to add any layer from this GeoPackage to QGIS.

1. Click on the Connect button. In the central part of the window you should now see the list of all the layers
contained in the GeoPackage file.

2. Select the roads layer and click on the Add button.

Data Source Manager | GeoPackage

I srowser Connections
- g Vector training_data.gpkg@j/media/sf_GitHub/QGIS-Training-Data/exercise_dataj/training_data.gpkg -
P Raster New Remove
XU/
=z Mesh Table * Type Geometry column Sql
Delimited Text - /medl.a/.sf_thub/QGIS—Tralmng—Data/exer(lse_data/trmnlng_data.gpkg )
* buildings = MultiPolygon geom
roads " Linestring geom
4™ SpatiaLite
- PostgreSQL
Py MSSQL
DE2 pB2
m Virtual Layer
@a WMS/WMTS
-I@:; WCS
.y WFS [ ’

*
F Also list tabl ith b
ﬁ ArCGIS Map S SO UsC Cables wi no geometry

Search options

ArcGIS Feature
server

4 GeoNode @Help Set Filter «/ Add ¥ Close

A roads layer is added to the Layers panel with features displayed on the map canvas.
3. Click on Close.

Congratulations! You have loaded the first layer from a GeoPackage.

2.2.4 Follow Along: Loading vector data from a SpatiaLite Database with the
Browser

QGIS provides access to many other database formats. Like GeoPackage, the SpatiaLite database format is an
extension of the SQLite library. And adding a layer from a SpatiaLite provider follows the same rules as described
above: Create the connection —> Enable it —> Add the layer(s).

While this is one way to add SpatiaLite data to your map, let’s explore another powerful way to add data: the Browser.
1. Click the ‘l icon to open the Data Source Manager window.

2. Click on the |/ Browser tab.
3. In this tab you can see all the storage disks connected to your computer as well as entries for most of the tabs

in the left. These allow quick access to connected databases or folders.

For example, click on the drop-down icon next to the 0 GeoPackage entry. You'll see the
training-data.gpkg file we previously connected to (and its layers, if expanded).
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4. Right-click the f SpatiaLite entry and select New Connection....

5. Navigate to the exercise_data folder, select the landuse.sqglite file and click Open.
Notice that a @ landuse.sqglite entry has been added under the SpatiaLite one.

6. Expand the @ landuse.sqlite entry.

7. Double-click the -~ landuse layer or select and drag-and-drop it onto the map canvas. A new layer is added
to the Layers panel and its features are displayed on the map canvas.

Data Source Manager | Browser

| Browser LoTneE
v QETHO
< Vector - Favorites
» [® Project Home
Raster
L » [&] Home
A% Mesh » D/
. ~ @ GeoPackage
 Delimited Text ~ [ training_data.gpkg
_ 9 buildings
‘& GeoPackage " roads

~ / SpatiaLite

i":_ SpatialLite ~ = landuse.sqlite

4 PostgresQL @ PostGIs
> mssQL
» MSSQL = pB2
@ WMS/WMTS
0% B2 ~ &% XYZ Tiles
va . i OpenStreetMap
L_ﬁ Virtual Layer ® wes
v @ WFS
WMS/WMTS iy
‘E / = OWS
—j@"—‘_ WCS @i ArcGisMapServer
%" ArcGisFeatureServer
| WFS ¢ GeoNode

i ArcGIS Map Server

ArcGIS Feature
/% Server

» GeoNode

Dica: Enable the Browser panel in View » Panels » and use it to add your data. It’s a handy shortcut for the Data
Source Manager » Browser tab, with the same functionality.

Nota: Remember to save your project frequently! The project file doesn’t contain any of the data itself, but it
remembers which layers you loaded into your map.
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2.2.5 Try Yourself Load More Vector Data
Load the following datasets from the exercise_data folder into your map using any of the methods explained
above:

e buildings

* water

Answer
Your map should have seven layers:
e protected_areas
* places
* rivers
* roads

e landuse

buildings (taken from training_data.gpkg) and

water (taken from exercise_data/shapefile).

2.2.6 Follow Along: Reordering the Layers

The layers in your Layers list are drawn on the map in a certain order. The layer at the bottom of the list is drawn
first, and the layer at the top is drawn last. By changing the order that they are shown on the list, you can change the
order they are drawn in.

Nota: You can alter this behavior using the Control rendering order checkbox beneath the Layer Order panel. We
will however not discuss this feature yet.

The order in which the layers have been loaded into the map is probably not logical at this stage. It’s possible that the
road layer is completely hidden because other layers are on top of it.

For example, this layer order...

Layers (E]ES]
o @ ® T & - i L

v| [] water

v| [[] buildings

v| [ landuse

v/ — roads

v/ — rivers

v/ * places

v| [ ] protected_areas

... would result in roads and places being hidden as they run underneath the polygons of the landuse layer.
To resolve this problem:

1. Click and drag on a layer in the Layers list.

2. Reorder them to look like this:

2.2. Lesson: Adding your first layers 19
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basic_map - QGIS
Project Edit View Layer Settings Plugins Vector Raster Database Web Help

DEARRERY OBALLAHPPLAAREDNRE &6 K-N-5,0E I m- -
REV.A® # /B R S@<0 0 “qE%% 3 s ® @

Layers B
o & o T v
places
v/ — roads
v| — rivers
v! [ buildings
V! [ water
v| [] protected_areas
v/ [l landuse

Layers | Browser

Q Type to locate (Ctrl+K) - Cnn’rdinala 20.4981,33.9741 |95 Scale| 1:56077 ~| @ Magniﬁer Rotation | 0.0° :I v Render ¢ EPSG4326 @
You'll see that the map now makes more sense visually, with roads and buildings appearing above the land use regions.

2.2.7 In Conclusion

Now you’ve added all the layers you need from several different sources and created a basic map!

2.2.8 What’s Next?

Now you're familiar with the basic function of the Open Data Source Manager button, but what about all the others?
How does this interface work? Before we go on, let’s take a look at some basic interaction with the QGIS interface.
This is the topic of the next lesson.

2.3 Lesson: Navegar na Tela do Mapa

Esta secc¢@o ird focar-se nas ferramentas de navegagao basicas do QGIS utilizadas para navegar na «Tela do Mapa».
Estas ferramentas irdo permitir-lhe explorar visualmente as camadas em escalas diferentes.

O objetivo desta licao: saiba como utilizar as ferramentas «Mover e Ampliar» no QGIS e saiba como escalar o
mapa.

2.3.1 Ferramentas de Navegacao Basicas do Follow Along:

Antes de aprender a navegar na «Tela do Mapa», vamos adicionar algumas camadas que ndés podemos explorar
durante este tutorial.

1. Open a new blank project and using the steps learnt in Create a Map, load the previously seen
protected_areas, roads and buildings layers to the project. The result view should look similar to
the snippet in Fig.2.2 below (colors do not matter):
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Browser (=]
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v [ VirtualBox
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¢ Anaconda3
» AppMods
¢ Autodesk
» Contacts
¢ Desktop
» Documents
b Downloads
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Figura2.2: Areas protegidas, estradas e edificios adicionados

Let’s first learn how to use the Pan Tool.

1. In the Map Navigation Toolbar, make sure the @ Pan button is activated.
2. Move the mouse to the center of the Map Canvas area.
3. Left-click and hold, and drag the mouse in any direction to pan the map.

Next, let’s zoom in and take a closer look at the layers we imported.

1. In the Map Navigation Toolbar, click on the 4*+’ Zoom In bystton,
2. Move your mouse to approximately the top left area of where there is the highest density of buildings and roads.
3. Clique esquerdo e mantenha.

4. Then drag the mouse, which will create a rectangle, and cover the dense area of buildings and roads (Fig.2.3).
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Figura2.3: Zoom +

5. Release the left click. This will zoom in to include the area that you selected with your rectangle.
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@ *Untitled Project - QGIS — O X
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Help
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[ eclipse ]
|+ [ eclipse-workspace
Layers =] . X
i » T &8 7 O i

— roads : 7.6 -
M buildings ' - ol .-
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1]
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6. To zoom out, select the }9 Zoom Out byytton and perform the same action as you did for zooming in.

As you pan, zoom in, or zoom out, QGIS saves these views in a history. This allows you to backtrack to a previous
view.

1. In the Map Navigation Toolbar, click on ;a Zoom Last hytton to go to your previous view.

2. Click on }a Zoom Next bytton to proceed to move forward in your history.
Sometimes after exploring the data, we need to reset our view to the extent of all the layers. Instead of trying to use
the Zoom Out tool multiple times, QGIS provides us with a button to do that action for us.

1. Click on the ﬂ Zoom Full Extent tyyon,

As you zoomed in and out, notice that the Scale value in the Status Bar changes. The Scale value represents the Map
Scale. In general, the number to the right of : represents how many times smaller the object you are seeing in the
Map Canvas is to the actual object in the real world.
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Coordinate  20.6324,-34.0757 - Scale 1:128472 ~ | & Magnifier 100% +| Rotation |0.0° 5| v/ Render X @

You can also use this field to set the Map Scale manually.
1. In the Status Bar, click on the Scale textfield.

2. Type in 50000 and press Enter. This will redraw the features in the Map Canvas to reflect the scale you
typed in.

3. Alternatively, click on the options arrow of the Scale field to see the preset map scales.

£
1:1000000 =

1:500000
1:250000
1:100000
1:50000
1:10000
1:5000
1:2500
1:1000 '~
b Scale|1:50000 v

4. Select 1:5000. This will also update the map scale in the Map Canvas.

Now you know the basics of navigating the Map Canvas. Check out the User Manual on Zooming and Panning to
learn about alternative ways of navigating the Map Canvas.

2.3.2 In Conclusion

Knowing how to navigate the Map Canvas is important, as it allows one to explore and visually inspect the layers.
This could be done for initial data exploration, or to validate output of a spatial analysis.

2.4 Lesson: Symbology

The symbology of a layer is its visual appearance on the map. The basic strength of GIS over other ways of
representing data with spatial aspects is that with GIS, you have a dynamic visual representation of the data you’re
working with.

Therefore, the visual appearance of the map (which depends on the symbology of the individual layers) is very
important. The end user of the maps you produce will need to be able to easily see what the map represents. Equally
as important, you need to be able to explore the data as you’re working with it, and good symbology helps a lot.

In other words, having proper symbology is not a luxury or just nice to have. In fact, it’s essential for you to use a
GIS properly and produce maps and information that people will be able to use.

The goal for this lesson: To be able to create any symbology you want for any vector layer.
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2.4.1 Follow Along: Changing Colors

To change a layer’s symbology, open its Layer Properties. Let’s begin by changing the color of the 1anduse layer.
1. Right-click on the 1anduse layer in the layers list.

2. Select the menu item Properties... in the menu that appears.

Nota: By default, you can also access a layer’s properties by double-clicking on the layer in the Layers list.

Dica: The d button at the top of the Layers panel will open the Layer Styling panel. You can use this panel
to change some properties of the layer: by default, changes will be applied immediately!

3. In the Layer Properties window, select the @( Symbology tab:

Layer Properties - landuse | Symbology
S [Esinglesymbol -]

@ nformation I T ¢ |

. [ simple fill

3 source

& symbology
€3 Labels
€D Masks Unit | Millimeters ~|
. Opacity 1/1000% |+
a Diagrams -
Color | H
N# 3D View
E Fields
E Attributes Form | . Favorites ~| 8
Joins
F
£} Auxiliary Storage
a - SR
@ Actions ) . . . .
" gradient gray 3 fill hashed black / hashed black\,  hashed black X outline blue outline green outline red
L
, Display plasma
. : r
“ Rendermg . @ - - -
i [
Variables
. outline xpattern pattern dot pattern zelda simple blue fill  simple green fill  simple red fill
a [LEELELE] black
" Dependencies )= |save Symbol...| Advanced - |
Legend » Layer Rendering
&4 qais server .| @relp || style - | /apply || ®cancel | [ /oK ]

4. Click the color select button next to the Color label. A standard color dialog will appear.
5. Choose a gray color and click OK.

6. Click OK again in the Layer Properties window, and you will see the color change being applied to the layer.
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2.4.2 Try Yourself

Change the color of the water layer to light blue. Try to use the Layer Styling panel instead of the Layer Properties
menu.

Solution

 Verify that the colors are changing as you expect them to change.

« It is enough to select the water layer in the legend and then click on the ‘& Open the Layer Styling panel o
Change the color to one that fits the water layer.

symbology - QGIS
Project Edit View Layer Settings Plugins Vector Raster Database Web Help

DEBRRRY OUPALAHRPPLAALBORS 6 N-0-5FEHHE 2 =~ I

BEV. AW # /B2 2T %0 0 mafl%s s ® 4 B
Layers ® Layer Styling ®
o 0l e TE-F » (= water -
N & = Single symbol -
7] ] simple fill
v || water
[
v [[] landuse
& OaflY
unit | Millimeter x| =
OpaCity e—— | 100.0% |+
Color
. Favorites a|-| i

b Layer Rendering

Layers | Browser oo V| Live update | « Apply

2 Type to locate (Ctri+K) Coordinate | 20.5265,-33.9850 |95 Scale  1:50008 - | @ Magnifier 100% ~| Rotation |0.0°

%[V Render & EPSG4326 @

If you want to work on only one layer at a time and don’t want the other layers to distract you, you can hide a layer
by clicking in the checkbox next to its name in the layers list. If the box is blank, then the layer is hidden.

2.4.3 Follow Along: Changing Symbol Structure
This is good stuff so far, but there’s more to a layer’s symbology than just its color. Next we want to eliminate the
lines between the different land use areas so as to make the map less visually cluttered.
1. Open the Layer Properties window for the 1anduse layer.
Under the (3/ Symbology tab, you will see the same kind of dialog as before. This time, however, you’re
doing more than just quickly changing the color.
2. In the symbol layers tree, expand the Fill dropdown and select the Simple fill option.
3. Click on the Stroke style dropdown. At the moment, it should be showing a short line and the words Solid Line.
4. Change this to No Pen.
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Layer Properties - landuse | Symbology

| = Single symbol -]

(4 Information > [ Fill |E|

Simple Fill
N :
AN Source e
Q2]
ﬂ' symbology
€3 Labels
5 Masks symbol layer type| Simple Fill v |
: i .
" Diagrams Fill color | H =
Fill skyl Solid v
Wf 3D View syle | -| =
stroke color | (NN - =,
B Fielas B
Stroke width | 0,260000 2| Mmillimeters  ~ | &,
E Attributes Form
Stroke style | No Pen '| LEH
o] Joinstyle | T Bevel M=
ﬂ Auxiliary Storage % | 0,000000 |:
Offset ' Millimeters - |
@ Actions y  0,000000 2]
@ oisplay v| Enable symbol layer €=, Draw effects
q. Rendering
P Layer Rendering
Variables _| @nelp || style - | «/Apply || % cancel |[ < oK ]

5. Click OK.

Now the 1anduse layer won’t have any lines between areas.

2.4.4 Try Yourself

* Change the water layer’s symbology again so that it has a darker blue outline.

* Change the rivers layer’s symbology to a sensible representation of waterways.

Remember: you can use the d Open the Layer Styling panel by;tton and see all the changes instantly. That panel also allows
you to undo individual changes while symbolizing a layer.

Answer

Your map should now look like this:
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symbology - QGIS 0

Project Edit View Layer Settings Plugins Vector Raster Database Web Help
0 B (e, HPPLARRINLS &6 N-N-GEHE I - [T
REV.AR J/BVER-ZT BB =4 HEB3%T R 2 « K

@® Layer Styling =[]
® /" rivers -
& = Single symbol -
v b 5 — Simple line
areas D
8 ' K
= B
Q & O allw
{
= e unit  Millimeter x|~
N Opacity _1/100.0 % =
’ color | NN
Wwidth | 0.36000 ERES
<. Favorites a |- a
» Layer Rendering
Layers | Browser b e V| Live update | « Apply
Q Type to locate (Ctrl+K) Coordinate  20.3963-34.0335 | 9§  Scale | 1:51337 ~ | @ Maagnifier| 100% 2| Rotation |0.0° || Render ¢ EPSG:4326 @

If you are a Beginner-level user, you may stop here.
 Use the method above to change the colors and styles for all the remaining layers.
» Try using natural colors for the objects. For example, a road should not be red or blue, but can be gray or black.

* Also feel free to experiment with different Fill style and Stroke style settings for the polygons.

symbology - QGIS
Project Edit View Layer Settings Plugins WVector Raster Database Web Help

NEEBRREY NE,sNPPAAGBEIS 66 -0 - B8 e -
BV A y/BRER-ZTd<8 B o g e E o on = @A x

Layers ® Layer Styling ®
|0 e T & -8 » - 7 buildings -
Vi 8 places = Single symbol -
v/ — roads nd
7 — rteere __F
v! [l buildings W simple fill
v| [ | water | " .
v || protected_areas , ML ¢ i "l
v landuse
’, 7 & ol[a|[¥
<4 =
i unit  Millimeter |~
Opacity _1/100.0 % -
Color I
. Favorites a|-| &
P Layer Rendering
Layers | Browser / LIS V| Live update | « Apply
Q Type to locate (Ctrl+K) Coordinate| 20.5355-33.9815 |5 Scale 1:53664 ~ | @ Magnifier 100% ~| Rotation |0.0° +| v Render @ Epsc:4326 @
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2.4.5 Follow Along: Scale-Based Visibility

Sometimes you will find that a layer is not suitable for a given scale. For example, a dataset of all the continents may
have low detail, and not be very accurate at street level. When that happens, you want to be able to hide the dataset
at inappropriate scales.

In our case, we may decide to hide the buildings from view at small scales. This map, for example...

symbology - QGIS %

Project Edit View Layer Settings Plugins Vector Raster Database Web Help

NEARREN UL LLPHPPRKLABEORS @6 -N-N-588 Z & -0 [0~
RV W V/JBRR-Z 0> B =By E e @A « X

Layers @&
« il ® T &~ »
vl = places
V| — roads
V| — rivers
v [7] bulldings
v/ [ | water

I protected_areas

v landuse

Layers = Browser

-

Q Type to locate (Ctrl+K) sordinal| 20.7122-33.9589 | zal|1:150104 |~ | & agnifi 100% < | otatic |0.0° | ¥ Render % EPSGid3z6 @

... is not very useful. The buildings are hard to distinguish at that scale.
To enable scale-based rendering:

1. Open the Layer Properties dialog for the buildings layer.

2. Activate the f Rendering tab.
3. Enable scale-based rendering by clicking on the checkbox labeled Scale dependent visibility:
4. Change the Minimum value to 1:10000.
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Layer Properties - buildings | Rendering >

v |v| Scale Dependent Visibility

q’ L Minimum (exclusive) Maximum (inclusive)
4= [1:10000 - |[&| P o - ||m
" Source
v| Simplify G b
& Symbology mplify Geometry
Note: Feature simplification may speed up rendering but can result in rendering inconsistencies
€3 Labels S . . - e N -
Simplification threshold (higher values result in more simplification) 1,00 pixels
€D Masks simplification algorithm Distance ~
Diagrams
‘4; 3D View Maximum scale at which the layer should be simplified (1:1 always simplifies) | 1:1 -
E Fields Force layer to render as a raster (may result in smaller export file sizes)
E Attributes Form Refresh layer at interval (seconds)

, Refresh layer on notification
Joins

ﬁ Auxiliary Storage
{;'.-Q Actions
, Display

@’ Rendering

5. Click OK.

Test the effects of this by zooming in and out in your map, noting when the buildings layer disappears and
reappears.

Nota: You can use your mouse wheel to zoom in increments. Alternatively, use the zoom tools to zoom to a window:

ye

2.4.6 Follow Along: Adding Symbol Layers
Now that you know how to change simple symbology for layers, the next step is to create more complex symbology.
QGIS allows you to do this using symbol layers.

1. Go back to the 1anduse layer’s symbol properties panel (by clicking Simple fill in the symbol layers tree).

In this example, the current symbol has no outline (i.e., it uses the No Pen border style).
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f}' Information

‘}S,‘_- Source

ﬂ’ symbology

€3 Labels

B Masks

. Diagrams

Wf 3D View
B Fielas

E Attributes Form

Joins

ﬂ Auxiliary Storage
@ Actions
. Display

& f Rendering

Variables

Layer Properties - landuse | Symbology

| = Single symbol -]

v [ Fill | & |
Simple Fill —
el
symbol layer type| Simple Fill |
Fillcolor | M |;| LEE
Fill style [ solid - &
stroke color | (. - .
Stroke width | 0,260000 2| Mmillimeters  ~ | &,
Stroke style | No Pen K=t
Join style |a Bevel - | =i
X | 0,000000 E
Offset ' Millimeters - |
y  0,000000 2]

v| Enable symbol layer =, Draw effects

P Layer Rendering
@Help || style -|

| Japply || ®cancel || JoK |

2. Select the Fill level in the tree and click the Ifl-l-ll:| Add symbol layer 1y,tton, The dialog will change to look something
like this, with a new symbol layer added:
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Layer Properties - landuse | Symbology >

= Single symbol =
"’;’ Information ~ H Fill
Simple Fill =l
33 source . [X simple Fill .
' =E
& symbology
€= Labels
symbol layer type Simple Fill -
D Masks Y ver typ s
. i O
S Fill color [=h
Fill style I solid -
WF 3D View 2 &
stroke color | [ - <.
E Fields
Stroke width | 0,260000 @ |7 |Millimeters K =N
E Attributes Form —
Stroke style | ——Solid Line - | €
Joins Join style 1 Bevel K=
ﬁ Auxiliary Storage x | 0,000000 -
Offset Millimeters -
U_@ Actions y | 0,000000 =
® oisplay v| Enable symbol layer 4=, Draw effects
Qj,/ Rendering
» Layer Rendering
e dblee @Help Style -~ « Apply || % cancel «/ OK

-

It may appear somewhat different in color, for example, but you’re going to change that anyway.

Now there’s a second symbol layer. Being a solid color, it will of course completely hide the previous kind of symbol.
Plus, it has a Solid Line border style, which we don’t want. Clearly this symbol has to be changed.

Nota: It's important not to get confused between a map layer and a symbol layer. A map layer is a vector (or raster)
that has been loaded into the map. A symbol layer is part of the symbol used to represent a map layer. This course
will usually refer to a map layer as just a layer, but a symbol layer will always be called a symbol layer, to prevent
confusion.

With the new Simple Fill symbol layer selected:
1. Set the border style to No Pen, as before.

2. Change the fill style to something other than Solid or No brush. For example:
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Layer Properties - landuse | Symbology

- |

| = single symbol

fi' Information ~ [ Fill |§|

Simple Fill — =
‘:{:\\ Source [T simple Fill :i: :l:
: Q|| a
& symbology -
€= Labels
€D Masks symbol layer type| Simple Fill - |
: i (.
S Fill color | H <
Fill skyl i cross -
WF 3D View term | _| =
stroke color | (. - <.
E Fields -
Stroke width | 0,260000 @ || Millimeters  ~ | &,
E Attributes Form
Stroke style | No Pen - &
Joins Joinstyle | T Bevel - &
E’. Auxiliary Storage % | 0.000000 |:
Offset | Millimeters - |
L Actions y |0,000000 S ——
® oisplay v| Enable symbol layer =, Draw effects
&  Rendering
» Layer Rendering
Variables _| @Help || style ~| | «/Apply || % cancel H «/ OK ]

3. Click OK.

Now you can see your results and tweak them as needed. You can even add multiple extra symbol layers and create
a kind of texture for your layer that way.

O |- |
4 simple Fill
IF simple Fill
] simple Fill

It’s fun! But it probably has too many colors to use in a real map...

2.4.7 Try Yourself

Remembering to zoom in if necessary, create a simple, but not distracting texture for the buildings layer using
the methods above.

Answer

Customize your buildings layer as you like, but remember that it has to be easy to tell different layers apart on
the map.

Aqui tem um exemplo:
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symbology - QGIS

Project Edit View Layer Settings Plugins Vector Raster Database Web Help
NoERGERY U, srHdPRPRARRITR Q& N-N-EET -
WOVAM /) /BAR DG <2000 "aEs%s - @R & B -

Layers
« @ ® T & -8 &L =

* places

— roads

— rivers

[7] buildings

|:| water

[] protected_areas

[ landuse

Layers & Browser
[ 2 Type to locate (ctrl+K) | 1| 2045020-3401345 | 2| 1:5000

|2| v Render @ Epsgiezzs @

|-| & r[100% EEREXS

2.4.8 Follow Along: Ordering Symbol Levels

When symbol layers are rendered, they are also rendered in a sequence, similar to the way the different map layers
are rendered. This means that in some cases, having many symbol layers in one symbol can cause unexpected results.

1. Give the roads layer an extra symbol layer (using the method for adding symbol layers demonstrated above).
2. Give the base line a Stroke width of 1 . 5 and a black color.

3. Give the new, uppermost layer a thickness of 0. 8 and a white color.

You'll notice that this happens:

34 Capitulo 2. Module: Criando e explorando um mapa simples



QGIS Training Manual

Well, roads have now a street like symbology, but you see that lines are overlapping each others at each cross. That’s
not what we want at all!

To prevent this from happening, you can sort the symbol levels and thereby control the order in which the different
symbol layers are rendered.

To change the order of the symbol layers:
1. Select the topmost Line layer in the symbol layers tree.

2. Click Advanced w Symbol levels... in the bottom right-hand corner of the window.
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Layer Properties - roads | Symbology B

Q = single symbol =
@ information %
simple line
33 source == Simple line
& symbology
€€ Labels
Unit Millimeters >
B Masks .
Opacity _11100,0% v
", Disgrams Color | -
@& .
3D View
alg width | 1,50000 =RES
E Fields
. (73
E Attributes Form . Favorites a|~| 8
Joins
E_'i Augxiliary Storage
{;'.-® Actions dash black dash blue dash green dash red
- Display Sl v
i Save Symbol...
4 Rendering Symboly evels...

_ b Layer Rendering v| Clip Features to Canvas Extent
Variables _ | @Help Style ~ « Apply || % Cancel < OK

This will open a dialog like this:

symbol Levels x

Enable symbol levels

Define the order in which the symbol layers are rendered. The numbers
in the cells define in which rendering pass the layer will be drawn.

@Help % Cancel

3. Check oA Enable symbol levels. You can then set the layer order of each symbol by entering the corresponding
level number. O is the bottom layer.
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In our case, we just want to activate the option, like this:

Symbol Levels

Enable symbol levels

Define the order in which the symbol layers are rendered. The numbers
in the cells define in which rendering pass the layer will be drawn.

Layer 0 Layer 1
= () 1

% cancel |[_Jok_|

This will render the white line above the thick black line borders:
4. Click OK twice to return to the map.

The map will now look like this:

N\

When you’re done, remember to save the symbol itself so as not to lose your work if you change the symbol again

in the future. You can save your current symbol style by clicking the Save Style... button at the bottom of the Layer
Properties dialog. We will be using the QGIS QML Style File format.
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Save your style in the solution/styles/better_roads.qgml folder. You can load a previously saved style
at any time by clicking the Load Style... button. Before you change a style, keep in mind that any unsaved style you
are replacing will be lost.

249 Try Yourself

Change the appearance of the roads layer again.

Make the roads narrow and yellow, with a thin, pale gray outline and a thin black line in the middle. Remember that
you may need to change the layer rendering order via the Advanced » Symbol levels... dialog.

Answer

To make the required symbol, you need three symbol layers:

Layer Properties - roads (triple_levels) | Symbology

| 2 single symbol

0}
=
o —tLne

fi Information

— Simple line
Q‘:\ Source simple line
= Simple line
& symbology
€7 Labels —
| & | LalV
- el
. Diagrams
~ Unit  Millimeter -|
n# 3D View Opacity 1/100.0% <
E Source Fields REsL |—|j|
Attributes <
Form width | 2.10000 SR="
Joins
. Auxiliary | @ Favorites ~| 8¢
& Storage -
@ Actions
B | ======:  ssss==:  ssss==:  sssss=s — aEE——
- Display
‘ Rendering dash black dash blue dash green dash red effect emboss effect neon
Variables |:| = |save symbol| | Advanced ~|
!h Metadata
P Layer Rendering
™ Dependencies | @Help || style - | JApply || ®cancel || Jok |

The lowest symbol layer is a broad, solid gray line. On top of it there is a slightly thinner solid yellow line and finally
another thinner solid black line.
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If your symbol layers resemble the above but you’re not getting the result you want:

1. Check that your symbol levels look something like this:

symbol Levels

Enable symbol levels

Define the order in which the symbol layers are
rendered. The numbers in the cells define in which
rendering pass the layer will be drawn.

Layer 0 Layer 1 Layer
= . 1 — 2

1] v

 cancet | [_J0_|

2. Now your map should look like this:

2.410 Try Yourself

Symbol levels also work for classified layers (i.e., layers having multiple symbols). Since we haven’t covered
classification yet, you will work with some rudimentary pre-classified data.

1. Create a new project and add only the roads dataset.

2. Apply the style file advanced_levels_demo.qml provided in exercise_data/styles to the

layer. This can be done through the Style » Load Style... combobox at the bottom of the Layer Properties
dialog.

3. Zoom in to the Swellendam area.
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4. Using symbol layers, ensure that the outlines of layers flow into one another as per the image below:
‘k,r:::-% \\ t WL

- —
SN/

A

)
&K )

SIS
-

S P

@

Answer

1. Adjust your symbol levels to these values:

Symbol Levels .

v Enable symbol levels

Define the order in which the symbol layers are
rendered. The numbers in the cells define in which
rendering pass the layer will be drawn.

Layer 0 Layer 1
T Trunk | B 3
—|Tertiary - 2
=— Unclassified == 0 1

@Help ¥ cancel

1. Experiment with different values to get different results.

2. Open your original map again before continuing with the next exercise.
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2.4.11 Follow Along: Symbol layer types

In addition to setting fill colors and using predefined patterns, you can use different symbol layer types entirely. The
only type we’ve been using up to now was the Simple Fill type. The more advanced symbol layer types allow you to
customize your symbols even further.

Each type of vector (point, line and polygon) has its own set of symbol layer types. First we will look at the types
available for points.

Point Symbol Layer Types

1. Uncheck all the layers except for places.

2. Change the symbol properties for the places layer:

Layer Properties - places | Symbology
| = single symbol ]

'rf Information

@ Simple marker

;.'@ Source

Q’ Symbology
€2 Labels
€D Masks Unit | Millimeters -
: Opacity 1100,0% |+
, Diagrams =
Color | H
e . -
g 3D View Size 2,00000 BKE=S
i retos Rotation | 0,00 ° | €
E Attributes Form | O Favorites @ |~ | 8
Joins
ﬁ Augxiliary Storage ® O @ O O *
@ Actions )
dot black dot white dot blue dot green dok red effect drop
. shadow
- Display
& Rendering 3 @ ®

Variables
shield disability topo hospital  topo pop capital

E Metadata

|save Symbol... | |Advanced - |

M Dependencies |_| =

» Layer Rendering
[ @relp |[ syie - _Jaoply || ®cancel |[ ok

3. You can access the various symbol layer types by selecting the Simple marker layer in the symbol layers tree,
then click the Symbol layer type dropdown:
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Layer Properties - places | Symbology

Q = Single symbol -

Ellipse marker

fi Information

Filled marker

15
W Source Font marker

(0t}

& symbology Geometry generator

Mask

€3 Labels .
Raster image marker —

O Masks symbol layer type[STiTE El TN

- : . SVG marker
. [MELEINE Size .
Vector field marker
Np 3D View Fill color N | S
E Fields stroke color | (I - <.
E Attributes Form Stroke style | —— Solid Line ~| &
. Stroke width | Hairline || Millimeters ~| &
Joins
. Join style 5 Bevel ~| S
ﬂ Augxiliary Storage
Rotation 0,00° = EL
o actions 0,000000 =
) X0, -
® Display Offset Millimeters ~| &
y | 0,000000 =
rd .
4  Rendering VCenter MRS
Anchor point
VELELIES . HCenter -~ &
[ Metadata
& OCO0AAKXT@++X 1| > D
ﬁ Dependencies £ a O O |_| I\ /] “ a -

P Layer Rendering

@Help Style - «/ Apply || % Cancel

4. Investigate the various options available to you, and choose a symbol with styling you think is appropriate.

5. If in doubt, use a round Simple marker with a white border and pale green fill, with a Size of 3. 00 and a Stroke
width of 0. 5.

Line Symbol Layer Types

To see the various options available for line data:

1. Change the Symbol layer type for the roads layer’s topmost symbol layer to Marker line:
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"i Information

-?& Source

Q’ Symbology

€= Labels

B Masks

: Diagrams

N7 3D View

E Fields

E Attributes Form

Joins

ﬁ Augxiliary Storage

@ Actions
- Display

&  Rendering

Variables
E Metadata

ﬁ Dependencies

| = single symbol

[ @rep | syle -

Layer Properties - roads | Symbology

v — Line

Arrow
Geometry generator
Hashed line

Marker line &
symbol layer type| Simple line

Color . ] E| L=
Stroke width | 0,260000 @ ||| Milimeters  ~| &,
Offset 10,000000 2| Millimeters  ~| &
stroke style | ——Solid Line K=
Join style | B Bevel - &
Cap style | B square - e
Use custom dash pattern
| Millimeters - g

v| Enable symbol layer 4=, Draw effects

P Layer Rendering

 /Apply || %cancel || JoK |

2. Select the Simple marker layer in the symbol layers tree. Change the symbol properties to match this dialog:
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Layer Properties - roads | Symbology
| = single symbol

"i Information ~ -+ Line |E|
* . - Marker line

;{s} Source v - Marker

Q/ Symbology

""""" jla

€3 Labels
EED Masks symbol layer type Simple marker - 1=
: Diagrams Size 0,500000 |$| | Millimeters ~| &
.." 3D View Fill color | E| (=8
B s stroke color | MM | <,
E Attributes Form Stroke style | ——Solid Line KEE
Soirs Stroke width | Hairline |‘| | Millimeters MKEN
. Join style | B Bevel - &
5" Augxiliary Storage
Rotation | 0,00° | &
& actions 10,000000 [ P
- x y -
- Offset | Millimeters - &
O oisplay y |0,000000 B
& Rendering \VCenter - &
Variables Anchor point 'HCenter aK=E
| Metadat:
AT D000AAK T @++X | > b
"™ Dependencies Dd aoif hA M a -
P Layer Rendering
.| @Help || style - JApply || Xcancel || JoK |

3. Select the Marker line layer and change the interval to 1.00:
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Layer Properties - roads | Symbology

Q = Single symbol -

%) Information ~ . Line e

3

"W Source ~ + Marker =
- simple marker L2

Q’ Symbology

€3 Labels

B Masks symbol layer type| Marker line -

: Diagrams Marker placement =,

.‘.’, 3D View (s with interval 1,000000 < | | Millimeters ~ &

E Fields ' on every vertex

() on last vertex only

E Attributes Form ) )
! on first vertex only

Joins (! on central poink
s’i Augxiliary Storage ) on central point of segments

() on every curve point

{;'.-® Actions
- Display

Q." Rendering

Offset along line 0,000000 Millimeters ~| &

v| Rotate marker to Follow line direction

Average angle over | 4,000000 < | Millimeters ~| &
Variables Line offset 0,000000 2 |Millimeters  ~ | &
E Metadata
v| Enable symbol layer 4=, Draw effects

ﬁ Dependencies

P Layer Rendering

@Help Style - «/ Apply || % Cancel

4. Ensure that the symbol levels are correct (via the Advanced w Symbol levels dialog we used earlier) before
applying the style.

Once you have applied the style, take a look at its results on the map. As you can see, these symbols change direction
along with the road but don’t always bend along with it. This is useful for some purposes, but not for others. If you
prefer, you can change the symbol layer in question back to the way it was before.

Polygon Symbol Layer Types

To see the various options available for polygon data:
1. Change the Symbol layer type for the water layer, as before for the other layers.
2. Investigate what the different options on the list can do.
3. Choose one of them that you find suitable.

4. If in doubt, use the Point pattern fill with the following options:
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Layer Properties - water | Symbology
& [Ssinglesymbol

"i Information - Fill |E|
~ °  Point pattern fill
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: Diagrams Size 2,000000 |$||Millimeter5 ~| &
.r' 3D View Fill color | E| (=8
B s stroke color | (N | =,
E Attributes Form Stroke style | ——Solid Line KEE
Soirs Stroke width | Hairline |‘| | Millimeters MKEN
. Join style | B Bevel - &
5" Augxiliary Storage
Rotation | 0,00° | &
& actions 10,000000 [ P
- x y -
- Offset | Millimeters - &
O oisplay y |0,000000 B
4" Rendering \VCenter K=
Variables Anchor point 'HCenter aK=E
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B mecadoro OCO00CAANXTO@F+F X | DD
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P Layer Rendering
.| @Help || style - JApply || Xcancel || JoK |
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Layer Properties - water | Symbology
& [Ssinglesymbol

%) Information ~ . . Fill | |

a cooo Point pattern Fill
"W Source o000 v © Marker — =
o000 © simple marker |E| |Q|
Q’ Symbology o000
€3 Labels
B Masks symbol layer type Point pattern fill - |
: Diagrams Distance
Horizontal |4,000000 <| | Millimeters K =R
N7 3D View [ | <] |
Vertical | 4,000000 2| Millimeters  ~| &
E Fields .
Displacement
B8 Attributes Form Horizontal | 0,000000 4| Mmillimeters  ~| &
Joins Vertical | 0,000000 4| Mmillimeters  ~ | &
L Offset
5" Augxiliary Storage
Horizontal | 0,000000 2| Millimeters  ~| &
@ Actions - —
Vertical | 0,000000 2| Millimeters  ~| &
- Display
g. Rendering
Variables
E Metadata
v| Enable symbol layer 4=, Draw effects

ﬁ Dependencies

P Layer Rendering
.| @Help || style - JApply || Xcancel || JoK |

5. Add a new symbol layer with a normal Simple fill.
6. Make it the same light blue with a darker blue border.

7. Move it underneath the point pattern symbol layer with the Move down button:
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Layer Properties - water | Symbology X

Q = Single symbol -

fi Information ~ | Fill o
2 simple Fill = @

"% Source » . . Point pattern Fill Olla
& symbology -
€3 Labels
B Masks symbol layer type Simple Fill -
-

, Diagrams Fllcolor | M - (=,
N7 3D View Fill style I solid -la
E Fields stroke color | (I - =
E P — Stroke width | 0,260000 = | Millimeters ~| &

. Stroke style |—— Solid Line K=k
Joins
. Join style 5 Bevel ~| S
E_" Augxiliary Storage -
X | 0,000000 -
@ Actions Offset Millimeters -
. y | 0,000000 =
- Display
/ .
4 Rendering
Variables

E Metadata

ﬁ Dependencies v| Enable symbol layer <=, Draw effects
P Layer Rendering
@Help Style - «/ Apply || % Cancel o OK

As a result, you have a textured symbol for the water layer, with the added benefit that you can change the size, shape
and distance of the individual dots that make up the texture.

2412 Try Yourself

Apply a green transparent fill color to the protected_areas layer, and change the outline to look like this:
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Answer

Here are examples of the symbol structure:

Layer Properties - protected_areas | Symbology
| = single symbol -

"rf Information ~ . Fill

Marker line Nhkddk
;-'o_';_\ Source ~ 4 Marker : :
+ Simple marker ) >
w' symbology simple Fill ayvvvy
€2 Labels — — — — —
1®||=|8laallY]
. Diagrams
symbol layer type| Outline: Marker line v| =
u# 3D View
Marker placement <,
E Source Fields ® with | | I la
®) with interval |3.000000 = Millimeter -
Attributes
Form ) on every vertex
Joins ) on last vertex only
&% Auxiliary ) on first vertex only
L Storage )
: _! on central point
& Actions ]
- ! on every curve point
Display y | PP
Offset along line | 0.000000 || Millimeter -~ &
& Rendering ¥| Rotate marker
Variables Line offset |0.000000 /| Millimeter K=
!h Metadata T I
P Layer Rendering
™ Dependencies _| @Help | stle -| | «/Apply || ®cancel |’ «/ OK ]
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Layer Properties - protected_areas | Symbology

| 2 single symbol -
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;{0} Source * 4+ Marker - -

1 £
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1E|[=|8]|3]| a]l¥
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Symbol layer type| Simple marker v| =
W 3D View
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E Source Fields .

: i ]
Attributes AlLe | l;| &
— Stroke color | H (=R
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o stroke style | ——Solid Line aK=E
=~ Auxiliary
& B storage Stroke width | 0.200000 @ ||| Millimeter K =N
@ Actions Join style | B Bevel - a
. Display Rotation |0.00° |:| <
o o x | 0.000000 s
& Rendering Offset | | Millimeter aK=E
Variables y 0.000000 |'|
| vcenter K =

ah Metadata

P Layer Rendering

™ Dependencies _| @Help | style -| | «/Apply || %cancel |’ «/ OK ]

2.4.13 Follow Along: Geometry generator symbology

You can use the Geometry generator symbology with all layer types (points, lines and polygons). The resulting symbol

depends directly on the layer type.

Very briefly, the Geometry generator symbology allows you to run some spatial operations within the symbology

itself. For example you can run a real centroid spatial operation on a polygon layer without creating a point layer.
Moreover, you have all the styling options to change the appearance of the resulting symbol.
Let’s give it a try!

1. Select the water layer.

2. Click on Simple fill and change the Symbol layer type to Geometry generator.
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G‘ Information
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Gradient fill
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-?& Source
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.r' 3D View Fill style | Outline: Hashed line
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E" Augxiliary Storage -
x | 0,000000 - |—
1B Actions Offset - | Millimeters ~|
y | 0,000000 2] R
- Display
&  Rendering
Variables
E Metadata
v| Enable symbol layer 4=, Draw effects

E Dependencies

P Layer Rendering
.| @Help || style - JApply || Xcancel || JoK |

3. Before to start writing the spatial query we have to choose the Geometry Type in output. In this example we
are going to create centroids for each feature, so change the Geometry Type to Point / Multipoint.

4. Now let’s write the query in the query panel:

[centroid($geometry) ]
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Layer Properties - water | Symbology

| = single symbol

"i Information ~ @ Fill |

Geometry generator

-?& Source ~ @ Marker
® simple marker |

Q’ Symbology

€= Labels

B Masks symbol layer type Geometry generator - |

Diagrams Geometry type | " Point / MultiPaint - |

b
I —
\" 3D View centroid($geometry) |£|
E Fields

E Attributes Form

Joins

ﬁ Augxiliary Storage

@ Actions
- Display

" Rendering

Variables

| Metadata 4 L

Dependencies v/ Enable symbol layer <=, Draw effects

P Layer Rendering
.| @Help || style - | «/Apply || % cancel |[ o OK ]

5. When you click on OK you will see that the water layer is rendered as a point layer! We have just run a
spatial operation within the layer symbology itself, isn’t that amazing?
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With the Geometry generator symbology you can really go over the edge of normal symbology.

Try Yourself

Geometry generator are just another symbol level. Try to add another Simple fill underneath the Geometry generator
one.

Change also the appearance of the Simple marker of the Geometry generator symbology.

The final result should look like this:
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Answer

1. Click on the "--II:I-II:I button to add another Symbol level.

2. Move the new symbol at the bottom of the list clicking the v button.
3. Choose a good color to fill the water polygons.
4. Click on Marker of the Geometry generator symbology and change the circle with another shape as your wish.

5. Try experimenting other options to get more useful results.

2.4.14 Follow Along: Creating a Custom SVG Fill

Nota: To do this exercise, you will need to have the free vector editing software Inkscape installed.

1. Start the Inkscape program. You will see the following interface:
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You should find this familiar if you have used other vector image editing programs, like Corel.

First, we’ll change the canvas to a size appropriate for a small texture.

Change the Units to px.

NS A »N

Select the Circle tool:

Close the dialog when you are done.

Change the Width and Height to 100.

Click on the menu item File » Document Properties. This will give you the Document Properties dialog.

Click on the menu item View » Zoom » Page to see the page you are working with.
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8. Click and drag on the page to draw an ellipse. To make the ellipse turn into a circle, hold the Ct r1 button
while you're drawing it.

9. Right-click on the circle you just created and open its Fill and Stroke options. You can modify its rendering,
such as:

1. Change the Fill color to a somehow pale grey-blue,
2. Assign to the border a darker color in Stroke paint tab,

3. And reduce the border thickness under Stroke style tab.
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10. Draw a line using the Pencil tool:

1. Click once to start the line. Hold Ctr1 to make it snap to increments of 15 degrees.

2. Move the pointer horizontally and place a point with a simple click.

3. Click and snap to the vertex of the line and trace a vertical line, ended by a simple click.
4. Now join the two end vertices.
5

. Change the color and width of the triangle symbol to match the circle’s stroke and move it around as
necessary, so that you end up with a symbol like this one:
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11. If the symbol you get satisfies you, then save it as landuse_symbol under the directory that the course is

in, under exercise_data/symbols, as SVG file.
In QGIS:

1. Open the Layer Properties for the 1anduse layer.

2. Inthe (}{ Symbology tab, change the symbol structure by changing the Symbol Layer Type to SVG Fill shown

below.

3. Click the ... button and then Select File... to select your SVG image.

It’s added to the symbol tree and you can now customize its different characteristics (colors, angle, effects,

units. ..).
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Once you validate the dialog, features in 1anduse layer should now be covered by a set of symbols, showing a
texture like the one on the following map. If textures are not visible, you may need to zoom in the map canvas or set
in the layer properties a bigger Texture width.
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2.4.15 In Conclusion

Changing the symbology for the different layers has transformed a collection of vector files into a legible map. Not
only can you see what’s happening, it’s even nice to look at!

2.4.16 Further Reading

Examples of Beautiful Maps

2.4.17 What's Next?

Changing symbols for whole layers is useful, but the information contained within each layer is not yet available to
someone reading these maps. What are the streets called? Which administrative regions do certain areas belong to?
What are the relative surface areas of the farms? All of this information is still hidden. The next lesson will explain
how to represent this data on your map.

Nota: Did you remember to save your map recently?
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CAPITULO 3

Module: Classificar Dados Vetoriais

A classificacdo de dados vetoriais permite atribuir simbolos diferentes aos elementos (objetos diferentes na mesma
camada), de acordo com os seus atributos. Isso permite a alguém que use o mapa veja facilmente os atributos de
varios elementos.

3.1 Lesson: Vector Attribute Data

Vector data is arguably the most common kind of data in the daily use of GIS. The vector model represents the location
and shape of geographic features using points, lines and polygons (and for 3D data also surfaces and volumes), while
their other properties are included as attributes (often presented as a table in QGIS).

Up to now, none of the changes we have made to the map have been influenced by the objects that are being shown.
In other words, all the land use areas look alike, and all the roads look alike. When looking at the map, the viewers
don’t know anything about the roads they are seeing; only that there is a road of a certain shape in a certain area.

But the whole strength of GIS is that all the objects that are visible on the map also have attributes. Maps in a GIS
aren’t just pictures. They represent not only objects in locations, but also information about those objects.

The goal for this lesson: To learn about the structure of vector data and explore the attribute data of an object

3.1.1 Follow Along: Viewing Layer Attributes
It’s important to know that the data you will be working with does not only represent where objects are in space, but
also tells you what those objects are.

From the previous exercise, you should have the protected_areas layer loaded in your map. If it is not loaded,
then you can find the protected_areas. shp ESRI Shapefile format dataset in directory exercise_data/
shapefile.

The polygons representing the protected areas constitute the spatial data, but we can learn more about the protected
areas by exploring the attribute table.

1. In the Layers panel, click on the protected_areas layer to select it.

2. In the Layer menu, click the Open Attribute Table 1yt (also accessible from top toolbars buttons). This will
open a new window showing the attribute table of the protected_areas layer.
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full_id osm_id osm_type boundary is_in leisure name type wikidata
1/ 12855697 2855697 relation protected_a... Western Ca... nature_reser... Bontebok N... boundary Q892884
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Next, let’s see how a record in the attribute table is linked to a polygon feature that we see on the Map Canvas.

wil

en:Bc

A row is called a record and is associated with a feature in the Canvas Map, such as a polygon. A column is
called a field (or an attribute), and has a name that helps describe it, such as name or id. Values in the cells
are known as attribute values. These definitions are commonly used in GIS, so it is good to become familiar

with them.

In the protected_areas layer, there are two features, which are represented by the two polygons we see

on the Map Canvas.

Nota: In order to understand what the fields and attribute values represent, one may need to find
documentation (or metadata) describing the meaning of the attribute values. This is usually available from

the creator of the data set.

1. Go back to the main QGIS window.

-

2. In the Edit —> Select menu, click on the 5% Select Feature(s) button.

3. Make sure the protected_areas layer is still selected in the Layers panel.

4. Move your mouse to the Map Canvas and left click on the smaller of the two polygons. The polygon will turn

yellow indicating it is selected.
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5. Go back to the Artribute Table window, and you should see a record (row) highlighted. These are the attribute
values of the selected polygon.

Q protected_areas ©: Features Total: 2, Filtered: 2, Selected: 1 - [l *

/ 2 B 0§ LT ES P PE EDe

full id osm id 0sm type boundary is in leisure name tvpe wikidata Wi

) r2855697 protected_a... |Western Ca... |nature_reser... |Bontebok M... |boundary (892884
2/w187055916 187055916 way protected_a... Western Ca... nature_reser... Marloth Mat... NULL NULL NULJ
L) L3

| 7 show All Features _ 2|8
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You can also select a feature using the Attribute Table.

1. In the A#tribute Table window, on the far left, click on the row number of the record that is currently not

selected.
( protected_areas : Features Total: 2, Filtered: 2, Selected: 1 - O X
J e 8 & A EYe PE B ee
full id osm id osm type boundary is in leisure name tvpe wikidata Wi

28556897 protected_a... [Western Ca... |nature_reser... |[Bontebok N...
187055916 way protected_a... Western Ca... nature_reser... Marloth Nat... NULL NULL NULJ

4 3

T show All Features _

2. Go back to the main QGIS window and look at the Map Canvas. You should see the larger of the two polygons
colored yellow.
3. To deselect the feature, go to the Attribute Table window and click on D..-_f] Deselect all features from the layer ¢y,

Sometimes there are many features shown on the Map Canvas and it might be difficult to see which feature is selected
from the Attribute Table. Another way to identify the location of a feature is to use the Flash Feature tool.

1. In the Attribute Table, right-click on any cell in the row that has the attribute value r2855697 for the field
full_id.

2. In the context menu, click on Flash Feature and watch the Map Canvas.

() protected_areas : Features Total: 2, Filte

J Q ® 0§

full id osm id osm type
1

2 w1870559

Select All

Copy Cell Content
Zoom to Feature
Pan to Feature

Flash Feature

Open Form

You should see the polygon flash red a few times. If you missed it, try it again.
Another useful tool is the Zoom to Feature tool, that tells QGIS to zoom to the feature of interest.

1. In the Attribute Table, right-click on any cell in the row that has the attribute value r2855697 for the field
full_id.

2. In the context menu, click on Zoom to Feature

64 Capitulo 3. Module: Classificar Dados Vetoriais



QGIS Training Manual

0 protected_areas @ Features Total: 2, Fi

¥ [ | -
¥ ) El

S F

full id osm id osm tvi

JOCCo0T

il r23855697 -
Select All

2/ w1870559
Copy Cell Content

Zoom to Feature

Pan to Feature

Flash Feature

Open Form

Look at the Map Canvas. The polygon should now occupy the extent of the Map Canvas area.

You may now close the attribute table.

3.1.2 Try Yourself Exploring Vector Data Attributes

1. How many fields are available in the rivers layer?
2. Tell us a bit about the t own places in your dataset.

3. Open the attribute table for the places layer. Which field would be the most useful to represent in label form,
and why?

Answer
* There should be 9 fields in the rivers layer:
1. Select the layer in the Layers panel.
2. Right-click and choose Open Attribute Table, or press the button on the Attributes Toolbar (it can be
enabled from View » Toolbars menu).
3. Count the number of columns.

A quicker approach could be to double-click the rivers layer, open the Layer properties » Fields tab, where you
will find a numbered list of the table’s fields.

* Information about towns is available in the places layer. Open its attribute table as you did with the rivers layer:
there are two features whose place attribute is set to town: Swellendam and Buffeljagsrivier. You can add
comment on other fields from these two records, if you like.

e The name field is the most useful to show as labels. This is because all its values are unique for every object
and are very unlikely to contain NULL values. If your data contains some NULL values, do not worry as long
as most of your places have names.
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3.1.3 In Conclusion

You now know how to use the attribute table to see what is actually in the data you're using. Any dataset will only
be useful to you if it has the attributes that you care about. If you know which attributes you need, you can quickly
decide if you're able to use a given dataset, or if you need to look for another one that has the required attribute data.

3.1.4 What’s Next?

Different attributes are useful for different purposes. Some of them can be represented directly as text for the map
user to see. You'll learn how to do this in the next lesson.

3.2 Lesson: Labels

Labels can be added to a map to show any information about an object. Any vector layer can have labels associated
with it. These labels rely on the attribute data of a layer for their content.

The goal for this lesson: To apply useful and good-looking labels to a layer.

3.2.1 Follow Along: Using Labels

First, ensure that the “2k=! button is visible in the GUI:
1. Go to the menu item View » Toolbars

2. Ensure that the Label Toolbar item has a check mark next to it. If it doesn’t, click on the Label Toolbar item
to activate it.

3. Click on the places layer in the Layers panel so that it is highlighted
4. Click on the ‘stz toolbar button to open the Labels tab of the Layer Styling panel
5. Switch from No Labels to ‘2k=| Single Labels

You'll need to choose which field in the attributes will be used for the labels. In the previous lesson, you decided
that the name field was the most suitable one for this purpose.

6. Select name from the Value list:
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Layer Styling )
o places =

=1 Single Labels - ||
(g

Value |abc name ~ || E

-

abe i abe abc . J

Text

Font | MS ShellDig 2 | S

Style Regular = @.
uE|sl€ B E 1€

Size | 10.0000 | &
Points | S

coor | (GG - <.

Dpaﬂtyl __l IDD.D E‘n"u -

1. Favorites v | 8
= Save Settings...

| e | Live update Apply

7. Click Apply

The map should now have labels like this:
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= /¢ Favorites -| i Single Labels - | \E|

» 5 QGIS-Training-Datate | |[g]
Value | ab< riame -

~ [ QGIS-Training-Data\s
SRR ISR

b [ styles
Font  |Ms Shel Dig 2 MK =S

| abe
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1" Spatial Bookmarks
[ Project Home
[¢] Home
[
" GeoPackage
f SpatiaLite
@ postGls
P mssaL
& pe2
B wms wmTS
ﬂ Wector Tiles
I XVZ Tiles
B wcs
) WFS / OGC AP| - Feature
) ows
& ArcGisMapServer
p=4

NP AP
4 »
Layers (=15
|i“@ ® T &~ »
v| @ places
v roads
v rivers
v| M buitdings
v . ‘water

v . protected_areas
v landuse

Style | Regular ME=E
u&s € 8l&|lr&
Size | 10.0000 BESE
| Paints - | S
cor [ - =,
Opacity m— o |2 S

avorites :i
| O Faverite: al-| 2

v vy owow

E [cave settings..|
(0][e] v Lveupdate | Aoy |

| @ Type to locate (ctl+k) Coordinate| 20,5409,-33.9529 W Scale 1:59610 v | (@ Magnifier | 100% |2] Rotaton [0.0° 2| W/Render @ EpsGiazes @

3.2.2 Follow Along: Changing Label Options

Depending on the styles you chose for your map in earlier lessons, you might find that the labels are not appropriately
formatted and either overlap or are too far away from their point markers.

Nota: Above, you used the ‘=< button in the Label Toolbar to open the Layer Styling panel. As with Symbology,
the same label options are available via both the Layer Styling panel and the Layer Properties dialog. Here, you'll use
the Layer Properties dialog.

1. Open the Layer Properties dialog by double-clicking on the places layer
2. Select the ‘=E<| Labels tab

3. Make sure Zext is selected in the left-hand options list, then update the text formatting options to match those
shown here:
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@ Layer Properties - places | Labels

Information
Source

: Symbology
Labels
D Masks

o -
. Diagrams
E Fields

E Attributes Form

Joins

ﬂ Auxiliary Storage
{;@ Actions
- Display

Rendering

Variables

E Metadata
ﬁ’ Dependencies

Legend
QGIS Server

B oigitizing

W e

4. Click Apply

=1 Single Labels

Value | abc name

w Text Sample

Lorem Ipsum

Larem Ipsum

abe Text
2% Farmatting
abe Byffer

abc! Mask

. Background
- Shadow
ape Callouts
1-:0 Placement

_,"’ Rendering

=
- &
# | |usesw | v | (B |- -

Text
Font |Arial Vl E,
Style Regular - @.
U € (s & BE 1€
Size | 13.0000 A ER
Points | S
coor | (. - =
Opacity 1| 100.0 % 3| €
L Favorites >~ | 8%

Save Settings...

0K, Cancel Apply Help

That font may be larger and more familiar to users, but its readability is still dependent on what layers are
rendered beneath it. To solve this, let’s take a look at the Buffer option.

5. Select Buffer from the left-hand options list

6. Select the checkbox next to Draw text buffer, then choose options to match those shown here:
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@ Layer Properties - places | Labels

Q

{@be| Labels

abe

i
ujuj

7. Click Apply

4
| =1 Single Labels - | |E|
= Value |ib< name - | |E|
w Text Sample
Lorem Ipsum
|Larem Tpsum |E| |1:50810 | ¢ | |§|E| | |E|
abe Text Buffer —
2% Formatting V| Draw textbuffer (=],
@8 puffer Size | 1.0000 |:| e
abc) Mask
. Background |Mi||imeters - | E-
:.f Shadow e | |:| a
/ Callouts

1':0 Placement

“ Rendering

V| Color buffer's fil

Opacity 1| 100.0 % | €

Pen join style | B Bevel - | LEN
Blend mode |Normal - | @
Draw effects
oK | | cancel || Apply [ Help |

You'll see that this adds a colored buffer or border to the place labels, making them easier to pick out on the

map:
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3 QGIS-Training-Data'
~ [ QGIS-Training-Data\s
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v @ basic_map
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Project Home
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" GeoPackage
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I XVZ Tiles
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) WFS / OGC AP| - Feature |
) ows
& ArcGisMapServer -

v vy owow

\
e
=
%&ﬁsuagsri\dsr
_ >,

= -
< [ D

Layers (=15
o 1@ QT EYR G T

@ places

roads

E ~ rivers

B buitdings

. water

. protected_areas
landuse

| Q Type to locate (cul+k) Coordinate | 20.4841,-33.3781 | % Scale 142259 v | (@ Magrifier | 100% |+] Rrotaton [0.0° 2| ViRendsr @epsciazs @

Now we can address the positioning of the labels in relation to their point markers.
8. Select Placement from the left-hand options list

9. Select Around point and change the value of Distance to 2 . 0 Millimeters:

3.2. Lesson: Labels 71



QGIS Training Manual

@ Layer Properties - places | Labels

Q =1 Single Labels -
q Information Value | abs name - || &
w Text Sample
J{:\‘- Source
.“' Symbology Lorem |pGLIITI
Labels b
Lorem Ipsum | (142258 |- | |BF|~ v
D Masks o Placement
- * . a
¢ Diagrams s Farmatting
8Be [uffer
E Fields abe! pask Cartographic '®' Around point Offset from point
Background
E Attributes Form . g
- Shadow
. abe
Joins Callouts
/, Distance | 2.0000 -
. #y¥ Placement
ﬁ Auxiliary Storage 4 Renderi
«+ hendenng Milimeters v @

G@ Actions Duadrant EL
- Display

4
4 Rendering

__ v Geometry generator
Variables

E Metadata
ﬁ’ Dependencies

Point / MultiPoint
Legend

— w Data defined
QGIS Server

“ L Coordinate X E, ¥ E,
Digitizing -

Style * 0K, Cancel Apply Help

W e

10. Click Apply

You'll see that the labels are no longer overlapping their point markers.

3.2.3 Follow Along: Using Labels Instead of Layer Symbology

In many cases, the location of a point doesn’t need to be very specific. For example, most of the points inthe places
layer refer to entire towns or suburbs, and the specific point associated with such features is not that specific on a large
scale. In fact, giving a point that is too specific is often confusing for someone reading a map.

To name an example: on a map of the world, the point given for the European Union may be somewhere in Poland,
for instance. To someone reading the map, seeing a point labeled European Union in Poland, it may seem that the
capital of the European Union is therefore in Poland.

So, to prevent this kind of misunderstanding, it’s often useful to deactivate the point symbols and replace them
completely with labels.

In QGIS, you can do this by changing the position of the labels to be rendered directly over the points they refer to.
1. Open the ‘22| Labels tab of the Layer Properties dialog for the places layer
2. Select the Placement option from the options list

3. Click on the Offset from point button
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This will reveal the Quadrant options which you can use to set the position of the label in relation to the point
marker. In this case, we want the label to be centered on the point, so choose the center quadrant:

() Layer Properties - places | Labels

Q

{abe| Labels

abc

0
{n]u]

7

P4
| =4 Single Labels - | |§|
= Value |HIN: name T | |E|
w Text Sample
-
Lorem Ipsum
-
|Lorem Ipsum IE| |142250 |~ | |EE| | |E|
abe Text Placement

o] Formatting
sbe B ffer

abe) Mask

. Background
-/ Shadow
a/bo Callouts
0:" Placement

‘,‘ Rendering

() Cartographic || Around peint (®) Offset from point

Quadrant

&8s
808
LILIE)

OffsetX,Y | 0.0000 || | 0.0000

2] €

| Millimeters

Rotation | 0.00°

v Geometry generator

Point / MultiPaint

w Data defined

oK [

Cancel || Apply || Hep |

4. Hide the point symbols by editing the layer Symbology as usual, and setting the size of the Marker size to 0 . 0:
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@ Layer Properties - places | Symbology

Q

E Single symbal

¥ Symbology

- Marker |¥|
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abe
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Opacity | 00.0% <l
Color | I:l
= Sze | p.00000 BEEE
=0 . -
- Rotation | 0.00 © B ="
. Favorites a |~ | 8
B ° ® O O ® ¥
dot black dot white dot blue dot green dot red effect drop
shadow
& ® ©
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i/ |_| E Save Symbol . | | Advanced ~ |
v b Layer Rendering
= | style - | oK | | cancel || Apply [ Help |
5. Click Apply and you’ll see this result:
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If you were to zoom out on the map, you would see that some of the labels disappear at larger scales to avoid
overlapping. Sometimes this is what you want when dealing with datasets that have many points, but at other times
you will lose useful information this way. There is another possibility for handling cases like this, which we’ll cover

in a later exercise in this lesson. For now, zoom out and click on the button in the toolbar and see what happens.

3.2.4 Try Yourself Customize the Labels

* Reset the label and symbol settings to have a point marker and a label offset of 2 . 0 Millimeters.

Answer

Your map should now show the marker points and the labels should be offset by 2mm. The style of the markers and
labels should allow both to be clearly visible on the map:
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* Set the map to the scale 1: 100000. You can do this by typing it into the Scale box in the Status Bar. Modify
your labels to be suitable for viewing at this scale.

Answer

One possible solution has this final product:
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To arrive at this result:

e Use a font size of 10

* Use an around point placement distance of 1.5 mm

¢ Use a marker size of 3.0

mm

* In addition, this example uses the Wrap on character option:
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* Enter a space in this field and click Apply to achieve the same effect. In our case, some of the place names
are very long, resulting in names with multiple lines which is not very user friendly. You might find this setting
to be more appropriate for your map.
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3.2.5 Follow Along: Labeling Lines

Now that you know how labeling works, there’s an additional problem. Points and polygons are easy to label, but
what about lines? If you label them the same way as the points, your results would look like this:
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We will now reformat the roads layer labels so that they are easy to understand.

1. Hide the places layer so that it doesn’t distract you

2. Activate &<l Single Labels for the roads layer as you did above for places

3. Set the font Size to 10 so that you can see more labels

4. Zoom in on the Swellendam town area

5. In the Labels tab’s Placement tab, choose the following settings:

3.2. Lesson: Labels

79



QGIS Training Manual
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You'll probably find that the text styling has used default values and the labels are consequently very hard to
read. Update the Text to use a dark-grey or black Color and the Buffer to use a light-yellow Color.
The map will look somewhat like this, depending on scale:
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You'll see that some of the road names appear more than once and that’s not always necessary. To prevent this
from happening:

6. In the Labels tab of the Layer Properties dialog, choose the Rendering option and select Merge connected lines
to avoid duplicate labels as shown:
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=1 Single Labels -
Information Value | abc name - || &

w Text Sample

g

Source
Symbology Larem Ipsum
Labels 4
Lorem Ipsum % | | 1:8860 - | | B~ v
D Masks o Rendering
y u - - - -
Diagrams % Formatting
abe B ffer Pixel size-based visibility (Jabels in map units) E,
Fields abc) pqask
Minimum 3 px - o
Background
Attributes Form . g 5
J Shadow Maximurn 10000 px - L
Joins }” Callouts
.:’ Placement Label zindex | 0,00 - E.
liary Storage / Rendering Show all labels for this layer (induding colliding labels)
. Data defined
Actions
Show label @ Always show @.
Display Show upside-down labels
: 8 never when rotation defined always
Rendering
o Featu i
Variables bt re options
Label every part of multi-part features
Metadata vea e E’
v Merge connected lines to avoid duplicate labels
Dependencies Limit number of features to be labeled to
Legend 2000 -
Suppress labeling of features smaller than
QGls
5.00 mm -
Digitizing -
Style * 0K, Cancel Apply Help

7. Click OK
Another useful function is to prevent labels being drawn for features too short to be of notice.

8. In the same Rendering panel, set the value of Suppress labeling of features smaller than ... to 5.00 mm and
note the results when you click Apply

Try out different Placement settings as well. As we’ve seen before, the Horizontal option is not a good idea in
this case, so let’s try the Curved option instead.

9. Select the Curved option in the Placement panel of the Labels tab

Here’s the result:
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« @l ® T &~ » %
® places
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As you can see, this hides some labels that were previously visible, because of the difficulty of making some of them
follow twisting street lines while still being legible. It makes other labels much more useful since they track the roads
rather than float in space between them. You can decide which of these options to use, depending on what you think
seems more useful or what looks better.

3.2.6 Follow Along: Data Defined Settings

1. Deactivate labeling for the roads layer

2. Reactivate labeling for the places layer

3. Open the attribute table for places via the button

It has one field which is of interest to us now: place which defines the type of urban area for each record.
We can use this data to influence the label styles.

4. Navigate to the Text panel in the places Labels panel

5. Click the \= button next to the Italic text button beneath Style and select Edit... to open the Expression String
Builder:
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@ Expression String Builder

Expression Function Editor

= L= =~ (e

Expected format: bool [1=True|0=False]

Preview:

Feature < Mational Park Reception & Shop | ~

&, Search...

T T T T T YT YT T YTTYTTTTTTYTTTTTE

symbol_color
value
Aggregates
Arrays

Color
Conditionals
Conversions
Date and Time
Fields and Values
Files and Paths
Fuzzy Matching
General
Geometry

Map Layers
Maps

Math

Operators
Rasters

Record and Attributes
String

User expressions
Variables

Recent (generic)

Show Help

Ok Cancel Help

6. Under Fields and Values, double click on place and then click All Unique. This will list all unique values of

the place field of this layer. Add a = in the text editor and then double click on t own.

Alternatively, you can type: "place"

7. Click OK twice:

= 'town' directly in the text editor.

Q@ Expression String Builder

Function Editor

B L
o "town’

Expression

= e - L= e
Expected format: bool [1=True|0=False]
Feature «Mational Park Reception & Shop | ~

Preview: 0

&, Search...

{d vy v v ¥vw¥vovw

rF T T T rorw

symbol_color
value
Aggregates
Arrays

Color

Conditienals
Conversions
Date and Time
Fields and Values
abe fyll_id
abc psm_id
abc gsm_type
abc 5 _in
abc name
abc place
abc sagns_id
abc wikidata
abe wikipedia
Files and Paths
Fuzzy Matching
General
Geometry
Map Layers
Maps
Math

Show Values

group field

Double-click to add field name to expression
string.

Right-Click on field name to open context
menu sample value loading options,
Loading field values from WF5 layers isn't
supported, before the layer is actually
inserted, ie. when building queries.

Values | L Search..
All Unique 10 Samples
hamlet
locality
suburb
town
Ok Cancel Help

Notice that the labels for all places whose place field matches t own are displayed in italics.
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3.2.7 Try Yourself Using Data Defined Settings

Nota: We’re jumping ahead a bit here to demonstrate some advanced labeling settings. At the advanced level, it’s
assumed that you’ll know what the following means. If you don’t, feel free to leave out this section and come back
later when you’ve covered the requisite materials.

1. Open the Attribute Table for places

2. Enter edit mode by clicking the i button

3. Add a new column with the ll?ﬂ button

4. Configure it like this:
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(2} Add Field X
Name FONT _SIZE

Comment

Type Decimal number (real) -

Provider type double
Length 3

Ll

qk

Precision 1

K Cancel

5. Use this to set custom font sizes for each different type of place (each key in the place field)

Answer

1. Still in edit mode, set the FONT__SIZE values to whatever you prefer. The example uses 1 6 for towns, 14 for
suburbs, 12 for localities, and 10 for hamlets.

2. Remember to save changes and exit edit mode
3. Return to the Text formatting options for the places layer and select FONT_SIZE in the A#utribute field of

the font size \= data defined override dropdown:

@ “basic_map - QG aeB3df1 — [m] ® « Re
| ) Layer Properties - places | Labels * « Re
Q 1 = v i [
Q = Single Labels - [ @)= fel
@ irrormation Value [ abc name - (e
w Text Sample
I :{4:\\ Source
Lorem Ipsum
Lorem Ipsum | 135423 |~ | By v
b Text Text 3
Diagrarms % Formatting  Font  |Arial -
5 Buffer
E Fields B8 Mosk style  |Regular - .
Background v
BE] uibutes Form [ uals a Bl & [
J Shadow
abo Size 13,0000 = %|
Joins 7 Callouts
. % Placement Points - -
Y Awiry Storage 7 Rendering | Description... Agsrivier
coor | Store Data in the Praject
B actions
= Opadty |1 100.0 % - Attribute Field N
0 oicpiy e dle : full id (string)
. <, Favorites a@ - Expression osm_id  (string)
& Rendering
Variable | osmtype (string)
Variables Edit... isin  (string)
‘ ~ Paste name  (string)
Bl veteoa Assistant... place  (string)
ﬁ Dependencies sagns_id  (string)
wikidata (string)
Legend wikipedia (string)

FONT_SIZE (double)

& qais server

Save Settings...

BsY

ﬂ [

Style  ~ oK | Cancel Apply Help

APE

.

Q Type to locate (Cirl+) Toagles the editing st Coordinate | 20.4135,-34.0203 | Scale| 1:35423 |~ | @ Magnifier | 100% 2| Rotation |0.0° +| V|Render @ Ersia3e @

Your results, if using the above values, should be this:
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3.2.8 Further Possibilities With Labeling

We can’t cover every option in this course, but be aware that the Label tab has many other useful functions. You
can set scale-based rendering, alter the rendering priority for labels in a layer, and set every label option using layer
attributes. You can even set the rotation, XY position, and other properties of a label (if you have attribute fields
allocated for the purpose), then edit these properties using the tools adjacent to the main Layer Labeling Options
button:

ol - Aok R

(These tools will be active if the required attribute fields exist and you are in edit mode.)

Feel free to explore more possibilities of the labeling system.
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3.2.9 In Conclusion

You've learned how to use layer attributes to create dynamic labels. This can make your map a lot more informative
and stylish!

3.2.10 What’s Next?

Now that you know how attributes can make a visual difference for your map, how about using them to change the
symbology of objects themselves? That’s the topic for the next lesson!

3.3 Lesson: Classification

Labels are a good way to communicate information such as the names of individual places, but they can’t be used for
everything. For example, let us say that someone wants to know what each 1anduse area is used for. Using labels,
you would get this:

This makes the map’s labeling difficult to read and even overwhelming if there are numerous different landuse areas
on the map.

The goal for this lesson: To learn how to classify vector data effectively.

3.3.1 Follow Along: Classifying Nominal Data

1. Open the Layer Properties dialog for the 1anduse layer
2. Go to the Symbology tab
3. Click on the dropdown that says Single Symbol and change it to Categorized:
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"i Information

‘:{:\? Source

& symbology

€€ Labels

B Masks

- .
. [MELEINE

N7 3D View

E Fields

Attributes
Form

Joins

% Auxiliary
< B storage

@ Actions
- Display

4. In the new panel, change the Value to 1anduse and the Color ramp to Random colors

5. Click the button labeled Classify

'rf Information

:-'C\ Source

Q’ Ssymbology

€= Labels

B Masks

Diagrams
W# 3D View

E Fields

Attributes
Form

Joins

L Auxiliary
< B Storage

@ Actions
- Display

3

6. Click OK

| = Categorized

= Categorized

Layer Properties - landuse | Symbology

Value |

Symbol ||

Color ramp |

Random colors

symbol = Value Legend

P Layer Rendering
@Help || style -

- |

Layer Properties - landuse | Symbology

| Classify | |E| |E| | Delete All |

|Advanced ~ |

| /Apply || % cancel |[ & OK ]

value abc landuse ~|| €]
symbol || [+
Color ramp | Random colors |'|
Symbol = Value Legend

v [l cemetery cemetery

v/ [ conservation conservation

v/ [l farmland farmland

v/ [l forest forest

v/ [ grass grass

v Il industrial industrial

v/ [l orchard orchard

v/ [ reservoir reservoir

v/ [l residential residential

v/ [l village _green village green

v [ vineyard vineyard

v [ all other values

| Classify | |E| |E| | Delete All |

» Layer Rendering
@Help || stle -

- |

You'll see something like this:

|Advanced - |

 JApply || ®cancel || JoK |
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7. Click the arrow (or plus sign) next to 1anduse in the Layers panel, you'll see the categories explained:
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Layers (&) )
o [ ® T &~5 & [
» v o places -
v| ] buildings
v — roads
water [
v rivers
* W .~ landuse
v . cemetery
. conservation

B farmland

. Forest

I grass
B industrial

I orchard
. reservoir

B residential

I village_green
"] vineyard

e e e e e e L

Now our landuse polygons are colored and are classified so that areas with the same land use are the same
color.

8. If you wish to, you can change the symbol of each landuse area by double-clicking the relevant color block in
the Layers panel or in the Layer Properties dialog:
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Symbol Selector

(%]
Unit | Millimeters - |
Opacity ~1/100,0 % |:_|
Color | H
| ©. Favorites a|~| &
| Z/ BN

gradient gray 3 fill hashed black/  hashed black,

plasma
|| B |save Symbol... | | Advanced ~|
| @Help | | % cancel H « oK ]

Notice that there is one category that’s empty:
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Layer Properties - landuse | Symbology B
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Symbol [ ] |+

‘:{:\‘_- Source

& symbology

Color ramp Random colors M
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€3 Labels v [ cemetery cemetery
v/ [l conservation conservation
EED Masks v/ [l farmland farmland
. v/ [l forest forest
, Diagrams v/ [ grass grass
v Il industrial industrial
\*’ 3D View v [l orchard orchard
v [ reservoir reservoir
E Fields v/ [l residential residential
Attributes v/ [l v?llage_green v?llage_green
v [ vineyard vineyard

Form
all other values

<
|

Joins

L Auxiliary
< B storage

{;'.-® Actions
@ Display —| @Help Style - « Apply || % cancel

Classify | = | = | Delete All Advanced ~
P Layer Rendering

This empty category is used to color any objects which do not have a landuse value defined or which have a NULL
value. It can be useful to keep this empty category so that areas with a NULL value are still represented on the map.
You may like to change the color to more obviously represent a blank or NULL value.

Remember to save your map now so that you don’t lose all your hard-earned changes!

3.3.2 Try Yourself More Classification

Use the knowledge you gained above to classify the buildings layer. Set the categorisation against the building
field and use the Spectral color ramp.

Nota: Remember to zoom into an urban area to see the results.

3.3.3 Follow Along: Ratio Classification

There are four types of classification: nominal, ordinal, interval and ratio.

In nominal classification, the categories that objects are classified into are name-based; they have no order. For
example: town names, district codes, etc. Symbols that are used for nominal data should not imply any order or
magnitude.

* For points, we can use symbols of different shape.
* For polygons, we can use different types of hatching or different colours (avoid mixing light and dark colours).

* For lines, we can use different dash patterns, different colours (avoid mixing light and dark colours) and different
symbols along the lines.

In ordinal classification, the categories are arranged in a certain order. For example, world cities are given a rank
depending on their importance for world trade, travel, culture, etc. Symbols that are used for ordinal data should
imply order, but not magnitude.
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¢ For points, we can use symbols with light to dark colours.
* For polygons, we can use graduated colours (light to dark).
* For lines, we can use graduated colours (light to dark).

In interval classification, the numbers are on a scale with positive, negative and zero values. For example: height
above/below sea level, temperature in degrees Celsius. Symbols that are used for interval data should imply order and
magnitude.

* For points, we can use symbols with varying size (small to big).
* For polygons, we can use graduated colours (light to dark) or add diagrams of varying size.
 For lines, we can use thickness (thin to thick).

In ratio classification, the numbers are on a scale with only positive and zero values. For example: temperature above
absolute zero (0 degrees Kelvin), distance from a point, the average amount of traffic on a given street per month,
etc. Symbols that are used for ratio data should imply order and magnitude.

¢ For points, we can use symbols with varying size (small to big).
* For polygons, we can use graduated colours (light to dark) or add diagrams of varying size.
¢ For lines, we can use thickness (thin to thick).

In the example above, we used nominal classification to color each record in the 1anduse layer based on its
landuse attribute. Now we will use ratio classification to classify the records by area.

We are going to reclassify the layer, so existing classes will be lost if not saved. To store the current classification:
1. Open the layer’s properties dialog
2. Click the Save Style ... button in the Style drop-down menu.
3. Select Rename Current..., enter Land usage and press OK.
The categories and their symbols are now saved in the layer’s properties.

4. Click now on the Add... entry of the Style drop-down menu and create a new style named ratio. This will
store the new classification.

5. Close the Layer Properties dialog

We want to classify the landuse areas by size, but there is a problem: they don’t have a size field, so we’ll have to
make one.

1. Open the Attributes Table for the 1anduse layer.
2. Enter edit mode by clicking the §/ Toggle editing by yon

3. Add a new column of decimal type, called AREA, using the | £ New field button:

Add Field -

Name AREA
Comment
Type Decimal number (double) ~

Provider type FLOAT
# cancel | «/ OK

4. Click OK

The new field will be added (at the far right of the table; you may need to scroll horizontally to see it). However,
at the moment it is not populated, it just has a lot of NULL values.

To solve this problem, we will need to calculate the areas.
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o

1. Open the field calculator with the === button.

You will get this dialog:

() landuse — Field Calculator X

Only update 0 selected features

v | Create a new field Update existing field

Create virtual field
Qutput field name
Cutput field type | Binary object (BLOB) -

Cutput field length | 0 Precision 3
Expression Function Editor

2, se.. Show Help

row_number
Aggregates
Arrays

Color
Conditionals
Conversions
Date and Time
Fields and Values
Files and Paths
Fuzzy Matching
General
Geometry

Map Layers
Maps

Math

Operatars
Rasters

Record and Attnibu...
String

User expressions
Variables

Feature A F‘

r *F Y F ¥ ¥ ¥ ¥ F ¥ ¥ ¥ Y ¥ F ¥ ¥ FXFW

Preview:

OK Cancel Help

2. Check the oA Update existing fields
3. Select AREA in the fields drop-down menu

Field calculator %

Create a new field V| Update existing field

1.2 AREA -

4. Under the Expression tab, expand the Geometry functions group in the list and find $area

5. Double-click on it so that it appears in the Expression field
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landuse — Field Calculator S5

Create a new Field v Update existing Field
1.2 AREA -

Expression | Function Editor

|8 ol Q search... function $area
area -
$ > B . Returns the area of the current feature. The
» Date and Time ) )
» Fields and Values area calculated by this function respects both
» Files and Paths the current project's ellipsoid setting and area
» Fuzzy Matching unit settings. For example, if an ellipsoid has
» General been set for the project then the calculated
~ Geometry area will be ellipsoidal, and if no ellipsoid is
anale at_vertex set then the calculated area will be
planimetric.
area
azimuth Syntax
boundary
o bounds $area
=LA A L) [ bounds_height
bounds_width Examples
Feature |1 - I3 buffer
* $area - 42
Preview: 1312821.1395745648 buffer_by_m ~ $
@Help % cancel < oK
6. Click OK

7. Scroll to the AREA field in the attribute table and you will notice that it is populated with values (you may
need to click the column header to refresh the data).

Nota: These areas respect the project’s area unit settings, so they may be in square meters or square degrees.

5. Press B to save the edits and exit the edit mode with ,ﬁ; Toggle editing
6. Close the attribute table
Now that we have the data, let’s use them to render the 1anduse layer.
1. Open the Layer properties dialog’s Symbology tab for the 1anduse layer
2. Change the classification style from Categorized to Graduated
3. Change the Value to AREA

4. Under Color ramp, choose the option Create New Color Ramp...:
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@ Layer Properties - landuse | Symbology

‘ Symbology

*

= Graduated -
ke |12 area -] |E|
Symbol | |:|

Legend format |%1- kv

||Precision4 |3| | Trim

Colorramp | -
Labels S
€ | Classes | ] Invert Coler Ramp
i Random Color Ramp
Masks Symbol * V
] I Blues
Diagrams I Greens
G
Fields M Greys
. Magma
Attributes Form I | RdGy
I Reds
Jains
I |Spectra|
Auxiliary Storage . Viridis
All Color Ramps b
Actions
Create Mew Celor Ramp...
Display Edit Color Ramp...
—] Save Color Ramp...
Rendering Mode |HEHEqua1‘cmmmc, T Classes | 5 =
Temporal |ﬂ| |E| |E| |M| |M|
| Link dass boundaries
Variables
P Layer Rendering
Metadata - |?| oK Apply | | Help |
5. Choose Gradient (if it’s not selected already) and click OK. You will see this:
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() Select Color Ramp >

Color 1 | (N |~ color 2 | IR |~/ Type | Continuous B

] ]
w Gradient Stop -
Relative position | 0.0 %G Delete Stop
5 * .
m|® Z o B N o :
Standard colors * | = 100%  |w

100% |«

255 =

L ~| | Opadty S v -

o | = HTML notation | 0000

Current

w Flot

Information oK Cancel Help

You'll be using this to denote area, with small areas as Color 1 and large areas as Color 2.
6. Choose appropriate colors

In the example, the result looks like this:
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(&) Select Color Ramp >

Color 1 - Color 2 _ - Type | Continuous =
| I |~ | O | o | |

w Gradient Stop |~

Relative position | 0.0 % = | Delete Stop

CREERE-REA Ow RV v [}

Standird colors “H | Os Y O e -
—‘ - -

. o I o

1
[ | - | Opadty T lw00% |2

|£"E| HTML notation | #h2dfaa v |

ot o eI
Y OO ]

Information oK ] | Cancel | | Help

7. Click OK
8. You can save the colour ramp by selecting Save Color Ramp... under the Color ramp tab. Choose an appropriate
name for the colour ramp and click Save. You will now be able to select the same colour ramp easily under All
Color Ramps.
9. Under Mode choose H_H Equal Count (Quantile)
10. Click Classify

Now you will have something like this:
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@ Layer Properties - landuse | Symbelogy x
Q = Graduated - |
= value 12 anea - [g]
Symboal | |:|

Legend format | %1 - %2 | | Precision 0 |$| V! Trim

‘ Symbology -
Colorramp | . S——

abe -

| Classes | Histogram

e Symbol ™ Values Legend
v 131.30 - 10512.65 131-10313
v 10312.65 - 35728.06 10313 - 35728
= vl 35728.06 - 132271.73 35728 - 132272
= vl 132271.73 - 362220.57 132272 - 362221
— v 362220.57 - 112894046,06 362221 - 112894046
=0
Mode |H:EHEquaI Count (Quantile) ~ | Classes |5 3|
| Classify | |¥| |;| | Delete Al | | Advanced '|
V| Link class boundaries
O
B Layer Rendering
| stye - ok || cancel || Appy || hHep |
Leave everything else as-is.
11. Click OK:

Bontebok &¥Shop)
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3.3.4 Try Yourself Refine the Classification

¢ Change the values of Mode and Classes until you get a classification that makes sense.

Answer

The settings you used might not be the same, but with the values Classes = 6 and Mode = Natural Breaks (Jenks) (and
using the same colors, of course), the map will look like this:

“Boniebok National|Rark[Recepion/& Shoplt

3.3.5 Follow Along: Rule-based Classification
It’s often useful to combine multiple criteria for a classification, but unfortunately normal classification only takes one
attribute into account. That’s where rule-based classification comes in handy.

In this lesson, we will represent the 1anduse layer in a way to easily identify Swellendam city from the other
residential area, and from the other types of landuse (based on their area).

1. Open the Layer Properties dialog for the 1anduse layer
2. Switch to the Symbology tab
3. Switch the classification style to Rule-based

QGIS will automatically show the rules that represent the current classification implemented for this layer. For
example, after completing the exercise above, you may see something like this:
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@ Layer Properties - landusze | Symbolo: *
y P Y gy
- [= Rule-based -
q Information Label Rule Min, scale Max.
v 131 - 101924 "AREA" »= 131.299349 AND "AREA" <= 101924.439748
J\-:\a_ TrnmEz v 101924 - 300418 "AREA" » 101924.495748 AND "AREA" <= 309417.846808
: v . 300418 - 839955 "AREA" » 309417.846808 AND "AREA" <= 839954.777508
v . 839955 - 1578789 "AREA" » 839954,777508 AND "AREA" <= 1578788.863263
v . 1578789 - 34452227 "AREA" » 1578788.863263 AND "AREA" <= 34452226.958486
£ Labels v . 34452227 - 112884046 "AREA" » 34452226,958486 AND "AREA" <= 112894046.060455
LD Masks
- . _
. Diagrams 7 5
E Eiskis g S E Symbol Levels. ..
: Refine Selected Rules
E Attributes Form

p Layer Rendering

Joins Style - oK Cancel Apply Help

4. Click and drag to select all the rules

5. Use the "= Remove selected rules 1101 to remove all of the existing rules

Let’s now add our custom rules.

1. Click the ':II-I:I-I:| Addrule by tton
2. The Edit rule dialog then appears

3. Enter Swellendam city as Label

4. Click the € button next to the Filter text area to open the Expression String Builder

5. Enter the criterion "name" = 'Swellendam' and validate

Expression String Builder x

Expression | Function Editor

] L Q search... group field

= 'Swellendam' Conditionals =

Double-click to add field name to expression string.

b
b G i
» Cﬁ:::;lsmns Right-Click on field name to open context menu sample value
» Date and Time loading options.
~ Fields and Values Notes
NULL - -
123 ogc_Ffid
ave Full_id Values | & search...
abc osm_id
< psm_type All Unique 10 Samples
»< landuse Fynbos Heights -
Gaikou Lodge
anc type Koloniesbos
ahe wikipedia Koornland
=0+ A w s boundary Marloth Nature Reserve
an< s in Railton
Feature 1 e > abe lefsure Swellendam
Preview: 0 e name:de - Wamakersbos -
@Help 3 Cancel

6. Back to the Edit rule dialog, assign it a darker grey-blue color in order to indicate the town’s importance in the
region and remove the border
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Label swellendam city =
e Filter "name" = 'Swellendam’ £ Test
Else Caktch-all For other features
Description
Scale range
v Symbol
o

M simple Fill

Unit Millimekers -
Opacity _11100.0 % -
Color [

-

@Help ¥ cancel

7. Prima OK
8. Repeat the steps above to add the following rules:

1. Other residential label with the criterion "landuse" = 'residential' AND "name" <>
'Swellendam'. Choose a pale blue-grey Fill color

2. Bignon residential areas label with the criterion "1anduse" <> 'residential' AND "AREA"
>= 605000. Choose a mid-green color.

Layer Properties — landuse (basic) — Symbology 0

Q = Rule-based -

@ information * |Label Rule Min. Scale Max. Scale  Count Duplicate Count
v| [l swellendam city "name" = 'Swellendam’

:{_‘\\ Source v Other residenttial "landuse" = 'residential' AND "name" <> 'Swellendam’

v| [l Big non residential areas "landuse" <> 'residential' AND "AREA" >= 605000
& symbology

WF 3D View

Diagrams

-
'
o Z[|Z symbol Levels...

E Fields

E Attributes Form e Redering

Joins - | @Help Style - < Apply | % cCancel

These filters are exclusive, in that they exclude areas on the map (non-residential areas which are smaller
than 605000 (square meters) are not included in any of the rules).

3. We will catch the remaining features using a new rule labeled Small non residential areas. Instead of

a filter expression, Check the ® ' Else. Give this category a suitable pale green color.
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Label small non residential areas =
) Filter
(e Else Catch-all for other features

Description

Scale range
v| Symbol
o
simple Fill
Unit Millimeters -
Opacity _11100.0 % -
Color v
©@Help % Cancel

Your rules should now look like this:

Layer Properties — landuse (basic) — Symbology

= Rule-based

@ information | Label Rule Min. Scale Max. Scale  Count Duplicate Count
v| [l swellendam city "name” = 'Swellendam’
a\:\\ Source v Other residenttial "landuse” = 'residential' AND "name" <> 'Swellendam'
v| [l Big non residential areas "landuse" <> 'residential' AND "AREA" >= 605000
d Symbology v Small non residential areas ELSE
€3 Labels
€D Masks
W@ 30 View
>
4 Diagrams
L 4| Z symbol Levels...
E Fields

E Attributes Form

b Layer Rendering
Joins - | @Help Style ~

«/ Apply || % cancel

9. Apply this symbology

Your map will look something like this:
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Om&

Now you have a map with Swellendam the most prominent residential area and other non-residential areas colored
according to their size.

3.3.6 In Conclusion
Symbology allows us to represent the attributes of a layer in an easy-to-read way. It allows us as well as the map reader

to understand the significance of features, using any relevant attributes that we choose. Depending on the problems
you face, you’ll apply different classification techniques to solve them.

3.3.7 What’s Next?

Now we have a nice-looking map, but how are we going to get it out of QGIS and into a format we can print out, or
make into an image or PDF? That’s the topic of the next lesson!
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Module: Laying out the Maps

In this module, you’ll learn how to use the QGIS print layout to produce quality maps with all the requisite map
components.

4.1 Lesson: Using Print Layout

Now that you've got a map, you need to be able to print it or to export it to a document. The reason is, a GIS map
file is not an image. Rather, it saves the state of the GIS program, with references to all the layers, their labels,colors,
etc. So for someone who doesn’t have the data or the same GIS program (such as QGIS), the map file will be useless.
Luckily, QGIS can export its map file to a format that anyone’s computer can read, as well as printing out the map if
you have a printer connected. Both exporting and printing is handled via the Print Layout.

The goal for this lesson: To use the QGIS Print Layout to create a basic map with all the required settings.
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4.1.1 Follow Along: The Layout Manager

QGIS allows you to create multiple maps using the same map file. For this reason, it has a tool called the Layout
Manager.

1. Click on the Project » Layout Manager... menu entry to open this tool. You'll see a blank Layout manager

dialog appear.

v New from Template

Empty layout -

Open template directory User

@Help % Close

2. Under New from Template, select Empty layout and press the Create... button.
3. Give the new layout the name of Swellendam and click OK.

4. You will now see the Print Layout window:

*Swellendam

Layout Edit View Items AddItem Atlas Settings

BHLRER G O b 1 7
ALPRT BE QL EE hH]

Itemns Undo History
Items ®
® & Item

|0 |5a ‘100 |\50 ‘2(:0 ‘ |25c| ‘300
nnnlfnanionnnlFeanntanan Wi annannnlF5aanunnnlmfaanaaoE5annunnn i,

?
b Lo

sa|
innalann

Layout | Item Properties | Guides
Layout ®

¥ General Settings

100

Reference map hd

w Guides and Grid

150

Grid spacing
10,00 || mMm -

Grid offset

200

x: 0,00
mm -

:.H:':\no :SE"E’::H :;'.'H:ﬂnﬁ:?ﬁzz%)@

yv: 0,00

Snap tolerance

<
[

0

X238 mm y: 0 mm page: 1 35.6% - |9

You could also create this new layout via the Project » New Print Layout... menu.
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Whichever route you take, the new print layout is now accessible from the Project » Layouts » menu, as in the image
below.

Edit View Layer Settings Plugins Vector Raster Databa

" New Ctri+N ;] g__} g__} &q

New from Template »
Open... ctrl+o
Open From b
Open Recent »
Close

= save Ctrl+s

| Save As... Ctrl+Shift+s
save To »
Revert...
Properties... Ctrl+Shift+P
Snapping Options...
Import/Export »

i New Print Layout... Ctrl+P

2} New Report...

4 Layout Manager...

Swellendam
Exit QGIS crl+Q

4.1.2 Follow Along: Basic Map Composition

In this example, the composition was already the way we wanted it. Ensure that yours is as well.

1. Right-click on the sheet in the central part of the layout window and choose Page properties... in the context
menu.

2. Check that the values in the Item Properties tab are set to the following:
o Size: A4
e Orientation: Landscape

Now you’ve got the page layout the way you wanted it, but this page is still blank. It clearly lacks a map. Let’s
fix that!

3. Click on the ”__"H Add Map tyytton.
With this tool activated, you will be able to place a map on the page.

4. Click and drag a box on the blank page:

4.1. Lesson: Using Print Layout 109



QGIS Training Manual

*Swellendam

Layout Edit View [tems AddItem Atlas Settings

BRLURORE B @ikt e | | BE H- @

|o |50 |1on |150 |2ﬂn |250 | ‘300 ltems E®
v bbb b bvraoa b bvooo v bvvoar b bl vrah g —
@ 3 = & Item
el
ﬁ 3
5 EE Layout = Item Properties = Guides
!f;’ = Item Properties =]
8| :
L2
E
) .
E_
. |23
=._n ]
= ]
he <
3
width: 289.104 mm height: 202.495 mm X:292.763 mm y: 206.154 mm page: 1 43.4% v [

The map will appear on the page.
5. Move the map by clicking and dragging it around:

*Swellendam

Layout Edit View [tems AddIitem Atlas Settings

BRLRDR oy e | | B® H- B

300 Jtems
@ & Itern

|0 |50 |100 ||150 |200 |250
s oo b b oo b b oo boode b rcoac oo b ocoa v boroa vl

Aol &

Layout | Item Properties | Guides

I’;’ = Item Properties @®
2} = Map 1

— SERER MR =
IFYEE :
= 3 ¥ Main Properties [
| = Scale 38108 | &

E - -
i-'u = Map rotation 0,00° |v| LET
= E CRS Use Project CRS - | |§|
A} . v Draw map canvas items

Rz

2 2 ¥ Lavers |~

1 item selected X: 140.892 mm y: 101.247 mm page: 1 |43.4% v | (———

6. Resize it by clicking and dragging the boxes on the edges:
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*Swellendam

Layout Edit View [tems AddItem Atlas Settings

BRURORE B @ik o B® S B
|n ] |50 |1nn |150 |2nn |250 ‘300 ltems B
v b b tveor v oo b bvoabovonborre b bl -

@ ] @ & Itern
T [=4 n M Map 1
>~
AR | = \Zl—lr B L e A
% E h __“—\—:\_\"\ﬁ\-._{ -

~R =
lg a- Layout | Item Properties | Guides
ﬁ\’ = i At Item Properties Bx
JE P e o STls

| - 22 AERERMNE =
|g ,g_: o .‘ lics =
E r 7 TR ¥ Main Properties

= -
| Scale 38108 <
i 'LDE Map rotation 0,00 ° =X =8
= = CRS Use Project CRS ™

A} — v Draw map canvas items

10.

11.

4.1.

200

w Lavers

:270.196 mm height: 187.247 mm X: 25.0069 mm y: 20.7374 mm page: 1 43.4%

Nota: Your map may look a lot different, of course! This depends on how your own project is set up. But not
to worry! These instructions are general, so they will work the same regardless of what the map itself looks
like.

Be sure to leave margins along the edges, and a space along the top for the title.

Zoom in and out on the page (but not the map!) by using these buttons:

& A
Zoom and pan the map in the main QGIS window. You can also pan the map using the lﬂ Move item content ¢q)]
The map view updates as you zoom in or zoom out.
If, for any reason, the map view does not refresh correctly, you can force the map to refresh by clicking the

E Refresh view button.

Remember that the size and position you’ve given the map doesn’t need to be final. You can always come back
and change it later if you’re not satisfied. For now, you need to ensure that you’ve saved your work on this map.
Because a Print Layout in QGIS is part of the main map file, you must save your project.

=]
Go to the Layout » Save Project. This is a convenient shortcut to the one in the main dialog.

3 Follow Along: Adding a Title

Now your map is looking good on the page, but your readers/users are not being told what’s going on yet. They need
some context, which is what you’ll provide for them by adding map elements. First, let us add a title.

. T
. Click on the AddLabel 1y, ¢ton

. Click on the page, above the map, accept the suggested values in the New Item Properties dialog, and a label

will appear at the top of the map.

. Resize it and place it in the top center of the page. It can be resized and moved in the same way that you resized

and moved the map.
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As you move the title, you'll notice that guidelines appear to help you position the title in the center of the page.

However, there is also a tool in the Actions Toolbar to help position the title relative to the map (not the page):
|IZI
4. Click the map to select it

5. Hold in Shift on your keyboard and click on the label so that both the map and the label are selected.

I .
6. Look for the | Alienseleced tems kft byygton and click on the dropdown arrow next to it to reveal the positioning

options and click |i—| Align center:

QS M » )
|3|ﬂ'? Iltem Align Left
all . Align Center g
| Align Right
~ Align Top

-~ Align Center Vertical

Layi - Align Bottom

Now the label frame is centered on the map, but not the contents. To center the contents of the label:
1. Select the label by clicking on it.
2. Click on the Item Properties tab in the side panel of the layout window.

3. Change the text of the label to «Swellendam»:
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Layout | Item Properties | Guides

Itemn Properties @
Label

¥ Main Properties

Sswellendam

Render as HTML

Insert an Expression...

v Appearance

Font r
Font color I (-
Horizontal margin | 0.00 mm =
Vertical margin 0.00 mm =

Horizontal alignment

Left Center Right (e Justify
Vertical alignment
e Top Middle Bottom

Position and Size

>

P Rotation

3 Frame

3 Background
P Item ID

4. Use this interface to set the font and alignment options under the Appearance section:
1. Choose a large but sensible font (the example will use the default font with a size of 36)
2. Set the Horizontal Alignment to Center.
You can also change the font color, but it’s probably best to keep it black as per the default.

5. The default setting is not to add a frame to the title’s text box. However, if you wish to add a frame, you
can do so:

1. In the Item Properties tab, scroll down until you see the Frame option.
2. Click the Frame checkbox to enable the frame. You can also change the frame’s color and width.

In this example, we won’t enable the frame, so here is our page so far:
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*Swellendam
Layout Edit View [tems AddItem Atlas Settings
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g -

IPYEE

=
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E
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To make sure that you don’t accidentally move these elements around now that you’ve aligned them, you can
lock items into place:

1. Select both the label and the map items

Fii
2. Click the % Lock Selected Items 1yy¢to in the Actions Toolbar.

Nota: Click the [@ Unlock AllTtems by ton in the Actions Toolbar to be able to edit the items again.

4.1.4 Follow Along: Adding a Legend

The map reader also needs to be able to see what various things on the map actually mean. In some cases, like the

place names, this is quite obvious. In other cases, it’s more difficult to guess, like the colors of the forests. Let’s add
a new legend.

1. Click on the 5 Add Leend pygeon
2. Click on the page to place the legend, accept the suggested values in the New Item Properties dialog,
3. Alegend is added to the layout page, showing layers symbology as set in the main dialog.

4. As usual, you can click and move the item to where you want it:
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*Swellendam
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4.1.5 Follow Along: Customizing Legend Items
Not everything on the legend is necessary, so let’s remove some unwanted items.
1. In the Item Properties tab, you’ll find the Legend items group.

2. Uncheck the L) Auto update box, allowing you to directly modify the legend items
3. Select the entry with buildings

4. Delete it from the legend by clicking the = button
You can also rename items.

1. Select a layer from the same list.

2. Click the @ Edit selected item properties button

3. Rename the layers to Places, Roads and Streets, Surface Water, and Rivers.

You can also reorder the items:

-
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*Swellendam
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As the legend will likely be widened by the new layer names, you may wish to move and resize the legend and or map.
This is the result:

*Swellendam

Layout Edit View |[tems AddItem Atlas Settings
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4.1.6 Follow Along: Exporting Your Map

Nota: Did you remember to save your work often?

Finally the map is ready for export! You’ll see the export buttons near the top left corner of the layout window:

o U5 princLayout; jneerfaces with a printer. Since the printer options will differ depending on the model of printer

that you’re working with, it’s probably better to consult the printer manual or a general guide to printing for
more information on this topic.

The other buttons allow you to export the map page to a file.

o g Bxportas Image, gives you a selection of various common image formats to choose from. This is probably the
simplest option, but the image it creates is «dead» and difficult to edit.

o [2f@ Bxportas SVG: If you’re sending the map to a cartographer (who may want to edit the map for publication),
it’s best to export as an SVG. SVG stands for «Scalable Vector Graphic», and can be imported to programs
like Inkscape or other vector image editing software.

B

o £ Bxportas PDF. Tf you peed to send the map to a client, it’s most common to use a PDF, because it’s easier
to set up printing options for a PDF. Some cartographers may prefer PDF as well, if they have a program that
allows them to import and edit this format.

For our purposes, we’re going to use PDF.

1. Click the "}"IE Exportas PDF byyton

2. Choose a save location and a file name as usual. The following dialog will show up.
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PDF Export Options 0

lw| Export Options

Always export as vectors
v Append georeference information
v Export RDF metadata (title, author, etc.)

Text export | Always Export Text as Paths (Recommended) -

v Advanced Options

Disable tiled raster layer exports

v Simplify geometries to reduce output File size

@Help % cancel | Psave |

3. You can safely use the default values now and click Save.
QGIS will proceed to the map export and push a message on top of the print layout dialog as soon as it finishes.

4. Click the hyperlink in the message to open the folder in which the PDF has been saved in your system’s file
manager

5. Open it and see how your layout looks.
Everything is OK? Congratulations on your first completed QGIS map project!
6. Anything unsatisfying? Go back to the QGIS window, do the appropriate modifications and export again.

7. Remember to save your project file.
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4.1.7 In Conclusion

Now you know how to create a basic static map layout. We can go a step further and create a map layout that adapts
dynamically, with more layout items.

4.2 Lesson: Creating a Dynamic Print Layout

Now that you have learned to create a basic map layout we go a step further and create a map layout that adapts
dynamically to our map extent and to the page properties, e.g. when you change the size of the page. Also, the date
of creation will adapt dynamically.

4.2.1 Follow Along: Creating the dynamic map canvas

1. Load the ESRI Shapefile format datasets protected_areas.shp, places.shp, rivers.shp and
water . shp into the map canvas and adapt its properties to suit your own convenience.

2. After everything is rendered and symbolized to your liking, click the h New Print Layout joon in the Project

toolbar or choose Project » "2 New Print Layout. You will be prompted to choose a title for the new print
layout.

3. We want to create a map layout consisting of a header and a map of the region near Swellendam, South Africa.
The layout should have a margin of 7.5 mm and the header should be 36mm high.

4. Create a map item called main map on the canvas and go to the Layout panel. Scroll down to the Variables
section and find the Layout part. Here we set some variables you can use all over the dynamic print layout. Go
to the Layout panel and scroll down to the Variables section. The first variable will define the margin. Press the

Ifl'l:ll-:| button and type in the name sw_layout_margin. Set the value to 7.5. Press the Ifl'l:ll-:| button again
and type in the name sw_layout_height_header. Set the value to 36.

5. Now you are ready to create the position and the size of the map canvas automatically by means of the
variables. Make sure that your map item is selected, go to the Ifem Properties panel, scroll down to and

open the Position and Size section. Click the 4] Daa defined override for X and from the Variables entry, choose
@sw_layout_margin.

6. Click the 4£| Data defined override o,y choose Edit... and type in the formula:

[tofreal(@sw_layout_margin) + to_real (@sw_layout_height_header) ]

7. You can create the size of the map item by using the variables for Width and Height. Click the €
Data defined override for Width and choose Edit ... again. Fill in the formula:

[@layout_pagewidth — @sw_layout_margin * 2 }

Click the 46| Data defined override g, Height and choose Edit .... Here fill in the formula:

[@layout_pageheight — (@sw_layout_height_header - (@sw_layout_margin * 2 }

8. We will also create a grid containing the coordinates of the main canvas map extent. Go to Item Properties

again and choose the Grids section. Insert a grid by clicking the ':II-I:I-I:| button. Click on Modify grid ... and set
the Interval for X, Y and Offset according to the map scale you chose in the QGIS main canvas. The Grid type
Cross is very well suited for our purposes.
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4.2.2 Follow Along: Creating the dynamic header

1. Insert a rectangle which will contain the header with the "5 AddShape by tton. In the Jrems panel enter the name
header.

2. Again, go to the Item Properties and open the Position and Size section. Using €] Data defined override | hoose the
sw_layout_margin variable for X as well as for Y. Width shall be defined by the expression:

[@layout_pagewidth - @sw_layout_margin * 2 ]

and Height by the sw_layout_height_header variable.

3. We will insert a horizontal line and two vertical lines to divide the header into different sections using the IE
AddNode Item - Creqte a horizontal line and two vertical lines and name them Horizontal line,Vertical
line 1Vertical line 2.

1. For the horizontal line:
1. Set X to the variable sw_layout_margin

2. Set the expression for Y to:

[@sw_layout_margin + 8 J

3. Set the expression for Width to:

[@layout_pagewidth - (@sw_layout_margin * 3 - 53.5 ]

2. For the first vertical line:

1. Set the expression for X to:

[@layout_pagewidth - @sw_layout_margin * 2 - 53.5

2. Set Y to the variable sw_layout_margin

3. The height must be the same as the header we created, so set Height to the variable
sw_layout_height_header.

3. The second vertical line is placed to the left of the first one.

1. Set the expression for X to:

[@layout_pagewidth - @sw_layout_margin * 2 - 83.5 }

2. Set Y to the variable sw_layout_margin

3. The height shall be the same as the other vertical line, so set Height to the variable
sw_layout_height_header.

The figure below shows the structure of our dynamic layout. We will fill the areas created by the lines with
some elements.
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4.2.3 Follow Along: Creating labels for the dynamic header

1. The title of your QGIS project can be included automatically. The title is set in the Project Properties. Insert

a label with the E!: AddLabel bytton and enter the name project title (variable). In the Main
Properties of the Items Properties Panel enter the expression:

[[%@project_title%]

Set the position of the label.

1. For X, use the expression:

[@sw_layout_margin + 3

2. For Y, use the expression:

[@sw_layout_margin + 0.25

3. For Width, use the expression:

[@layout _pagewidth - @sw_layout_margin *2 - 90

4. Enter 11.25 for Height
Under Appearance set the Font size to 16 pt.

2. The second label will include a description of the map you created. Again, insert a label and name it map
description. Inthe Main Properties enter the text map description. Inthe Main Properties we will
also include:

[printed on: [%format_date(now (), 'dd.MM.yyyy') %] ]

Here we used two Date and Time functions (now and format_date).
Set the position of the label.

1. For X, use the expression:
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[@sw_layout_margin + 3 J

2. For Y, use the expression:

[@sw_layout_margin + 11.5 J

3. The third label will include information about your organisation. First we will create some variables in the

Variables menu of the Item Properties. Go to the Layout menu, click the I:II-I:I-I:I button each time and enter the
names o_department, o_name, o_adress and o_postcode. Inthe second row enter the information
about your organisation. We will use these variables in the Main Properties section.

In Main Properties enter:

)

@Qo_name %]
@o_department %]
@o_adress %]
Qo_postcode %]

o° o o

o

[
[
[
[

Set the position of the label.

1. For X, use the expression:

[@1ayout_pagewidth - @sw_layout_margin - 49.5 ]

2. For Y, use the expression:

[@sw_layout_margin + 15,5 ]

3. For Width, use 49.00

4. For Height, use the expression:

{@sw_layout_height_header = 15,5 ]
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Layout @ Item Properties = Guides = Atlas

Item Properties (3]
Label

¥ Main Properties

[% @o_name%]

[% @0 department]
[% @o_adress%]

Pﬁ @o_postcode%|

Render as HTML

Insert an EKPFEESiGI"I...

4.2.4 Follow Along: Adding pictures to the dynamic header

1. Use the "3 AddPicwre byiton to place a picture above your label organisation information. After
entering the name organisation logo define the position and size of the logo:

1. For X, use the expression:

[@layout_pagewidth — @sw_layout_margin - 49.5 ]

2. For Y, use the expression:

{@sw_layout_margin + 3.5 ]

3. For Width, use 39.292
4. For Height, use 9.583
To include a logo of your organisation you have to save your logo under your home directory and enter the path
under Main Properties » Image Source.
2. Our layout still needs a north arrow. This will also be inserted by using A] Add North Arrow  WWe will use the
default north arrow. Define the position:

1. For X, use the expression:

[@layout_pagewidth - @sw_layout_margin * 2 - 78 ]

2. For Y, use the expression:

[@ sw_layout_margin + 9
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3. For Width,use 21 .027
4. For Height,use 21 .157

4.2.5 Follow Along: Creating the scalebar of the dynamic header

1. To insert a scalebar in the header click on Add Seale Bar and place it in the rectangle above the north arrow.

In Map under the Main Properties choose your main map (Map 1). This means that the scale changes
automatically according to the extent you choose in the QGIS main canvas. Choose the Style Numeric. This
means that we insert a simple scale without a scalebar. The scale still needs a position and size.

1. For X, use the expression:

[@1ayout_pagewidth - @sw_layout_margin * 2 - 78

2. For Y, use the expression:

[@sw_layout_margin + 1

3. For Width, use 25
4. For Height, use 8
5. Place the Reference point in the center.

Congratulations! You have created your first dynamic map layout. Take a look at the layout and check if everything
looks the way you want it! The dynamic map layout reacts automatically when you change the page properties. For

| .
example, if you change the page size from DIN A4 to DIN A3, click the M Refreshview bytton and the page design is
adapted.
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4.2.6 What’s Next?

On the next page, you will be given an assignment to complete. This will allow you to practice the techniques you
have learned so far.

4.3 Tarefa 1

Abra o seu projecto de mapa e reveja-o na integra. Se encontrar pequenos erros ou detalhes que gostaria de ter
melhorado, faca-o agora.

Enquanto estiver a personalizar o seu mapa, questione-se a si mesmo. O mapa € facil de ler e de interpretar por alguém
sem conhecimento prévio dos dados? Se visse este mapa na internet, num poster ou numa revista, iria chamar a minha
atenc@o? Iria querer interpretar este mapa se ele ndo fosse de minha autoria?

If you’re doing this course at a Basic or Intermediate level, read up on techniques from the more advanced sections.
If you see something you’d like to do in your map, why not try to implement it?

If this course is being presented to you, the course presenter may require you to submit a final version of your map,
exported to PDF, for evaluation. If you're doing this course by yourself, it’s recommended that you evaluate your own
map using the same criteria. Your map will be evaluated on the overall appearance and symbology of the map itself,
as well as the appearance and layout of the map page and elements. Remember that the emphasis for evaluating the
appearance of maps will always be ease of use. The nicer the map is to look at and the easier it is to understand at a
glance, the better.

Happy customizing!

4.3.1 In Conclusion

The first four modules have taught you how to create and style a vector map. In the next four modules, you’ll learn
how to use QGIS for a complete GIS analysis. This will include creating and editing vector data; analyzing vector
data; using and analyzing raster data; and using GIS to solve a problem from start to finish, using both raster and
vector data sources.
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CAPITULO D

Module: Criar Dados Vetoriais

Criar mapas utilizando dados existentes € apenas o comego. Neste modulo, ird aprender a alterar dados vetoriais
existentes e criar novos conjuntos de dados.

5.1 Lesson: Creating a New Vector Dataset

The data that you use has to come from somewhere. For most common applications, the data exists already; but the
more particular and specialized the project, the less likely it is that the data will already be available. In such cases,
you'll need to create your own new data.

The goal for this lesson: To create a new vector dataset.

5.1.1 Follow Along: The Layer Creation Dialog
Before you can add new vector data, you need a vector dataset to add it to. In our case, you'll begin by creating new
data entirely, rather than editing an existing dataset. Therefore, you’ll need to define your own new dataset first.

1. Open QGIS and create a new blank project.

2. Navigate to and click on the menu entry Layer » Create Layer » New Shapefile Layer. You'll be presented
with the New Shapefile Layer dialog, which will allow you to define a new layer.
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.
File name
File encoding UTF-8 >
Geometry type Point v
Additional dimensions ‘@' None Z (+ M values) M values
EPSG:4326 - WG5S B4 v ||

New Field

Name

Type | abc Text data v

Length |80 Precision

Add to Fields List

Fields List

MName Type Length Precision

id Integer 10

Remowve Field

OK Cancel Help

Click ... for the File name field. A save dialog will appear.
Navigate to the exercise_data directory.
Save your new layer as school_property.shp.

It’s important to decide which kind of dataset you want at this stage. Each different vector layer type is «built
differently» in the background, so once you’ve created the layer, you can’t change its type.

For the next exercise, we're going to create new features which describe areas. For such features, you'll need
to create a polygon dataset.

For Geometry Type, select Polygon from the drop down menu:

Geometry type ~ Polygon -

This has no impact on the rest of the dialog, but it will cause the correct type of geometry to be used when the
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vector dataset is created.

The next field allows you to specify the Coordinate Reference System, or CRS. CRS is a method of associating
numerical coordinates with a position on the surface of the Earth. See the User Manual on Working with
Projections to learn more.

For this example we will use the default CRS associated with this project, which is WGS84.

EP5G:4326 - WG5S 84 - ||

Next there is a collection of fields grouped under New Field. By default, a new layer has only one attribute, the
id field (which you should see in the Fields list) below. However, in order for the data you create to be useful,
you actually need to say something about the features you’ll be creating in this new layer. For our current
purposes, it will be enough to add one field called name that will hold Text data and will be limited to text
length of 80 characters.

7. Replicate the setup below, then click the Add to Fields List button:

New Field

MName |name
Type |ab<Text data -
Length 80 Precision

Add to Fields List

8. Check that your dialog now looks like this:
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.
File name aining-Data-2.0\exercise_data\school_property.shp
File encoding UTF-8 >
Geometry type ~ Polygon -
Additional dimensions ‘@' None Z (+ M values) M values
EPSG:4326 - WGS 84 v ||
New Field
Name
Type | abc Text data v
Length |80 Precision
Add to Fields List
Fields List
MName Type Length Precision
id Integer 10
name String a0
Remove Feld
OK Cancel Help
9. Click OK

The new layer should appear in your Layers panel.

5.1.2 Follow Along: Data Sources

When you create new data, it obviously has to be about objects that really exist on the ground. Therefore, you'll need
to get your information from somewhere.

There are many different ways to obtain data about objects. For example, you could use a GPS to capture points in
the real world, then import the data into QGIS afterwards. Or you could survey points using a theodolite, and enter
the coordinates manually to create new features. Or you could use the digitizing process to trace objects from remote
sensing data, such as satellite imagery or aerial photography.

For our example, you’ll be using the digitizing approach. Sample raster datasets are provided, so you’ll need to import
them as necessary.
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1. Click on "B D Sorc Manage b0

. Select :'- Raster on the left side.

. In the Source panel, click on the ... button:

2

3

4. Navigate to exercise_data/raster/.

5. Select the file 3420C_2010_327_RGB_LATLNG.tif.
6

. Click Open to close the dialogue window.

Q Data Source Manager | Raster #
i Browser Source type

+ Vector i .
'@ Fle () Protocol: HTTP(S), cloud, etc.

_';!:_ Mesh =lliiz

. Delimited Text Raster Dataset(s) ercise_data\raster\3420C_2010_327_RGB_LATLNG.tf & | ... |

GeoPackage

patiaLite

. Oracle
082, DB2

m Virtual Layer

&2 wms/wmTs
£ wes

- f‘_ WFS

ArcGIS Map Server
- ArcGIS Feature Server

* GeoMNode

| Cose || add || Hep |

7. Click Add and Close. An image will load into your map.
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@ *Untitled Project - QGIS - [} X
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Help

DEEREX Lo PPRABLNR @6 -5 55 83 =90
®R@V.awm @ o - =y @ : ® 2

Layers (E2]E3)
o @ ® T O -0
v ¥ 3420C 2010 327 RGB LATLNG
v! [ school_property

[ & Typetolocate (cul+k) | Ready Coordinate| 20.5018,34.0192 |% Scale 1:27241 |~ | @ Mognifier 100%  |*| Rotation [0.0° %/ [v/Render @ EPsGia3zs @

8. If you don’t see an aerial image appear, select the new layer, right click, and choose Zoom fo Layer in the
context menu.
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() *Untitled Project - QGIS

Project Edit View Layer Settings Plugins Vector Raster Datab:

DEBRRY QPRI PR
B@V.Aam @ /7 :

Layers &
v [l ® T - O

3420C ?2n1n 227 par 1LATING |
sl '® Zoom to Layer

o2 Show in Overview

Copy Layer
Rename Layer
1 Zoom to Native Resolution (100%)
Stretch Using Current Extent
L] Duplicate Layer
[l Remove Layer...
Change Data Source...
Set Layer Scale Visibility...
Set CRS
Export
Styles

Properties...

9. Click on the ﬁ-) ZoomIn bytton, and zoom to the area highlighted in blue below:
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(@ *Untitled Project - QGIS - O x
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Help

DEBRRX OBFLPAIPRPALEENR &6 -5 -5-5 Im-9 -
R@V- AR B ) b Sl R 2

Layers (E2]E3)
o @ ® T O -0
v ¥ 3420C 2010 327 RGB LATLNG
v! [ school_property

[ & Typetolocate (cul+k) | Ready Coordinate| 20.4529,-34.0291 |¥ Scale 1:27241 |~ @ Magnifier 100%  |%| Rotation [0.0° *|v/Render @ epsGi36 @

Now you are ready to digitize these three fields:
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Before starting to digitize, let’s move the school_property layer above the aerial image.

1. Select school_property layer in the Layers pane and drag it to the top.

Layers e
o [l ® T &§~3 F 4

v [ school property
v 2 3420C 2010 327 RGB LATLNG

In order to begin digitizing, you'll need to enter edit mode. GIS software commonly requires this to prevent you
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from accidentally editing or deleting important data. Edit mode is switched on or off individually for each layer.
To enter edit mode for the school_property layer:

1. Click on the school_property layer in the Layers panel to select it.

F/ .
2. Click on the .’/ Toggle Editing [ytton.

If you can’t find this button, check that the Digitizing toolbar is enabled. There should be a check mark next to
the View » Toolbars » Digitizing menu entry.

As soon as you are in edit mode, you'll see that some digitizing tools have become active:

. £ Capture Polygon

o / % Vertex Tool

Other relevant buttons are still inactive, but will become active when we start interacting with our new data.

Notice that the layer school_property in the Layers panel now has the pencil icon, indicating that it is in
edit mode.

e )
3. Click on the L3 Capwre Polyzon bytton to begin digitizing our school fields.

You'll notice that your mouse cursor has become a crosshair. This allows you to more accurately place the
points you’ll be digitizing. Remember that even when you're using the digitizing tool, you can zoom in and
out on your map by rolling the mouse wheel, and you can pan around by holding down the mouse wheel and
dragging around in the map.

The first feature you’ll be digitizing is the athletics field:

4. Start digitizing by clicking on a point somewhere along the edge of the field.

5. Place more points by clicking further along the edge, until the shape you're drawing completely covers the field.
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@ +Untitled Project - QGIS — O b4
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Help

DEBREY 0 ALHAPD "Q  LEORS &&-NN-8-F;HE -~
BR@V:Z2Rm @ 4/ 8BR - b =g mE R A

Layers e
@l e T &-#H0

v! [ school property
v/ I 3420C_2010_327_RGB_LATLNG

| Q Type to locate (Ctri+K) | i 20.444140,-34.024140 | ¢[1:1308 <| @rfwowe |33 00° |2 VIRender @ epsGiaszs @

6. After placing your last point, right click to finish drawing the polygon. This will finalize the feature and show
you the Attributes dialog.

7. Fill in the values as below:

school_property - Feature Attributes

d 1 a |
name | Athletics Field a |
OK || Cancel |
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8. Click OK, and you have created a new feature!

Q@ *Untitled Project - QGIS - O X
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Help

heBRRY 0P2PLPHNPDI A BEORS @€ -Ti--58E -~
B@V.Z2m B 4/ BR%- o e = - @A

Layers
o e Ta-BAO

v [# school property
v! ¥ 3420C_2010_327_RGB_LATLNG

| Q. Type to locate (Ctri+K) | i) 20.447232,-34.023345 | ¥ ¢ 1:1308 v @rlwoe 3]s looe  [f| VIRender @ epsci43s @

9. In the Layers panel select the school_property layer.

10. Right click and choose Open Attribute Table in the context menu.
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() *Untitled Project - QGIS

Project Edit View Layer Settings Plugins Vector Ras

NEERREY U 2K
RSV Z @B 47

Layers |
o [ ® T &§~6F & 4 '
7 school prisa l

v % 3420C 2( + Zoom to Layer

Zoom to Selection
“2 Show in Overview
Show Feature Count
Copy Layer
Rename Layer
L Duplicate Layer
[4 Remove Layer...
8 Open Attribute Table
|;.i" |TDggIe Editing
; Current Edits
Filter...
Change Data Source...
Set Layer Scale Visibility...
Set CRS
Export
Styles

Properties...

In the table you will see the feature you just added. While in edit mode you can update the attributes data by
double click on the cell you want to update.
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id name
1 1| Athletics Field

T show Al Features _

g LT ES D BE P E »

* || Update All || Update Selected

11. Close the attribute table.

12. To save the new feature we just created, click on n' Save Edits ¢t

Remember, if you've made a mistake while digitizing a feature, you can always edit it after you’re done creating it.
If you’ve made a mistake, continue digitizing until you're done creating the feature as above. Then:

1. Click on /E;{ Vertex Tool ¢,

2. Hover the mouse over a vertex you want to move and left click on the vertex.

3. Move the mouse to the correct location of the vertex, and left click. This will move the vertex to the new

location.
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The same procedure can be used to move a line segment, but you will need to hover over the midpoint of the
line segment.

If you want to undo a change, you can press the b Undo bytton or Ctr1+2.
4. Remember to save your changes by clicking the -4 Save Edits hyton,

5. When done editing, click the y Toggle Editing ytton to get out of edit mode.
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5.1.3 Try Yourself Digitizing Polygons

Digitize the school itself and the upper field. Use this image to assist you:

Remember that each new feature needs to have a unique id value!

Nota: When you’re done adding features to a layer, remember to save your edits and then exit edit mode.

Nota:  You can style the fill, outline and label placement and formatting of the school_property using
techniques learnt in earlier lessons.
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5.1.4 Follow Along: Using Vertex Editor Table

Another way to edit a feature is to manually enter the actual coordinate values for each vertex using the Vertex Editor
table.

1. Make sure you are in edit mode on layer school_property.

2. If not already activated, click on /ﬂ;‘ Vertex Tool y¢ton,

3. Move the mouse over one of the polygon features you created in the school property layer and right
click on it. This will select the feature and a Vertex Editor pane will appear.

Vertex Editor (E]ES)
X v r

0l 20.4456 -34,0226 |
o e —
2 20.4457 -34,0251

3 20.4453 -34,0247

4/20.4450 -34,0250

5| 204441 -34.0241

6 20.4456 -34,0226

Nota: This table contains the coordinates for the vertices of the feature. Notice there are seven vertices for
this feature, but only six are visually identified in the map area. Upon closer inspection, one will notice that
row 0 and 6 have identical coordinates. These are the start and end vertices of the feature geometry, and are
required in order to create a closed polygon feature.

4. Click and drag a box over a vertex, or multiple vertices, of the selected feature.
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)

The selected vertices will change to a color blue and the Vertex Editor table will have the corresponding rows
highlighted, which contain the coordinates of the vertices.
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Q@ “basic_map - QGIS - O X
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Help

DB mRR @@w@a@ﬂa PP, EBLO
LLAYA NS AN % & < = B - @

Browser (=]
QaTHO
<+ Favorites =

» IV Spatial Bookmarks
’ Project Home
+ [a] Home
v OC\
+ @ GeoPackace
Layers (=]
o @l®To-#FTDL

roads

[#] school_property

¥ 3420C 2010 327 RGB LATLNG

[

Vertex Editor 3]
X ' r

0 20.4456 34,0226

1 20.4469 -34.0238

2 20,4457 -34.0251

-34.0247

-34.0250

-34.0241

| Q. Type tolocate (Ctri+K) | Validi rdi| 20.447353,-34.025117 |9 ¢|1:1521

5. To update a coordinate, double left click on the cell in the table that you want to edit and enter the updated
value. In this example, the x coordinate of row 4 is updated from 20.4450t0 20.4444.
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Vertex Editor ®
X v r
0| 20.4456 -34.0226
1) 20,4469 -34.0238
2| 20.4457 -34,0251
3/ 20.4453 -34.0247
e |
5 20,444 -34.0241
6| 20.4456 -34.0226
Q Type to locate (Ctri+K) Validi rdii| 20.4441

6. After entering the updated value, hit the enter key to apply the change. You will see the vertex move to the
new location in the map window.

7. When done editing, click the f Toggle Editing tyytton to get out of edit mode, and save your edits.

5.1.5 Try Yourself Digitizing Lines

We are going to digitize two routes which are not already marked on the roads layer; one is a path, the other is a track.
Our path runs along the southern edge of the suburb of Railton, starting and ending at marked roads:
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Our track is a little further to the south:
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. Since you are working with a line feature, click on the

. If the roads layer is not yet in your map, then add the roads layer from the GeoPackage file
training-data.gpkg included in the exercise_data folder of the training data you downloaded.
You can read 77 Follow Along: Loading vector data from a GeoPackage Database for a how-to.

. Create a new ESRI Shapefile line dataset called routes. shp in the exercise_data directory, with

attributes 1d and type (use the approach above to guide you.)

. Activate edit mode on the routes layer.

Va

Add Line byytton to initiate line digitizing mode.

. One at a time, digitize the path and the track on the routes layer. Try to follow the routes as accurately as

possible, adding additional points along corners or turns.

. Set the type attribute value to path or track.

. Use the Layer Properties dialog to add styling to your routes. Feel free to use different styles for paths and

tracks.

4 -
. Save your edits and toggle off editing mode by pressing the f/ Toggle Editing 1y, tton,

5.1.
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Answer

The symbology doesn’t matter, but the results should look more or less like this:

00606 QGIS 2.0.1-Dufour - basic_map.
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Loyors
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5.1.6 In Conclusion

Now you know how to create features! This course doesn’t cover adding point features, because that’s not really
necessary once you’ve worked with more complicated features (lines and polygons). It works exactly the same, except
that you only click once where you want the point to be, give it attributes as usual, and then the feature is created.

Knowing how to digitize is important because it’s a very common activity in GIS programs.
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5.1.7 What’s Next?

Features in a GIS layer aren’t just pictures, but objects in space. For example, adjacent polygons know where they
are in relation to one another. This is called topology. In the next lesson you'll see an example of why this can be
useful.

5.2 Lesson: Feature Topology

Topology is a useful aspect of vector data layers, because it minimizes errors such as overlap or gaps.

For example: if two features share a border, and you edit the border using topology, then you won’t need to edit first
one feature, then another, and carefully line up the borders so that they match. Instead, you can edit their shared
border and both features will change at the same time.

The goal for this lesson: To understand topology using examples.

5.2.1 Follow Along: Snapping
Snapping makes topological editing easier. This will allow your mouse cursor to snap to other objects while you
digitize. To set snapping options:

1. Navigate to the menu entry Project » Snapping Options....

2. Set up your Snapping options dialog to activate the 1landuse layer with Type vertex and tolerance 12 pixels:

Project Snapping Settings X

o || % Advanced Configuration_|| © Topological Editing Snapping on Intersection

Layer Type Tolerance Units Avoid overlap
® places
[ buildings
— roads
M water
rivers
v landuse vertex 12 pixels v
[Tl protected_areas

Q, Filter layers...

3. Make sure that the box in the Avoid overlap column is checked.

4. Leave the dialog.

5. Select the landuse layer and enter edit mode ( .r )
6. Check (under View » Toolbars) that the Advanced Digitizing toolbar is enabled.

7. Zoom to this area (enable layers and labels if necessary):
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*example - QGIS

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Processing Help
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@ vanva-arn
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v| — roads
v| [ water
v rivers
| M Bl landuse |
Browser @®
LET®O

» ¢ Favorites
» " spatial Bookmarks
» [¥ Project Home

» [&] Home

» [0/
»
»
13

-

4

@ GeoPackage
# spatiaLite
@ Postals

4

SEDHAABANLEMS

i
a
o
B

&

@ WMS/WMTS
@ XYZ Tiles
& wes

7 WFS / OGC API - Features
) ows

@ ArcGismapServer

& ArcGisFeatureServer

¢ GeoNode

v vy wvow

| @ Type to locate (Ctrl+k) Coordinate| 20.48982-34.00907 |9 Scale|1:14392 = | @ Magnifier 100% | Rotation |0,0° %[V Render 4 gPsGi4326 @

8. Digitize this new (fictional) area shown in red:

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Processing Help

DEBRmE OA2ARLHAPPR A L LR

LAVAIELL T “QRE RPERRYG -Q-R-B-G- |
6e-M-8-LEE#IZ=- 7 LB BOIRRRARPS HRP
Layers @6
o @ ® T &~ AL
v/ e places =
! [ buildings
v| — roads
v| [ water
v rivers
| M Bl landuse |
< v
Browser @®
Lerv®e

» ¢ Favorites
» " spatial Bookmarks
» [*¥ Project Home

» [&] Home

» O/
»
»
»

-

@ GeoPackage — landuse - Feature Attributes

# spatiaLite

T Actions
@ Postclis -

SEHSSBABNS

4
v
=
0
]
Q
=

ogc_fid [999{ a I v
Full_id |NULL |

i
a
o
B

&

@ WMS/WMTS

@ XYZ Tiles

& wes

&7 WFS / OGC API - Features
) ows

@ ArcGismapServer

Si‘t' ArcGisFeatureServer

# GeoNode

osm_id |NULL

v v e ww

Q Type to locate (Ctrl+K) Coordinate| 20.4923134.00731 |9 Scale[114392 |~ | @ Magnifier 100% | Rotation |0.0° % |V Render @ EPSCa32e @

9. When prompted, give it an OGC_FID of 999, but feel free to leave the other values unchanged.
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If you are careful while digitizing, and allow the cursor to snap to the vertices of adjoining areas, you’ll notice
that there won’t be any gaps between your new area and the existing adjacent areas.

10. Note the @ undo apd @ redo tools in the Advanced Digitizing toolbar.

5.2.2 Follow Along: Correct Topological Features

Topology features can sometimes need to be updated. In our study area, an area has been turned into forest, so the
landuse layer need an update. We will therefore expand and join some forest features in this area:

*example - QGIS B

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Processing Help
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'ﬂ v| [ water
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Eg M P landuse 153
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V;' P MssQL
= @ pB2
K@ @ WMS/WMTS
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» @& wes
» @ WFS / OGC API - Features
» O ows

@ ArcGismapServer
& ArcGisFeatureServer
¢ GeoNode

N

Q Type to locate (Ctrl+K) Coordinate| 20.48982,34.00907 % Scale|1:14392 ~ | @ Magnifier| 100%

~| Rotation |0,0° | |v/ Render # EPsG4326 @

Instead of creating new polygons to join the forest areas, we are going to use the Vertex Tool to edit and join existing
polygons.

1. Enter edit mode (if it is not active already)

2. Select the /BE( Vertex Tool 4]

3. Choose an area of forest, select a vertex, and move it to an adjoining vertex so that the two forest features meet:
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*example - QGIS
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4. Click on the other vertices and snap them into place.

The topologically correct border looks like this:

*example - QGIS
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P
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Go ahead and join a few more areas using the Vertex Tool.

2 Add Polygon F
You can also use the £ olygon Feature 0] to fill the gap between the two forest polygons. If you have
enabled Avoid overlap, you don’t have to add every single vertex - they will be added automatically if your new
polygon overlaps the existing ones.

If you are using our example data, you should have a forest area looking something like this:

*example - QGIS B
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Don’t worry if you have joined more, less or different areas of forest.

5.2.3 Follow Along: Tool: Simplify Feature

Continuing on the same layer, we will test the %) Simplify Feature ¢6,]:
1. Click on it to activate it.

2. Click on one of the areas which you joined using either the Vertex Tool or Add Feature tool. You will see this
dialog:
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|J¢§ancel|l «/ OK ]

- |

Method | simplify by distance

:] Layer units

Tolerance ’ oloooo00
1 feature(s): 17 to 17 vertices (100%)

3. Modify the Tolerance and watch what happens:

|X§ancel|[ «/ OK ]

- |

Method | Simplify by distance

A
“ | Tolerance ’

1 feature(s): 17 to 5 vertices (29%)

|:] | Layer units

This allows you to reduce the number of vertices.

4. Click OK
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The advantage of this tool is that it provides you with a simple and intuitive interface for generalization. But notice
that the tool ruins topology. The simplified polygon no longer shares boundaries with its adjacent polygons, as it
should. So this tool is better suited for stand-alone features.

Before you go on, set the polygon back to its original state by undoing the last change.

5.2.4 Try Yourself Tool: Add Ring

The AddRing t0] allows you to add an interior ring to a polygon feature (cut a hole in the polygon), as long as the
hole is completely contained within the polygon (touching the boundary is OK). For example, if you have digitized
the outer boundaries of South Africa and you need to add a hole for Lesotho, you would use this tool.

If you experiment with the tool, you may notice that the snapping options can prevent you from creating a ring inside

a polygon. So you are advised to turn off snapping before cutting a hole.

1. Disable snapping for the 1anduse layer using the @ Enable Snapping by tton (or use the shortcut s).

2. Use the AddRing 0] to create a hole in the middle of a polygon geometry.

(o)
3. Draw a polygon over the target feature, as if you were using the Add polygon (0],

4. When you right-click, the hole will be visible.
(@)

5. Remove the hole you just created using the £ Pelete Ring o0] - Click inside the hole to delete it.

Answer

The exact shape doesn’t matter, but you should be getting a hole in the middle of your feature, like this one:
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¢ Undo your edit before continuing with the exercise for the next tool.
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5.2.5 Try Yourself Tool: Add Part

The % AddPart ¢60] allows you to add a new part to a feature, that is not directly connected to the main feature. For
example, if you have digitized the boundaries of mainland South Africa, but you haven’t yet added the Prince Edward
Islands, you would use this tool to create them.

1. Select the polygon to which you wish to add the part by using the Eﬁ Select Features by area or single click 0]

2. Use the Add Part tool to add an outlying area.

3. Delete the part you just created using the ggl Delete Part 0],

Nota: Click inside the part to delete it.

Answer

1. First select the Bontebok National Park:
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2. Now add your new part:
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QGIS 2.0.1-Dufour - basic_map.
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3. Undo your edit before continuing with the exercise for the next tool.

5.2.6 Follow Along: Tool: Reshape Features

The ? Reshape Features 10] j5 used to extend a polygon feature or cut away a part of it (along the boundary).

Extending:

1. Select the pOlngIl using the % Select Features by area or single click tool.

2. Left-click inside the polygon to start drawing.

3. Draw a shape outside the polygon. The last vertex should be back inside the polygon.

4. Right-click to finish the shape:
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This will give a result similar to:
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Cut away a part:

1
1. Select the pOlngIl using the % Select Features by area or single click tool.
2. Click outside the polygon.

3. Draw a shape inside the polygon. The last vertex must be back outside the polygon.
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4. Right-click outside the polygon:
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The result of the above:
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5.2.7 Try Yourself Tool: Split Features

"l:]-'{:“I Split F . . . (P Resh: F . . .
The ¢ SPhtFeatures vo4] is gsimilar to the eshape Features 140], except that it does not delete either of the two parts.
Instead, it keeps them both.

We will use the tool to split a corner from a polygon.

1. First, select the 1anduse layer and re-enable snapping for it.

ado .
2. Select the ¢® SPlitFeawres ¢60] and click on a vertex to begin drawing a line.

3. Draw the bounding line.

4. Click a vertex on the «opposite» side of the polygon you wish to split and right-click to complete the line:
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Validation finished.

5. At this point, it may seem as if nothing has happened. But remember that the 1anduse layer is rendered
without border lines, so the new division line will not be shown.

6. Use the ;::[!«-?: Select Features by area or single click ] 1o select the part you just split out; the new feature will now be

highlighted:
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5.2.8 Try Yourself Tool: Merge Features
Now we will re-join the feature you just split out to the remaining part of the polygon:

==
1. Experiment with the @Merge Selected Features and % Merge Attributes of Selected Features tools.

2. Note the differences.

Answer
* Use the Merge Selected Features tool, making sure to first select both of the polygons you wish to merge.

* Use the feature with the OGC_FID of 1 as the source of your attributes (click on its entry in the dialog, then
click the Take attributes from selected feature button):

If you're using a different dataset, it is highly likely that your original polygon’s OGC_FID will not be 1. Just choose
the feature which has an OGC_FID.
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8086 Merge feature attributes
OGC_FID | GEOMETRY | osm_id | osm_way_id | name | type | aeroway amenity | adminjeve | barrier |
Id Skip attribute _:I Feature 1 _H Feature 1 _:T Feature 1 _:I Feature 1 _H Feature 1 _:T Feature 1 _:I Feature 1 _H Feature 1 _:T Feature 1 _:I Fei
|1 H1 HNULL Hzasﬁag? ” NULL ”Bomebok National Park Hboundary ”NULL HNULL HNULL ”NULL ‘@
14 NULL 2855697 NULL Bontebok National Park boundary NULL NULL NULL NULL atior
Morge  Skipped 2855607 Bontebok National Park boundary natic

| ] | Take atiributes from selected feature

| & | Remove feature from selection

| Cancel | OK

Using the Merge Attributes of Selected Features tool will keep the geometries distinct, but give them the same attributes.

5.2.9 In Conclusion

Topology editing is a powerful tool that allows you to create and modify objects quickly and easily, while ensuring
that they remain topologically correct.

5.2.10 What’s Next?

Now you know how to digitize the shape of the objects easily, but adding attributes is still a bit of a headache! Next
we will show you how to use forms, making attribute editing simpler and more effective.

5.3 Lesson: Forms

When you add new data via digitizing, you're presented with a dialog that lets you fill in the attributes for that feature.
However, this dialog is not, by default, very nice to look at. This can cause a usability problem, especially if you
have large datasets to create, or if you want other people to help you digitize and they find the default forms to be
confusing.

Fortunately, QGIS lets you create your own custom dialogs for a layer. This lesson shows you how.

The goal for this lesson: To create a form for a layer.
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5.3.1 Follow Along: Using QGIS” Form Design Functionality

1. Select the roads layer in the Layers panel

2. Enter Edit Mode as before

3. Open the roads layer’s attribute table

4. Right-click on any cell in the table. A short menu will appear, that includes the Open form entry.
5. Click on it to see the form that QGIS generates for this layer

Obviously it would be nice to be able to do this while looking at the map, rather than needing to search for a specific
street in the Attribute Table all the time.

1. Select the roads layer in the Layers panel

p
2. Using the QR Identify Features 0] click on any street in the map.

3. The Identify Results panel opens and shows a tree view of the fields values and other general information about
the clicked feature.

4. At the top of the panel, check the Auto open form for single feature results checkbox in the “ Identify Settings

menu.

5. Now, click again on any street in the map. Along the previous Identify Results dialog, you'll see the now-familiar
form:

0086 Attributes - roads

osm_id  |47587910) a

name NULL

highway unclassified &

waterway |NULL

aerialway | NULL

barrier NULL

man_made NULL

other_tags | 'lanes'=="2" @

[ ol | [0K]

6. Each time you click on a single feature with the Identify tool, its form pops up as long as the Auto open form is
checked.

5.3. Lesson: Forms 165



QGIS Training Manual

5.3.2 Try Yourself Using the Form to Edit Values

If you are in edit mode, you can use this form to edit a feature’s attributes.

1. Activate edit mode (if it isn’t already activated).

2. Using the Q% Identify Features 0], click on the main street running through Swellendam:

x %
X
X X
sy -
x
X
. X - £
o KKK S i 3 ¢ \, osm_id |238808188 2|
x ><)‘K’( x name |Voorlrek Street ‘
.

highway |tar|iary ‘

waterway | NULL ‘

aerialway  [NULL |

barrier [nuLe |

man_made |NULL |

other_tags |"Ianm"=>"2“

3. Edit its highway value to be secondary

4. Exit edit mode and save your edits

5. Open the Attribute Table and note that the value has been updated in the attributes table and therefore in the
source data

5.3.3 Follow Along: Setting Form Field Types
It’s nice to edit things using a form, but you still have to enter everything by hand. Fortunately, forms have different
kinds of so-called widgets that allow you to edit data in various different ways.

1. Open the roads layer’s Properties...

2. Switch to the Fields tab. You'll see this:
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Layer Properties - roads | Fields

|/ | &)
,’i e Tem id -~ Name Alias Type Typename Length Precision Comment WMS WFS *
s 122 0 [fid glonglong Integer64 0 0 v v
W Source . . :
: abe 1 Full_id Qstring  String 255 0 v v
-
& Symbology ac 2 | osm_id Qstring  String 255 0 v v
a3 Labels abc 3 osm_type QString  String 255 0 v v
ac 5 lanes Strin strin 0 v v
d Diagrams Q < =
-~ ac §  maxspeed Qstring  String 255 0 v v
hy 3D View . .
abc 7 oneway Qstring  String 255 0 v v
[ 5 Fields ae 8 | ref QString  String 255 0 v v
Attributes . .
B abc 9 surface Qstring  String 255 0 v v
Joins abc 10 name Qstring  string 255 0 v v
_’l Augxiliary abc 11 embankment Qstring  String 255 0 v v
Storage . . .
@ abc 12 maxweight Qstring  String 255 0 v v -
AF} Actions
.| @Help || shyle - | JApply || X cancel || oK |
3. Switch to the Attributes Form tab. You'll see this:
Layer Properties - roads | Attributes Form
|Autogenerate - \ |E\ |Show form on add Feature (global settings) ~ |
) Information “ | Available widgets =
Fields
23 source fid
- Full_id
=" symbol osm_id
o Abehy osm_type
€= Labels highway
lanes
maxspeed
€D Masks oneway
- , ref
, Diagrams surface
name
W 3D View embankment
maxweight
E Fields destination:back...
destination:Fforward
Attributes Form destination:ref:ba...
destination:symb...
Joins cutting
access
ﬂ Augxiliary hgv
Storage Foot -
——— |
B oacions T “Jnopl | Xcancel [ doK_]

4. Click on the oneway row and choose Checkbox as Widget Type in the list of options:
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Layer Properties - roads | Attributes Form X

Autogenerate

“ Available widgets =
~ Fields
fid
full_id
osm_id
osm_type
highway
lanes

-||A

v General

Alias

Comment

v| Editable Label on top

Show form on add feature (global settings) ~

-

maxsEeed

ref

surface

name

embankment
maxweight
destination:backw...
destination:forward
destination:ref:ba...
destination:symbo...
cutting

access

hgv

foot

sac_scale

name:af
lanes:backward
lanes:forward
reg_ref

bicycle

cycleway v
sidewalk

service

bridge

it -8B B « & @

Classification
Color
Date/Time

Attachment
Hidden

Relation Reference
Text Edit

Unigue Values
Uuid Generator
Value Map

Value Relation

_

layer =

@Help

Style -~

5. Click OK

</ Apply

6. Enter edit mode (if the roads layer is not already in edit mode)

7. Click on the Q& Identify Features 6]

8. Click on the same main road you

chose earlier

-

#® Cancel

You will now see that the oneway attribute has a checkbox next to it denoting True (checked) or Fa 1 se (unchecked).

5.3.4 Try Yourself

Set a more appropriate form widget for

the highway field.

Answer

For the TYPE, there is obviously a limited amount of types that a road can be, and if you check the attribute table for
this layer, you’ll see that they are predefined.

1. Set the widget to Value Map and click Load Data from Layer.

2. Select roads in the Label dropdown and highway for both the Value and Description options:
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|2 | highway | QSiring ‘ String | 254

| R I P |

|° | | EERGeVRESEaARIE

[a I I

Attribute Edit Dialog "highway"

ms Line edit (¥ Editable
Classification || Label on top
ata Range

Unigue values
File name

Value map shown in the combo box.

Combo box with predefined items. Value is stored in the attribute

™ v
| ~ ~
& ~

Select data from atiributes in selected layer.

Enumeration
Immutable

Load Data from layer l [ Load Data from CSV file

Hidden

Checkbox Value Description

Text edit
Calendar 1 |

Layer
Value

Description

[ roads ;]

highway

View All

“
v

Value

Description

Value relation
UUID generator
Photo

Webview

Color

footway

footway

path

path

primary

primary

residential

residential

service

service

tertiary

tertiary

Remove Selected

el | [0k ]

3. Click OK three times.

4. If you use the Identify tool on a street now while edit mode is active, the dialog you get should look like this:

8006 Attributes - roads - -
osm_id 238808188
name Voortrek Street |
highway [ secondary 4]
waterway | NULL |
aerialway  NULL |
barrier 'NULL |
man_made ||
other_tags | "lanes'=>"2" a|

Cancel | (0K
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5.3.5 Try Yourself Creating Test Data

You can also design your own custom form completely from scratch.
1. Create a simple point layer named test-data with two attributes:
¢ name (text)

* age (integer)

New GeoPackage Layer X

Database training_data.gpkg

Table name test-data

Geometry type Point >
Include Z dimension Include M values

EPSG:4326 - WGS 84 v | |
New Field
Name
Type 123 \Whole Number (integer) -

Maximum length

Fields List
Name Type Length
name text 80
age integer

w Advanced Options

Layer identifier  test-data
Layer description

Feature id column | fid
Geometry column |geometry

¥ Create a spatial index

©Help Ocancel QoK

2. Capture a few points on your new layer using the digitizing tools so that you have a little data to play with. You
should be presented with the default QGIS generated attribute capture form each time you capture a new point.

Nota: You may need to disable Snapping if still enabled from earlier tasks.
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test-data - Feature Attributes X

fid Autogenerate a| v
name richard a
age 23 =

Ocance

5.3.6 Follow Along: Creating a New Form

Now we want to create our own custom form for the attribute data capture phase. To do this, you need to have QT
Designer installed (only needed for the person who creates the forms).
1. Start QT Designer.

2. In the dialog that appears, create a new dialog:

006 New Form

templates/torms
Dialog with Buttons Bottom

Dialog with Buttons Right
Dialog without Buttons
Main Window
Widget
Widgets
Cancel 0K
Embedded Design
Device: Nene
Screen Size: | Default size s
(¥ Show this Dialog on Startup
| Open.. | [ Recentw | | Close | [ Create |

3. Look for the Widget Box along the left of your screen (default). It contains an item called Line Edit.
4. Click and drag this item into your form. This creates a new Line Edit in the form.

5. With the new line edit element selected, you'll see its properties along the side of your screen (on the right by
default):
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10.
11.
12.

13.
14.

000

Property Editor

[Filter

lineEdit : QLineEdit

ar, = 7,

Praperty

Valug

lineEdit

-

enabled ™

» geometry [(80, 40), 113 x 21]

» sizePolicy [Expanding, Fixed, 0, 0]

»  minimumSize 0x0

» maximumSize 16777215 x 16777215

» sizelncrement 0x0

» baseSize 0x0
palette Inherited

» font A [Lucida Grande Ul, 13]
cursor | I1Beam
mouseTracking ™
focusPolicy StrongFocus
contextMenuPolicy | DefaultContextMenu
acceptDrops ™

» toolTip

b statusTip

» whatsThis

» accessibleName

» accessibleDescrip...
layoutDirection LeftToRight

autoFillBackground

styleSheet

» locale

English, SouthAfrica

p inputMethodHints ImhNone

\

» inputMask

b text
maxLength 32767
frame [21
echoMode Normal
cursorPosition 0

» alignment AlignLeft, AlignVCenter
dragEnabled ]
readOnly ]

p placeholderText

curanrifnvaShiles

| nniralMovaShile

Set its name to name.
Using the same approach, create a new Spin Box and set its name to age.

Add a Label with the text Add a New Person in a bold font (look in the object properties to find out how
to set this). Alternatively, you may want to set the title of the dialog itself (rather than adding a label).

Add a Label for your Line Edit and your Spin Box.
Arrange the elements to your own desire.
Click anywhere in your dialog.

Find the Lay Out in a Form Layout button (in a toolbar along the top edge of the screen, by default). This lays
out your dialog automatically.

Set the dialog’s maximum size (in its properties) to 200 (width) by 150 (height).

Your form should now look similar to this:
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8 -add_people.ui* |- [X

15. Save your new form as exercise_data/forms/add_people.ui

16. When it’s done saving, you can close Qf Designer

5.3.7 Follow Along: Associating the Form with Your Layer

1. Go back to QGIS
Double click the fest-data layer in the legend to access its properties.
Click on the Aftributes Form tab in the Layer Properties dialog

In the Attribute editor layout dropdown, select Provide ui-file.

wook wn

Click the ellipsis button and choose the add_people.ui file you just created:

Layer Properties - test-data | Attributes Form x

Q Provide ui-file ~ | @ | Show form on add feature (global settings) ~

G’ InFormation = Edit Ul |/home/qgis-user/forms/add_people.ui
Available widgets

2a v General
W\ Source ¥ Fields
fid ;
4 Al
& symbology name ias
___age | Comment
X Labels Relations .
- Other Widgets v/ Editable | | Labelon top
@B masks QML Widget
HTML Widget v Widget Type
. Diagrams
Text Edit -
Wp 3D View
Multiline
E Fields
prm .
|=1| Attributes Form
Joins w Constraints
L Auxiliary
0 storage Mot null
(;‘.G) Actions Unique
. Expression ~||€
. Display
- Expression description
& Rendering
Enforce expression constraint
Variables
_ v Defaults
H Metadata
Default value £
ﬁ Dependencies Prane

Apply default value on update

@Help Style ~ « Apply || % cancel

Legend

QGIS Server

-

6. Click OK on the Layer Properties dialog
7. Enter edit mode and capture a new point

8. When you do so, you will be presented with your custom dialog (instead of the generic one that QGIS usually
creates).
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9. If you click on one of your points using the Q& Identify Featwres t0] you can now bring up the form by right
clicking in the identify results window and choosing View Feature Form from the context menu.

10. If you are in edit mode for this layer, that context menu will show Edit Feature Form instead, and you can then
adjust the attributes in the new form even after initial capture.

5.3.8 In Conclusion

Using forms, you can make life easier for yourself when editing or creating data. By editing widget types or creating
an entirely new form from scratch, you can control the experience of someone who digitizes new data for that layer,
thereby minimizing misunderstandings and unnecessary errors.

5.3.9 Further Reading

If you completed the advanced section above and have knowledge of Python, you may want to check out this blog entry
about creating custom feature forms with Python logic, which allows advanced functions including data validation,
autocompletion, etc.

5.3.10 What’s Next?

Opening a form on identifying a feature is one of the standard actions that QGIS can perform. However, you can also
direct it to perform custom actions that you define. This is the subject of the next lesson.

5.4 Lesson: Actions

Now that you have seen a default action in the previous lesson, it is time to define your own actions.

An action is something that happens when you click on a feature. It can add a lot of extra functionality to your map,
allowing you to retrieve additional information about an object, for example. Assigning actions can add a whole new
dimension to your map!

The goal for this lesson: To learn how to add custom actions.

In this lesson you will use the school_property layer you created previously. The sample data include photos of each
of the three properties you digitized. What we are going to do is to associate each property with its image. Then we
will create an action that will open the image for a property when clicking on the property.

5.4.1 Follow Along: Add a Field for Images
The school_property layer has no way to associate an image with a property yet. First we will create a field for
this purpose.

1. Open the Layer Properties dialog.

2. Click on the Fields tab.

3. Toggle editing mode:
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Layer Properties - school_property | Fields

NE

d - 1Toggle editing mode t'pe Type name  Length Precision = Comment

‘:{:\? Source

1230 |id glonglong | Integer64 10 0 v

%" symbology

abc | name Qstring  String 80 0 v
€3 Labels

B Masks

- .
. [MELEIN S

W7 3D View
E 5 Fields

E Aktributes Form

1 4

Joins
s Auxiliary . @telp || style -  Japply | ®cancel || Jok |

4. Add a new column:

Layer Properties - school_property | Fields

If? ® (/] |E
New field |me Alias Type Type name Length Precision Comment

1220 |id glonglong | Integer64 10 0 v

(;’i Information

:{:\\ Source . :
: abc name Qstring String 80 0 v

%~ symbology
€= Labels
B Masks

. Diagrams

Ng 3D View

E g Fields

E Attributes Form

5. Enter the values below:
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Add Field

Name

Comment

Type

|image|

Text (string)

Provider type string

Length

il
-

% cancel | o OK |

6. After the field has been created, move to the Atributes Form tab and select the image field.

7. Set Widget Type to Attachment:

Layer Properties - school_property | Attributes Form x

G’ Information

‘:{:\} Source

¥ symbology

> .
" Diagrams

W# 3D View
ﬁ Fields

::E: Attributes For

Joins

L Auxiliary
&M Storage

«;@ Actions
- Display
Qj./ Rendering

Variables

l Metadata

ﬁ Dependencies
Legend

& qais server

8. Click OK in the Layer Properties dialog.

* | Available widgets

~ Other Widgets

v General

Alias
Comment
v| Editable

v Widget Type
Attachment

Path

Label on top

~ | @ || show form on add feature (global settings) ~

-

Default path |/home/tveite/Downloads/QGIS/QGISTrainin... || ... | €

Relative paths

Storage Mode

@ File paths
Directory paths

v Display Resource Path

v Display button to open File dialog

Filter

Use a hyperlink For document path (read-only)

-

</ Apply || % cancel oK

9. Use the Identify tool to click on one of the three features in the school_property layer.

Since you are still in edit mode, the dialog should be active and look like this:
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school_property - Feature Attributes .

Actions

id |2 |

name school campus

image

% cancel | &/ OK |

10. Click on the browse button (the ... next to the image field).

11. Select the path for your image. The images are in exercise_data/school_property_photos/
and are named the same as the features they should be associated with.

12. Click OK.
13. Associate all of the images with the correct features using this method.

14. Save your edits and exit edit mode.

5.4.2 Follow Along: Creating an Action

1. Open the Actions tab for the school_property layer, and click on the Ifl-l-ll:| Add anew action b0,

Layer Properties - school_property | Actions x

Q, ¥ Action List

"i Information Description Short Title Action  Capture Action Scopes On Notification Only when editable
‘?\_“\\ Source

% symbology

€ Labels

€O Masks

- N
a Diagrams

W# 3D View

E Fields

E Attributes Form

Joins
4 »

ﬂ Auxiliary Storage Lk Create Default Actions

Actions Add a new action

» Show in Attribute Table

® Display _| @Help Style - «/ Apply || % Cancel

2. In the Add New Action dialog, enter the words Show Image into the Description field:

5.4. Lesson: Actions 177



QGIS Training Manual

Add New Action -~

Type Generic - Capture output

Description |Mandatory description
Short Mame |Leave empty to use only icon
lcon

Action Scopes

Field Scope
Layer Scope
v Canvas

v Feature Scope

Action Text

The action text defines what happens if the action is triggered.
The content depends on the type.

For the type Python the content should be python code
For other types it should be a file or application with optional parameters

1 3
| E Insert
Execute if notification matches

Enable only when editable

@Hel ¥ cancel
p L

What to do next varies according to your operating system, so choose the appropriate course to follow:

¢ Windows
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Click on the Type dropdown and choose Open.
e Ubuntu Linux

Under Action, write eog for the Gnome Image Viewer, or write display to use ImageMagick.
Remember to put a space after the command!

* macOS
1. Click on the Type dropdown and choose Mac.
2. Under Action, write open. Remember to put a space after the command!
Now you can continue writing the command.

You want to open the image, and QGIS knows where the image is. All it needs to do is to tell the Action where
the image is.

3. Select image from the list:
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Add New Action i3

Type Generic - Capture output

Description |Mandatory description
Short Mame |Leave empty to use only icon
lcon

Action Scopes

Field Scope
Layer Scope
v Canvas

v Feature Scope

Action Text

The action text defines what happens if the action is triggered.
The content depends on the type.

For the type Python the content should be python code
For other types it should be a file or application with optional parameters

1 eoq- [%imageS]

4 b
123 id

abc name

@Help % Cancel

4. Click the Insert field button. QGIS will add the phrase [$ "image" %] in the Action Text field.
5. Click the OK button to close the Add New Action dialog

180 Capitulo 5. Module: Criar Dados Vetoriais



QGIS Training Manual

6. Click OK to close the Layer Properties dialog
Now it is time to test the new action:

1. Click on the school_property layer in the Layers panel so that it is highlighted.

. "@-\l‘- Run feature acti : .
2. Find the == Runteatureacion yytton (in the Antributes Toolbar).

3. Click on the down arrow to the right of this button. There is only one action defined for this layer so far, which
is the one you just created.

TN oo

4. Click the button itself to activate the tool.

5. Using this tool, click on any of the three school properties.

The image for that property should open.

5.4.3 Follow Along: Searching the Internet

Let’s say we are looking at the map and want to know more about the area that a farm is in. Suppose you know
nothing of the area in question and want to find general information about it. Your first impulse, considering that
you’re using a computer right now, would probably be to Google the name of the area. So let’s tell QGIS to do that
automatically for us!

1. Open the attribute table for the landuse layer.
We will be using the name field for each of our landuse areas to search Google.
2. Close the attribute table.
3. Go back to Actions in Layer Properties.
4. Click on the Create Default Actions button to add a number of pre-defined actions.

5. Remove all the actions but the Open URL action with the short name Search Web using the =

Remove the selected action by1¢ton below.
6. Double-click on the remaining action to edit it
7. Change the Description to Google Search, and remove the content of the Short Name field.
8. Make sure that Canvas is among the checked Action scopes.
What to do next varies according to your operating system, so choose the appropriate course to follow:
* Windows

Under Type, choose Open. This will tell Windows to open an Internet address in your default browser,
such as Internet Explorer.

¢ Ubuntu Linux

Under Action, write xdg—open. This will tell Ubuntu to open an Internet address in your default browser,
such as Chrome or Firefox.

¢ macOS

Under Action, write open. This will tell macOS to open an Internet address in your default browser,
such as Safari.
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Now you can continue writing the command

Whichever command you used above, you need to tell it which Internet address to open next. You want it to
visit Google, and to search for a phrase automatically.

Usually when you use Google, you enter your search phrase into the Google Search bar. But in this case, you
want your computer to do this for you. The way you tell Google to search for something (if you don’t want to
use its search bar directly) is by giving your Internet browser the address https://www.google.com/
search?gq=SEARCH_PHRASE, where SEARCH_PHRASE " is what you want to search for. Since we don’t
know what phrase to search for yet, we will just enter the first part (without the search phrase).

In the Action field, write https://www.google.com/search?g=. Remember to add a space after
your initial command before writing this in!

Now you want QGIS to tell the browser to tell Google to search for the value of name for any feature that you
could click on.

10. Select the name field.

11. Click Insert button:
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Edit Action -~

Type Generic - Capture output

Description |Google Search
Short Mame |Leave empty to use only icon

lcon

Action Scopes

Field Scope
Layer Scope
v Canvas

Feature Scope

Action Text

The action text defines what happens if the action is triggered.
The content depends on the type.

For the type Python the content should be python code
For other types it should be a file or application with optional parameters

1 xdg-open-http://www.google.com/search?q=[%name%]

1 b

| E Insert

Execute if notification matches || |

Enable only when editable

@Help % Cancel « OK

What this means is that QGIS is going to open the browser and send it to the address https://www.

google.com/search?g=[% "name" %]. [%$ "name" %] tells QGIS to use the contents of the
name field as the phrase to search for.
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So if, for example, the landuse area you click on is named Marloth Nature Reserve, QGIS is going to
send the browser to https://www.google.com/search?g=Marloth%20Nature%20Reserve,
which will cause your browser to visit Google, which will in turn search for «Marloth Nature Reserve».

12. If you have not done so already, set everything up as explained above.
13. Click the OK button to close the Add New Action dialog
14. Click OK to close the Layer Properties dialog

Now to test the new action.

@ .
1. With the landuse layer active in the Layers panel, click on the down arrow to the right of the &1& Run feature action

button, and select the only action (Google Search) defined for this layer.

2. Click on any landuse area you can see on the map. Your browser will now open, and will start a Google search
for the place that is recorded as that area’s name value.

Nota: If your action doesn’t work, check that everything was entered correctly; typos are common with this kind of
work!

5.4.4 Follow Along: Open a Webpage Directly in QGIS

Above, you’ve seen how to open a webpage in an external browser. There are some shortcomings with this approach
in that it adds an unknowable dependency — will the end-user have the software required to execute the action on
their system? As you’ve seen, they don’t necessarily even have the same kind of base command for the same kind
of action, if you don’t know which OS they will be using. With some OS versions, the above commands to open the
browser might not work at all. This could be an insurmountable problem.

However, QGIS sits on top of the incredibly powerful and versatile Qt library. Also, QGIS actions can be arbitrary,
tokenized (i.e. using variable information based on the contents of a field attribute) Python commands!

Now you will see how to use a python action to show a web page. It is the same general idea as opening a site in an
external browser, but it requires no browser on the user’s system since it uses the Qt QWebView class (which is a
webkit based html widget) to display the content in a pop-up window.

Let us use Wikipedia this time. So the URL you request will look like this:
https://wikipedia.org/wiki/SEARCH_PHRASE
To create the layer action:
1. Open the Layer Properties dialog and head over to the Actions tab.
2. Set up a new action using the following properties for the action:
e Type: Python
* Description: Wikipedia
e Scope: Feature, Canvas

e Action Text:

from ggis.PyQt.QtCore import QUrl
from ggis.PyQt.QtWebKitWidgets import QWebView

myWV = QWebView (None)
myWV.load (QUrl ('https://wikipedia.org/wiki/ [$name%] "))
myWV . show ()
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Edit Action X

Type Python - Capture output
Description |wikipedia

Short Name |Leave empty to use only icon

lcon

Action Scopes

Layer
| Feature
¥ Canvas

Field

Form

Action Text

The action text defines what happens if the action is triggered.

The content depends on the type.

For the type Python the content should be Python code, if the action is triggered from a button
widget embedded in a drag and drop designer Form, the form instance is exposed to Python as
the formvariable.

For other types it should be a File or application with optional parameters.

1 from-qgis.PyQt.QtCore-import -QuUrl

2 from-qgis.PyQt.QtWebKitWidgets import  QwWebView

3

4 myWV =-QWebView(None)

5 myWv.load(QUrl("https://wikipedia.org/wiki/[%name%]"'))

6 mywv.show()

7
1 #
123 *|| £ Insert

Execute if notification matches

Enable only when editable

@ Help © cancel QoK

There are a couple of things going on here:

* [$name%] will be replaced by the actual attribute value when the action is invoked (as before).

¢ The code simply creates a new QWebView instance, sets its URL, and then calls show () on it to make
it visible as a window on the user’s desktop.

You could also use this approach to display an image without requiring that the users have a particular image
viewer on their system.

3. Try to use the methods described above to load a Wikipedia page using the Wikipedia action you just created.

5.4. Lesson: Actions 185



QGIS Training Manual

5.4.5 In Conclusion
Actions allow you to give your map extra functionality, useful to the end-user who views the same map in QGIS. Due

to the fact that you can use shell commands for any operating system, as well as Python, the sky is the limit in terms
of the functions you could incorporate!

5.4.6 What’s Next?

Now that you’ve done all kinds of vector data creation, you will learn how to analyze the data to solve problems. That
is the topic of the next module.
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Module: Analise Vetorial

Now that you have edited a few features, you must want to know what else one can do with them. Having features
with attributes is nice, but when all is said and done, this doesn’t really tell you anything that a normal, non-GIS map
can’t.

A principal vantagem de um SIG € esta: um SIG pode responder a perguntas.

For the next three modules, we’ll endeavor to answer a research question using GIS functions. For example, you are an
estate agent and you are looking for a residential property in Swellendam for clients who have the following criteria:

1. It needs to be in Swellendam.

2. It must be within reasonable driving distance of a school (say 1km).
3. It must be more than 100m squared in size.

4. Closer than 50m to a main road.

5. Closer than 500m to a restaurant.

Within the next few modules, we’ll harness the power of GIS analysis tools to locate suitable farm properties for this
new residential development.

6.1 Lesson: Reprojecting and Transforming Data

Let us talk about Coordinate Reference Systems (CRSs) again. We have touched on this briefly before, but haven’t
discussed what it means practically.

The goal for this lesson: To reproject and transform vector datasets.
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6.1.1 Follow Along: Projections
The CRS that all the data, as well as the map itself are in right now is called WGS84. This is a very common
Geographic Coordinate System (GCS) for representing data. But there’s a problem, as we will see.

1. Save your current map

2. Then open the map of the world which you will find under exercise_data/world/world.ggs
3. Zoom in to South Africa by using the Zoom In tool
4

. Try setting a scale in the Scale field, which is in the Statusbar along the bottom of the screen. While over South
Africa, set this value to 1 : 5 000 000 (one to five million).

5. Pan around the map while keeping an eye on the Scale field

Notice the scale changing? That’s because you are moving away from the one point that you zoomed into at 1 : 5
000 000, which was at the center of your screen. All around that point, the scale is different.

To understand why, think about a globe of the Earth. It has lines running along it from North to South. These
longitude lines are far apart at the equator, but they meet at the poles.

In a GCS, you are working on this sphere, but your screen is flat. When you try to represent the sphere on a flat
surface, distortion occurs, similar to what would happen if you cut open a tennis ball and tried to flatten it out. What
this means on a map is that the longitude lines stay equally far apart from each other, even at the poles (where they
are supposed to meet). This means that, as you travel away from the equator on your map, the scale of the objects
that you see gets larger and larger. What this means for us, practically, is that there is no constant scale on our map!

To solve this, let’s use a Projected Coordinate System (PCS) instead. A PCS «projects» or converts the data in a way
that makes allowance for the scale change and corrects it. Therefore, to keep the scale constant, we should reproject
our data to use a PCS.

6.1.2 Follow Along: «On the Fly» Reprojection

By default, QGIS reprojects data «on the fly». What this means is that even if the data itself is in another CRS, QGIS
can project it as if it were in a CRS of your choice.

You can change the CRS of the project by clicking on the ‘E Current projection ytton in the bottom right corner of
QGIS.

1. In the dialog that appears, type the word global into the Filter field. A few CRSs should appear in the
Predefined Reference Systems field below.

2. Select WGS 84 / NSIDC EASE-Grid 2.0 Global | EPSG:6933 entry by clicking on it, and then click OK.

Notice how the shape of South Africa changes. All projections work by changing the apparent shapes of objects
on Earth.

3. Zoomtoascaleof 1:5 000 000 again, as before.
4. Pan around the map.
Notice how the scale stays the same!
«On the fly» reprojection is also used for combining datasets that are in different CRSs.

1. Add another vector layer to your map which has the data for South Africa only. You will find it as
exercise_data/world/RSA. shp.

2. Load it. A quick way to see its CRS is by hovering the mouse over the layer in the legend. Itis EPSG:3410.
What do you notice?

The layer is visible even if it has a different CRS from the continents one.
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6.1.3 Follow Along: Saving a Dataset to Another CRS

Sometimes you need to export an existing dataset with another CRS. As we will see in the next lesson, if you need
to make distance calculations on layer, it is always better to have the layer in a projected coordinate system.

Be aware that the “on the fly” reprojection is related to the project and not to single layers. This means that a layer
can have a different CRS from the project even if you see it in the correct position.

You can easily export the layer with another CRS.

1.
2.
3.

Add the buildings dataset from training_data.gpkg
Right-click on the buildings layer in the Layers panel

Select Export » Save Features As... in the menu that appears. You will be shown the Save Vector Layer as...
dialog.

Click on the Browse button next to the File name field

Navigate to exercise_data/ and specify the name of the new layer as buildings_reprojected.
shp.

Change the value of the CRS. Only the recent CRSs used will be shown in the drop-down menu. Click on the
3‘:&; Select projection {ytton next to the drop-down menu.

The Coordinate Reference System Selector dialog will appear. In its Filter field, search for 34S.

Select WGS 84 / UTM zone 34S | EPSG:32734 from the list
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Coordinate Reference System Selector

Select the coordinate reference system for the vector file. The data points will be transformed fraom the layer
coordinate reference system.

Filter | ©. 345 a |
Recently used coordinate reference systems

Coordinate Reference System Authority 1D

WGS 84/ UTM zone 345 EPSG:32734

1

[»

Coordinate reference systems of the world Hide deprecated CRSs

wordinate Reference System Authority ID [
RGRDC 2005 / UTM zone 345 EPSG:4062
WGS 72 [ UTM zone 345 EP5G:32334
WGS 72BE / UTM zone 345 EP5G:32534

WG5S 84 / UTM zone 345 EP5G:32734

A

7

Selected CRS |WGS 84 / UTM zone 345

. ¥ i W g u
Extent: 18.00, -20.00, 24.00, 0.00 \ o
Projd: +proj=utm +zone=34 +south .’I ' = .
+datum=WGS84 +units=m +no_defs - g
| [@lHelp | | @cancel || Fok |

9. Leave the other options unchanged. The Save Vector Layer as... dialog now looks like this:
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Save Vector Layer as...

Format ESRI Shapefile

File name |ome/matteo/exercise_data/exercise_data/buildings_reprojected.shp &

Layer name
CRS EPSG:32734 - WGS 84 7 UTM zone 345 - | |
Encoding UTF-8 -

v | Add saved file to map

b Select fields to export and their export options
v Geometry

Geometry type Automatic =

» Extent (current: layer)
P Layer Options

P Custom Options

Help @ Cancel oK

10. Click OK

You can now compare the old and new projections of the layer and see that they are in two different CRS but they
are still overlapping.
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6.1.4 Follow Along: Creating Your Own Projection

There are many more projections than just those included in QGIS by default. You can also create your own
projections.

1.

Start a new map

2. Load the world/oceans. shp dataset

3. Go to Settings » Custom Projections... and you will see this dialog.

Custom Coordinate Reference System Definition x

v Define

You can define your own custom Coordinate Reference System (CRS) here. The definition must conform to a WKT or Proj string Format for specifying a CRS.

Name Parameters dha
=
Name
Format WKT (Recommended) -
Validate
Parameters
v Test

Use the text boxes below to test the CRS definition you are creating. Enter a coordinate where both the lat/long and the transformed result are known (for example by
reading off a map). Then press the calculate button to see if the CRS definition you are creating is accurate.

Geographic / WGS84 Destination CRS

Calculate

@Help Ocancel QoK

Click on the 5 Add new crs button to create a new projection
An interesting projection to use is called Van der Grinten I.Enter its name in the Name field.

This projection represents the Earth on a circular field instead of a rectangular one, as most other projections
do.

In Format, select WKT (Recommended)

Add the following string in the Parameters field:

(PROJCRS["unknown",
BASEGEOGCRS [ "unknown",
DATUM["unknown",
ELLIPSOID["unknown", 6371000,0,
LENGTHUNIT ["metre", 1,
ID["EPSG",9001]111,
PRIMEM|["Greenwich", O,
ANGLEUNIT ["degree",0.0174532925199433],
ID["EPSG",8901]11,
CONVERSION ["unknown",
METHOD ["Van Der Grinten"],
PARAMETER|["Longitude of natural origin", 0,

(continues on next page)
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ANGLEUNIT ["degree",0.0174532925199433],
ID["EPSG",8802]],
PARAMETER["False easting", 0,
LENGTHUNIT ["metre",1],
ID["EPSG",8806]],
PARAMETER["False northing", 0,
LENGTHUNIT ["metre",1],
ID["EPSG",8807]11,
CS[Cartesian, 2],
AXIS[" (E)",east,
ORDER[17],
LENGTHUNIT["metre", 1,
ID["EPSG", 9001111,
AXIS[" (N)",north,
ORDER[2],
LENGTHUNIT ["metre", 1,
ID["EPSG", 90011111

(continuac@o da pégina anterior)

Custom Coordinate Reference System Definition X

v Define

You can define your ewn custom Coordinate Reference System (CRS) here. The definition must conform to a WKT or Proj string Fermat for specifying a CRS.

Name Parameters o
Van der Grinten | PROJCRS["unknown", BASEGEOGCRS["unknown", DATUM["unknown" ELLIPSOID["unknown",6371000,0,LENGTHUNIT["metre”,1,ID[... -
Name Van der Grinten |
Format WKT (Recommended) -
PROJCRS["unknown", = Vvalidate
BASEGEOGCRS["unknown",
DATUM["unknown",
ELLIPSOID["unknown",6371000,0,
LENGTHUNIT["metre",1,
Parameters ID["EPSG",9001]]]],
PRIMEM["Greenwich",0,
ANGLEUNIT["degree",0.0174532925199433],
ID["EPSG",8901]]],
CONVERSION["unknown",
METHOD["Van Der Grinten"], -
» Test 1
@Help Ocancel QoK
8. Click OK

9. Click on the 2 Curent CRS byion at the right of the status bar to change the project CRS

10. Choose your newly defined projection (search for its name in the Filter field)

11. On applying this projection, the map will be reprojected thus:
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6.1.5 In Conclusion

Different projections are useful for different purposes. By choosing the correct projection, you can ensure that the
features on your map are being represented accurately.

6.1.6 Further Reading

Materials for the Advanced section of this lesson were taken from this article.

Read further information on Coordinate Reference Systems.

6.1.7 What’s Next?

In the next lesson you will learn how to analyze vector data using QGIS” various vector analysis tools.

6.2 Lesson: Vector Analysis

Vector data can also be analyzed to reveal how different features interact with each other in space. There are many
different analysis-related functions, so we won’t go through them all. Rather, we will pose a question and try to solve
it using the tools that QGIS provides.

The goal for this lesson: To ask a question and solve it using analysis tools.

194 Capitulo 6. Module: Analise Vetorial


https://anitagraser.com/2012/03/18/beautiful-global-projections-adding-custom-projections-to-qgis/

QGIS Training Manual

6.2.1 The GIS Process

Before we start, it would be useful to give a brief overview of a process that can be used to solve a problem. The way
to go about it is:

1. State the Problem
2. Get the Data
3. Analyze the Problem

4. Present the Results

6.2.2 The Problem

Let’s start off the process by deciding on a problem to solve. For example, you are an estate agent and you are looking
for a residential property in Swellendam for clients who have the following criteria:

1. It needs to be in Swellendam

2. It must be within reasonable driving distance of a school (say 1km)
3. It must be more than 100m squared in size

4. Closer than 50m to a main road

5. Closer than 500m to a restaurant

6.2.3 The Data

To answer these questions, we are going to need the following data:
1. The residential properties (buildings) in the area
2. The roads in and around the town
3. The location of schools and restaurants
4. The size of buildings

These data are available through OSM, and you should find that the dataset you have been using throughout this
manual also can be used for this lesson.

If you want to download data from another area, jump to the Introduction Chapter to read how to do it.

Nota: Although OSM downloads have consistent data fields, the coverage and detail does vary. If you find that your
chosen region does not contain information on restaurants, for example, you may need to chose a different region.

6.2.4 Follow Along: Start a Project and get the Data

We first need to load the data to work with.
1. Start a new QGIS project

2. If you want, you can add a background map. Open the Browser and load the OSM background map from the
XYZ Tiles menu.
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3. In the training_data.gpkg Geopackage database, you will find most the datasets we will use in this
chapter:

1. buildings
2. roads
3. restaurants
4. schools
Load them, and also 1anduse.sglite.
4. Zoom to the layer extent to see Swellendam, South Africa
Before proceeding we will filter the roads layer, in order to have only some specific road types to work with.

Some roads in OSM datasets are listed as unclassified, tracks, path and footway. We want to
exclude these from our dataset and focus on the other road types, more suitable for this exercise.

Moreover, OSM data might not be updated everywhere, and we will also exclude NULL values.
5. Right click on the roads layer and choose Filter....

6. In the dialog that pops up we filter these features with the following expression:

"highway" NOT IN ('footway', 'path', 'unclassified', 'track') AND "highway" IS.
—NOT NULL

The concatenation of the two operators NOT and IN excludes all the features that have these attribute values
in the highway field.

IS NOT NULL combined with the AND operator excludes roads with no value in the highway field.

Note the I? icon next to the roads layer. It helps you remember that this layer has a filter activated, so some
features may not be available in the project.
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The map with all the data should look like the following one:
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6.2.5 Try Yourself Convert Layers” CRS

Because we are going to be measuring distances within our layers, we need to change the layers” CRS. To do this,
we need to select each layer in turn, save the layer to a new one with our new projection, then import that new layer

into our map.

You have many different options, e.g. you can export each layer as an ESRI Shapefile format dataset, you can append
the layers to an existing GeoPackage file, or you can create another GeoPackage file and fill it with the new reprojected
layers. We will show the last option, so the training_data.gpkg will remain clean. Feel free to choose the
best workflow for yourself.

Nota: In this example, we are using the WGS 84 / UTM zone 34S CRS, but you should use a UTM CRS which is
more appropriate for your region.

1. Right click the roads layer in the Layers panel

. Click Export —> Save Features As...

In the Save Vector Layer As dialog choose GeoPackage as Format

Click on ... for the File name, and name the new GeoPackage vector_analysis
. Change the Layer name to roads_34S

. Change the CRS to WGS 84 / UTM zone 34S

. Click on OK:

I NV R N U N
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Save Vector Layer as... o

Format GeoPackage -
File name ning-Data-release 3.10/exercise_data/vector_analysis.gpkg
Layer name roads 34S

CRS EPSG:32734 - WGS 84 / UTM zone 345 - | | &

Encoding

[#| select fields to export and their export options
v Geomekry

Geometry type Automatic -

[ Extent (current: layer)
P Layer Options

P Custom Options

©@Help v| Add saved file to map | % Cancel « OK

This will create the new GeoPackage database and add the roads_34S layer.

8. Repeat this process for each layer, creating a new layer in the vector_analysis.gpkg GeoPackage file
with _34S appended to the original name.

On macOS, press the Replace button in the dialog that pops up to allow QGIS to overwrite the existing
GeoPackage.

Nota: When you choose to save a layer to an existing GeoPackage, QGIS will add that layer next to the
existing layers in the GeoPackage, if no layer of the same name already exists.

9. Remove each of the old layers from the project

10. Once you have completed the process for all the layers, right click on any layer and click Zoom fo layer extent
to focus the map to the area of interest.
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Now that we have converted OSM data to a UTM projection, we can begin our calculations.

6.2.6 Follow Along: Analyzing the Problem: Distances From Schools and Roads

QGIS allows you to calculate distances between any vector object.

1. Make sure that only the roads_34S and buildings_34S layers are visible (to simplify the map while
you’re working)

2. Click on the Processing » Toolbox to open the analytical core of QGIS. Basically, all algorithms (for vector
and raster analysis) are available in this toolbox.

3. We start by calculating the area around the roads_34S by using the Buffer algorithm. You can find it in the
Vector Geometry group.
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Processing Toolbox
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(2} Vector creation
() Vector general
() Vector geometry
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&% Collect geometries

# Concave hull (alpha shapes)

¥ Concave hull (k-nearest neighbaor)

4% Convert geometry type
& convex hull

4% Create layer from extent
4% Create wedge buffers

@ Delaunay triangulation
¥ Delete holes

4% Densify by count

4% Densify by interval

P Dissolve

4% Drape (set z-value from raster)
4# Drop M/Z values

¥ Eliminate selected polygons
4% Explode lines

4 Extend lines

¥ Extract specific vertices
"'* Extract vertices

4% Filter vertices by m value
4% Filter vertices by z value
4F Fix geometries

4% Geometry by expression
4 Interpolate point on line

i vrnn M hisensck ek

-

You can add more algorithms to the toolbox,
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Or you can type buf fer in the search menu in the upper part of the toolbox:

Strumenti di Processing &
w e O %)
| 2 buffer| & |

allc.

* (.} Geometria vettore
Buffer multi-anello (distanza costante)
Buffer su singalo lato
Create wedge buffers
Tapered buffers
Variable width buffer (by m-value)
v o GDAL
+ Geoprocessing di Vettori
- Buffer su singolo lato
aw Vettori buffer
- g GRASS
~ Raster (r.*)
@ r.buffer
& r.bufferlowmem
* Vettore (v.*)
@ v.buffer
-~ & SAGA
* Raster tools
& Raster buffer
& Raster proximity buffer
& Threshold raster buffer

= Wlmrtor aeneres |

4. Double click on it to open the algorithm dialog

5. Select roads_34S as Input layer, set Distance to 50 and use the default values for the rest of the parameters.
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»
Parameters | Log Buffer
Input layer . .
P y This algorithm computes a buffer area for all the
W/ roads_34S [EPSG:32734] v ||...|| @ features in an input layer, using a fixed or dynamic
distance.
Dist. The segments parameter controls the number of
Istance line segments to use to approximate a quarter circle
50,000000 @ % |meters K =N when creating rounded offsets.
Segments The end cap style parameter controls how line
s — endings are handled in the buffer.
d l The join style parameter specifies whether round,
el s miter or beveled joins should be used when
Round - offsetting corners in a line.
Join style The miter limit parameter is only applicable For
miter join styles, and conkrols the maximum
Round M distance from the offset curve to use when creating
Miter limit a mitered join.
2,000000 -

Dissolve result
Buffered

[Create temporary layer]

¥| Open output file after running algorithm

@Help Run as Batch Process... # Close

6. The default Distance is in meters because our input dataset is in a Projected Coordinate System that uses meter
as its basic measurement unit. You can use the combo box to choose other projected units like kilometers,
yards, etc.

Nota: If you are trying to make a buffer on a layer with a Geographical Coordinate System, Processing will
warn you and suggest to reproject the layer to a metric Coordinate System.

7. By default, Processing creates temporary layers and adds them to the Layers panel. You can also append the
result to the GeoPackage database by:

1. Clicking on the ... button and choose Save fo GeoPackage...
2. Naming the new layer roads_buffer_50m

3. Saving it in the vector_analysis.gpkg file
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Parameters ‘ Log

Input layer
/" roads_34s [EPSG:32734]

-|[..][2]

Distance

'50,000000 @ |3 [meters ~| G
Segments

E 2
End cap style

'Round -
Join style

'Round -
Miter limit

2,000000 2]

Dissolve result
Buffered

okg' table="roads_buffer_50m" (geom) |:|

¥| Open output file after running algorithm

Buffer

This algorithm computes a buffer area for all the
features in an input layer, using a fixed or dynamic
distance.

The segments parameter controls the number of
line segments ko use to approximate a quarter circle
when creating rounded offsets.

The end cap style parameter controls how line
endings are handled in the buffer.

The join style parameter specifies whether round,
miter or beveled joins should be used when
offsetting corners in a line.

The miter limit parameter is only applicable For
miter join styles, and conkrols the maximum
distance from the offset curve to use when creating
a mitered join.

| 0%

| @Help || RunasBatch Process... |

8. Click on Run, and then close the Buffer dialog

Now your map will look something like this:

| %Close |l «/Run ]
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If your new layer is at the top of the Layers list, it will probably obscure much of your map, but this gives you all the
areas in your region which are within 50m of a road.

Notice that there are distinct areas within your buffer, which correspond to each individual road. To get rid of this
problem:

1. Uncheck the roads_buffer_50m layer and re-create the buffer with Dissolve results enabled.
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Parameters ‘ Log

Input layer
"/ roads_34S [EPSG:32734] <~ | .| @]

Distance

150,000000 @ || |meters ~| €&

Segments

E <]
End cap style

'Round -
Join style

'Round -
Miter limit

'2,000000 2]

issolve result

By Dissolve result

ok{python identifier: ‘DISSOLVE lgeom) | ... |

¥| Open output file after running algorithm

Buffer

This algorithm computes a buffer area for all the
features in an input layer, using a fixed or dynamic
distance.

The segments parameter controls the number of
line segments ko use to approximate a quarter circle
when creating rounded offsets.

The end cap style parameter controls how line
endings are handled in the buffer.

The join style parameter specifies whether round,
miter or beveled joins should be used when
offsetting corners in a line.

The miter limit parameter is only applicable For
miter join styles, and conkrols the maximum
distance from the offset curve to use when creating
a mitered join.

| 0%

| @Help || RunasBatch Process... |

2. Save the output as roads_buffer_50m_dissolved

3. Click Run and close the Buffer dialog

| %Close |l «/Run ]

Once you have added the layer to the Layers panel, it will look like this:

6.2. Lesson: Vector Analysis

205



QGIS Training Manual

*tm_ch72 - QGIS

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Progessing Help

DeEREY O, RPPRH Q0 &I

J = : R —
@o-M-a-LEE¥I &0 - R

Layers (@S]
Q@ « o A G- A 2=

roads_buffer 5om |
v — roads_34S
= v [l schools_34s

] v [[] restaurants_34s
W roads_buffer_s0m

¥ [ buildings_34s

, v [l landuse_34s
f - ¥ OpenStreetMap

(+]

l" Browser @®
LeT®o

» 7 Favorites

@' » " spatial Bookmarks
» [¥ Project Home

% » |4 Home

@- r O/
» @ GeoPackage
\/:v » / SpatiaLite
+ @ postGls
€ P MssQL
DB2
b B WMS/WMTS

b & XYZ Tiles

S e -
4 »
\ Q Type to locate (Ctrl+K) Coordinate  2271575-4030207 |5 Scateh:smss v| & Magnifier| 100% |:\ Rotation |0,0°

|2V Render @ Epsc3ss7 @

Now there are no unnecessary subdivisions.

Nota: The Short Help on the right side of the dialog explains how the algorithm works. If you need more information,
just click on the Help button in the bottom part to open a more detailed guide of the algorithm.

6.2.7 Try Yourself Distance from schools

Use the same approach as above and create a buffer for your schools.

It shall be 1 km in radius. Save the new layer in the vector_analysis.gpkg file as
schools_buffer_ lkm_dissolved.

Answer

* Your buffer dialog should look like this:
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Buffer
Parameters Log ¢ Buffer
Input layer - This algorithm computes a buffer area
|C:jschco|5_34s [EPSG:32734] - | | .. ||®@]|| [forallthe features in an input layer,
o using a fixed or dynamic distance.
) The segments parameter controls the
Distance number of line segments to use to
- . . approximate a quarter circle when
|1.000000 a@ |'| kilometers ~ | 5, creating rounded offsets.
Segments The end cap style parameter controls
[s |:| how line endings are handled in the
buffer.
End cap style o N
The join style parameter specifies
| Round hd | whether round, miter or beveled joins
) should be used when offsetting corners
Join style in a line.
Round - T .
| oun | The miter limit parameter is only
Miter limit applicable for miter join styles, and
= controls the maximum distance from the
| 2.000000 |- offset curve to use when creating a
. mitered join.
v Dissolve result
Buffered
|ﬂgr:dbname='fhomejmattec.f\.rectcr_anaIysis.gpkg' table='sch00|s_buffer_lkm_d| | |
v Open output file after running algorithm
| 0% |
| [&Help | | Run as Batch Process... # Close | l &Run ]

The Buffer distance is 1 kilometer.

» The Segments to approximate value is set to 20. This is optional, but it’s recommended, because it makes the
output buffers look smoother. Compare this:
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To this:
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The first image shows the buffer with the Segments to approximate value set to 5 and the second shows the value set
to 20. In our example, the difference is subtle, but you can see that the buffer’s edges are smoother with the higher
value.

6.2.8 Follow Along: Overlapping Areas

Now we have identified areas where the road is less than 50 meters away and areas where there is a school within 1
km (direct line, not by road). But obviously, we only want the areas where both of these criteria are satisfied. To do
that, we will need to use the Intersect tool. You can find it in Vector Overlay group in the Processing Toolbox.

1. Use the two buffer layers as Input layer and Overlay layer, choose vector_analysis.gpkg GeoPackage
in Intersection with Layer name road_school_buffers_intersect. Leave the rest as suggested
(default).
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Intersection B

3 .
Parameters = Log Intersection
Input layer

This algorithm extracts the

-~ schools_buffer 1km [EPSG:32734] ||...|| @ overlapping portions of features
in the Input and Overlay layers.
Features in the output

Overlay layer Intersection layer are assigned
the attributes of the overlapping
~'roads_buffer_50m [EPSG:32734] = || .- [|®]| |Features from both the Input and

Overlay layers.

Input fields to keep (leave empty to keep all fields) [optional]
Overlay fields to keep (leave empty to keep all fields) [optional]

v Advanced parameters

Overlay fields prefix [optional]

Intersection

lysis.gpkg' table="road_school buffers_intersect" (geom)

¥| Open output file after running algorithm

@Help Run as Batch Process... # Close

o Pl e M e ma

2. Click Run.

In the image below, the blue areas are where both of the distance criteria are satisfied.
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0 *chapter_7 - QGIS 9e45223d42 [tm] - @

Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help

BERRH [Qapps PRI Y S -R-REE#I s M-
24 / @ ¢ ) Qa® ~9- B " X
Layers
. ¢ BeTVE-BAD
3 v [l road _school_buffers.
roads buffer 50
ya p—
" ]
v [l schools_buffer_1km_dissolved
]
-]
=
|
~Or

Browser | Layers
X Type to locate (Ctri+K) 1legend entie removed. Coortinata [2265496,4035853 | 9§ Scue 12255 |~ | @ Wagnier| 100% 2] Rotation (00" 2 V] Render @ wsc38T @

3. You may remove the two buffer layers and only keep the one that shows where they overlap, since that’s what
we really wanted to know in the first place:

o *chapter_7 - QGIS 9e45223d42 [tm] - @

Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help

BRERBRHX QL0 51 B R S-D-LEE %I sS-9 M-
/ /@ ¢ QQR ~9- K
Layers
L]
e ¢ BOTE BADL
v v [l road school buffers intersect
L VI roads_3as
~ v [ schools_34s
w v/ restaurants 345
V! [] buildings_3as
v [l 1anduse _34s
~OF
S
5 S
)
-
Browser | Layers
X Type to locate (Ctri+K) Llagend enties removed. Coortinta [2265730,8033115 | 9§ Scue (152255 |~ | @ Magnier | 100% 2| Rotaton (00" 2| VI Render @ EsoaeT @
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6.2.9 Follow Along: Extract the Buildings

Now you've got the area that the buildings must overlap. Next, you want to extract the buildings in that area.
1. Look for the menu entry Vector Selection » Extract by location within the Processing Toolbox

2. Selectbuildings_34S in Extract features from. Check intersect in Where the features (geometric predicate),
select the buffer intersection layer in By comparing to the features from. Save to the vector_analysis.
gpkg, and name the layer well_located_houses.

Extract by Location £

] .
Parameters | Log Extract by location

Extract features from . .
This algorithm creates a new

-~ buildings_34S [EPSG:32734] - ... vector layer that only contains
maktching features from an input

Where the features (geometric predicate) layer. The criteria for adding

V| intersect touch Features to the resulting layer is
defined based on the spatial
contain overlap relationship between each
disjoint are within Feature and the Features in an
additional layer.
equal Cross

By comparing to the features from

“'road_school_buffers_interse: ~ || ... | @

Extracted (location)

.g' table="well_located houses" (geom)

¥ Open output file after running algorithm

| 0%

@Help Run as Batch Process... % Close </ Run

3. Click Run and close the dialog

4. You will probably find that not much seems to have changed. If so, move the well_located_houses layer to the
top of the layers list, then zoom in.
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*chapter_7 - QGIS 9e45223d42 [tm]

The red buildings are those which match our criteria, while the buildings in green are those which do not.

5. Now you have two separated layers and can remove buildings_34S from the layer list.

6.2.10 Try Yourself Further Filter our Buildings
‘We now have a layer which shows us all the buildings within 1km of a school and within 50m of a road. We now
need to reduce that selection to only show buildings which are within 500m of a restaurant.

Using the processes described above, create a new layer called houses_restaurants_500m which further filters your
well_located_houses layer to show only those which are within 500m of a restaurant.

Answer
To create the new houses_restaurants_500m layer, we go through a two step process:

1. First, create a buffer of 500m around the restaurants and add the layer to the map:
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Parameters | Log |

Buffer

Input layer

| restaurants_345 [EPSG:32734]

[se

Distance

@)

| 500.000000

& |¢‘ [meters

R="

End cap style

|R0und

Join style

l Round

Miter limit

| 2.000000

Dissolve result
Buffered

hejm atteo/vector_analysis.gpkg' table="houses_restaurants_500m" (geom) sql= | .

Open output file after running algorithm

Buffer

This algorithm computes a buffer area
for all the features in an input layer,
using a fixed or dynamic distance.

The segments parameter controls the
number of line segments to use to
approximate a quarter circle when
creating rounded offsets.

The end cap style parameter controls
how line endings are handled in the
buffer.

The join style parameter specifies
whether round, miter or beveled joins
should be used when offsetting corners
in a line.

The miter limit parameter is only
applicable for miter join styles, and
controls the maximum distance from the
offset curve to use when creating a
mitered join.

[

0%

) (concel ]

[ Help I [ Run as Batch Process...

¥ Close H Run ]

Project Edit View Layer Settings Plugins Vector Raster Database Web Proessing Help

*chapter_7 - QGIS 9e45223d42 [tm]

DeBRRRY QL s HPPRAARBRER @G K-N-LBEXI=-9 0

A /BYGR-BEax0Boe "qE“E%9% QQQR Aao0- B

Layers e%

Browser | Layers

[[QType to locate (ctri+k) Llegend entres removed.

2. Next, extract buildings within that buffer area:

Conranate| 2157254029287 |95 o 122008

| @ Magnir 1000 2] Rotstn [00°

[2] v Rerter @ mseze @
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Extract by Location

Parameters | Log | Extract by location

el T This algorithm creates a new vector

layer that only contains matching
features from an input layer. The criteria
for adding features to the resulting layer
is defined based on the spatial
relationship between each feature and

| 2 well_located_houses [EPS5G:32734] - | |:|

Where the features (geometric predicate)

intersect | | touch

| | contain | | overlap the features in an additional layer.
| disjoint | | are within
| | equal || cross

By comparing to the features from

| (2 restaurants_buffer_500m [EPSG:32734] - |[..][®]
[ Selected features only

Extracted (location)

|1attec{vectcr_analysis.gpkg' table="restaurants_buffer_500m" {geom) 5q|=| |_|

Open output file after running algorithm

[ 0% | |

| [@Help || Run as Batch Process... | | # Close |[ «Run ]

Your map should now show only those buildings which are within 50m of a road, 1km of a school and 500m of a
restaurant:

[} *chapter_7 - QGIS 9e45223d42 [tm] - B x
Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help

Y PBBRRX Q*rLr s NPPRALARBRER 6 K-O-GEE#Z=-9 M-

P /BARAR-FTx0B6e “"qQE%999% QQR 49- 0B s

<l

IRREY

Browser

houses _restaurants_500m
vell located hou
restaurant_buffer_500m
roads_34s
restaurants_34s

[ tayers |
[ Type to locate (ctri+k)

1tegend entris removed.

Conranae| 2004001515 |95 scne[13m2 |+ | @ Mot 1005 2] oaton 00

[2] v Rerser @ Eseze @
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6.2.11 Follow Along: Select Buildings of the Right Size
To see which buildings are of the correct size (more than 100 square meters), we need to calculate their size.

1. Select the houses_restaurants_500m layer and open the Field Calculator by clicking on the ==l Open Field Calculator
button in the main toolbar or in the attribute table window

2. Select Create a new field, set the Output field name to AREA, choose Decimal number (real) as Output field
type, and choose $Sarea from the Geometry group.

Field Calculator x|

¥ Create a new Field Update existing Field

Create virtual field
Output field name |AREA
Qutput field type | Decimal number (real) -

Output field length Precision

Expression | Function Editor

=+ AR e (O] 8 Q Searc... function $area 3
$area d - . = Returns the area of the current
» Date and Time
» |Eieldsand valles fe‘:ature. The area calculated by
» Files and Paths this function respects both the
} Fuzzy Matching current project’s ellipsoid setting
» General and area unit settings. For
~ Geometry example, if an ellipsoid has been
anale at_vertex set for the project then the
calculated area will be ellipsoidal,
Output preview: 1501.0355253089597 area ~| Land if no ellinsoid is set then the |~
o You are editing information on this layer but the layer is currently not in edit mode. If you click

OK, edit mode will automatically be turned on.
@Help % Cancel « 0K

The new field AREA will contain the area of each building in square meters.
3. Click OK. The AREA field has been added at the end of the attribute table.

4. Click the ¢ Toggle Editing bytion to finish editing, and save your edits when prompted.

5. In the Source tab of the layer properties, set the Provider Feature Filter to "AREA >= 100.
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Query Builder X

Set provider filter on houses_restaurants_500m
Fields Values

old_name = Q search...
addr:erf

internet_access

level

sport

man_made

layer Sample All

height
= Use unfiltered layer

v Operators
= < = LIKE % IM MNOT IN

<= = 1= ILIKE AND OR NOT

Provider specific Filter expression

== 100

1 b

©@Help Test Clear * cancel

6. Click OK.

Your map should now only show you those buildings which match our starting criteria and which are more than 100
square meters in size.

6.2.12 Try Yourself

Save your solution as a new layer, using the approach you learned above for doing so. The file should be saved within
the same GeoPackage database, with the name solution.
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6.2.13 In Conclusion

Using the GIS problem solving approach together with QGIS vector analysis tools, you were able to solve a problem
with multiple criteria quickly and easily.

6.2.14 What’s Next?

In the next lesson, we will look at how to calculate the shortest distance along roads from one point to another.

6.3 Lesson: Analise de Rede

Calculating the shortest distance between two points is a common GIS task. Tools for this can be found in the
Processing Toolbox.

Objectivo deste médulo: aprender a utilizar os algoritmos de Andlise de Rede.

6.3.1 Follow Along: As Ferramentas e os Dados

Pode encontrar todos os algoritmos de andlise de rede no menu Processamento » Andlise de rede. Existem vérias
ferramentas disponiveis:

Processing Toolbox BE®
a0 =2 Vo T,

Q Search.

+ (U Recently used

@ Cartography

@ Database

@ File tools

@ GPS

@ Interpolation

=

=

=

=

=

=

@ Layer tools
@ Mesh
~ @ Network analysis
. Service area (from layer)
.. Service area (from point)
.. Shortest path (layer to point)
.. Shortest path (point to layer)
.. Shortest path (point to point)
@ Plots
@ Raster analysis

=

=

=

=

C Raster creation

=

@ Raster terrain analysis

=

! Raster tools

=

@ Vector analysis

=

G Vector creation

=

@ Vector general
@ Vector geometry
@ Vector overlay

=

=

=

G Vector selection
@ Vector table

@ Vector tiles

v @ GDAL

» @ GRASS

=

=
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Open the project exercise_data/network_analysis/network.qggz. It contains two layers:
* network_points
* network_lines

The network_lines layer has already a style that helps to understand the road network.

Os algoritmos de caminho mais curto disponibilizam formas de calcular tanto o caminho mais curto, como o caminho
mais rapido, entre dois pontos da rede, dados:

* start and end points selected on the map
* um ponto de partida seleccionado no mapa e vdrios pontos de chegada seleccionados numa camada de pontos
* varios pontos de partida seleccionados numa camada de pontos e um ponto de chegada seleccionado no mapa

Maos a obra.

6.3.2 Calculo do caminho mais curto (entre pontos)
Andlise da rede » Caminho mais curto (ponto para ponto) permite-lhe calcular o percurso mais curto entre dois pontos
seleccionados manualmente no mapa.
Neste exemplo vamos calcular o caminho mais curto (e ndo mais rapido) entre dois pontos.
1. Escolha o algoritmo Caminho mais curto (ponto para ponto)
2. Em Camada vectorial representando a rede seleccione network_lines
3. Use Shortest for Path type to calculate

Use these two points as starting and ending points for the analysis:
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Starting Point

-

Ending Peint

4. Click on the ... button next to Start point (x, y) and choose the location tagged with Starting Point inthe
picture. Enable the snapping options for an accurate selection. The coordinates of the clicked point are added.

5. Do the same thing, but choosing the location tagged with Ending point for End point (x, y)

6. Clique no botdo Executar:

Shortest Path (Point to Point)

Parameters | Log Shortest path (point to
Vector layer representing network point)
/" network_lines [EPSG:32734] - @3 % || | This algorithm computes optimal

(shortest or fastest) route between
given start and end points.

ed features only
Path type to calculate
Shortest -
Start point
-337683.461296,14891793.324881 [EPSG:32734]
End point
-338394.378190,14891385.941820 [EPSG:32734]

p Advanced Parameters
Shortest path

[Create tem ry layer]

V| Open output file after running algorithm

0% Cancel

i Aide Advanced - Run as Batch Process... ~ Run | @ Fermer |

7. A new line layer is created representing the shortest path between the chosen points. Uncheck the
network_lines layer to see the result better:
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*network - QGIS 9e45223d42 [tm]

ABBER 6o B-0-a2EM:=-¢@F
“31%%% @GR Ao- B &%

8. Open the attribute table of the output layer. It contains three fields, representing the coordinates of the start
and end points and the cost.

Ao escolher para Tipo de caminho a calcular, o parametroMais curto, o campo cost ird conter a distancia
entre os dois pontos, nas unidades definidas para a camada.

Neste caso, a distancia mais curta entre os pontos escolhidos € aproximadamente 1000 metros:

Shortest path — Features Total: 1, Filtered: 1, Selected: 0

7 & LT E S O ¥ E = 8 &
start = end cost
11-337683.461296, 14891793.3249 -338394.37819, 148913859418 906,4072543701861

- Show All Features _ B

Now that you know how to use the tool, feel free to test other locations.

6.3.3 Try Yourself Caminho mais rapido

Com os mesmos dados do exercicio anterior, tente calcular o caminho mais rapido entre os dois pontos.

De quanto tempo necessita para ir do ponto de partida até ao ponto de chegada?

Answer

1. Open Network Analysis » Shortest Path (Point to Point) and fill the dialog as:
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Shortest Path (Point to Point)

Parameters | Log Shortest path (point to
Vector layer representing network pOInt)
/" network _lines [EPSG:32734] v @gj] Q% = This algorithm computes optimal

(shortest or fastest) route between
given start and end points.
Path type to calculate

Fastest =
Start point

-337683.461296,14891793.324881 [EP5G:32734]

End point

-338394.378190,14891385.941820 [EP5G:32734]

p Advanced Parameters
Shortest path

[Create temporary layer]

V| Open output file after running algorithm

0% Cancel

B Aide Advanced - Run as Batch Process... v Run | @ Fermer

2. Make sure that the Path type to calculate is Fastest.
3. Click on Run and close the dialog.

4. Open now the attribute table of the output layer. The cost field contains the travel time between the two points
(as fraction of hours):

Shortest path — Features Total: 1, Filtered: 1, Selected: 0

7 & LT E & D ¥ B = & &
start end cost

1]|-337683.461296, 14891793.3249 -338394.37819, 14891385.9418 0,018128145087403721

| Show All Features _

6.3.4 Follow Along: Opcoes avancadas
Let us explore some more options of the Network Analysis tools. In the previous exercise we calculated the fastest
route between two points. As you can imagine, the time depends on the travel speed.
We will use the same layers and starting and ending points of the previous exercises.
1. Escolha o algoritmo Caminho mais curto (ponto para ponto)

2. Preencha Camada vectorial representando a rede, Ponto de partida (x, y) e Ponto de chegada (x, y) conforme
fez anteriormente.
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3. Em Tipo de caminho a calcular escolna Mais réapido
4. Abra o menu Pardmetros avangados

5. Em Velocidade padrao (km/h), altere o valor predefinido (50) para 4
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Shortest Path (Point to Point)

Parameters | Log

Shortest path (point to

Vector layer representing network

point)

| /" network_lines [EPSG:32734]

This algerithm computes optimal

Selected featuras only

Path type to calculate

(shortest or fastest) route between
given start and end points.

| Fastest

Start point

-337683.461206,14891793.324881 [EPSG:32734] [ o |

End point

-338394.378190,14891385.041820 [EPSG:32734] | |:|

w Advanced Parameters

Direction field [optional]

Walue for forward direction [optional]

WValue for backward direction [optional]

Walue for both directions [optional]

Default direction

| Both directions

Speed field [optional]

Default speed (km/h)

4,000000 a@ |2
Topology tolerance
0,000000 | |meters  + |
Shortest path
|[C reate temporary layer] | | oo
v | Open output file after running algorithm
‘ 0% | Cancel
| i aide | | Advanced '| | Run as Batch Process... ~ Run | | & Fermer |

6. Clique em Executar

7. Uma vez executado o algoritmo, feche a caixa de didlogo e abra a tabela de atributos da camada resultante.
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The cost field contains the value according to the speed parameter you have chosen. We can convert the cost
field from hours with fractions to the more readable minutes values.

8. Open the field calculator by clicking on the

ﬁ
Pt

icon

9. Add a new field to store the path cost in minutes.

V| Create a new field

Create virtual field
Output field name |minutes

Output field type

1.2 Decimal Mumber (real)

Output field length |10 | Precision
Expression Function Editor
8 L.t
"cost" * 6@
ol | | A | M I "n'

Feature 61296, 14891793.3249 ~

Preview: 13,596108815552794

i Aide

3 =

Shortest path — Field Calculator

Update existing field

+ Date and Time
~ Fields and Values
feature
geometry
id
MNULL
abc start
abec and
1.2 cost
+ Files and Paths

group field
Double-click to add field name to expression
string.

Values | Q. Search...

All Unique 10 Samples

v 0Ok | & Annuler

That’s it! Now you know how many minutes it will take to get from one point to the other one if the whole network

speedisat 4 km/h.

6.3.5 Shortest path with speed limit

A ferramenta de processamento Andlise de rede, possui outras opcdes interessantes. Olhando para o seguinte mapa:
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gostariamos de determinar o percurso mais rapido, tendo em consideragio os limites de velocidade de cada estrada
(as etiquetas indicam os limites, em km/h). Sem considerar esses limites, o caminho mais curto seria, como € 6bvio,
o de cor purpura. Mas nessa estrada o limite de velocidade é de 20 km/h, enquanto que na estrada verde se pode
circular a 100 km/h!

Assim como fizemos no primeiro exercicio, vamos seleccionar Andlise de rede » Caminho mais curto (ponto a ponto)
e capturar os pontos de partida e chegada.

1.

Abra o algoritmo Andlise de rede » Caminho mais curto (ponto a ponto)

. Seleccione network_lines como parametro em Camada vectorial representando a rede
. Em Tipo de caminho a calcular escolha Mais rapido

2
3
4.
5
6

Select the Start point (x, y) and End point (x, y) as we did before

. Abra o menu Pardmetros avangados

. Choose the speed field as the Speed Field parameter. With this option the algorithm will take into account the

speed limits for each road.
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Shortest Path (Point to Point)

Parameters | Log

Vector layer representing network

|/ network_lines [EPSG:32734]

d featur

L
m

ect

o
b

s only

Path type to calculate

Shortest path (point to
point)

This algorithm computes optimal
(shortest or fastest) route between
given start and end points.

| Fastest

Start point

|—337683.461 2096,14891793.324881 [EPSG:32734]

End point

|—33 8394.378190,14891385.941820 [EP5G:32734]

w Advanced Parameters

Direction field [optional]

Value for forward direction [optional]

Value for backward direction [optional]

Value for both directions [optional]

Default direction

| Both directions

Speed field [optional]

|l-2 spead

Default speed (km/h)

50,000000

Topology tolerance

0,000000 2| [meters  ~ |
Shortest path
|[C reate temporary layer] | |:
v| Open output file after running algorithm
‘ 0% | Cancel
| H pide | | Advanced - | | Run as Batch Process... +" Run | | & Fermer |

7. Clique no botdo Executar

8. Turn off the network_1lines layer to better see the result

6.3. Lesson: Analise de Rede
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*network - QGIS 9e45223d42 [tm]
Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help
B8 ¢ Y pprHNPPA tUR e *E-REE TE-Pr

SNSSHS

Como pode verificar, o caminho mais rdpido ndo corresponde ao caminho mais curto.

6.3.6 Area de servico (da camada)

O algoritmo Andlise de rede » Area de servico (da camada) oferece resposta a questdo: dada uma camada de pontos,
quais sdo todas as dreas que se podem alcangar, dentro de uma determinada distancia ou de um determinado tempo
de percurso?

Nota: The Network Analysis » Service area (from point) is the same algorithm, but it allows you to manually choose
the point on the map.

Dada uma distancia de 250 metros, queremos saber, para cada ponto da camada network_points, quao longe nos é
possivel deslocar-nos através da rede.

1. Uncheck all the layers except network_points

Abra o algoritmo Andlise de rede » Area de servico (da camada)
Choose network_1ines for Vector layer representing network
Choose network_points for Vector layer with start points
Em Tipo de caminho a calcular escolha Mais curto

Enter 250 for the Travel cost parameter

T B

Click on Run and close the dialog
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vice Area (From Layer)

Parameters ‘ Log

Vector layer representing network

L=

d featur

m

eCt

o]
T

s only

Path type to calculate

/" network_lines [EPSG:32734] LN

| Shortest - |
Vector layer with start points
- netwark_points [EPSG:32734] -6 X
Selected features only
Travel cost (distance for 'Shortest’, time for ‘Fastest')
250,000000 H

p Advanced Parameters

Service area (lines) [optional]

[Create temporary layer]

v Open output file after running algerithm

Service area (boundary nodes) [optional]

Service area (from layer)

This algorithm creates a new vector with all
the edges or parts of edges of a network line
layer that can be reached within a distance
or a time, starting from features of a point
layer. The distance and the time (both
referred to as "travel cost”) must be specified
respectively in the network layer units or in
hours.

[Skip output] | |:
Open output file after running algorithm
| 0% | Cancel
| i Aide | | Advanced -~ | Run as Batch Process... ~ Run | | @ Fermer |

A camada resultante apresenta, para cada ponto, os percursos que se podem efectuar, sem exceder a distancia

maxima de 250 metros:
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0 *network - QGIS 9e45223d42 [tm]
Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help
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Porreiro, ha?

6.3.7 In Conclusion

Now you know how to use Network analysis algorithm to solve shortest and fastest path problems.

E estd pronto para fazer um pouco de andlise e estatistica espacial em camadas de dados vectoriais. Vamos 14!

6.3.8 What’s Next?

A seguir verd como executar algoritmos de estatistica espacial sobre dados vectoriais.

6.4 Lesson: Spatial Statistics

Nota: Lesson developed by Linfiniti and S Motala (Cape Peninsula University of Technology)

Spatial statistics allows you to analyze and understand what is going on in a given vector dataset. QGIS includes many
useful tools for statistical analysis.

The goal for this lesson: To know how to use QGIS” spatial statistics tools within the Processing Toolbox.
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6.4.1 Follow Along: Create a Test Dataset

We will create a random set of points, to get a dataset to work with.
To do so, you will need a polygon dataset to define the area you want to create the points in.
We will use the area covered by streets.

1. Start a new project

2. Add your roads dataset, as well as srtm_41_19 (elevation data) found in exercise_data/raster/
SRTM/.

Nota: You might find that the SRTM DEM layer has a different CRS to that of the roads layer. QGIS is
reprojecting both layers in a single CRS. For the following exercises this difference does not matter, but feel
free to reproject (as shown earlier in this module).

3. Open Processing toolbox

4. Use the Vector Geometry » Minimum bounding geometry tool to generate an area enclosing all the roads by
selecting Convex Hull as the Geometry Type:

Minimum Bounding Geometry .

4

Parameters | Log Minimum bounding
Input layer geomeltry
/" roads [EPSG:4326] v||...||®

This algorithm creates geometries which
enclose the features from an input layer.

Field (optional, set if features should be grouped by class) [optional] | Mumerous enclosing geometry types are
supported, including bounding boxes
(envelopes), oriented rectangles, circles

-

Geometry type and convex hulls.

Convex Hull - Optionally, the features can be grouped by
) a field. If set, this causes the output layer

Bounding geometry to contain one Feature per grouped value

with a minimal geometry covering just the

[Create temporary layer] ! !
features with matching values.

v| Open output file after running algorithm

| 0%

@Help Run as Batch Process... # Close

As you know, if you don’t specify the output, Processing creates temporary layers. It is up to you to save the
layers immediately or at a later stage.

Creating random points

¢ Create 100 random points in this area using the tool at Vector Creation » Random points in layer bounds, with
a minimum distance of 0. 0:

6.4. Lesson: Spatial Statistics 231



QGIS Training Manual

Random Points in Layer Bounds

[ 2 e
Parameters | Log Random

Input layer points in
= Bounding geometry [EPSG:4326] ~ || ... || 2| layer bounds

This algorithm
creates a new point

NMumber of points J
layer with a given

| 100 & ||| | number of random
. : . points, all of them
Minimum distance between points within the extent of
0,000000 *| degrees A\ | | agivenlayer. A
. distance factor can
Random points be specified, to

avoid poinkts being
too close to each

v Open output file after running algorithm other. =

[Create temporary layer]

| 0%

@Help Run as Batch Process... # Close

Nota: The yellow warning sign tells you that that parameter concerns distances. The Bounding geometry layer
is in a Geographical Coordinate System and the algorithm is just reminding you this. For this example we
won’t use this parameter so you can ignore it.

If needed, move the generated random point to the top of the legend to see them better:

*Untitled Project - QGIS x

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Progessing Help

DEBRE OPLPLAPP M Q. @ LEORZ ¥ [0 : >
f EIUL q »
Ri-B-LEE ¥ I =0 - @

Layers E&
o [l ® T IF 9=
v| ® Random points =)

v|[[] Bounding geometry (=)

— roads
- 5 erkmm A1 da

Browser @R
GRRYTO

3 Favorites

b " spatial Bookmarks
» [&] Home

[y

» @ GeoPackage

» /# Spatialite <

Q Type to locate (Ctri+k) rdil| 20.08334.046 | : 1324314 |~ @ n 100% ¥l 1 |00°

-

A

« .:"}\n\’%n‘nﬁ (A &@

||V Render & Epsi43ze @
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Sampling the data

To create a sample dataset from the raster, you’ll need to use the Raster Analysis » Sample raster values algorithm.
This tool samples the raster at the locations of the points and adds the raster values in new field(s) depending on the
number of bands in the raster.

1. Open the Sample raster values algorithm dialog

2. Select Random_points as the layer containing sampling points, and the SRTM raster as the band to get
values from. The default name of the new field is rvalue_N, where N is the number of the raster band. You
can change the name of the prefix if you want.

Sample Raster Values B

»
Parameters | Log Sample raster
Input Point Layer values
© Random points [EPSG:4326] - & This algorithm creates
a new vector layer
with the same
Raster Layer to sample attributes of the input
" srtm_41_19 [EPSG:32733] - ||...|| [laverand the raster
values corresponding
|w| Advanced parameters on the point location.
Output column prefix If the raster layer has
more than one band,
rvalue all the band values are
sampled.

sampled Points
[Create temporary layer]

v Open output file after running algorithm

| 0%

@Help Run as Batch Process... # Close

3. Press Run

Now you can check the sampled data from the raster file in the attribute table of the Sampled Points layer. They
will be in a new field with the name you have chosen.

A possible sample layer is shown here:
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The sample points are classified using the rvalue_1 field such that red points are at a higher altitude.

You will be using this sample layer for the rest of the statistical exercises.

6.4.2 Follow Along: Basic Statistics
Now get the basic statistics for this layer.

1. Click on the E Show statistical summary jo0n in the Attributes Toolbar. A new panel will pop up.
2. In the dialog that appears, specify the Sampled Points layer as the source.
3. Select the rvalue_1 field in the field combo box. This is the field you will calculate statistics for.

4. The Statistics Panel will be automatically updated with the calculated statistics:
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Statistics (&) (]
. sampled Points v |
1.2 rvalue_1 ~|| €|
* Statistic Value
',3 Count 100
BB sum 14148
9, |Mean 141.48
ﬁ: Median 122.5
Fﬁ_ st dev (pop) 89.4792
'u' St dev (sample) 89.93
@ Minimum 18
-
% Maximum 737
@ RE!I"IQE 719
w
Minority 18
+
Majorikty 120
&
Variety 78
Q1 97
Q3 163.5
IQR 66.5

Missing (null) values 0

Selected featuresonly = &2

W g

| Statistics | Layers  Browser

| Q Type to locate (Ctrl+K) |
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Nota: You can copy the values by clicking on the Copy Statisties To Clipboard 1y,tton and paste the results into
a spreadsheet.

5. Close the Statistics Panel when done
Many different statistics are available:

Count
The number of samples/values.

Sum
The values added together.

Mean
The mean (average) value is simply the sum of the values divided by the number of values.

Median
If you arrange all the values from smallest to greatest, the middle value (or the average of the two middle values,
if N is an even number) is the median of the values.

St Dev (pop)
The standard deviation. Gives an indication of how closely the values are clustered around the mean. The
smaller the standard deviation, the closer values tend to be to the mean.

Minimum
The minimum value.

Maximum
The maximum value.

Range

The difference between the minimum and maximum values.
Q1

First quartile of the data.
Q3

Third quartile of the data.

Missing (null) values
The number of missing values.

6.4.3 Follow Along: Compute statistics on distances between points

1. Create a new temporary point layer.
2. Enter edit mode, and digitize three points somewhere among the other points.
Alternatively, use the same random point generation method as before, but specify only three points.
3. Save your new layer as distance_points in the format you prefer.
To generate statistics on the distances between points in the two layers:
1. Open the Vector Analysis » Distance matrix tool.
2. Selectthe distance_points layer as the input layer, and the Sampled Points layer as the target layer.

3. Configure-o assim:
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Distance Matrix

Parameters | Log Distance matrix

T s o0 This algorithm creates a table

Distance Points [EPSG:4326] || . ||D containing a distance matrix, with
distances between all the pointsin a
points layer.

Input unigue 1D field
123 id -
Target point layer
Sampled Points [EP5G:4326] (.|| D

Target unique ID field

123 id -
Output matrix type

Summary distance matrix {mean, std. dev., min, max) -
Use only the nearest (k) target points
[2] a |;

Distance matrix

[Create temporary layer]

v Open output file after running algorithm

| 0%

&2 he un as Batc rocess... ase un
@|Help R Batch P % Cl @R

4. If you want you can save the output layer as a file or just run the algorithm and save the temporary output layer
later.

5. Click Run to generate the distance matrix layer.

6. Open the attribute table of the generated layer: values refer to the distances between the distance_points features
and their two nearest points in the Sampled Points layer:

] Distance matrix :: Features Total: 3, Filtered: 3, Selected: 0 - o x
/) 2B R BT e & s VT E &P B E e
InputiD MEAN STDDEW MIN MAX
1 1 401.87013 235.74757 166.12256 637.61770
2 2 653.19728 229.72430 423.47299 882.92158
3 0 1005.87036 296.03133 709.83903 1301.90169

T Show All Features _ = |

With these parameters, the Distance Matrix tool calculates distance statistics for each point of the input layer with
respect to the nearest points of the target layer. The fields of the output layer contain the mean, standard deviation,
minimum and maximum for the distances to the nearest neighbors of the points in the input layer.
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6.4.4 Follow Along: Nearest Neighbor Analysis (within layer)

To do a nearest neighbor analysis of a point layer:
1. Choose Vector analysis » Nearest neighbor analysis.
2. In the dialog that appears, select the Random points layer and click Run.

3. The results will appear in the Processing Result Viewer Panel.

Processing Toolbox ®
*‘t R "-.. l‘:' 3 i "':l}

Ty
Ll

» (Y Recently used =
b (2 Cartography

» () Database

b () File Fanls b
Results Viewer £

" Nearest neighbour [04:51:51]

Algorithm: Nearest neighbour =
File path: /tmp/processing MXcuYE/
Gaa2320aecdf41d4adbe6ed5440F23
be/OUTPUT HTML FILE.html -

4. Click on the blue link to open the htm1 page with the results:
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Mozilla Firefox

Jtmp/processing MXcuYE/« X
G | @ File:///tmp/processing MXcu' =+ X =

Observed mean distance: 1408.03338044153

Expected mean distance: 0.01577808561

Nearest neighbour index: 89239.81118148957

Number of points: 100

Z-Score: 1707201.00974689284

6.4.5 Follow Along: Mean Coordinates

To get the mean coordinates of a dataset:
1. Start Vector analysis » Mean coordinate(s)
2. In the dialog that appears, specify Random points as Input layer, and leave the optional choices unchanged.
3. Click Run.
Let us compare this to the central coordinate of the polygon that was used to create the random sample.
1. Start Vector geometry w Centroids
2. In the dialog that appears, select Bounding geometry as the input layer.
As you can see, the mean coordinates (pink point) and the center of the study area (in green) don’t necessarily coincide.

The centroid is the barycenter of the layer (the barycenter of a square is the center of the square) while the mean
coordinates represent the average of all node coordinates.
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*Untitled Project - QGIS 6
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Al ™
[+] 1548
M — vector_analysis roads_34S
@, -
&~
Vo~
Layers | Browser
Q Type to locate (Ctrl+K) Coordinate| 20.1914,-33.9933 |%§ Scale 1:159115 |~ | @ Magnifier 100% | Rotation |00° + |v/Render & gpsciaize @

6.4.6 Follow Along: Image Histograms
The histogram of a dataset shows the distribution of its values. The simplest way to demonstrate this in QGIS is via
the image histogram, available in the Layer Properties dialog of any image layer (raster dataset).

1. In your Layers panel, right-click on the srtm_41_19 layer

2. Select Properties

3. Choose the Histogram tab. You may need to click on the Compute Histogram button to generate the graphic.
You will see a graph that shows the frequency distribution for the raster values.
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Layer Properties - srtm_41_19 | Histogram

3 i i
£ Information Raster Histogram
¥ Source 6000 7
& symbology 5000 ]
!J'_i Transparency ]
. 4000 -
{*~ Histogram = ]
> ]
U ]
& Rendering € 3000 4
c -
1] i
@R Pyramids i .
. 2000 -
a Metadata ]
Legend 1000 -
QGIS Server 1
n _' _J_,...--—-—w-..,_“_ . _ L

0 200 400 600 800 1000 1200 1400

Pixel Value
® Band 1
& PrefsfActions. [ |
Set min/max style For Band 1 -
Min 0 EW
Max 1548 EW
©Help Style - « Apply || % Cancel  OK

=]
4. The graph can be exported as an image with the Save plot hyytton

5. You can see more detailed information about the layer in the Information tab (the mean and max values are
estimated, and may not be exact).

The mean value is 332. 8 (estimated to 324.3), and the maximum value is 1699 (estimated to 1548)! You can
zoom in the histogram. Since there are a lot of pixels with value 0, the histogram looks compressed vertically. By
zooming in to cover everything but the peak at 0, you will see more details:
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Layer Properties - srtm_41_19 | Histogram

[
=

@ information Raster Histogram

A% source .

% symbology 150 -

L Transparency 4

[l>~ Histogram i

=%

=]

[=]
|

Qﬁj Rendering

Frequency

B8 Pyramids

m Metadata

Legend

QGIS Server

200 400 600 800 1000 1200 1400

Pixel Value
® Band 1
@ prefs/Actions., H
Set min/max style for Band 1 -
Min 1 EW
Max 1548 W
©@Help Style ~ « Apply | % Cancel & OK

Nota: If the mean and maximum values are not the same as above, it can be due to the min/max value calculation.

Open the Symbology tab and expand the Min / Max Value Settings menu. Choose * @ Min /max and click on Apply.

Keep in mind that a histogram shows you the distribution of values, and not all values are necessarily visible on the
graph.
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6.4.7 Follow Along: Spatial Interpolation

Let’s say you have a collection of sample points from which you would like to extrapolate data. For example, you
might have access to the Sampled points dataset we created earlier, and would like to have some idea of what the
terrain looks like.

1. Tostart, launch the GDAL » Raster analysis » Grid (IDW with nearest neighbor searching) tool in the Processing
Toolbox.

For Point layer select Sampled points
Set Weighting power to 5. 0

In Advanced parameters, set Z value from field to rvalue_1

A

Finally click on Run and wait until the processing ends
6. Close the dialog

Here is a comparison of the original dataset (left) to the one constructed from our sample points (right). Yours may
look different due to the random nature of the location of the sample points.

As you can see, 100 sample points aren’t really enough to get a detailed impression of the terrain. It gives a very
general idea, but it can be misleading as well.

6.4.8 Try Yourself Different interpolation methods

1. Use the processes shown above to create a set of 10 000 random points

Nota: If the number of points is really big, the processing time can take a long time.

2. Use these points to sample the original DEM
3. Use the Grid (IDW with nearest neighbor searching) tool on this dataset.
4. Set Power and Smoothing to 5.0 and 2 . 0, respectively.

The results (depending on the positioning of your random points) will look more or less like this:
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This is a better representation of the terrain, due to the greater density of sample points. Remember, larger samples
give better results.

6.4.9 In Conclusion

QGIS has a number of tools for analyzing the spatial statistical properties of datasets.

6.4.10 What's Next?

Now that we have covered vector analysis, why not see what can be done with rasters? That is what we will do in the
next module!

244 Capitulo 6. Module: Analise Vetorial



CAPITULO /

Module: Rasters

Anteriormente ji usamos rasters para a digitalizagdo, mas os dados raster também podem ser utilizados diretamente.
Neste capitulo, vamos explicar como isto pode ser feito no QGIS.

7.1 Lesson: Working with Raster Data

Raster data is quite different from vector data. Vector data has discrete features with geometries constructed out of
vertices, and perhaps connected with lines and/or areas. Raster data, however, is like any image. Although it may
portray various properties of objects in the real world, these objects don’t exist as separate objects. Rather, they are
represented using pixels with different values.

During this module you are going to use raster data to supplement your existing GIS analysis.

The goal for this lesson: To learn how to work with raster data in QGIS.

7.1.1 Follow Along: Loading Raster Data
Raster data can be loaded with the same methods we used for vector data. However we suggest to use the Browser
Panel.
1. Open the Browser Panel and expand the exercise_data/raster folder.
2. Load all the data in this folder:
¢ 3320C_2010_314_RGB_LATLNG.tif
¢ 3320D_2010_315_RGB_LATLNG.tif
e 3420B_2010_328_RGB_LATLNG.tif
e 3420C_2010_327_RGB_LATLNG.tif

You should see the following map:

245



QGIS Training Manual
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There we have it - four aerial images covering our study area.

7.1.2 Follow Along: Create a Virtual Raster

Now as you can see from this, your solution layer lies across all four images. What this means is that you are going
to have to work with four rasters all the time. That’s not ideal. It would be better to have one file to work with.

Luckily, QGIS allows you to do exactly this, and without needing to actually create a new raster file. You can create
a Virtual Raster. This is also often called a Catalog, which explains its function. It’s not really a new raster. Rather,
it is a way to organize your existing rasters into one catalog: one file for easy access.

To make a catalog we will use the Processing » Toolbox.
1. Open the Build virtual raster algorithm from the GDAL w» Raster miscellaneous;
2. In the dialog that appears, click on the ... button next to the Input layers parameter and check all the layers or

use the Select All button;

3. Uncheck Place each input file into a separate band. Notice the code that is generated at the bottom of the
dialog under GDAL/OGR console call. This is the command that will be executed when you click Run. The

text updates as you change different options in the dialog.

Nota: Keep in mind that you can copy and paste the text in the 0SGeo Shell (Windows user) or
Terminal (Linux and OSX users) to run the command. You can also create a script for each GDAL
command. This is very handy when the procedure is taking a long time or when you want to schedule specific
tasks. Use the Help button to get more help on the syntax of the command.

4. Finally click on Run.

Nota: As you know from the previous modules, Processing creates temporary layers by default. To save the file,
click on the ... button under Virtual.
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Build Virtual Raster X

Parameters | Log

Input layers E

Resolution

Average

v Place each input file into a separate band
Allow projection difference

v Advanced parameters

Add alpha mask band to VRT when source raster has none

Override projection for the output file [optional]

Resampling algorithm
Nearest Neighbour -

Nodata value(s) For input bands (space separated) [optional]

Additional command-line parameters [optional]

Virtual
[Save to temporary File]
v Open output file after running algorithm

GDAL/OGR console call

gdalbuildvrt -resolution average -separate -r nearest -input_File_list /tmp/
processing_waXvap/9e7966068f424564a9ca71decadc15F9/buildvrtinputFiles.txt /
tmp/processing waXvap/219f32d6606644108251F5ad770a7945/0OUTPUT.vrt -

| 0%

@Help Run as Batch Process... % Close «/ Run

You can now remove the original four rasters from the Layers Panel and leave only the output virtual catalog raster.
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7.1.3 Transforming Raster Data

The above methods allow you to virtually merge datasets using a catalog, and to reproject them «on the fly». However,
if you are setting up data that you’ll be using for quite a while, it may be more efficient to create new rasters that are
already merged and reprojected. This improves performance while using the rasters in a map, but it may take some
time to set up initially.

Reprojecting rasters

Open Warp (reproject) from GDAL w Raster projections.

You can also reproject virtual rasters (catalogs), enable multithreaded processing, and more.

248 Capitulo 7. Module: Rasters



QGIS Training Manual

Warp (Reproject) o

Parameters Log

Input layer
" Virtual [EPSG:4326] -
Source CRS [optional]

Target CRS [optional]
Project CRS: EPSG:4326 - WGS 84 v ||
Resampling method to use

Nearest Neighbour -
Nodata value for output bands [optional]

Mot set

Output file resolution in target georeferenced units [optional]
Mokt set

P Advanced parameters
Reprojected

[Save to temporary file]
¥ Open output File after running algorithm
GDAL/OGR console call

gdalwarp -t_srs EPSG:4326 -r near -of GTiff /tmp/
processing E3t0r2/4d43521175294d8a8F7935de8c0d5¢ca3/OUTPUT.vrt /tmp/
processing_E3t0r2/cf35Ff6625870499798aa2930475ab4b1/OUTPUT.LIF

| 0%
©@Help Run as Batch Process... % Close «' Run

Merging rasters

If you need to create a new raster layer and save it to disk you can use the merge algorithm.

Nota: Depending on how many raster files you are merging and their resolution, the new raster file created can be
really big. Consider instead to create a raster catalog as described in the Create a Virtual Raster section.

1. Click on the Merge algorithm from the GDAL w Raster miscellaneous menu.

2. As we did for the Create a Virtual raster, use the ... button to choose which layers you want to merge.

7.1. Lesson: Working with Raster Data 249



QGIS Training Manual

You can also specify a Virtual raster as input, and then all of the rasters that it consists of will be processed.

3. If you know the GDAL library, you can also add your own options by opening the Advanced parameters menu.

Parameters | Log

Input layers

Grab pseudocolor table from First layer

Place each input file into a separate band
Output data type
Float32 v

P Advanced parameters
Merged

[Save to temporary file]
¥ Open output File after running algorithm
GDAL/OGR console call

gdal_merge.py -ot Float32 -of GTiff -o /tmp/

processing E3t0r2/517F150854b344bc9f4588a6e9884e32/OUTPUT.LIF --optfile
Jemp/processing E3t0r2/44e87c4b7bdf44533a9552e0d6695F3b/
mergelnputFiles.txt

| 0%
©@Help Run as Batch Process... % Close « Run

7.1.4 In Conclusion

QGIS makes it easy to include raster data into your existing projects.

7.1.5 What’s Next?

Next, we'll use raster data that isn’t aerial imagery, and see how symbolization is useful in the case of rasters as well.
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7.2 Lesson: Changing Raster Symbology

Not all raster data are aerial photos. There are many other forms of raster data, and in many of those cases, it is
essential to symbolize the them so that they becomes properly visible and useful.

The goal for this lesson: To change the symbology for a raster layer.

7.21 Try Yourself

1. Use the Browser Panel to load srtm_41_19.tif, found under exercise_data/raster/SRTM/
2. Zoom to the extent of this layer by right-clicking on it in the Layers panel and selecting Zoom to Layer.

This dataset is a Digital Elevation Model (DEM). 1t is a map of the elevation (altitude) of the terrain, allowing us to
see where the mountains and valleys are, for example.

While each pixel of the dataset of the previous section contained color information, in a DEM, each pixel contains
elevation values.

Once the DEM is loaded, you will notice that it is a grayscale representation:

QGIS has automatically applied a stretch to the pixel values of the image for visualization purposes, and we will learn
more about how this works as we continue.
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7.2.2 Follow Along: Changing Raster Layer Symbology

You have two different options to change the raster symbology:
1. Within the Layer Properties dialog, by right-clicking on the layer in the Layer tree and selecting the Properties
option. Then switch to the Symbology tab
2. By clicking on the ‘Q'/ Open the Layer Styling panel byyton right above the Layers panel (shortcut F7). This will open
the Layer Styling panel, where you can switch to the ‘Q*/ Symbology tapy

Choose the method you prefer to work with.

7.2.3 Follow Along: Singleband gray

When you load a raster file, if it is not a photo image like the ones of the previous section, the default style is set to a
grayscale gradient.

Let’s explore some of the features of this renderer.
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Layer Properties - srtm_41_19 | Symbology x

v Band Rendering

G’ Information

Render type | Singleband gray

'{_‘\‘_- Source

& symbology

Gray band Band 1 (Gray)

Color gradient | Black to white

l_g Transparency Min |0 Max 1548
= Histogram E:R;:‘a:etment Stretch to MinMax -
.}/ Rendering ¥ Min / Max Value Settings
&R Pyramids User defined
m Metadata E(I)J::]L'I:ISE?E 20 [3/-980 [7/%
Legend * Min / max
QGIS Server :gszga?rd_ deviation x 2,00
Statistics extent whole raster -
Accuracy Estimate (Faster) -
w Color Rendering
Blending mode | Mormal -  Reset
Brightness —F 0 = [Cuntrast —F 0 =
Saturation = | 0 = [Grayscale Off -
Hue Colorize Strength il

¥ Resampling

Zoomed: in | Nearest neighbour ~ | out | Nearest neighbour - | Oversampling 2,00 |3

Thumbnail Legend Palette

/oK

# Cancel

The default Color gradient is set to Black to white, meaning that low pixel values are black and while high
values are white. Try to invert this setting to White to black and see the results.

Very important is the Contrast enhancement parameter: by default it is set to St retch to MinMax meaning that
the pixel values are stretched to the minimum and maximum values.

Look at the difference with the enhancement (left) and without (right):
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But what are the minimum and maximum values that should be used for the stretch? The ones that are currently
under Min / Max Value Settings. There are many ways to calculate the minimum and maximum values and use them
for the stretch:

1. User Defined: you enter the Min and Max values manually

2. Cumulative count cut: this is useful when you have some extreme low or high values. It cuts the 2% (or the
value you choose) of these values

3. Min/ max: the Real or Estimated minimum and maximum values of the raster

4. Mean +/- standard deviation: the values will be calculated according to the mean value and the standard
deviation

7.2.4 Follow Along: Singleband pseudocolor

Grayscales are not always great styles for raster layers. Let’s try to make the DEM more colorful.

* Change the Render type to Singleband pseudocolor. If you don’t like the default colors loaded, select another
Color ramp

¢ Click the Classify button to generate a new color classification

« If it is not generated automatically click on the OK button to apply this classification to the DEM
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Layer Properties - srtm_41_19 | Symbology

o :
@ Information Render type |Singleband pseudocolor v|

bl ;
‘& Source Band |Band 1 (Gray) -

& symbology Min 0 | Max 1548 |
P Min / Max Value Settings

!g Transparency

(et Interpolation ' Linear - |
. Color ramp | [ - H
4 Rendering =
Label unit | |
B Pyramids sufFix
, value Color  Label
! Metadata
Legend
387 387
E QGIS Server
774 774
1161 1161
1548 . 1548
Mode  Continuous  ~ | Classes | |

Clip out of range values

v Color Rendering -

. @Help || style - | JApply | %cancel || JOK |

You'll see the raster looking like this:
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This is an interesting way of looking at the DEM. You will now see that the values of the raster are again properly
displayed, going from blue for the lower areas to red for the higher ones.

7.2.5 Follow Along: Changing the transparency
Sometimes changing the transparency of the whole raster layer can help you to see other layers covered by the raster
itself and better understand the study area.

To change the transparency of the whole raster switch to the Transparency tab and use the slider of the Global Opacity
to lower the opacity:
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Layer Properties - srtm_41_19 | Transparency
w Global Opacity

Information _F 55.6 % =
Source w No Data Value

Symbology

Additional no data value

i
2

<

-

*
LP’. Transparency

: w Custom Transparency Options

I_ﬂ Histogram

P Transparency band | None -
4 Rendering o

Transparent pixel list
B Pyramids From To Percent Transparent o
ah Metadata [ o
. =l
& qGis server

5]

[B|Help Style - W Apply @ cancel

More interesting is changing the transparency for some pixel values. For example in the raster we used you can see
a homogeneous color at the corners. To set these pixels as transparent, go to Custom Transparency Options in the
Transparency tab.

* By clicking on the EHE Add values mamaly button, you can add a range of values and set their transparency
percentage

. 7] - .
» For single values the [ Aad vatues trom dispay 1440 i more useful

. L7 ; . . . .
« Click on the 1 Add values from display byton. The dialog disappears, and you can interact with the map.
* Click on the homogeneous color in a corner of the DEM

* You will see that the transparency table will be filled with the clicked values:
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v Global Opacity

Layer Properties - srtm_41_19 | Transparency

1/100,0% 2/

",_f Information

:t"- Source v No Data Value

% symbology

Additional no data value |

Lr Transparency

Histogram [»| Custom Transparency Options
Rendering Transparency band |None - |
Transparent pixel list

B Pyramids P P -
From To Percent Transparent |$|
B Metadata 1/o 0 100 8]
Legend |§|
58 Qais server (=]
=]
=]

| @Help || style -|

* Click on OK to close the dialog and see the changes.

| Japply || %cancel || oK |

See? The corners are now 100% transparent.
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7.2.6 In Conclusion

These are some the basic functions to get you started with raster symbology. QGIS also gives you many other
options, such as symbolizing a layer using paletted/unique values, representing different bands with different colors
in a multispectral image, or making an automatic hillshade effect (useful only with DEM raster files).

7.2.7 Referéncia

The SRTM dataset was obtained from http://srtm.csi.cgiar.org/

7.2.8 What’s Next?

Now that we can see our data displayed properly, let’s investigate how we can analyze it further.

7.3 Lesson: Terrain Analysis

Certain types of rasters allow you to gain more insight into the terrain that they represent. Digital Elevation Models
(DEMs) are particularly useful in this regard. In this lesson you will use terrain analysis tools to find out more about
the study area for the proposed residential development from earlier.

The goal for this lesson: To use terrain analysis tools to derive more information about the terrain.

7.3.1 Follow Along: Calculating a Hillshade
We are going to use the same DEM layer as in the previous lesson. If you are starting this chapter from scratch, use
the Browser panel and load the raster/SRTM/srtm_41_19.tif.

The DEM layer shows you the elevation of the terrain, but it can sometimes seem a little abstract. It contains all the
3D information about the terrain that you need, but it doesn’t look like a 3D object. To get a better impression of the
terrain, it is possible to calculate a hillshade, which is a raster that maps the terrain using light and shadow to create
a 3D-looking image.

We are going to use algorithms in the Raster » Raster terrain analysis menu.
1. Click on the Hillshade menu

2. The algorithm allows you to specify the position of the light source: Azimuth has values from 0 (North) through
90 (East), 180 (South) and 270 (West), while the Vertical angle sets how high the light source is (0 to 90
degrees).

3. We will use the following values:
e Zfactorat1.0
* Azimuth (horizontal angle) at 300 .0°

e Vertical angle at 40 .0°
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vertical

300g

angle

4. Save the file in a new folder exercise_data/raster_analysis/ with the name hillshade
5. Finally click on Run

You will now have a new layer called hillshade that looks like this:
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-
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% f ,lg’%, fﬂ%}?;
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That looks nice and 3D, but can we improve on this? On its own, the hillshade looks like a plaster cast. Can’t we use
it together with our other, more colorful rasters somehow? Of course we can, by using the hillshade as an overlay.

7.3.2 Follow Along: Using a Hillshade as an Overlay
A hillshade can provide very useful information about the sunlight at a given time of day. But it can also be used for
aesthetic purposes, to make the map look better. The key to this is setting the hillshade to being mostly transparent.

1. Change the symbology of the original srem_41_19 layer to use the Pseudocolor scheme as in the previous
exercise

Hide all the layers except the srtm_41_19 and hillshade layers
Click and drag the srtm_41_19 to be beneath the hillshade layer in the Layers panel

Set the hillshade layer to be transparent by clicking on the Transparency tab in the layer properties

A

Set the Global opacity to 50%.

You'll get a result like this:

6. Switch the hillshade layer off and back on in the Layers panel to see the difference it makes.

Using a hillshade in this way, it’s possible to enhance the topography of the landscape. If the effect doesn’t seem
strong enough to you, you can change the transparency of the hillshade layer; but of course, the brighter the hillshade
becomes, the dimmer the colors behind it will be. You will need to find a balance that works for you.

Remember to save the project when you are done.
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7.3.3 Follow Along: Finding the best areas

Think back to the estate agent problem, which we last addressed in the Vector Analysis lesson. Let us imagine that
the buyers now wish to purchase a building and build a smaller cottage on the property. In the Southern Hemisphere,
we know that an ideal plot for development needs to have areas on it that:

¢ are north-facing
 with a slope of less than 5 degrees
 But if the slope is less than 2 degrees, then the aspect doesn’t matter.

Let’s find the best areas for them.

7.3.4 Follow Along: Calculating the Slope
Slope informs about how steep the terrain is. If, for example, you want to build houses on the land there, then you
need land that is relatively flat.
To calculate the slope, you need to use the Slope algorithm of the Processing » Raster terrain analysis.
1. Open the algorithm
2. Choose srtm_41_19 as the Elevation layer
3. Keep the Z factor at 1. 0
4. Save the output as a file with the name s lope in the same folder as the hillshade
5. Clique em Executar

Now you'll see the slope of the terrain, each pixel holding the corresponding slope value. Black pixels show flat terrain
and white pixels, steep terrain:
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7.3.5 Try Yourself Calculating the aspect
Aspect is the compass direction that the slope of the terrain faces. An aspect of O means that the slope is North-facing,
90 East-facing, 180 South-facing, and 270 West-facing.

Since this study is taking place in the Southern Hemisphere, properties should ideally be built on a north-facing slope
so that they can remain in the sunlight.

Use the Aspect algorithm of the Processing » Raster terrain analysis to get the aspect layer saved along with the
slope.

Answer

Set your Aspect dialog up like this:
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(&) Aspect >

Parameters | Log Aspect

Elevation layer
g This algorithm calculates the aspect of the Digital

0" orim_41_19 [EPSG:32733] - .. Terrain Model in input. The final aspect raster layer
contains values from O to 360 that express the
Z factar slope direction: starting from Morth (0% and
continuing dockwise.
1.000000 =
Aspect
QGIS-Training-Data/exerdse_data fraster_analysis/aspect. tif
v | Open output file after running algorithm
0% Cancel
Run as Batch Process... Run | Close Help

Your result:

£ 5 eh

. 3=
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7.3.6 Follow Along: Finding the north-facing aspect
Now, you have rasters showing you the slope as well as the aspect, but you have no way of knowing where ideal
conditions are satisfied at once. How could this analysis be done?
The answer lies with the Raster calculator.
QGIS has different raster calculators available:
* Raster » Raster Calculator
* In processing:
— Raster Analysis » Raster calculator
— GDAL » Raster miscellaneous » Raster calculator
— SAGA » Raster calculus » Raster calculator

Each tool is leading to the same results, but the syntax may be slightly different and the availability of operators may
vary.
We will use Raster Analysis » Raster calculator in the Processing Toolbox

1. Open the tool by double clicking on it.

e The upper left part of the dialog lists all the loaded raster layers as name @N, where name is the name
of the layer and N is the band.

* In the upper right part you will see a lot of different operators. Stop for a moment to think that a raster
is an image. You should see it as a 2D matrix filled with numbers.

2. North is at O (zero) degrees, so for the terrain to face north, its aspect needs to be greater than 270 degrees or
less than 90 degrees. Therefore the formula is:

[aspect@l <= 90 OR aspect@l >= 270 }

3. Now you have to set up the raster details, like the cell size, extent and CRS. This can be done manually or it
can be automatically set by choosing a Reference layer. Choose this last option by clicking on the ...
button next to the Reference layer(s) parameter.

4. In the dialog, choose the aspect layer, because we want to obtain a layer with the same resolution.
5. Save the layer as aspect_north.

The dialog should look like:
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() Raster Calculator o

Parameters | Log Raster calculator

Expression
This algorithm allows performing algebraic operations using
ter | 1
I_ay\ers Operatnrs raster layers.

The resulting layer will have its values computed according to
aspect@1 | + | = || s | sin || log10 | AND | an expression, The expression can contain numerical values,
hillshade@1 operators and references to any of the layers in the current
slope@1 | = | / || acos | asin || In | OR | praject. The following functions are also supported:
srtm_41_19@1 .

‘ ~ | | sart | | tan | | atan | | ( | | ) ‘ -sin{), cos(), tan(), atan2{), In{), log10(
‘ < | | > | | - | | = | | <= | | = ‘ The extent, cell size, and output CRS can be defined by the
user, If the extent is not specified, the minimum extent that
‘ b | | N | | | covers selected reference layer(s) will be used. If the cell size
abs min max is not specified, the minimum cell size of selected reference
layer(s) will be used. If the output CRS is not specified, the
Expression CRS of the first reference layer will be used,

The cell size is assumed to be the same in both X and ¥ axes.
aspect@] <= 90 OR aspect@1 »= 270

Layers are referred by their name as displayed in the laver list

and the number of the band to use (based on 1), using the

pattern layer_name@band number', For instance, the first
band from a layer named DEM will be referred as DEM@1.

Expression is valid WWhen using the calculator in the batch interface or from the

console, the files to use have to be spedified. The
Predefined expressions corresponding layers are referred using the base name of the
file (without the full path). For instance, if using a layer at
path/tofmy/rasterfile. tif, the first band of that layer will be
referred as rasterfile. if@1.

|ND\|"[ = | | Add... || save.

Reference layer(s) (used for automated extent, cellsize, and CRS) [optional]

| linputs selected | |:|

Cell size (use 0 or empty to set it automatically) [optional]

| 0.000000 a [z
Output extent [optional]

|Not set

Qutput CRS [optional]
Output
|D: fdev fgithub/QGIS-Training-Data/exercise_data/raster_analysis/aspect_north, tif

v | Open output file after running algorithm

| 0% | Cancel

|Run as Batch Process... Run J | Close | Help |

6. Finally click on Run.

Your result will be this:
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The output values are 0 or 1. What does it mean? For each pixel in the raster, the formula we wrote returns whether
it matches the conditions or not. Therefore the final result will be False (0) and True (1).

7.3.7 Try Yourself More criteria

Now that you have done the aspect, create two new layers from the DEM.
* The first shall identify areas where the slope is less than or equal to 2 degrees
¢ The second is similar, but the slope should be less than or equal to 5 degrees.

e Save them under exercise_data/raster_analysis as slope_lte2.tif and slope_lte5.
tif.

Answer
¢ Set your Raster calculator dialog up with:
* the following expression: slope@l <= 2

* the slope layer as the Reference layer(s)
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() Raster Calculator e
S ]

Parameters Log Raster calculator

Expression

This algorithm allows performing algebraic operations using
raster layers.

Layers Operators
The resulting layer will have its values computed according to
aspect@1 | + | = || s | sin || log10 | AND | an expression, The expression can contain numerical values,
aspect_north@1 operators and references to any of the layers in the current
hillshade@1 | - | / || acos | asin || n | OR | project. The following functions are also supported:
slope@1 .
srtm_41_19@1 | e | sqrt || tan | atan | ( | ) | sin(), cos(), tan(), atan2(), In{), log10(
‘ < | | > | | - | | = | | <= | | = ‘ The extent, cell size, and output CRS can be defined by the
user, If the extent is not specified, the minimum extent that
‘ b | | N | | | covers selected reference layer(s) will be used. If the cell size
abs min max is not specified, the minimum cell size of selected reference
layer(s) will be used. If the output CRS is not specified, the
Exxpression CRS of the first reference layer will be used,
The cell size is assumed to be the same in both X and ¥ axes.
“slope@1” <=2
Layers are referred by their name as displayed in the laver list
and the number of the band to use (based on 1), using the
pattern layer_name@band number', For instance, the first
band from a layer named DEM will be referred as DEM@1.
Expression is valid When using the calculator in the batch interface or from the
console, the files to use have to be spedified. The
Predefined expressions corresponding layers are referred using the base name of the
= file (without the full path). For instance, if using a layer at
path/tofmy/rasterfile. tif, the first band of that layer will be
MNDVI v || add || save referred as rasterfile, if@1.

Reference layer(s) (used for automated extent, cellsize, and CRS) [optional]

| linputs selected | |:|

Cell size {use 0 or empty to set it automatically) [optional]

| 0.000000 a [z
Output extent [optional]
|Not set | |_,|

Output CRS [optional]

| - |®
Qutput

|D:fdEvfg\ﬂ']ubIQGIS—Training-DaiBj'exerdse_damfraster_analysisjslupe_ltez.ﬁf & || ,l

v | Open output file after running algorithm

| 0% | Cancel

| Run s Batch Process.. Run J | Close | Help |

* For the 5 degree version, replace the 2 in the expression and file name with 5.
Your results:

¢ 2 degrees:
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* 5 degrees:
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7.3.8 Follow Along: Combining Raster Analysis Results

Now you have generated three raster layers from the DEM:
* aspect_north: terrain facing north
* slope_lte2: slope equal to or below 2 degrees
* slope_lte5: slope equal to or below 5 degrees

Where the condition is met, the pixel value is 1. Elsewhere, it is 0. Therefore, if you multiply these rasters, the pixels
that have a value of 1 for all of them will get a value of 1 (the rest will get 0).

The conditions to be met are:
* at or below 5 degrees of slope, the terrain must face north
* at or below 2 degrees of slope, the direction that the terrain faces does not matter.

Therefore, you need to find areas where the slope is at or below five degrees AND the terrain is facing north, OR the
slope is at or below 2 degrees. Such terrain would be suitable for development.

To calculate the areas that satisfy these criteria:
1. Open the Raster calculator again

2. Use this expression in Expression:
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[( aspect_north@l = 1 AND slope_lte5@l1 = 1 ) OR slope_lte2@l = 1 ]

3. Set the Reference layer(s) parameter to aspect_north (it does not matter if you choose another - they have
all been calculated from srtm_41_19)

4. Save the output under exercise_data/raster_analysis/asall_conditions.tif

5. Click Run

O resultado:

Dica: The previous steps could have been simplified using the following command:

[((aspect@l <= 90 OR aspect@l >= 270) AND slope@l <= 5) OR slope@l <= 2 }
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7.3.9 Follow Along: Simplifying the Raster

As

you can see from the image above, the combined analysis has left us with many, very small areas where the

conditions are met (in white). But these aren’t really useful for our analysis, since they are too small to build anything
on. Let us get rid of all these tiny unusable areas.

1. Open the Sieve tool (GDAL » Raster Analysis in the Processing Toolbox)

2. Set the Input file to all_conditions, and the Sieved to all_conditions_sieve.tif (under
exercise_data/raster_analysis/).

3. Set the Threshold to 8 (minimum eight contiguous pixels), and check Use 8-connectedness.

Sieve
Parameters | Log
Input layer =
2" all_condition [EPSG:32733] -
Threshold
8

Ll

¥ Use B-connectedness

Do not use the default validity mask for the input band
Validity mask [optional]

Sieved
fhome/matteo/exercise_data/exercise_data/raster_analysis/all_conditions_sieve.tif

v | Open output file after running algorithm

GDAL/OGR console call

0%

|&|Help Run as Batch Process... # Close #Run

Once processing is done, the new layer will be loaded.
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What is going on? The answer lies in the new raster file’s metadata.

4. View the metadata under the Information tab of the Layer Properties dialog. Look the
STATISTICS_MINIMUM value:

Layer Properties - all_conditions_sieve | Information

Information from provider
@ Information
Mame  all_conditions_sieve

3 Path 1ome/matieo/exercis: ita e xercise italfraster analysis
\& Source R
CRS EPSG:32733 - WGS 84 / UTM zone 335 - Projected
Extent 9469491.2754000000422520,61%60%9.34080000035486476 ¢
1038119.773099999991 2454 62502946 9956000000238419

%" symbology

l,_g Transparency Unit meters
Width 837
B Histogram Height 661
Datatype Float32 - Thirty two bit floating point
"/ Rendering GDAL Driver Description  GTiff
GDAL Driver Metadata GedTIFF
‘ Pyramids Dataset Description  /home/mattec/exercise_data/exercise_data/raster_analysis/
all_conditions_sieve.tif
m [REELEE] Compression
Band 1 * STATISTICS_APPROXIMATE=YES
" * STATISTICS_MAXIMUM=1
Legend * STATISTICS MEAN=-266696562.2513
e NSNS =-2147483648
QGIS Server * STATISTICS_STDDEWV=708237202.43956
More information * AREA_OR_POINT=Area

Dimensions  X: 837 ¥: 661 Bands: 1
Origin  269491.6.2503e+6
Pixel Size 8§1.9934.-81.9934

ldentification 3

[E|Help Style - o Apply @ cancel
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This raster, like the one it is derived from, should only feature the values 1 and 0, but it has also a very large
negative number. Investigation of the data shows that this number acts as a null value. Since we are only after
areas that weren'’t filtered out, let us set these null values to zero.

5. Open the Raster Calculator, and build this expression:

L(all_conditions_sieve@l <= 0) =0 }

This will maintain all non-negative values, and set the negative numbers to zero, leaving all the areas with value
1 intact.

6. Save the output under exercise_data/raster_analysis/ as all_conditions_simple.
tif.

Your output looks like this:

This is what was expected: a simplified version of the earlier results. Remember that if the results you get from a tool
aren’t what you expected, viewing the metadata (and vector attributes, if applicable) can prove essential to solving
the problem.

7.3.10 Follow Along: Reclassifying the Raster
We have used the Raster calculator to do calculations on raster layers. There is another powerful tool that we can use
to extract information from existing layers.

Back to the aspect layer. We know now that it has numerical values within a range from O through 360. What we
want to do is to reclassify this layer to other discrete values (from 1 to 4), depending on the aspect:

¢ 1 = North (from 0 to 45 and from 315 to 360);
e 2 = East (from 45 to 135)
¢ 3 = South (from 135 to 225)
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e 4 = West (from 225 to 315)
This operation can be achieved with the raster calculator, but the formula would become very very large.
The alternative tool is the Reclassify by table tool in Raster analysis in the Processing Toolbox.
1. Open the tool
2. Choose aspect as the Input raster layer

3. Click on the ... of Reclassification table. A table-like dialog will pop up, where you can choose the minimum,
maximum and new values for each class.

4. Click on the Add row button and add 5 rows. Fill in each row as the following picture and click OK:

Minimum  Maximum Value | o OK |
10 45 1 * Cancel
2/315 360 1 Add Row
3 45 135 2

Remove Row(s)
4135 225 3

The method used by the algorithm to treat the threshold values of each class is defined by the Range boundaries.

Remove All

5. Save the layer as reclassified.tif inthe exercise_data/raster_analysis/ folder
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Reclassify by Table .

b

Parameters | Log Recla 55":}'
Raster layer hy table
=" Aspect [EPSG:32733] - This algorithm
Band number reclassifies a
g raster band by
Band 1 (Gray) - assigning new

class values
based on the
ranges specified
in a fixed table.

Reclassification table

v Advanced parameters

Output no data value

-9999 000000 -
Range boundaries
min < value <= max -

Use no data when no range matches value
Output data type
Float32 -

Reclassified raster

rcise_data/raster_analysis/reclassified.sdat

v Open output File after running algorithm

| 0%

@Help Run as Batch Process... ¥ Close

6. Clique em Executar

If you compare the native aspect layer with the reclassified one, there are not big differences. But by looking at the
legend, you can see that the values go from 1 to 4.

Let us give this layer a better style.
1. Open the Layer Styling panel
2. Choose Paletted/Unique values, instead of Singleband gray
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3. Click on the Classify button to automatically fetch the values and assign them random colors:

Layer Styling & X
| B reclassified - |
o 8= Paletted/Unique values - 3
Band 'Band 1 (Gray) - |
Color ramp | Random colors |;|
Value Color Label _
1 . 1
2 2
3 . 3
4 4
| Classify o || =] Delete All ] o]

Layer Rendering

Blending mode 'Normal - |

|E| |E| v Live update | ' Apply |

| Layer Styling | Processing Toolbox

The output should look like this (you can have different colors given that they have been randomly generated):
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With this reclassification and the paletted style applied to the layer, you can immediately differentiate the aspect areas.

7.3.11 Follow Along: Querying the raster
Unlike vector layers, raster layers don’t have an attribute table. Each pixel contains one or more numerical values
(singleband or multiband rasters).
All the raster layers we used in this exercise consist of just one band. Depending on the layer, pixel values may
represent elevation, aspect or slope values.
How can we query the raster layer to get the value of a pixel? We can use the q% Identify Features pyyton

1. Select the tool from the Attributes toolbar.

2. Click on a random location of the srtm_41_19 layer. Identify Results will appear with the value of the band at
the clicked location:
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Identify Results E]ES)
W g G Biv

Feature Value

* 0 srtrm 41 19
srtm 41 19
Band 1 592
b (Derived)

Mode Current layer -

View Tree - Help

3. You can change the output of the Identify Results panel from the current tree mode to a table one by
selecting Table in the View menu at the bottom of the panel:

Identify Results e
Layer FID Attribute Value

1/srtm_41 19 1 Band 1 592

View Table ~ Help

Clicking each pixel to get the value of the raster could become annoying after a while. We can use the Value Tool
plugin to solve this problem.

1. Va a Plugins » Manage/Install Plugins...
2. In the All tab, type value t in the search box

3. Select the Value Tool plugin, press Install Plugin and then Close the dialog.
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Plugins | All (539) .
& All A value t &«

| )
F ] Installed

e Value Tool qk

bl Qgis plugin to display in table or plot values from raster layers

Y% Install from ZIP (or mesh layers, from version 3.0.5) at the current mouse
' position
.ﬁ SEEEGE Qgis plugin to display in table or plot values from raster layers (or mesh layers, from

version 3.0.5) at the current mouse position
If this plugin is useful for you, please consider to make a donation of any value to the
Maintainer

WIWWWW 84 rating vote(s), 136917 downloads

Tags raster, mesh
More info homepage bug tracker code repository
Author Jorge Almerio (maintainer)

Available version 3.06

Install Plugin
@Help % Close

The new Value Tool panel will appear.

Dica: If you close the panel you can reopen it by enabling it in the View » Panels » Value Tool or by clicking
on the icon in the toolbar.

4. To use the plugin just check the Enable checkbox and be sure that the srtm_41_19 layer is active (checked)
in the Layers panel.

5. Move the cursor over the map to see the value of the pixels.

Layers @@
o [l ® T &, -BF & L

HEEEEEEN

== srtm 41 19

Browser Layers
Value Tool [E5]
v| Enable

Table | Graph = Options

Decimals |2 |%

Layer Value
1/srtm_41.19  76.0

Coordinate: (997960.378142, 6216696.900344)
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6. But there is more. The Value Tool plugin allows you to query all the active raster layers in the Layers panel.
Set the aspect and slope layers active again and hover the mouse on the map:

Layers [E]ES]
N 2 3= gt
b v B slope

b |V ¥ aspect

b s

b -

3 :.'

3 :.'

3 -

2 -

bV B srtm_41_19

Browser Layers
Value Tool B®E
v Enable

Table | Graph = Options

Decimals |2 |3

Layer Value
1|slope 56.08386993...
2|aspect 173.8803253...

3/stm 41 19 328.0

Coordinate: (1001434.695838, 6227891.924031)

7.3.12 In Conclusion

You've seen how to derive all kinds of analysis products from a DEM. These include hillshade, slope and aspect
calculations. You've also seen how to use the raster calculator to further analyze and combine these results. Finally
you learned how to reclassify a layer and how to query the results.

7.3.13 What's Next?

Now you have two analyses: the vector analysis which shows you the potentially suitable plots, and the raster analysis
that shows you the potentially suitable terrain. How can these be combined to arrive at a final result for this problem?
That’s the topic for the next lesson, starting in the next module.
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CAPITULO 8

Module: Completar a Analise

Tem agora duas partes de uma andlise: uma parte vetorial e outra matricial. Neste médulo, vai ver como combind-las.
Vai concluir a andlise e apresentar os resultados finais.

8.1 Conversao Matricial para Vetor ILSI

A conversdo entre formatos matriciais e vetoriais permite fazer uso dos dados de ambos, quando se resolve um
problema SIG, bem como utilizar os virios métodos de andlise, tnicos a estes dois formatos de dados geograficos.
Isto aumenta a flexibilidade que se tem considerando fontes de dados e métodos de processamento para resolver um
problema SIG.

Para combinar uma andlise matricial e vetorial, precisa de converter um tipo de dados para o outro. Vamos converter
o resultado matricial, da licdo anterior, para um vetor.

O objetivo para esta licdo: Obter o resultado matricial num vetorial que pode ser utilizado para completar a anélise.

8.1.1 Follow Along: A Ferramenta Raster para Vector
Abra o mapa do dltimo médulo, raster_analysis.ggs. Ai deve estar o ficheiro
all_conditions_simple.tif calculado no exercicio anterior.

* Clique em Raster » Conversdo » Vetorizar (Raster to Vector). A caixa de didlogo aparecera.

 Configure-o assim:
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Polygonize (Raster to Vector) X

Parameters | Log
Input layer
# all_conditions_simple [EPSG:32733] -
Band number
Band 1 (Gray) -
Name of the field to create
suitable
Use 8-connectedness

v Advanced parameters

Additional command-line parameters [optional]

Vectorized
ease_3.10/exercise_data/residential_development/all_terrain.shp
v! Open output file after running algorithm

GDAL/OGR console call

gdal_polygonize.py /home/hari/Desktop/QGIS-Training-Data-
release_3.10/exercise_data/raster_analysis/all_conditions_simple.tif
/home/hari/Desktop/QGIS-Training-Data-release_3.10/
exercise_data/residential_development/all_terrain.shp -b 1 -f "ESRI

Shapefile" all terrain suitable -
0%
[ElHelp Run as Batch Process... # Close #Run

* Change the field name (describing the values of the raster) to suitable.
 Save the layer under exercise_data/residential_development asall_terrain.shp.

Now you have a vector file which contains all the values of the raster, but the only areas you’re interested in are those
that are suitable; i.e., those polygons where the value of suitable is 1. You can change the style of this layer if you
want to have a clearer visualization of it.

8.1.2 Try Yourself

Recorra ao médulo sobre andlise vetorial.
¢ Create a new vector file that contains only the polygons where suitable has the value of 1.

e Save the new file under exercise_data/residential_development/ as
suitable_terrain.shp.

Answer

1. Open the Query Builder by right-clicking on the all_terrain layer in the Layers panel, and selecting the Properties
» Source tab.

2. Then build the query "suitable" = 1.

3. Click OK to filter out all the polygons where this condition isn’t met. When viewed over the original raster, the
areas should overlap perfectly:
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Polygonize (Raster to Vector) X

Parameters | Log
Input layer
# all_conditions_simple [EPSG:32733] -
Band number
Band 1 (Gray) -
Name of the field to create
suitable
Use 8-connectedness

v Advanced parameters

Additional command-line parameters [optional]

Vectorized
ease_3.10/exercise_data/residential_development/all_terrain.shp
v! Open output file after running algorithm

GDAL/OGR console call

gdal_polygonize.py /home/hari/Desktop/QGIS-Training-Data- =
release_3.10/exercise_data/raster_analysis/all_conditions_simple.tif
/home/hari/Desktop/QGIS-Training-Data-release_3.10/
exercise_data/residential_development/all_terrain.shp -b 1 -f "ESRI

Shapefile" all terrain suitable -
| 0%
[ElHelp Run as Batch Process... # Close #Run

4. You can save this layer by right-clicking on the all_terrain layer in the Layers panel and choosing Save As...,
then continue as per the instructions.

8.1.3 Follow Along: A ferramenta Vector para Raster
Although unnecessary for our current problem, it’s useful to know about the opposite conversion from the one
performed above. Convert to raster the suitable_terrain.shyp vector file you just created in previous step.

* Clique em Raster » Conversdo » Rasterizar (Vector para Raster) para iniciar esta ferramenta, depois configure-
a como indicado na seguinte captura de ecra:
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Rasterize (Vector to Raster) x

Parameters | Log
Input layer
all_terrain [EPSG:32733] || .- |[|®

Field to use for a burn-in value [optional]

123 SUITABLE -
A fixed value to burn [optional]
0.000000 -

Output raster size units
Pixels -

Width/Horizontal resolution

837.000000 =
Height/Vertical resolution
616.000000 -

Output extent (xmin, xmax, ymin, ymax)
54,1037709.8059691756,6196099.3408,6250051.015321028 [EPSG:32733]
Assign a specified nodata value to output bands [optional]

0.000000 =

v Advanced parameters

Additional creation options [optional]

Profile | Default -
Name Value
0%
& Help Run as Batch Process... # Close #Run

* Input layer is all_terrain.

* Field name is suitable.

 Qutput raster size units is Pixels.

» Width and Height are 837 and 661, respectively.
* Get the Output extent from the all_terrain layer.

¢ Set output file Rasterized to exercise_data/residential_development/
raster_conversion.tif.

Nota: O tamanho da imagem de saida € definido aqui para ser igual ao da imagem original que foi vetorizada. Para
ver as dimensdes de uma imagem, abra os seus metadados (no separador Metadados em :guilabel:" Propriedades da
camada).

* Clique em OK na caixa de didlogo para iniciar o processo de conversao.

* Quando estiver completo, avalie o seu sucesso comparando o novo dado matricial com o original. Eles devem
corresponder, exatamente, pixel por pixel.
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8.1.4 In Conclusion

Converter entre formatos matriciais e vetoriais permite ampliar a aplicabilidade dos dados e ndo precisa levar a
degradacgdo dos dados.

8.1.5 What’s Next?

Agora que temos os resultados da andlise do relevo disponiveis em formato vetorial, podem ser utilizados para resolver
o problema de quais os edificios que devem ser considerados para o desenvolvimento residencial.

8.2 Lesson: Combining the Analyses

Using the vectorized results of the raster analysis will allow you to select only those buildings on suitable terrain.

The goal for this lesson: To use the vectorized terrain results to select suitable plots.

8.2.1 Try Yourself

1.
2.

Save your current map (raster_analysis.qgs).

Open the map which you created during the vector analysis earlier (you should have saved the file as
analysis.qggs).

In the Layers panel, enable these layers:
e hillshade,
e solution (or buildings_over_100)

In addition to these layers, which should already be loaded in the map from when you worked on it before, also
add the suitable_terrain.shp dataset.

If you are missing some layers, you should find them in exercise_data/
residential_development/

Use the Intersection tool (Vector » Geoprocessing Tools) to create a new vector layer called new_solution.
shp which contains only those buildings which intersect the suitable_terrain layer.

You should now have a layer showing certain buildings as your solution, for example:
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8.2.2 Try Yourself Inspecting the Results

Look at each of the buildings in your new_solution layer. Compare them with the suitable_terrain layer by changing
the symbology for the new_solution layer so that it has outlines only. What do you notice about some of the buildings?
Are they all suitable just because they intersect with the suitable_terrain layer? Why or why not? Which ones would
you deem to be unsuitable?

Answer

You may notice that some of the buildings in your new_solution layer have been «sliced» by the Intersection
tool. This shows that only part of the building - and therefore only part of the property - lies on suitable terrain. We
can therefore sensibly eliminate those buildings from our dataset.

8.2.3 Try Yourself Refining the Analysis

You can see from the results that some buildings which were included were not really suitable, so we can now refine
the analysis.

‘We want to ensure that our analysis returns only those buildings which fall entirely within the suitable_terrain layer.
How would you achieve this? Use one or more Vector Analysis tools and remember that our buildings are all over
100m squared in size.

Answer

At the moment, your analysis should look something like this:
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Consider a circular area, continuous for 100 meters in all directions.

If it is greater than 100 meters in radius, then subtracting 100 meters from its size (from all directions) will result in
a part of it being left in the middle.
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Therefore, you can run an interior buffer of 100 meters on your existing suitable_terrain vector layer. In the output
of the buffer function, whatever remains of the original layer will represent areas where there is suitable terrain for
100 meters beyond.

To demonstrate:
1. Go to Vector » Geoprocessing Tools » Buffer(s) to open the Buffer(s) dialog.
2. Configure-o assim:
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8.0.8 Buffer(s)

Input vector layer

[ suitable_terrain_345

'

Segments to approximate

(=) Buffer distance
() Buffer distance field
suitable

[EI Dissolve buffer results

Output shapefile

[Ef.ﬂ.dd result to canvas

| | Use only selected features

10

-100

suitable_terrain_continuous_100m.shp |

Browse

| Close | [

OK

3. Use the suitable_terrain layer with 10 segments and a buffer distance of —100. (The distance is automatically
in meters because your map is using a projected CRS.)

4. Save the output in exercise_data/residential_development/

suitable_terrain_continuous100m. shp.

5. If necessary, move the new layer above your original suitable_terrain layer.

Your results will look like something like this:

as
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QGIS - analysis
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Scale (17,037 |+ & (/Render EPSG:32734 @) y

6. Now use the Select by Location tool (Vector » Research Tools » Select by location).
7. Set up like this:

0 6 Select by location

e TR Ry P S A e PR Ny e mm

Select features in:

4k

[ new_solution

that intersect features in:

4 W
—

[ suitable_terrain_continuous_100m

|| Use selected features only

Modify current selection by:

4k

[ creating new selection

™ Add result to canvas

[ | [ Close ] H

8. Select features in new_solution that intersect features in suitable_terrain_continuous100m.shp.

This is the result:
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4

The yellow buildings are selected.  Although some of the buildings fall partly outside the new
suitable_terrain_continuous100m layer, they lie well within the original suitable_terrain layer and therefore
meet all of our requirements.

9. Save the selection under exercise_data/residential_development/ as final_answer.
shp.

8.2.4 In Conclusion

You have now answered the original research question, and can offer an opinion (with reasons, backed by analysis)
for a recommendation regarding which property to develop.

8.2.5 What’s Next?

Next you will present these results as part of your second assignment.

8.3 Tarefa

Using the print layout, make a new map representing the results of your analysis. Include these layers:
¢ places (with labels),
e hillshade,
e solution (or new_solution),
* roads and
e either aerial_photos or DEM.

Write a short explanatory text to accompany it. Include in this text the criteria that were used in considering a house for
purchase and subsequent development, as well as explaining your recommendations for which buildings are suitable.
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8.4 Lesson: Supplementary Exercise

In this lesson, you will be guided through a complete GIS analysis in QGIS.

Nota: Lesson developed by Linfiniti Consulting (South Africa) and Siddique Motala (Cape Peninsula University of
Technology)

8.4.1 Problem Statement

You are tasked with finding areas in and around the Cape Peninsula that are suitable habitats for a rare fynbos plant
species. The extent of your area of investigation covers Cape Town and the Cape Peninsula between Melkbosstrand
in the north and Strand in the south. Botanists have provided you with the following preferences exhibited by the
species in question:

« It grows on east facing slopes

* It grows on slopes with a gradient between 15% and 60%

* It grows in areas that have a total annual rainfall of > 1000 mm

* It will only be found at least 250 m away from any human settlement

+ The area of vegetation in which it occurs should be at least 6000 m? in area

As a student at the University, you have agreed to search for the plant in four different suitable areas of land. You
want those four suitable areas to be the ones that are closest to the University of Cape Town where you live. Use your
GIS skills to determine where you should go to look.

8.4.2 Solution Outline

The data for this exercise can be found in the exercise_data/more_analysis folder.

You are going to find the four suitable areas that are closest to the University of Cape Town.

The solution will involve:
1. Analyzing a DEM raster layer to find the east facing slopes and the slopes with the correct gradients
2. Analyzing a rainfall raster layer to find the areas with the correct amount of rainfall

3. Analyzing a zoning vector layer to find areas that are away from human settlement and are of the correct size

8.4.3 Follow Along: Setting up the Map

1. Click on the & Current CRS hytton in the lower right corner of the screen. Under the CRS tab of the dialog that
appears, use the «Filter» tool to search for «33S». Select the entry WGS 84 / UTM zone 33S (with EPSG code
32733).

2. Click OK
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(2} Project Properties — CRS X
Q | Project Coordinate Reference System [CRS)
\g__ General Mo CRS {or unknown/non-Earth projection)
. Fiter | . 33s
a EETEE Recently Used Coordinate Reference Systems
View Settings Coordinate Reference System Authority 1D
WGS 84 / UTM zone 335 EP5G:32733
‘53 Transformations
"” Styles
q 3
E Data Sources Predefined Coordinate Reference Systems Hide deprecated CRSs
g b Relations Coordinate Reference System Authority 1D =
Schwarzeck / UTM zone 335 EP5G:29333
= WGS 72 / UTM zone 335 EPSG:32333
WGS 72BE / UTM zone 335 EP5G:32533

UTM zone 335 EP5G:32733

1 L3

{;‘-(9 Macros

WGS 84 | UTM zone 32§ = : f’{: = + ?"::“'_;_'_
= ] 2 %)
Properties 2 !
a' Temporal {
- * Units: meters {.L
. * Dynamic (relies on a datum which is not plate- s
‘ Terrain fixed) S, =
-— L o 1 - al b i -
| CK Cancel Apply Help

Figura8.1: Setting up the CRS

=] .
3. Save the project file by clicking on the Save Project toolbar button, or use the Project » Save As... menu item.

Save it in a new directory called Rasterprac, that you should create somewhere on your computer. You will
save whatever layers you create in this directory as well. Save the project as your_name_fynbos.ggs.

8.4.4 Loading Data into the Map

In order to process the data, you will need to load the necessary layers (street names, zones, rainfall, DEM, districts)
into the map canvas.

For vectors...

1. Click on the ‘! Open Data Source Manager tytton in the Data Source Manager Toolbar, and enable the Y& Vector

tab in the dialog that appears, or use the Layer » Add Layer » v; Add Vector Layer... menu item

. Ensure that -® File is selected

. Click on the ... button to browse for vector dataset(s)

. In the dialog that appears, open the exercise_data/more_analysis/Streets directory
. Select the file Street_Names_UTM33S. shp

. Click Open.

The dialog closes and shows the original dialog, with the file path specified in the text field next to Vector
dataset(s). This allows you to ensure that the correct file is selected. It is also possible to enter the file path in
this field manually, should you wish to do so.

AN LK B W
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10.
11.
12.

Click Add. The vector layer will be loaded into your map. Its color is automatically assigned. You will change
it later.

. Rename the layer to Streets

1. Right-click on it in the Layers panel (by default, the pane along the left-hand side of the screen)
2. Click Rename in the dialog that appears and rename it, pressing the Ent er key when done

Repeat the vector adding process, but this time select the Generalised_Zoning_Dissolve_UTM33S.
shp file in the Zoning directory.

Rename it to Zoning.
Load also the vector layer admin_boundaries/Western_Cape_UTM33S. shp into your map.

Rename itto Districts.

For rasters...

Click on the ‘! Open Data Source Manager bytton and enable the FC! Raster tab in the dialog that appears, or use

the Layer » Add Layer » FCI Add Raster Layer... menu item

Ensure that -® File is selected
Navigate to the appropriate file, select it, and click Open

Do this for each of the following two raster files, DEM/SRTM.tif and rainfall/reprojected/
rainfall.tif

Rename the SRTM raster to DEM and the rainfall raster to Rainfall (with an initial capital)

8.4.5 Changing the layer order

Click and drag layers up and down in the Layers panel to change the order they appear in on the map so that you can
see as many of the layers as possible.

Now that all the data is loaded and properly visible, the analysis can begin. It is best if the clipping operation is done
first. This is so that no processing power is wasted on computing values in areas that are not going to be used anyway.

8.4.6 Find the Correct Districts

Due to the aforementioned area of investigation, we need to limit our districts to the following ones:

Bellville

Cape

Goodwood

Kuils River
Mitchells Plain
Simon Town

Wynberg

. Right-click on the Districts layer in the Layers panel.

In the menu that appears, select the Filter... menu item. The Query Builder dialog appears.

You will now build a query to select only the candidate districts:
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1. In the Fields list, double-click on the NAME_ 2 field to make it appear in the SOL where clause text field
below

2. Click the IN button to append it to the SQL query
3. Open the brackets
4. Click the All button below the (currently empty) Values list.
After a short delay, this will populate the Values list with the values of the selected field (NAME_ 2).
. Double-click the value Be1l1lville in the Values list to append it to the SQL query.
. Add a comma and double-click to add Cape district

. Repeat the previous step for the remaining districts

[c <IN BN Y

. Close the brackets

Figura8.2: Query builder
The final query should be (the order of the districts in the brackets does not matter):

"NAME_2" in ('Bellville', 'Cape', 'Goodwood', 'Kuils River',

'"Mitchells Plain', 'Simon Town', 'Wynberg')

Nota: You can also use the OR operator; the query would look like this:

"NAME_2" = 'Bellville' OR "NAME_2" = 'Cape' OR

"NAME_2" = 'Goodwood' OR "NAME_2" = 'Kuils River' OR
"NAME_2" = 'Mitchells Plain' OR "NAME_2" = 'Simon Town' OR
"NAME_2" = 'Wynberg'

1. Click OK twice.

The districts shown in your map are now limited to those in the list above.

8.4.7 Clip the Rasters

Now that you have an area of interest, you can clip the rasters to this area.

1.

Open the clipping dialog by selecting the menu item Raster » Extraction » Clip Raster by Mask Layer...

2. In the Input layer dropdown list, select the DEM layer
3.
4

In the Mask layer dropdown list, select the Districts layer

. Scroll down and specify an output location in the Clipped (mask) text field by clicking the ... button and choosing

Save to File...
1. Navigate to the Rasterprac directory
2. Enter a file name - DEM_clipped.tif

3. Save

. Make sure that . Open output file after running algorithm is checked
. Click Run

After the clipping operation has completed, leave the Clip Raster by Mask Layer dialog open, to be able to
reuse the clipping area

. Select the Rainfall raster layer in the Input layer dropdown list and save your output as

Rainfall_clipped.tif

8.4.
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8. Do not change any other options. Leave everything the same and click Run.
9. After the second clipping operation has completed, you may close the Clip Raster by Mask Layer dialog

10. Save the map
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Figura8.3: Map view with filtered vector, clipped raster and reordered layers

Align the rasters

For our analysis we need the rasters to have the same CRS and they have to be aligned.
First we change the resolution of our rainfall data to 30 meters (pixel size):

1. Inthe Layers panel, ensure that Rainfall_clipped is the active layer (i.e., it is highlighted by having been
clicked on)

Click on the Raster » Projections » Warp (Reproject)... menu item to open the Warp (Reproject) dialog
Under Resampling method to use, select Bilinear (2x2 kernel) from the drop down menu

Set Output file resolution in target georeferenced units to 30

wooA »N

Scroll down to Reprojected and save the output in your rainfall/reprojected directory as
Rainfall30.tif.

6. Make sure that . Open output file after running algorithm is checked

Figura8.4: Wrap (Reproject) Rainfall_clipped

Then we align the DEM:
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8.

In the Layers panel, ensure that DEM_ c1ipped is the active layer (i.e., it is highlighted by having been clicked
on)

Click on the Raster » Projections » Warp (Reproject)... menu item to open the Warp (Reproject) dialog
Under Target CRS, select Project CRS: EPSG:32733 - WGS 84 / UTM zone 33S from the drop down menu
Under Resampling method to use, select Bilinear (2x2 kernel) from the drop down menu

Set Output file resolution in target georeferenced units to 30

Scroll down to Georeferenced extents of output file to be created. Use the button to the right of the text box to
select Calculate from Layer » Rainfall30.

Scroll down to Reprojected and save the output in your DEM/ reprojected directory as DEM30 . tif.

Make sure that i Open output file after running algorithm is checked

In order to properly see what’s going on, the symbology for the layers needs to be changed.

8.4.8 Changing the symbology of vector layers

1.

N o AR

In the Layers panel, right-click on the Streets layer

Select Properties from the menu that appears

Switch to the Symbology tab in the dialog that appears

Click on the Line entry in the top widget

Select a symbol in the list below or set a new one (color, transparency, ...)

Click OK to close the Layer Properties dialog. This will change the rendering of the Streets layer.

Follow a similar process for the Zoning layer and choose an appropriate color for it

8.4.9 Changing the symbology of raster layers

Raster layer symbology is somewhat different.

1.

[c BN e Y

Open the Properties dialog for the Rainfall30 raster layer

. Switch to the Symbology tab. You'll notice that this dialog is very different from the version used for vector
layers.

. Expand Min/Max Value Settings

. Ensure that the button Mean +/- standard deviation is selected

. Make sure that the value in the associated box is 2. 00

. For Contrast enhancement, make sure it says Stretch to MinMax

. For Color gradient, change it to White to Black

. Click OK

Figura8.5: Raster symbology

The Rainfall30 raster, if visible, should change colors, allowing you to see different brightness values for
each pixel

. Repeat this process for the DEM30 layer, but set the standard deviations used for stretching to 4. 00

8.4.

Lesson: Supplementary Exercise 299



QGIS Training Manual

8.4.10 Clean up the map

1. Remove the original Rainfall and DEM layers, as well as Rainfall_clipped and DEM_clipped
from the Layers panel:

¢ Right-click on these layers and select Remove.

Nota: This will not remove the data from your storage device, it will merely take it out of your map.

2. Save the map

3. You can now hide the vector layers by unchecking the box next to them in the Layers panel. This will make
the map render faster and will save you some time.

8.4.11 Create the hillshade

In order to create the hillshade, you will need to use an algorithm that was written for this purpose.
1. In the Layers panel, ensure that DEM30 is the active layer (i.e., it is highlighted by having been clicked on)
2. Click on the Raster » Analysis » Hillshade... menu item to open the Hillshade dialog

3. Scroll down to Hillshade and save the output in your Rasterprac directory as hillshade.tif

4. Make sure that g Open output file after running algorithm is checked
5. Click Run

6. Wait for it to finish processing.

Figura8.6: Raster analysis Hillshade

The new hillshade layer has appeared in the Layers panel.
1. Right-click on the hillshade layer in the Layers panel and bring up the Properties dialog
2. Click on the Transparency tab and set the Global Opacity slider to 20%
3. Click OK
4

. Note the effect when the transparent hillshade is superimposed over the clipped DEM. You may have to change
the order of your layers, or click off the Rainfall30 layer in order to see the effect.

8.4.12 Declives (angulos)

1. Click on the Raster » Analysis » Slope... menu item to open the Slope algorithm dialog

2. Select DEM30 as Input layer

3. Check g Slope expressed as percent instead of degrees. Slope can be expressed in different units (percent or
degrees). Our criteria suggest that the plant of interest grows on slopes with a gradient between 15% and 60%.
So we need to make sure our slope data is expressed as a percent.

4. Specify an appropriate file name and location for your output.

5. Make sure that i Open output file after running algorithm is checked
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6. Click Run

Figura8.7: Raster analysis Slope

The slope image has been calculated and added to the map. As usual, it is rendered in grayscale. Change the
symbology to a more colorful one:

1. Open the layer Properties dialog (as usual, via the right-click menu of the layer)
. Click on the Symbology tab
. Where it says Singleband gray (in the Render type dropdown menu), change it to Singleband pseudocolor

2
3
4. Choose Mean +/- standard deviation x for Min / Max Value Settings with a value of 2. 0
5. Select a suitable Color ramp

6

. Click Run

8.4.13 Try Yourself Aspect

Use the same approach as for calculating the slope, choosing Aspect... in the Raster » Analysis menu.

Remember to save the project periodically.

8.4.14 Reclassifying rasters

1. Choose Raster » Raster calculator...

2. Specify your Rasterprac directory as the location for the Output layer (click on the ... button), and save it
as slopel5_60.tif

3. Ensure that the Open output file after running algorithm box is selected.

In the Raster bands list on the left, you will see all the raster layers in your Layers panel. If your Slope layer is
called slope, it will be listed as s1ope@1. Indicating band 1 of the slope raster.

4. The slope needs to be between 15 and 60 degrees.

Using the list items and buttons in the interface, build the following expression:

[(slope@l > 15) AND (slope@l < 60) J

5. Set the Output layer field to an appropriate location and file name.
6. Click Run.

Figura8.8: Raster calculator Slope

Now find the correct aspect (east-facing: between 45 and 135 degrees) using the same approach.

1. Build the following expression:

[(aspect@l > 45) AND (aspect@l < 135) }

You will know it worked when all of the east-facing slopes are white in the resulting raster (it’s almost as if they are
being lit by the morning sunlight).

Find the correct rainfall (greater than 1000 mm) the same way. Use the following expression:
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[RainfallBO@i > 1000

Now that you have all three criteria each in separate rasters, you need to combine them to see which areas satisfy all
the criteria. To do so, the rasters will be multiplied with each other. When this happens, all overlapping pixels with
a value of 1 will retain the value of 1 (i.e. the location meets the criteria), but if a pixel in any of the three rasters
has the value of 0 (i.e. the location does not meet the criteria), then it will be O in the result. In this way, the result
will contain only the overlapping areas that meet all of the appropriate criteria.

8.4.15 Combining rasters

1. Open the Raster Calculator (Raster » Raster Calculator...)

2. Build the following expression (with the appropriate names for your layers):

[[aspect45_135} * [slopel5_60] * [rainfall_1000]

3. Set the output location to the Rasterprac directory

4. Name the output raster aspect_slope_rainfall.tif

5. Ensure that . Open output file after running algorithm is checked
6. Click Run
The new raster now properly displays the areas where all three criteria are satisfied.

Save the project.

¥

Figura8.9: Map view where all three criteria are satisfied

The next criterion that needs to be satisfied is that the area must be 250 m away from urban areas. We will satisfy
this requirement by ensuring that the areas we compute are inside rural areas, and are 250 m or more from the edge
of the area. Hence, we need to find all rural areas first.

8.4.16 Finding rural areas

1. Hide all layers in the Layers panel
2. Unhide the Zoning vector layer

3. Right-click on it and bring up the Aftribute Table dialog. Note the many different ways that the land is zoned
here. We want to isolate the rural areas. Close the Attribute table.

4. Right-click on the Zoning layer and select Filter... to bring up the Query Builder dialog
5. Build the following query:

["Gen_Zoning" = 'Rural'

See the earlier instructions if you get stuck.

6. Click OK to close the Query Builder dialog. The query should return one feature.

Query builder Zoning

You should see the rural polygons from the Zoning layer. You will need to save these.
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In the right-click menu for Zoning, select Export » Save Features As....

2. Save your layer under the Rasterprac directory
3.

4. Click OK

5.

Name the output file rural. shp

Save the project

Now you need to exclude the areas that are within 250m from the edge of the rural areas. Do this by creating a
negative buffer, as explained below.

8.4.17 Creating a negative buffer

1.
2.

® N s

Click the menu item Vector » Geoprocessing Tools » Buffer...

In the dialog that appears, select the rural layer as your input vector layer (Selected features only should not
be checked)

Set Distance to —250. The negative value means that the buffer will be an internal buffer. Make sure that the
units are meters in the dropdown menu.

Check Cif Dissolve result

In Buffered, place the output file in the Rasterprac directory, and name it rural_buffer.shp
Click Save

Click Run and wait for the processing to complete

Close the Buffer dialog.

Make sure that your buffer worked correctly by noting how the rural_buffer layer is different from the
rural layer. You may need to change the drawing order in order to observe the difference.

Remove the rural layer

Save the project
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Figura8.10: Map view with rural buffer

Now you need to combine your rural_buffer vector layer with the aspect_slope_rainfall raster. To
combine them, we will need to change the data format of one of the layers. In this case, you will vectorize the raster,
since vector layers are more convenient when we want to calculate areas.

8.4.18 Vectorizing the raster

1. Click on the menu item Raster » Conversion » Polygonize (Raster to Vector)...
Select the aspect_slope_rainfall raster as Input layer

Set Name of the field to create to suitable (the default field name is DN - Digital number data)

Ll

Save the output. Under Vectorized, select Save file as. Set the location to Rasterprac and name the file
aspect_slope_rainfall_ all.shp.

Ensure that i Open output file after running algorithm is checked
6. Click Run

e

7. Close the dialog when processing is complete
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Figura8.11: Raster to Vector

All areas of the raster have been vectorized, so you need to select only the areas that have a value of 1 in the

suitable field. (Digital Number.
1. Open the Query Builder dialog (right-click - Filter...) for the new vector layer
2. Build this query:

["suitable" =1

3. Click OK

4. After you are sure the query is complete (and only the areas that meet all three criteria, i.e. with a value of
1 are visible), create a new vector file from the results, using the Export » Save Features As... in the layer’s

right-click menu

. Save the file in the Rasterprac directory

5

6. Name the file aspect_slope_rainfall_1.shp

7. Remove the aspect_slope_rainfall_all layer from your map
8

. Save your project

When we use an algorithm to vectorize a raster, sometimes the algorithm yields what is called «Invalid geometries»,
i.e. there are empty polygons, or polygons with mistakes in them, that will be difficult to analyze in the future. So,

we need to use the «Fix Geometry» tool.
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8.4.19 Fixing geometry

5.
6.

Now

. In the Processing Toolbox, search for «Fix geometries», and Execute... it

For the Input layer, select aspect_slope_rainfall_ 1

Under Fixed geometries, select Save file as, and save the output to Rasterprac and name the file
fixed_aspect_slope_rainfall.shp.

Ensure that . Open output file after running algorithm is checked
Click Run
Close the dialog when processing is complete

that you have vectorized the raster, and fixed the resulting geometry, you can combine the aspect,

slope, and rainfall criteria with the distance from human settlement criteria by finding the intersection of the
fixed_aspect_slope_rainfall layer and the rural_buffer layer.

8.4.20 Determining the Intersection of vectors

9.

® Nk w N

Click the menu item Vector » Geoprocessing Tools w Intersection...

In the dialog that appears, select the rural_buf fer layer as Input layer

For the Overlay layer, select the fixed_aspect_slope_rainfall layer

In Intersection, place the output file in the Rasterprac directory

Name the output file rural_aspect_slope_rainfall.shp

Click Save

Click Run and wait for the processing to complete

Close the Intersection dialog.

Make sure that your intersection worked correctly by noting that only the overlapping areas remain.

Save the project

The next criteria on the list is that the area must be greater than 6000 m?2. You will now calculate the polygon areas
in order to identify the areas that are the appropriate size for this project.

8.4.21 Calculating the area for each polygon

. Open the new vector layer’s right-click menu

Select Open attribute table
Click the # Tosgleediting by¢t0n in the top left corner of the table, or press Ctr1+e

Click the Open field caleulaior by tton in the toolbar along the top of the table, or press Ct r1+1i

In the dialog that appears, make sure that o Create new field is checked, and set the Output field name to
area The output field type should be a decimal number (real). Set Precision to 1 (one decimal).

In the Expression area, type:

[$area

)

This means that the field calculator will calculate the area of each polygon in the vector layer and will then
populate a new integer column (called area) with the computed value.
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Figura8.12: Field Calculator

7. Click OK

8. Do the same thing for another new field called id. In Field calculator expression, type:

(ria

This ensures that each polygon has a unique ID for identification purposes.

9. Click # Toegleediting 509in and save your edits if prompted to do so
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Figura8.13: Attribute table with area and id columns

8.4.22 Selecting areas of a given size

Now that the areas are known:

1. Build a query (as usual) to select only the polygons that are larger than 6000 m?2. The query is:

["area" > 6000

2. Save the selection in the Rasterprac directory as a new vector layer called suitable_areas.shp.

You now have the suitable areas that meet all of the habitat criteria for the rare fynbos plant, from which you will
pick the four areas that are nearest to the University of Cape Town.

8.4.23 Digitize the University of Cape Town

1. Create a new vector layer in the Rasterprac directory as before, but this time, use Point as Geometry type
and name it university.shp
Ensure that it is in the correct CRS (Project CRS:EPSG:32733 — WGS 84 / UTM zone 335)
Finish creating the new layer (click OK)
Hide all layers except the new university layer and the St reets layer.

Add a background map (OSM):

A

1. Go to the Browser panel and navigate to XYZ Tiles » OpenStreetMap
2. Drag and drop the OpenStreetMap entry to the bottom of the Layers panel

Using your internet browser, look up the location of the University of Cape Town. Given Cape Town’s unique
topography, the university is in a very recognizable location. Before you return to QGIS, take note of where
the university is located, and what is nearby.
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6. Ensure that the St reet s layer clicked on, and that the university layer is highlighted in the Layers panel
7. Navigate to the View » Toolbars menu item and ensure that Digitizing is selected. You should then see a toolbar
icon with a pencil on it (¥ - Toggle editing) Thyis is the Toggle Editing button.

8. Click the Toggle editing button to enter edit mode. This allows you to edit a vector layer

oo o .
9. Click the ® £ Add PointFeature byytton  which should be nearby the # Tosgle editing byron

10. With the Add feature tool activated, left-click on your best estimate of the location of the University of Cape
Town

11. Supply an arbitrary integer when asked for the 1d
12. Click OK

13. Click the [_13 Save Layer Bdits 1y ttop
14. Click the Toggle editing button to stop your editing session

15. Save the project

8.4.24 Find the locations that are closest to the University of Cape Town
1. Go to the Processing Toolbox, locate the Join Attributes by Nearest algorithm (Vector general » Join Attributes
by Nearest) and execute it
2. Input layer should be university, and Input layer 2 suitable_areas
3. Set an appropriate output location and name (Joined layer)

4. Set the Maximum nearest neighbors to 4

5. Ensure that . Open output file after running algorithm is checked
6. Leave the rest of the parameters with their default values
7. Click Run

The resulting point layer will contain four features - they will all have the location of the university and its attributes,
and in addition, the attributes of the nearby suitable areas (including the id), and the distance to that location.

1. Open the attribute table of the result of the join

2. Note the id of the four nearest suitable areas, and then close the attribute table

3. Open the attribute table of the suitable_areas layer

4. Build a query to select the four suitable areas closest to the university (selecting them using the id field)
This is the final answer to the research question.

For your submission, create a fully labeled layout that includes the semi-transparent hillshade layer over an appealing
raster of your choice (such as the DEM or the slope raster, for example). Also include the university and the
suitable_areas layer, with the four suitable areas that are closest to the university highlighted. Follow all
the best practices for cartography in creating your output map.
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cAPiTULO 9

Module: Moédulos

Os médulos permitem aumentar as funcionalidade do QGIS. Neste capitulo, iremos ver como activar e usar 0s
modulos.

9.1 Lesson: Installing and Managing Plugins

To begin using plugins, you need to know how to download, install and activate them. To do this, you will learn how
to use the Plugin Installer and Plugin Manager.

The goal for this lesson: To understand and use QGIS” plugin system.
9.1.1 Follow Along: Managing Plugins

1. To open the Plugin Manager, click on the menu item Plugins » Manage and Install Plugins.

2. In the dialog that opens, find the Processing plugin:
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() Plugins | All (1081)

% Al
™
F -: Installed

.

Not installed

*‘ New

o

Install from ZIP

# Settings

4. Click Close.

1 processing

@ maps2WinBUGS -
& Mascaret

= Maxent Model

@ Merge Selected Features (Pro
2 MOJXML Loader

& MOPST

@ MOS-Adeupa-CE

o Metworks

2 NTw2 Datum Transformations

g OrfecToolbox provider

= ORS Tools

@ PAT - Precision Agriculture Tc
. PCRaster Tools

@ Pelias Geocoding

# PostGIS geoprocessing tools
@ Potential Slope Failure for pro
% Processing

@ Processing R Provider

% Processing 5aga MextGen Prc _

This is a core plugin, so you can't uninstall it
Processing

Spatial data processing framework for QGIS

Spatial data processing framework for QGIS

Category
More info
Author

Installed version

Upgrade All

L

Analysis

homepage bug tracker code repository
Victor Olaya

2.12.99

Uninstall Plugin Reinstall Plugin

Close Help

Click in the box next to this plugin and uncheck it to deactivate it.

Looking at the menu, you will notice that the Processing menu is is now gone. This means that many of the

processing functions you have been using before have disappeared! For example look at the Vector » and
Raster » menus. This is because they are part of the Processing plugin, which needs to be activated to use

them.

9.1.2 Follow Along: Installing New Plugins

Open the Plugin Manager again and reactivate the Processing plugin by clicking in the checkbox next to it.

Close the dialog. The Processing menu and functions should be available again.

The list of plugins that you can activate and deactivate draws from the plugins that you currently have installed. To
install new plugins:

1. Select the Not Installed option in the Plugin Manager dialog. The plugins available for you to install will be
listed here. This list will vary depending on your existing system setup.
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= Danish Address Tools

@ Degree to DMS table converty
. Disconnected Islands

@ Dissolve Adjacent Polygons
= DMS to degree table converte
- dzetsaka : Classification tool
@ Easy Processing Tool

@ Equi Processing ~ || Upgrade al Uninstall Plugin Reinstall Plugin

Cloze Help

2. Find information about the plugin by selecting it in the list

@ Plugins | Not installed {1069) ES

= CZML Billboard Maker -

= D3 Data Visualzation Data Plotly ]’;

= DA
i Mot installed # Danish Address Tools D3 Plots for QGIS
Data Plothy

2 Install from ZIP # Data-Driven Input Mask Draw D3 plots in QGIS

& DataFxplorer: Data Analysis a X
* Settings # Datafordeler W W 95 rating vote(s), 189842 downloads

(o ]
E ] Instalied

# Dataforsyningen

# DataGrandEst Tags vector, python, d3, plots, graphs,
* DataSud datavis, dataplotly, dataviz

Date/T Terol -
* Uate/Time loals More info homepage bug tracker code

& Datos Espaciales de Referenc repository

& DaumAP

& DB Style Manager . i )

= DBGI Available version (stable) 4.0.2 updated at uto jun 27
09:25:41 2023

Author Matteo Ghetta (Faunalia)

# DDG Street Images

# Deactivate Active Labels

= debugvs 1 L]
# Deepness: Deep Neural Reme _ Upgrade A tnstall Fiugin

Case Help

3. Install the one(s) you are interested in by clicking the Install Plugin button below the plugin information panel.

Nota: if the plugin has some error it will be listed in the Invalid tab. You can then contact the plugin owner to fix
the problem.
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9.1.3 Follow Along: Configuring Additional Plugin Repositories

The plugins that are available to you for installation depend on which plugin repositories you are configured to use.

QGIS plugins are stored online in repositories. By default, only the official repository is active, meaning that you can
only access plugins that are published there. Given the diversity of available tools, this repository should meet most
of your needs.

It is possible, however, to try out more plugins than the default ones. First, you want to configure additional
repositories. To do this:

1. Open the Settings tab in the Plugin Manager dialog

() Plugins | Settings X
Check for Updates on Startup -

— If this function is enabled, QGIS will inform you whenever a plugin update is available. Otherwise, fetching
F ': Installed repositories will be performed during opening of the Flugin Manager window.

w VvV Show also Experimental Plugins

-

Not installed

Experimental plugins are generally unsuitable for production use. These plugins are in early stages of
Install from ZIP development, and should be considered 'incomplete’ or 'proof of concept’ tools. QGIS does not recommend installing these
plugins unless you intend to use them for testing purposes.

- Show also Deprecated Plugins

Deprecated plugins are generally unsuitable for production use. These plugins are unmaintained, and should be
considered 'obsolete’ tools. QGIS does not recommend installing these plugins unless you still need it and there are no other
alternatives available.

Plugin Repositories

Status Mame URL
@ connected OGIS sluzbeni repozitorij dodataka https://plugins.qgis.org/plugins/plugins.cmi?ggis=3.32

</ Reload Repository | oadd. | Edit. . Delete | [+

Close Help

2. Click Add to find and add a new repository.

3. Provide a Name and URL for the new repository you want to configure and make sure the Enabled checkbox
is selected.
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Repository details

Name Faunalia

URL https:/fwww.faunalia.eu/ggis/plugins.xml

Parameters

Authentication Clear | Edit
Enabled v

o conce

4. You will now see the new plugin repo listed in the list of configured Plugin Repositories

Plugins | Settings

e Al Check for updates on startup

ry
E ] Installed

7% Not installed

& Invalid w v/ Show also experimental plugins
%% Install from ZIP Note: Experimental plugins are generally unsuitable for production use. These plugins are in early stages of development,

and should be considered 'incomplete’ or 'proof of concept’ tools. QGIS does not recommend installing these plugins unless
you intend to use them for testing purposes.

v Show also deprecated plugins

Plugin repositories

Status Name URL

@ connected Faunalia https:ffwww.faunalia.eu/qgis/plugins.xml?qgis=3.2
[©] connected QGIS Official Plugin Repository https://plugins.qgis.org/plugins/plugins.xmi?qgis=3.2

Reload all repesitories Add... Delete

Help * Close

5. You can also select the option to display Experimental Plugins by selecting the Show also experimental plugins
checkbox.

6. If you now switch back to the Not Installed tab, you will see that additional plugins are available for installation.

7. To install a plugin, click on it in the list and then on the Install plugin button.
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9.1.4 In Conclusion

Installing plugins in QGIS should be straightforward and effective!

9.1.5 What’s Next?

Next we’ll introduce you to some useful plugins as examples.

9.2 Lesson: Useful QGIS Plugins

Now that you can install, enable and disable plugins, let’s see how this can help you in practice by looking at some
examples of useful plugins.

The goal for this lesson: To familiarize yourself with the plugin interface and get acquainted with some useful
plugins.

9.2.1 Follow Along: The QuickMapServices Plugin

The QuickMapServices plugin is a simple and easy to use plugin that adds base maps to your QGIS project. It has
many different options and settings. Let’s start to explore some of its features.

1. Start a new map and add the roads layer from the t raining_data Geopackage.
2. Install the QuickMapServices plugin.

3. Click on Web » QuickMapServices. The first menu lists different map providers (OSM, NASA) with available
maps.

4. Click on an entry and you would load the base map into your project.

Project Edit View Layer Settings Plugins Vector Raster Database Web M 9 Hel
DEBRRY O=2LAI PR AL LOOR i) %* I =
AQV. A RED

Layers EE]
« il T 3 ey

v roads
~ ¥ ¥ OSM standard AN

Nice! But one of the main strengths of QMS is to provide access to many data providers. Let’s add them.
1. Click on Web » QuickMapServices » Settings
2. Go to the More services tab.

3. Read carefully the message of this tab and if you agree click on the Get Contributed pack button.
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4. Click Save.

5. Reopen the Web » QuickMapServices menu you will see that more providers are available.

W= Mesh Processing Help

MetaSearch

» QuickMapServices

M AutoNavi 4

I> Bing b

& esrr B

@@ GeoQ -

& Google 4

@ nasA 8
¢ CartoDB »
« BasemapAT »

-4 Stamen b

g usas g

& waze v
9 Yandex »

» O5M 3

€} search QMs

€} Add to Search

€3 set proper scale

@ settings

€ About QMS

6. Choose the one that best fits your needs, and load the data in the project!
It is also possible to search trough the now available data providers

1. Open the plugin’s search tab by clicking on Web » QuickMapServices » Search QMS. This option of the plugin
allows you to filter the available base maps by the current extent of the map canvas or using a search word.

2. Click on the Filter by extent and you should see one service available. If no service is found, zoom out and pan
around the world (or your location) or search with a keyword.

3. Click on the Add button next to a returned dataset to load it.

4. The base map will be loaded and you will have a background for the map.
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Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Progessing Help

DeERERY O 2LPPRRA GaLOOR &5 %* z &= -
B@QVAwED < Qe 2
Layers a® Search QMS B®
« @e T 2 land a

V| — roads
¥ OsM standard
~ v ¥ GLAD LANDSAT MOSAIC:

Filter by extent| | All -

GLAD Forest Change Landsat 2017

=

i)
.
>
z
&

WMs details, report a problem

o GLAD FOREST LOSS 2000-2021
U o | Add
TMS details, report a problem
> GLAD FOREST YEAR LOSS 2000-2021
R * | Add

TMS details, report a problem

‘GLAD LANDSAT MOSAIC 2018
TMS details, report a problem

-

5
.
:
:
5

GLAD LANDSAT MOSAIC 2019

o
.
8 115 i, report a problem Add
) GLAD LANDSAT MOSAIC 2021
o | add

TMS details, report a problem

GLAD Tree Canopy Height 2020

,,

5
.
:
:
5

WMS details, report a problem

GLAD Water Ice Mask
WMs details, report a problem

=

it
.
>
z
&

Layers | Browser Download geodatz for your project

Q Type to locate (Ctri+K Coortinate | 31,788 19814 | & scate[1:1277934 |+ | @ Wogniter| 100%  [2] Rotation [00° 5|Vl Rencer  @epscams @

9.2.2 Follow Along: The QuickOSM Plugin

With an incredible simple interface, the QuickOSM plugin allows you to download OpenStreetMap data.

1.
2.

Start a new empty project and add the roads layer from the t raining_data GeoPackage.

Install the QuickOSM plugin. The plugin adds two new buttons in the QGIS Toolbar and is accessible in the
Vector » QuickOSM menu.

Open the QuickOSM dialog. The plugin has many different tabs: we will use the Quick Query one.

You can download specific features by selecting a generic Key or be more specific and choose a specific Key
and Value pair.

Dica: if you are not familiar with the Key and Value system, click on the Help with key/value button. It will
open a web page with a complete description of this concept of OpenStreetMap.

Look for railway in the Key menu and let the Value be empty: so we are downloading all the railway features
without specifying any values.

Select Layer Extent in the next drop-down menu and choose roads.

Click on the Run query button.

uy ke e ol

e et i = | [ by bt Features
4 0 ke the bey Ty’ 0 B s o b e s goes 1 be sovmkded,

I S sy T W sy

b tenod
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After some seconds the plugin will download all the features tagged in OpenStreetMap as railway and load them
directly into the map.

Nothing more! All the layers are loaded in the legend and are shown in the map canvas.

Aviso: QuickOSM creates temporary layer when downloading the data. If you want to save them permanently,

click on the [::] icon next to the layer and choose the options you prefer. Alternatively you can open the
Advanced menu in QuickOSM and choose where to save the data in the Directory menu.

9.2.3 Follow Along: The QuickOSM Query engine

The quickest way to download data from QuickOSM plugin is using the Quick query tab and set some small
parameters. But if you need some more specific data?

If you are an OpenStreetMap query master you can use QuickOSM plugin also with your personal queries.

QuickOSM has an incredible data parser that, together with the amazing query engine of Overpass, lets you download
data with your specific needs.

For example: we want to download the mountain peaks that belongs into a specific mountain area known as Dolomites.

You cannot achieve this task with the Quick query tab, you have to be more specific and write your own query. Let’s
try to do this.

1. Start a new project.
2. Open the QuickOSM plugin and click on the Query tab.

3. Copy and paste the following code into the query canvas:

gl==
This shows all mountains (peaks) in the Dolomites.
You may want to use the "zoom onto data" button. =>
——>
<osm-script output="json">
<!-- search the area of the Dolomites —-->
<query type="area">
<has-kv k="place" v="region"/>
<has-kv k="region:type" v="mountain_area"/>
<has-kv k="name:en" v="Dolomites"/>

</query>
<print mode="body" order="quadtile"/>
<!-- get all peaks in the area --—>

<query type="node">
<area-query/>

(continues on next page)
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(continuagdo da pagina anterior)

<has-kv k="natural" v="peak"/>

</query>
<print mode="body" order="quadtile"/>
<!-- additionally, show the outline of the area -->

<query type="relation">
<has-kv k="place" v="region"/>
<has-kv k="region:type" v="mountain_area"/>
<has-kv k="name:en" v="Dolomites"/>
</query>
<print mode="body" order="quadtile"/>
<recurse type="down"/>
<print mode="skeleton" order="quadtile"/>
</osm-script>

Nota: This query is written in a xm1 like language. If you are more used to the Overpass QL you can
write the query in this language.

4. And click on Run Query:

(2 QuickQsM X

n Map preset <l
. This shows all mountains {peaks) in the Dolomites,
‘fou may want to use the “zoom onto data” butforn, ==
’ Quick query —-=

<osm-script oupuf="json" >

<querr7yr (;fpe= area’ >
<has4v k="place” v="region”f>
<has4v A=Tregion:type”™ v="mountain_area/>
' 05SM File <has4v k="name:en” v="Dolomites™/>
< fquery>

<print mode="body” order="quadtile™/=

D Parameters <i—geta
<guery fype="node">
<area-query/>

* About <hasdv k="natural” v="peak”/>
< fquery=

<print moge="body” order="quadtile’/>

<query fype="Trelation”=
<has4v &="place” v="region”/>
<has+v &="region:type” v="mountain_area"/>
<has4v #="name:en” v="Dolomites™/ =

< fquery=

<print mode="body” order="quadtile™/=

<recurse fype="down"[>

<print moge="skeleton” order="quadtile”/ =

<fosm-script]

Generate query oo » Run query
P Advanced

| QOverpass Turbo Documentation =

1 4

0%

The mountain peaks layer will be downloaded and shown in QGIS:

320 Capitulo 9. Module: Médulos



QGIS Training Manual

You can write complex queries using the Overpass Query language. Take a look at some example and try to explore
the query language.

9.2.4 Follow Along: The DataPlotly Plugin

The DataPlotly plugin allows you to create D3 plots of vector attributes data thanks to the plotly library.
1. Start a new project
2. Load the sample_points layer from the exercise_data/plugins folder

3. Install the plugin following the guidelines described in 277 Follow Along: Installing New Plugins searching
Data Plotly

4. Open the plugin by clicking on the new icon in the toolbar or in the Plugins » Data Plotly menu

In the following example we are creating a simple Scatter Plot of two fields of the sample_points layer. In the
DataPlotly Panel:

1. Choose sample_points in the Layer filter, cl for the X Field and mg for the Y Field:
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DataPlotly B
&f Plottype | i Scatter Plat - |
w Plot Parameters
Layer " sample_poaints - |
Use only selected features Use only visible features

Feature subset @,

X field 124 ~][€]
Y field 1.2 mg ~|[€]
w Properties
Legend title |dl-mg | €
Marker color ) || € vatersze (1000 [3] €
Stroke color I | = stokewidh (100 @ [3] €
Marker type | Paints - |
Paint type '@ - |
Opaciy oo |2
Hover tooltip | All values - |

Hover label as text

Type of plot Single Plot - |

% Clean Plot Canvas Update Plat ) Create Plot | | Configuration ~
i =) | |

2. If you want you can change the colors, the marker type, the transparency and many other settings: try to change
some parameters to create the plot below.
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DataPlothy n
¥ ) -z M

S & o-mg
= +F e ® L &
L
= &
+ + &
45 +
&+
2 40 & &
&
35
+
B % + @
*%
25
Zh + %
20 dh +
40 60 20 100 120 140
d
\‘.;Reload Dynamically update size ;nm qﬂ

3. Once you have set all the parameters, click on the Create Plot button to create the plot.

The plot is interactive: this means you can use all the upper buttons to resize, move, or zoom in/out the plot
canvas. Moreover, each element of the plot is interactive: by clicking or selecting one or more point on the plot,
the corresponding point(s) will be selected in the plot canvas.

TR

You can save the plot as a png static image or as an html file by clicking on the % or on the button in the
lower right corner of the plot.
There is more. Sometimes it can be useful to have two (or more) plots showing different plot types with different
variables on the same page. Let’s do this!

1. Go back to the main plot settings tab by clicking on the ({ button in the upper left corner of the plugin panel

2. Change the Plot Type to Box Plot

3. Choose group as Grouping Field and ph as Y Field

4

. In the lower part of the panel, change the Type of Plot from SinglePlot to SubPlots and let the default option
Plot in Rows selected.
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DataPlothy

& Phttype | [ BoxPlot A
w Plot Parameters

Layer " sample_points - |

Use only selected features Use only visible features

Feature subset @,

Grouping field S

{optionaD) 123 group - |€]

¥ field 1.2 ph -] [€]
w Properties

Legend title |ph | @,

sxcoor | (I - .
stroke color | (I - =, stokewidth 100 @ |2 €
Opacity : 1] 100.0 % =

Box orientation |\|'ert'n3| = |

Show statistics |None v |

Qutliers |Nc Cutliers = |
Type of plot |Subplcts - |

() Plotin columns (@) Plotin rows

4 Clean Plot Canvas Update Plot | | ) Create Plot | | Configuration = |
|

5. Once done click on the Create Plot button to draw the plot

DataPlotly

e

: [ ] g cl-mg
' > + m e
& + + L ] 75
50 ~ s
+ *é
45 +
7
& + *
35 + 6.5
L
? e PR R
L ] 6
25
+ + @
20 L +
5.5
50 100 150 1 2 3
:;Re\oad Dynamically update size ‘§| |£|

Now both scatter plot and box plot are shown in the same plot page. You still have the chance to click on each plot
item and select the corresponding features in the map canvas.
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Dica: Each plot has its own manual page available in the tab. Try to explore all the plot types and see all the
other settings available.

9.2.5 In Conclusion

There are many useful plugins available for QGIS. Using the built-in tools for installing and managing these plugins,
you can find new plugins and make optimum use of them.

9.2.6 What’s Next?

Next we'll look at how to use layers that are hosted on remote servers in real time.
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Module: Online Resources

When considering data sources for a map, there is no need to be restricted to data which you have saved on the
computer you're working on. There are online data sources which you can load data from as long as you are connected
to the Internet.

In this module, we’ll cover two kinds of web-based GIS services: Web Mapping Services (WMS) and Web Feature
Services (WES).

10.1 Lesson: Web Mapping Services

A Web Mapping Service (WMS) is a service hosted on a remote server. Similar to a website, you can access it as
long as you have a connection to the server. Using QGIS, you can load a WMS directly into your existing map.

From the lesson on plugins, you will remember that it’s possible to load a new raster image from Google, for example.
However, this is a once-off transaction: once you have downloaded the image, it doesn’t change. A WMS is different
in that it’s a live service that will automatically refresh its view if you pan or zoom on the map.

The goal for this lesson: To use a WMS and understand its limitations.

10.1.1 Follow Along: Loading a WMS Layer

For this exercise, you can either use the basic map you made at the start of the course, or just start a new map and
load some existing layers into it. For this example, we used a new map and loaded the original places, landuse and
protected_areas layers and adjusted the symbology:
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(2 *Untitled Project — QGIS — [m] x
]

Project Edit Vew Layer Settings Pluging Vector Raster Datsbase MWeb Mesh Progessing Help

DeBRRY O PALHNPP " A - BabLPOR H-8-G-0- QEHFZE-V -0

LAY AT 1R - - I A L L
Layers (=]E3)

v @ ® TV E&-RAL

V| + places

v! [ tanduse

! [ protected_areas

| A Type to locate (cri+k) Coordinate | -34,1015° 20,2775° | ¥ Scale 1:20.001 | v | (@ Magnifier| 100% 12| Rotaton [0,0° |2 V| Render  @epsciazze @

1. Load these layers into a new map, or use your original map with only these layers visible.

2. Before starting to add the WMS layer, deactivate «on the fly» projection (Project » Properties... » CRS tab,
check No CRS (or unknown/non-Earth projection). This may cause the layers to no longer overlap properly, but
don’t worry: we'll fix that later.

3. To add WMS layers, click on the ﬂ button to open the Data Source Manager dialog and enable the @
WMS/WMTS tab.
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- Data Source Manager -
() Data S M WMS/WMTS m] X
v - Layers Layer Order Tilesets

Raster -

il Connect Mew Edit Remave Load Save
== 4 Mesh

* Q

~ Paint Cloud D Name Title Abstract

+ Delimited Text

Image Encoding

tual Layer

Options

+ SAP HANA

Tile size

Request step size

Maximum number of GetFeatureInfo results 10

Coordinate Reference System EP5G:4326 - WGS5 84 bt

Use contextual WMS Legend

Layer name

Load as separate layers

Select layer(s)
Metadata Search

Close Add Help

Remember how you connected to a SpatiaLite or GeoPackage database at the beginning of the course. The
landuse, buildings, and roads layers are stored in a database. To use those layers, you first needed to connect
to the database. Using a WMS is similar, with the exception that the layers are on a remote server.

4. To create a new connection to a WMS, click on the New button.

You’ll need a WMS address to continue. There are several free WMS servers available on the Internet. One
of these is terrestris, which makes use of the OpenStreetMap dataset.

5. To make use of this WMS, set it up in your current dialog, like this:
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) Create a New WMS/WMTS Connection
Connection Details

MName |terrestris
URL https: /fows. terrestris. dejosm/service|
Authentication

Configurations Basic

Choose or create an authentication configuration

Mo Authentication  ~ LJ.-EJ

Configurations store encrypted credentials in the QGIS authentication
database,

HTTP Headers

Referer
b Advanced

WHMS/WMTS Options

WMS DPI-Mode all =
WMTS server-side tile pixel ratio Undefined {nat scaled) -
Ignore GetMap/GetTile/GetlegendGraphic URI reported in capabilities
Ignore GetFeatureInfo URI reported in capabilities
Ignore reported layer extents
Ignore axis orientation (WMS 1. 3/MMTS)
Invert axis orientation

Smooth pixmap transform

O Cancel Help

e The value of the Name field should be terrestris.

¢ The value of the URL field should be https://ows.terrestri

6. Click OK. You should see the new WMS server listed:
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() Data Source Manager | WMSWMTS

Layers | Layer Order Tilesets

| terrestris

| comnect | | New | | Edit
-~ Mesh

| Remove | | Load | Save |

@

B jis] Name Title

Abstract

+ Delimited Text

Image Encoding
Oradle

tual L

Options
4 SAP HANA

Tile size |

Request step size |

Maximum number of GetFeatureInfo results
Coordinate Reference System

Use contextual WMS Legend

10 |

EP5G:4326 - WGS5 84 bt

Layer name |

Load as separate layers

Select layer(s)

| Close | Add | Help |

7. Click Connect. In the list below, you should now see these new entries loaded:
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(&) Data Source Manager | WMS/WMTS

8. Click once on the OSM-WMS layer. This will display the default Coordinate Reference System in use and the

— O x
Layers | Layer Order Tilesets
| terrestris = |
| Connect | | New | | Edit Remove | | Load | | Save |
L2 |
Mesh D « Name Title Abstract
* 0 OpenStreetMap WMS
Paint Cloud v 1 OSM-WMS OpenStreetMap WMS - by terrestris
2 default default
3 OSM-WMS-no-abels 0SM WMS wio labels - by terrestris
b4 Q5M-Overlay-WMS O5M Overlay WMS - by terrestris
[} TOPO-WMS Topographic WMS - by terrestris
[} TOPO-0SM-WMS Topographic OSM WMS - by terrestris
10 SRTM30-Hillshade SRTM30 Hillshade - by terrestris
r 11 SRTM30-Colored SRTM30 Colored - by terrestris
b 13 SRTM30-Colored-Hillshade SRTM30 Colored Hillshade - by terrestris
15 SRTM30-Contour SRTM30 Contour Lines - by terrestris
b 16 Dark Dark
Image Encoding
: () pNG (®) JPEG
Virtual Layer
Options
SAP HAMA
Tile size | | | |
Request step size | | | |
Maximum number of GetFeatureInfo results |10 |
Coordinate Reference System EPSG:4326 - WGS 84 -
Use contextual WMS Legend
or Tile Layer name |
ArcGlS REST Server [t EE
Select layer(s)
Metadata Search | Close | Add | Help |

These are all the layers hosted by this WMS server.

number of CRSes supported by the dataset:
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() Data Source Manager | WMS/WMTS — O >
g

Layers | Layer Order Tilesets

| terrestris = |
| Connect | | New | | Edit | | Remove | | Load | | Save |
: (@ |
%] "
== " Mesh D « Name Title Abstract
- Point Cloud QOSM-WMS OpenStreetMap WMS - by terrestris
* 2 default default
3 OSM-WMS-no-abels 0SM WMS wio labels - by terrestris
. Delimited Text b4 Q5M-Overlay-WMS O5M Overlay WMS - by terrestris
[} TOPO-WMS Topographic WMS - by terrestris
e [} TOPO-0SM-WMS Topographic OSM WMS - by terrestris
d 10 SRTM30-Hillshade SRTM30 Hillshade - by terrestris
r 11 SRTM30-Colored SRTM30 Colored - by terrestris
[ [——— b 13 SRTM30-Colored-Hillshade SRTM30 Colored Hillshade - by terrestris
+ 15 SRTM30-Contour SRTM30 Contour Lines - by terrestris
b 16 Dark Dark

areS0L

M5 50L 5
Image Encoding
Orade
() PNG (8 JPEG
rtual Layer
Options
SAP HAMA
Tile size | | | |

Request step size | | | |

Maximum number of GetFeatureInfo results |10 |
Coordinate Reference System (25 available) | EPsG:4325 - wes 84 v ||
Use contextual WMS Legend
Layer name |0pen5h'eetMa|:| WMS - by terrestris
Load as separate layers
1 Layer selected
| Close | | Add | | Help |

Since we’re not using EPSG:4326 — WGS 84 for our map, let’s find one that meets our needs.

1. Click the %Sem CRS button. You will see a standard Coordinate Reference System Selector dialog showing
all the CRS the data is published with.
2. We want a projected CRS, so let’s choose WGS 84 / Pseudo-Mercator with EPSG: 3857. You can use

the top C‘L Filter widget.
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() Select CRS *
Predefined CRS -
Filter | <L

Recently Used Coordinate Reference Systems

Coordinate Reference System Authority 1D
WGS 84 EPSGi4326
Predefined Coordinate Reference Systems Hide deprecated CRSs
Coordinate Reference System Authority ID =
WGE5 84 EP5G:4325
~ [ Projected coordinate Systems
v Cassin
DHDN / Soldner Berlin EP5G:3068
~ Lambert Azimuthal Equal Area
ETRS89-extended [ LAEA Europe EP5G:3035
~  Lambert Conformal Conic
ETRS89 fLCC Germany (E-N) EP5G:5243
ETRS89 [ LCC Germany (N-E) EPSG:4839
ETR589-extended / LCC Europe EP5G:3034
™ Mercator
Google Maps Global Mercator EP5G:900313

S 84 [ Pseudo-Mercator EP5G:3857

1 ¥
WGS 84 | Pseudo-Mercator =
Properties I

* Units: meters N

* Dynamic (relies on & datum which is
not plate-fixed)

* Celestial body: Earth

* Based on World Geodefic Sysiem o R
1984 ensemble (EPSG:6326), which P a— : =
has a limited arrurary of at hest 2

1. Click OK. The Coordinate Reference System associated with the entry has changed.

9. Click Add to load the layer in your project using Layer name" (default is OpenStreetMap WMS - by terrestris).
10. Close the Data Source Manager dialog if not done automatically
11. In the Layers panel, click and drag it to the bottom of the list.
12. Zoom out in order to get a global view of the layers. You will notice that your layers aren’t located correctly
(near west of Africa). This is because «on the fly» projection is disabled.
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(@ "Untitled Project — QGIS
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»
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13. Let’s enable the reprojection again, but using the same projection as the OpenStreetMap WMS layer, which is

WGS 84 / Pseudo Mercator.

1. Open the Project » Properties... » CRS tab

2. Uncheck No CRS (or unknown/non-Earth projection)

3. Choose WGS 84 / Pseudo Mercator from the list.

10.1. Lesson: Web Mapping Services

335



QGIS Training Manual

() Project Properties — CRS X
Q Project Coordinate Reference System [CRS)

Mo CRS {or unknown/non-Earth projection)

Filter | CL 3857 a |
Recently Used Coordinate Reference Systems

] . Coordinate Reference System Authority ID

Predefined Coordinate Reference Systems Hide deprecated CRSs

Coordinate Reference System Authority ID

= ~ [ Projected Coordinate Systems
~ lambert Conformal Conic

i NAD_1983_HARN_Adi_WI_Marquette_Me . ESRI:103857
~ Mercator

| Pseudo-Mercator

i »
'WGS 84 | Pseudo-Mercator =
Properties
- * Units: meters
L * Dynamic {relies on a datum which |
i nat nlatafivadl b’
o« || concel || oy || rep |

4. Click OK.

14. Now right-click on one of your own layers in the Layers panel and click Zoom to layer(s). You should see the
Swellendam area:

(@ *Untitled Project — QGIS — [m] x
Project Edit View Layer Settings Plugine Vector Raster Database Web Mesh Progessing Help

NeERRE (22PN P RABALNOR M-85 QE#ZE--Po-
BEV.AWBB /. /1 - = @ ® ~ H

= EL] T s e
o @l T &R AL *4 = R

Jan Lootsrivier, « - p.
places /
landuse ey o)
protected_areas L Dro-Dwairiegarivler

OpenStreetMap WMS - by terrestris
Stadt == 1.000.000 EW
Stadt = 250.000 EW Ivier
Stadt > 25.000 EW

» ) Damsrivier
A

v
v
v
AL

Grootrivier.

.o WHN-

wiater- Daarmiegarivier S 5 =
Knapsakkraalsrivier
Strafie :

Goedgelagirivier
Bundesstralie L

/ Autobahn - Koringiardist
. Wasserflache '

Landfiiche Kabousrivier Holgatrivier

Middeirivier <

Wald 3 - " Bakoondsrivier
Bruintjesitvier |
Leeuker | Keurboo
Wiese / Acker : : . :
E‘ Gebaude —7 CABE?
s A
Krankenhaus 5 >
‘ Huisrvier.
e Keurbaorms Fiver
» {
Breede River, | ,\.,)
Buffellagsrivier
= _F
—_—
Q. Type tolocate (Cirl+) Coordinate | 2.255.454 4.041.638 |99 Scle 1:168.151  ~ | (@ Magnifier| 100% 12| Rotaton [0,0° |2 V| Render  @ERsmzsT @
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Note how the WMS layer’s streets and our own streets overlap. That’s a good sign!

The nature and limitations of WMS

By now you may have noticed that this WMS layer actually has many features in it. It has streets, rivers, nature
reserves, and so on. What’s more, even though it looks like it’s made up of vectors, it seems to be a raster, but you
can’t change its symbology. Why is that?

This is how a WMS works: it’s a map, similar to a normal map on paper, that you receive as an image. What usually
happens is that you have vector layers, which QGIS renders as a map. But using a WMS, those vector layers are on
the WMS server, which renders it as a map and sends that map to you as an image. QGIS can display this image, but

can’t change its symbology, because all that is handled on the server.

This has several advantages, because you don’t need to worry about the symbology. It’s already worked out, and

should be nice to look at on any competently designed WMS.

On the other hand, you can’t change the symbology if you don’t like it, and if things change on the WMS server, then
they’ll change on your map as well. This is why you sometimes want to use a Web Feature Service (WFS) instead,

which gives you vector layers separately, and not as part of a WMS-style map.

This will be covered in the next lesson, however. First, let’s add another WMS layer.

10.1.2 Try Yourself

1. Add the eAt1las WMS server at this URL: https://maps.eatlas.org.au/maps/wms

2. Load a World: Hillshading layer into the map.

3. You might want to set its Encoding to JPEG and its Tile size option to 200 by 200, so that it loads faster.

4. Your map should look like this (you may need to re-order the layers, and apply some transparency):

Layers

&4 = T e =
v ¥ places
v| [ protected_areas
! [ landuse
~ v I OpenStreetMap WMS - by terrestris
® Stadt > 1.000.000 EW

Layers

Stadt > 250.000 EV/
Stadt = 25,000 EW

Strabe
Bundesstrafie
Autobahn
Wasserflache
Landflache
Weald
Wiese / Acker

| Gebaude

Krankenhaus

Browser

Answer
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1. Go to the Data Source Manager, WMS / WMTS tab and create a new connection entry

2. Use the Q text box to filter the list of layers and select the corresponding layer
3. Remember to check/turn its CRS into EPSG:3857 - WGS 84 / Pseudo Mercator as the rest of the map.

i Data Source Manager | WMS/WMTS e
E’ Browser Layers Layer Order Tilesets
. Vector ehtlas -
) Raster Connect New Edit Remove Load Save
A4 ypesh Q. world: hillshading
iog Me
& . ID ¥ Name Title Abstract
Point Cloud
* v 0
Delimited Text = Imagery Base Maps Earth Cover Imagery Base Maps Earth Cover
* - “World: Bright Earth Basemap (e-Atlas) ‘World: Bright Earth Basemap (e-Atlas)

&3 GeoPackage ea-be:World_e-Atlas-UCSD_SRTM30-plus_v& Hillshading ‘World: Hillshading - SRTM30-plus v&.0 (e-Atlas... This layer shows hillshadi...
ff GeoPackag Bright-Earth_Hillshading Transparent Hillshade
LI s Bright-Earth_Raster Raster A sample style for rasters, ...
= ea-beWorld_e-Atlas-UCSD_SRTM30-plus_v&_Hillshading-Ir World: Hillshading Low Res - SRTM30-plus v&.... This layer shows hillshadi...
- Bright-Earth_Hillshading Transparent Hillshade
#,, SpatiaLite
* Bright-Earth_Raster Raster A sample style for rasters, ...

Image Encoding

- MS SQL Server

m Virtual Layer

PNG PNG8 (e JPEG GIF TIFF VG

Options

Tile size 200 200

'+ WEFS / OGC API - Features

Request step size

‘E.f; WCs Maximum number of GetFeaturelnfo results 10

XYZ Coordinate Reference System (6779 available) EPSG:3857 - WGS 84 / Pseudo-Mercator - —:S

or Tile Use contextual WMS Legend
&) ATCGIS REST Server
Layer name |World: Hillshading - SRTM30-plus v8.0 (e-Atlas, UCSD)
GeoNode
L Load as separate layers
Metadata Search 1 Layer selected
i Aide  Add @ Fermer

4. After the layer is loaded, you can modify its Opacity value (under the Transparency properties tab)

10.1.3 Try Yourself

Part of the difficulty of using WMS is finding a good (free) server.

e Find a new WMS at directory.spatineo.com (or elsewhere online). It must not have associated fees or
restrictions, and must have coverage over the Swellendam study area.

Remember that what you need in order to use a WMS is only its URL (and preferably some sort of description).

Answer

Spatineo is one of many places you can search for a OGC data. Type in the text area a name, keyword, location of
your interest to see if you get some working results. For this lesson, you might want to filter the results to include
WMS only.

You may notice that many WMS servers are not always available. Sometimes this is temporary, sometimes
it is permanent. An example of a WMS server that worked at the time of writing is the MapServer
Demonstration Server WMS at https://demo.mapserver.org/cgi-bin/wms?SERVICE=WMS&VERSION=1.3.0&
REQUEST=GetCapabilities. It does not require fees or have access constraints, and it is global. Therefore, it does
satisfy the requirements. Keep in mind, however, that this is merely an example. There are many other WMS servers
to choose from.
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10.1.4 Try Yourself

¢ Add the bluemarble layer from the MapServer Demonstration Server. 1s that a suitable dataset for our study
area?

Answer
1. Hide all other WMS layers to prevent them from rendering unnecessarily in the background.

2. Use the same approach as before to add the new server and the appropriate layer as hosted on that server:

\ Data Source Manager | WMS/WMTS v 9
i’ Browser Layers ‘ Layer Order Tilesets
H Vector |MapSen.'er’ - |
! Raster | Connect | | New | ‘ Edit ‘ | Remove Load ‘ | Save |
|/ Q
_‘!+ Mesh | = |
© it E ID ¥ Mame Title Abstract
aint Clouc 5
- 0  WMS_server WMS Demo Server for MapServer This demonstration server showcases MapServer (www.map...
Delimited Text 1 bluemarble Blue Marb\ World Elevation and Bathymetry ...
b 2continents World continents
N .
GeoPackage 4 coymtry_bounds World c.o!Jntry boundaries
b Gities World cities

GPS

SpatialLite

Image Encoding

BEELEERE ® PNG () PNGE () JPEG () TIFF () SVG

Virtual Layer R
Options

Tile size | | ‘ |

/ OGC API - Features Request step size | | ‘ |

Maximum number of GetFeaturelnfo results ‘ 10 |
Coordinate Reference System (4 available) ‘ EPSG:3857 - WGS 84 / Pseudo-Mercatar - || %|
Vector Tile Use contextual WMS Legend

]

ArcGIS REST Server

¥

Layer name |Blue Marble World Elevation and Bathymetry Raster

* GeoNode
Load as separate layers

Metadata Search 1 Layer selected

i Aide | + Add H @ Fermer |

3. If you zoom into the Swellendam area, you’ll notice that this dataset has a low resolution:
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Layers
« @ ® T 2= g

v ¥ places
v| [ protected_areas
! [ landuse

Layers | Browser

Therefore, it’s better not to use this data for the current map. The Blue Marble data is more suitable at global
or national scales

10.1.5 In Conclusion

Using a WMS, you can add inactive maps as backdrops for your existing map data.

10.1.6 Further Reading

* Spatineo Directory

¢ OpenStreetMap.org list of WMS servers

10.1.7 What’s Next?

Now that you've added an inactive map as a backdrop, you’'ll be glad to know that it’s also possible to add features
(such as the other vector layers you added before). Adding features from remote servers is possible by using a Web
Feature Service (WFS). That’s the topic of the next lesson.
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10.2 Lesson: Web Feature Services

A Web Feature Service (WFS) provides its users with GIS data in formats that can be loaded directly in QGIS. Unlike
a WMS, which provides you only with a map which you can’t edit, a WES gives you access to the features themselves.

The goal for this lesson: To use a WFS and understand how it differs from a WMS.

10.2.1 Follow Along: Loading a WFS Layer
1. Start a new map. This is for demo purposes and won’t be saved.

2. Click the % Open Data Source Manager button.

3. Enable the Y WFS /OGC API - Features tab.
4. Click the New button.

5. In the dialog that appears, enter the Name as nsidc.org and the URL as https://nsidc.org/
cgi-bin/atlas_south?version=1.1.0.

() Create a Mew WFS Cennection X
Connection Details

Mame |nsidc.org
URL https: /insidc.org/fcgi-bin fatias_south?version=1.1.0
Authentication
Configurations Basic

Choose or create an authentication configuration

Mo Authentication = S

Configurations store encrypted credentials in the QGIS
authentication database.

WFS Options

Version Maximum - Detect
Max. number of features
+ | Enable feature paging
Page size
Ignore axis orientation (WFS 1. 1AWFS 2.0)
Invert axis orientation

Use GML2 encoding for transactions

oK Cancel Help

6. Click OK, and the new connection will appear in your Server connections.

7. Click the Connect. A list of the available layers will appear:
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() Data Source Manager | WFS / OGC API - Features

Antarctic coastline (indudes ice shelves)
Antarctic continent

Antarctic grounding line (exdudes ice shel...
Antarctic ice core locations

Antarctic ice shelves

Antarctic island coastlines

Antarctic island coastiines

GPS Antarctic islands

Point Cloud

mited Text

GeoPackage

Antarctic megadunes
] Antarctic permanent research stations
Spatialite Antarctic Polar Front
Antarctic suface elevation contours
PostgresQL Antarctica border

coastlines (exduding Antarctica)
countries (excuding Antarctica)
glader outlines

glaciers

Oracle International Date Line

land {exduding Antarctica)
South Pole of Cold

South Pole of Inaccessibility
South Pole, Geographic

South Pole, Geomagnetic
South Pole, Magnetic

South Poles

MS 5QL

Virtual Layer

SAP HANA

+
‘E WMS MMTS

WFS [ OGC API -
Features

Use title for layer name

Coordinate Reference System

EPSG:3031

Server Connections
nsidc.org
Connect New | Edit Remove
Q
Title - Mame

antarctic_ice_shelves_outline
antarctic_continent
antarctic_coastline
antarctic_ice_cores
antarctic_ice_shelves_fil
antarctic_islands_coastlines
antarctica_islands_coastlines
antarctic_islands
antarctic_megadunes
antarctic_research_stations
antarctic_polar_front
antarctica_elevation_contours
antarctica_country_border
coastlines_exduding_antarctica

country_borders_exduding_antarctica

glacier_outlines

glaciers
international_date_line
land_exduding_antarctica
south_pole_of_cold
south_pole_inaccessibility
south_pole_geographic
south_pole_geomagnetic
south_pole_magnetic
south_poles_wfz

| Only request features overlapping the view extent

Build query

Load

Abstract

Bohlander, 1. and T. Scambos. 2007. Ant...
Bohlander, J. and T, Scambos, 2007, Ant...
Bohlander, 1. and T. Scambos. 2007, Ant...

Maurer, 1. compiler, 2009, Deep ice core ...

Bohlander, J. and T, Scambos, 2007, Ant...
Bohlander, J. and T. Scambos. 2007, Ant...
Bohlander, J. and T. Scambos. 2007, Ant...
Bohlander, 1. and T. Scambos. 2007. Ant...

Bohlander, J. and T. Scambos, 2005, Qut...

Wikipedia contributors, 24 January 2007, ...

Orsi, A, and Ryan, U. 2001. Locations of ..

Liu, H., K. Jezek, B. Li, and Z. Zhao. 200...
Bohlander, 1. and T. Scambos. 2007, Ant...

Center for International Earth Sdence Inf...
Center for International Earth Sdence Inf...

Armstrong, R., B. Raup, 5.1.5. Khalsa, R ...

Mational Imagery and Mapping Agency (M...

Mational Geographic Society, 1992, Natio...

Center for International Earth Sdence Inf...

Wikipedia contributors. 23 January 2007. ...
Wikipedia contributors. 20 January 2007. ..
Labels the location of the South Pole {90 ...

McClean, 5. 24 January 2007, Geomagne...
McClean, 5. 24 January 2007. Geomagne...

Labels the location of various types of So..

Close Add

Save

Sql

Change...

Help

8. Uncheck the Only request features overlapping the view extent option below the layers list, since your current
map canvas may not cover our area of interest: Antarctica.

9. Find the layer antarctica_country_border. You can use the Filter box at the top.

10. Click on the layer to select it:

11. Find and select also the layer south_poles_wfs. You might need to hold Ctr1.
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() Data Source Manager | WFS / OGC API - Features - O X
Server Connections
nsidc.org -
Connect New | Edit Remove Load Save
Q
Title - Mame Abstract Sql

Antarctic coastiine (indudes ice shelves) antarctic_ice_shelves_outiine Bohlander, 1. and T. Scambos. 2007, Ant...

Antarctic continent antarctic_continent Bohlander, 1. and T. Scambos, 2007, Ant...

Antarctic grounding line (exdudes ice shel...  antarctic_coastline Bohlander, 1. and T. Scambos. 2007, Ant...
Antarctic ice core locations antarctic_jice_cores Maurer, J. compiler. 2009, Deep ice core |...

Antarctic ice shelves antarctic_ice_shelves_fill Bohlander, J. and T. Scambos, 2007, Ant...

Antarctic island coastlines antarctic_islands_coastlines Bohlander, 1. and T. Scambos. 2007, Ant...

Antarctic island coastiines antarctica_islands_coastlines Bohlander, 1. and T. Scambos. 2007, Ant...

Antarctic islands antarctic_islands Bohlander, 1. and T. Scambos. 2007. Ant...

Antarctic megadunes antarctic_megadunes Bohlander, 1. and T. Scambos. 2005, Out...

Antarctic permanent research stations antarctic_research_stations Wikipedia contributors, 24 January 2007. ...

Antarctic Polar Front antarctic_polar_front Orsi, A, and Ryan, U. 2001. Locations of ...

Antarctic suface elevation contours antarctica_elevation_contours Liu, H., K. Jezek, B. Li, and Z. Zhao. 200...

Antarctica border antarctica_country_border Bohlander, 1. and T. Scambos. 2007. Ant...
coastlines (exduding Antarctica) coastlines_exduding_antarctica Center for International Earth Sdence Inf...
countries (exduding Antarctica) country_borders_exduding_antarctica Center for International Earth Sdence Inf...

glader outlines glacier_outlines Armstrong, R., B. Raup, 5.1.5. Khalsa, R...

glaciers glaciers Mational Imagery and Mapping Agency (M...

International Date Line international_date_line Mational Geographic Society, 1992, Natio...
land (exduding Antarctica) land_exduding_antarctica Center for International Earth Sdence Inf...

| Nl leyer South Pole of Cold south_pole_of_cold Wikipedia contributors. 23 January 2007. ...
' South Pole of Inaccessibility south_pole_inaccessibility wikipedia contributors. 20 January 2007. ...

South Pole, Geographic south_pole_geographic Labels the location of the South Pole (90 ...

SAP HANA South Pole, Geomagnetic south_pole_geomagnetic McClean, 5. 24 January 2007, Geomagne...
South Pole, Magnetic south_pole_magnetic McClean, 5. 24 January 2007, Geomagne...

South Poles south_poles_wfs Labels the location of various types of So...

WFS [ OGC API -
Features

Use title for layer name
Only request features overlapping the view extent

Coordinate Reference System

EPSG:3031 Change...

Build query Close Add Help

12. Click Add.

It may take a while to load the layers. When they are loaded, they will appear in the map, showing the outlines
of Antarctica and a few points over.
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() *Untitled Project — QGIS
DEBREE DAL BPP "R e tlOR K-8 -R-5%- QE# I E-+-00-
BEV.AMED /. - & - g RE qu g @ 4 @

Layers

« @ ®TE-BADL

® south_poles_wfs
[T] antarctica border

| Q Type to locate (Crl )

Coordinate | 3.329.287 4.724.383 | Scale 147.773.732 |~ | @ Magnifier [ 100%  |3| Rotation [0,0° [2] |V Render @®epscin @

How is this different from having a WMS layer?

13. Select any of the layers and you’ll notice that feature selection and attribute table tools are enabled. These are
vector layers.

14. Select the south_poles_wfs layer and open its attribute table. You should see this:

@ south_poles_wfs — Features Total: 1, Filtered: 1, Selected: 0 — O X
= BENGRTYTESD B =2 e &
1d MAME -

1I0 | Geographic South Pale

| Show All Features '|

Since the points have attributes, we are able to label them, as well as change their symbology. Here’s an
example:
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() *Untitled Project — QGIS - u} X
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Progessing Help
P Y @ MDD s oy =, 4
[ B e 22000 »d LORS Si-8--0O- G E-V-§
A@V. A WME@D =4 RE guagagy @ & H
Layers @®=

o il ® T &~ A0

south _poles wfs
| [-] antarctica_country_border

GeRidphis South'Pel

Type tolocate (Chrl+K) Coordinate | -3.646.519 4.083.415 | ¥ Scae 45,277,572 ~ | @ Maanifier | 100% | Rotation |0,0° 2| ¥Render @ePsciaoz @

Differences from WMS layers

A Web Feature Service returns the layer itself, not just a map rendered from it. This gives you direct access to the
data, meaning that you can change its symbology and run analysis functions on it. However, this is at the cost of much
more data being transmitted. This will be especially obvious if the layers you're loading have complicated shapes, a
lot of attributes, or many features; or even if you're just loading a lot of layers. WFS layers typically take a very long
time to load because of this.

10.2.2 Follow Along: Querying a WFS Layer

Although it is of possible to query a WES layer after having loaded it, it’s often more efficient to query it before you
load it. That way, you're only requesting the features you want, meaning that you use far less bandwidth.

For example, on the WFS server we’re currently using, there is a layer called countries (excluding Antarctica).
Let’s say that we want to know where South Africa is relative to the south_poles_wfs layer (and perhaps also the
antarctica_country_border layer) that’s already been loaded.

There are two ways to do this. You can load the whole countries ... layer, and then build a query as usual once it’s
loaded. However, transmitting the data for all the countries in the world and then only using the data for South Africa
seems a bit wasteful of bandwidth. Depending on your connection, this dataset can take several minutes to load.

The alternative is to build the query as a filter before even loading the layer from the server.
1. Enable the WFS / OGC API Features tab in the Data Source Manager dialog
2. Connect to the server we used before and you should see the list of available layers.

3. Find and double-click the countries (excluding Antarctica) layer. The layer name is
country_borders_excluding_antarctica. You can also select the layer and press Build
query button at the bottom of the dialog:
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() Data Source Manager — WFS / OGC API - Features

i Browser

Server Connections
nsidc.org

Connect

Point Cloud
Antarctic continent
R Antarctic ice core locations
Antarctic ice shelves
Antarctic island coastlines
Antarctic island coastiines
Antarctic islands

Antarctic megadunes

Antarctic Polar Front

Antarctica border

coastlines (exduding Antarctica)
duding Antarctica)

glader outlines

glaciers

International Date Line

land {exduding Antarctica)

South Pole of Cold

South Pole of Inaccessibility

South Pole, Geographic

South Pole, Geomagnetic

South Pole, Magnetic

South Poles

Virtual Layer

SAP HANA

+
I‘E WMS M/MT

WFS [ OGC API -
Features

Use title for layer name

Coordinate Reference System

Antarctic permanent research stations

Antarctic suface elevation contours

Edit

Remove

“ Name

Antarctic coastline (indudes ice shelves)

Antarctic grounding line (exdudes ice shel...

antarctic_ice_shelves_outline
antarctic_continent
antarctic_coastline
antarctic_ice_cores
antarctic_ice_shelves_fil
antarctic_islands_coastlines
antarctica_islands_coastlines
antarctic_islands
antarctic_megadunes
antarctic_research_stations
antarctic_polar_front
antarctica_elevation_contours
antarctica_country_border
coastlines_exduding_antarctica
country_borders_s
glacier_outlines

glaciers
international_date_line
land_exduding_antarctica
south_pole_of_cold
south_pole_inaccessibility
south_pole_geographic
south_pole_geomagnetic
south_pole_magnetic
south_poles_wfz

Only request features overlapping the view extent

Load

Abstract

Bohlander, 1. and T. Scambaos. 2007, Antarctic ...
Bohlander, 1. and T, Scambos, 2007, Antarctic ...
Bohlander, 1. and T. Scambos. 2007, Antarctic ...
Maurer, 1. compiler. 2009, Deep ice core locatio...
Bohlander, 1, and T, Scambos, 2007, Antarctic ...
Bohlander, 1. and T. Scambos. 2007, Antarctic ...
Bohlander, 1. and T. Scambos. 2007, Antarctic ...
Bohlander, 1. and T. Scambos. 2007. Antarctic ...
Bohlander, 1. and T. Scambos. 2005, Qutlines o...
Wikipedia contributors, 24 January 2007, List of ..
Orsi, A, and Ryan, U. 2001, Locations of the va...
Liu, H., K. Jezek, B. Li, and Z. Zhao. 2001. Rad...
Bohlander, 1. and T. Scambos. 2007, Antarctic ...

Center for International Earth Sdence Informati
nter for International Earth

Armstrong, R., B. Raup, 5.1.5. Khalsa, R. Barry...
National Imagery and Mapping Agency (NIMA). ...
National Geographic Society, 1992, National Ge...
Center for International Earth Sdence Informati...
Wikipedia contributors. 23 January 2007. Fole o...
Wikipedia contributors. 20 January 2007, South...
Labels the location of the South Pole (90 deg S, ...
McClean, 5. 24 January 2007, Geomagnetism Fr...
McClean, 5. 24 January 2007, Geomagnetism Fr...
Labels the location of various types of South Pol....

Save

Sql

EPSG:3031 Change...
- Build query Close Add Help
4. In the dialog that appears, type the following SELECT * FROM
country_borders_excluding_antarctica WHERE "Countryeng" = 'South Africa’
query in the SQL Statement box.
(2 SOL Query Composer X

SELECT
"South Africa’
SQL Statement | sEEREs

Columns | =
Table(s) |country_borders_exduding_antarctica
Where Countryeng = 'South Africa’
Order by
Reset

FROM country borders excluding antarctica WHERE "Count

Data
Columns A
Functions o
Spatial predicates -
Operators &
oK Cancel Help

5. Press OK.
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6. The expression used will appear as the Sql value of the target layer:

(2 Data Source Manager — WFS / OGC API - Features - O X

* server Connections

nsidc.org -
Connect [ew | Edit Remove Load Save
Q
Title ~ Name Abstract Sal

Antarctic coastine {includes ice shelves) antarctic_ice_shelves... Bohlander,

Antarctic continent antarctic_continent Bohlander,

Antarctic grounding line (exdudes ice ... antarctic_coastine Bohlander, ...
Antarctic ice core locations antarctic_ice_cores Maurer, 1. ...
Antarctic ice shelves antarctic_ice_shelves... Bohlander, ...
Antarctic island coastlines antarctic_islands_coa... Bohlander, ...
Antarctic island coastlines antarctica_islands_co .. Bohlander, ...
Antarctic islands antarctic_islands Bohlander, ...
Antarctic megadunes antarctic_megadunes  Bohlander, ...
Antarctic permanent research stations  antarctic_research_s._. Wikipedia c...
Antarctic Polar Front antarctic_polar_front ~ Orsi, A, an...
Antarctic suface elevation contours antarctica_elevation_... Liu, H., K. J

Antarctica border antarctica_country_b... Bohlander,

coastiines (exduding Antarctica) coastines_exduding_.

CT * FROM country uding_antarctica WHER
gladier outiines gladier_outlines
glaciers glaciers National Im..
International Date Line international_date_line MNational Ge...
land {excluding Antarctica) land_excluding_antar... Center for ...
South Pole of Cold south_pole_of_cold Wikipedia c...
South Pole of Inaccessibility south_pole_inaccessi . Wikipedia c...
South Pole, Geographic south_pole_geographic Labels the |..
South Pole, Geomagnetic south_pole_geomagn... McClean, 5
South Pole, Magnetic south_pole_magnetic  McClean, 5
South Poles south_poles_wfs Labels the |

Use title for layer name
Only request features averlapping the view extent

Coordinate Reference System

EPSG:3031 Change..

Metadata Build query Close Add Help

7. Click Add with the layer selected as above. Only the country with the Countryeng value of South
Africa will load from that layer:
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() “Untitled Project — QGIS - [m] >
Project Edit View Layer Setfings Plugins Vector Raster Datsbase Web Mesh Processing Help

DNEERE® O 2L RAPPM A LOR H-8-R-5- 6EHKIE-¥-§
WOV /2 B EW =4 qa qegqgpgyg @ 4 B

Layers &=
« il ® T &~ O

v [] country borders excluding antarct 77
V| » south_poles_wfs
| [] antarctica_country_border -

South Africa

ographic South Pale. » )

te (Ctrl+K) Coordinate | -1.120.199 -2.473.965 ¥ Scale 1:48.583.784 ~ | @ Magnifier | 100% % | Rotaten |0,0° 2| v/ Render @Epscizozr @

Did you notice the ? icon next to the country_borders_excluding_antarctica layer? It
indicates that the loaded layer is filtered and does not display in the project all of its features.

8. You don’t have to, but if you tried both methods, you’ll notice that this is a lot faster than loading all the
countries before filtering them!

Notes on WFS availability

It is rare to find a WEFS hosting features you need, if your needs are very specific. The reason why Web Feature
Services are relatively rare is because of the large amounts of data that must be transmitted to describe a whole
feature. It is therefore not very cost-effective to host a WFS rather than a WMS, which sends only images.

The most common type of WES you’ll encounter will therefore probably be on a local network or even on your own
computer, rather than on the Internet.

10.2.3 In Conclusion

WES layers are preferable over WMS layers if you need direct access to the attributes and geometries of the layers.
However, considering the amount of data that needs to be downloaded (which leads to speed problems and also a
lack of easily available public WES servers) it’s not always possible to use a WFS instead of a WMS.
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10.2.4 What’s Next?

Next, you’'ll see how to use QGIS Server to provide OGC services.
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Module: QGIS Servidor

Este m6dulo € um contributo de Tudor Barascu.
Neste mddulo é abordada a forma de instalar e usar o QGIS Servidor.

To learn more about QGIS Server, read the QGIS-Server-manual.

11.1 Lesson: Install QGIS Server

The goal for this lesson: To learn how to install QGIS Server on Debian Stretch. With negligible variations you
can also follow it for any Debian based distribution like Ubuntu and its derivatives.

Nota: In Ubuntu you can use your regular user, prepending sudo to commands requiring admin permissions. In
Debian you can work as admin (root), without using sudo.

11.1.1 Follow Along: Install from packages

In this lesson we’re going to do only the install from packages as shown here .

Install QGIS Server with:

apt install ggis—-server —--no-install-recommends —--no-install-suggests

# if you want to install server plugins, also:
apt install python3-ggis

QGIS Server should be used in production without QGIS Desktop (with the accompanying X Server) installed on the
same machine.
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11.1.2 Follow Along: QGIS Server Executable

The QGIS Server executable is qgis_mapserv.fcgi. You can check where it has been installed by running
find / -name 'ggis_mapserv.fcgi' which should output something like /usr/lib/cgi-bin/
ggis_mapserv.fcgi.

Optionally, if you want to do a command line test at this time you can run the /usr/lib/cgi-bin/
ggis_mapserv.fcgi --version command which should output something like:

QGIS 3.21.0-Master 'Master' (1c70953fle)

QOGIS code revision 1c¢70953fle

Qt version 5.15.2

Python version 3.9.5

GDAL/OGR version 3.2.2

PROJ version 7.2.1

EPSG Registry database version v10.008 (2020-12-16)
GEOS version 3.9.0-CAPI-1.16.2

SQLite version 3.34.1

0OS Ubuntu 21.04

We'll see later on how to make WMS requests.

11.1.3 HTTP Server Configuration

In order to access on the installed QGIS server from an Internet Browser we need to use an HTTP server. The Apache
HTTP Server installation process is detailed in httpserver section.

Nota: If you installed QGIS Server without running an X Server (included in Linux Desktop) and if you also want
to use the GetPrint command then you should install a fake X Server and tell QGIS Server to use it. You can do
that by following the Xvfb installation process.

11.1.4 Follow Along: Create another virtual host

Let’s create another Apache virtual host pointing to QGIS Server. You can choose whatever name you like (coco.
bango, super.duper.training, example.com, etc.) but for simplicity sake we’re going to use myhost.

* Let’s set up the myhost name to point to the localhost IP by adding 127.0.0.1 xtothe /etc/hosts
with the following command: sh -c "echo '127.0.0.1 myhost' >> /etc/hosts" or by
manually editing the file with gedit /etc/hosts.

* We can check that myhost points to the localhost by running in the terminal the ping myhost command
which should output:

qgis@ggis:~$ ping myhost
PING myhost (127.0.0.1) 56(84) bytes of data.
64 bytes from localhost (127.0.0.1): icmp
64 bytes from localhost (127.0.0.1): icmp_

=1 ttl=64 time=0.024 ms
=2 ttl=64 time=0.029 ms

e Let’s try if we can access QGIS Server from the myhost site by doing: curl http://myhost/
cgi-bin/qggis_mapserv.fcgi or by accessing the url from your Debian box browser. You will

probably get:
<!DOCTYPE HTML PUBLIC "-//IETF//DTD HTML 2.0//EN">
<html><head>
<title>404 Not Found</title>
</head><body>

<h1>Not Found</hl>
<p>The requested URL /cgi-bin/qggis_mapserv.fcgi was not found on this server.</p>
(continues on next page)
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(continuac@o da pégina anterior)
<hr>
<address>Apache/2.4.25 (Debian) Server at myhost Port 80</address>
</body></html>

* Apache doesn’t know that he’s supposed to answer requests pointing to the server named myhost. In
order to setup the virtual host the simplest way would be to make a myhost.conf file in the /etc/
apache?2/sites—available directory that has the same content as gqgis.demo.conf except for
the ServerName line that should be ServerName myhost. You could also change where the logs go as
otherwise the logs for the two virtual hosts would be shared but this is optional.

» Let’s now enable the virtual host with a2ensite myhost.conf and then reload the Apache service with
service apache2 reload.

* If you try again to access the http://myhost/cgi-bin/qgis_mapserv.fcgi url you'll notice everything is working
now!

11.1.5 In Conclusion

You learned how to install different QGIS Server versions from packages, how to configure Apache with QGIS Server,
on Debian based Linux distros.

11.1.6 What’s Next?

Now that you've installed QGIS Server and it’s accessible through the HTTP protocol, we need to learn how to access
some of the services it can offer. The topic of the next lesson is to learn how to access QGIS Server WMS services.

11.2 Lesson: Serving WMS

The data used for this exercise are available in the ggis—server-tutorial-data subdirectory of the training
data you downloaded. For convenience and to avoid possible permissions problems, we will assume that these files
are stored in /home /qgis/projects directory. Hence, adapt the following instructions to your path.

The demo data contains a QGIS project named wor1d. ggs that is already prepared to be served with QGIS Server.
If you want to use your own project or you want to learn how a project is prepared see the Creatingwmsfromproject
section.

Nota: This module presents the URLSs so that the audience can easily distinguish the parameters and parameters
values. While the normal format is:

[...&fieldlzvalue1&field2:value2&field3:value3

this tutorial uses:

&fieldl=valuel
sfield2=value?2
&field3=value3

Pasting them into Mozilla Firefox works properly but other web browsers like Chrome may add unwanted spaces
between the field:parameter pairs. So, if you encounter this issue you can either use Firefox or modify the
URLS so that they’re in one line format.

Let’s make a WMS GetCapabilities request in the web browser or with curl:
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http://ggisplatform.demo/cgi-bin/ggis_mapserv.fcgi
?SERVICE=WMS

&VERSION=1.3.0

&REQUEST=GetCapabilities
&map=/home/qgis/projects/world.qgs

In the Apache config from the previous lesson the QGIS_PROJECT_FILE variable sets the default project to /
home/qgis/projects/world.ggs. However, in the above request we made use of the map parameter to be
explicit and to show it can be used to point at any project. If you delete the map parameter from the above request
QGIS Server will output the same response.

By pointing any WMS client to the GetCapabilities URL, the client gets in response an XML document with
metadata of the Web Map Server’s information, e.g. what layers does it serve, the geographical coverage, in what
format, what version of WMS etc.

As QGIS is also a ogc-wms you can create a new WMS server connection with the help of the above GetCapabilities
url. See the Lesson: Web Mapping Services or the ogc-wms-servers section on how to do it.

By adding the countries WMS layer to your QGIS project you should get an image like the one below:

ViR AR -@-@Q-% WA -
e - -8 -EEIE- D

Layers Panel 5]

e Im Ty ? E.‘ - »
B classified by pop...

countries

[ .99.7850

[0 7850 - 69453
69453 - 304728
304728 - 1350999
1350999 - 4068089

4068089 - 6963512

6963512 - 10500223
N 10500223 -2188773
- 21887735 - 4740653
- 47406537 -1338612

Figurall.1l: QGIS Desktop consuming the QGIS Server countries layer WMS service
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Nota: QGIS Server serves layers that are defined in the world. ggs project. By opening the project with QGIS
you can see there are multiple styles for the countries layer. QGIS Server is also aware of this and you can choose
the style you want in your request. The classified_by_population style was chosen in the above image.

11.2.1 Registando

When you’re setting up a server, the logs are always important as they show you what’s going on. We have setup in
the * . conf file the following logs:

* QGIS Server logat /1logs/ggisserver.log
* ggisplatform.demo Apache access log at ggisplatform.demo.access.log
* ggisplatform.demo Apache error log at ggisplatform.demo.error.log

The log files are simply text files so you can use a text editor to check them out. You can also use the tail command
in a terminal: sudo tail -f /logs/ggisserver.log.

This will continuously output in the terminal what’s written in that log file. You can also have three terminals opened
for each of the log files like so:
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fqgis@qgis: ~ = B x
File Edit View Search Terminal Help
gois@gois:~$ sudo tail -T /var/log/apache2/qgisplatform.demo.error.log
*E
ﬁ;i gois:~% sudo tail -T /var/log/apache2/qgisplatform.demo.error.log

qgis@qgis: ~ “ - I

File Edit View Search Terminal Help

208 11378 "-" "curl/7.52.1"
127.0.6.1 - - [17/Mar/2017:04:09:41 -0400] "GET /cgi-bin/qgis mapserv.fcgi?SERVICE=W
MS&VERSION=1.3.0&REQUEST=GetCapabilities&map=/home/qgis/projects/world.qgs HTTP/1.1"
200 11378 "-" "curl/7.52.1"

127.0.6.1 - - [17/Mar/2017:04:09:42 -04008] "GET /cgi-bin/qgis mapserv.fcgi?SERVICE=W

MS&VERSION=1.3.0&REQUEST=GetCapabilities&map=/home/qgis/projects/world.qgs HTTR/1.1"

208 11378 "-" "curl/7.52.1" I
qgis@qgis: ~ - o x

File Edit Wiew Search Terminal Help
[1732][04:09:42] Sent 1 blocks of 11205 bytes
[1732][04:09:42] Request finished in 3 ms

*C
gois@qgis:~$ sudo tail -f /logs/qgisserver.loeg
ﬁ1?32][04:@9:42] MAP: /home/qgis/projects/world.qgs
11732][04:09:42] REQUEST:GetCapabilities

[1732][04:09:42] SERVICE:WMS

[1732][04:09:42] VERSION:1.3.0

[1732][04:09:42] Found capabilities document in cache
[1732][04:09:42] Checking byte array is ok to set...
[1732][04:09:42] Byte array looks good, setting response...
[1732][04:09:42] Sending HTTP response

[1732][04:09:42] Sent 1 blocks of 11205 bytes
[1732][04:09:42] Request finished in 3 ms

Figurall.2: Using the tail command to visualise QGIS Server logs output

When you use QGIS Desktop to consume the QGIS Server WMS services you will see all the requests QGIS sends
to the Server in the access log, the errors of QGIS Server in the QGIS Server log etc.

Nota:
* If you look at the logs in the following sections you should get a better understanding on what’s happening.

* By restarting Apache while looking in the QGIS Server log you can find some extra pointers on how things
work.
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11.2.2 GetMap requests

In order to display the countries layer, QGIS Desktop, like any other WMS client, is using GetMap requests.

A simple request looks like:

http://ggisplatform.demo/cgi-bin/gqgis_mapserv.fcgi
?MAP=/home/qggis/projects/world.qgs
&SERVICE=WMS

&VERSION=1.3.0

&REQUEST=GetMap
&BBOX=-432786,4372992,3358959, 7513746
&SRS=EPSG:3857

&WIDTH=665

&HEIGHT=551

&LAYERS=countries

&FORMAT=image/jpeg

The above request should output the following image:

Figure: simple GetMap request to QGIS Server

Figural1.3: Qgis Server response after a simple GetMap request
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11.2.3 Try Yourself Change the Image and Layers parameters

Based on the request above, let’s replace the count ries layer with another.

In order to see what other layers are available you could open up the world. ggs project in QGIS and look at its
contents. Keep in mind though that the WMS clients don’t have access to the QGIS project, they just look at the
capabilities document contents.

Also, there’s a configuration option so that some of the layers existing in the QGIS project are ignored by QGIS when
serving the WMS service.

So, you could look at the layer list when you point QGIS Desktop to the GetCapabilities URL or you could
try yourself finding other layer names in the Get Capabilities XML response.

One of the layer names that you could find and works is countries_shapeburst. You may find others but
keep in mind some may not be visible at such a small scale so you could get a blank image as response.

You can also play around with others parameters from above, like changing the returned image type to image /png.

11.2.4 Follow Along: Use Filter, Opacities and Styles parameters

Let’s do another request that adds another layer, some basic parameters, FILTER and OPACITIES, but also uses
the standard STYLES parameter.

http://ggisplatform.demo/cgi-bin/ggis_mapserv.fcgi
?MAP=/home/qggis/projects/world.qgs

&SERVICE=WMS

&VERSION=1.3.0

&REQUEST=GetMap
&§BBOX=-432786,4372992,3358959, 7513746
&SRS=EPSG:3857

&WIDTH=665

&HEIGHT=551

&FORMAT=1image/jpeg

&LAYERS=countries, countries_shapeburst
&STYLES=classified_by_name,blue

&OPACITIES=255, 30

&FILTER=countries:"name" IN ( 'Germany' , 'Italy' )

The above request should output the following image:
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Figural1.4: Response to a GetMap request with FILTER and OPACITIES parameters

As you can see from the above image, among other things, we told QGIS Server to render only Germany and Italy
from the countries layer.

11.2.5 Follow Along: Use Redlining

Let’s do another GetMap request that makes use of the redlining feature and of the SELECTION parameter detailed
in the Basics section:

http://ggisplatform.demo/cgi-bin/ggis_mapserv.fcgi

?MAP=/home/qggis/projects/world.qgs

& SERVICE=WMS

&VERSION=1.3.0

&REQUEST=GetMap

&BBOX=-432786,4372992,3358959, 7513746

&SRS=EPSG:3857

&WIDTH=665

&HEIGHT=551

&LAYERS=countries, countries_shapeburst

&FORMAT=image/jpeg

&HIGHLIGHT_GEOM=POLYGON ( (590000 6900000, 590000 7363000, 2500000 7363000, 2500000

—~6900000, 590000 6900000))

&HIGHLIGHT SYMBOL=<StyledLayerDescriptor><UserStyle><Name>Highlight</Name>

—<FeatureTypeStyle><Rule><Name>Symbol</Name><LineSymbolizer><Stroke><SvgParameter.
(continues on next page)
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(continuagdo da pagina anterior)

—name="stroke">%233a093a</SvgParameter><SvgParameter name="stroke-opacity">1</
—SvgParameter><SvgParameter name="stroke-width">1.6</SvgParameter></Stroke></
—LineSymbolizer></Rule></FeatureTypeStyle></UserStyle></StyledLayerDescriptor>
&HIGHLIGHT_LABELSTRING=QGIS Tutorial

&HIGHLIGHT_ _LABELSIZE=30

&HIGHLIGHT_LABELCOLOR=%23000000

&HIGHLIGHT_LABELBUFFERCOLOR=%23FFFFFF

&HIGHLIGHT_LABELBUFFERSIZE=3

&SELECTION=countries:171, 65

L

Pasting the above request in your web browser should output the following image:

France

Figural1.5: Response to a request with the REDLINING feature and SELECTION parameter

You can see from the above image that the countries with the 171 and 65 ids were highlighted in yellow (Romania
and France) by using the SELECTION parameter and we used the REDLINING feature to overlay a rectangle with
the QGIS Tutorial label.
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11.2.6 GetPrint requests
One very nice feature of QGIS Server is that it makes use of the QGIS Desktop print layouts. You can learn about it
in the wms_getprint section.

If you open the world.qggs project with QGIS Desktop you will find a print layout named Population
distribution. A simplified GetPrint request that exemplifies this amazing feature is:

http://ggisplatform.demo/cgi-bin/ggis_mapserv.fcgi
?map=/home/qggis/projects/world.ggs
&SERVICE=WMS

&VERSION=1.3.0&

REQUEST=GetPrint

&FORMAT=pdf

& TRANSPARENT=true

&SRS=EPSG:3857

&DPI=300

&TEMPLATE=Population distribution
&map0:extent=-432786,4372992, 3358959, 7513746
&LAYERS=countries

Legend

places

Ukraine

Figural1.6: Shows the pdf resulted from the above GetPrint request

Naturally, it’s hard to write your GetMap, GetPrint etc. requests.

QGIS Web Client or QWC is a Web client project that can work alongside QGIS Server so that you can publish your
projects on the Web or help you create QGIS Server requests for a better understanding about the possibilities.

You can install it like this:
e Asuser ggis go to the home directory with cd /home/ggis.
¢ Download the QWC project from here and unzip it.

* Make a symbolic link to the /var/www/html directory as it'’s the DocumentRoot that we've setup
in the virtual host configuration. If you unzipped the archive under /home/qgis/Downloads/
QGIS-Web-Client-master we can do that with sudo 1n -s /home/ggis/Downloads/
QGIS-Web-Client-master /var/www/html/.

* Access http://qgisplatform.demo/QGIS- Web- Client-master/site/qgiswebclient. html?map=/home/qgis/
projects/world.qgs from your Web browser.

Now you should be able to see the Map as in the following figure:
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GIS-Browser - world Engish

IﬂﬁéﬁTO?'S - ‘,«; @ Q ‘/‘;n‘[ Q Objectidentiﬁcation:i.Topmost hit i‘f [ ﬁ t |;|
Map themes
Search ]
Map (=]
Map Layers [»]
(@] i world
[#](& ) airports
D\'?\places

[¥]/ 4 countries
| & countries_shapeburst

=) Background Layers
["]OpenStreetMap (mapnik)
[]MapQuest-OSM Tiles
[]OpenCycleMap
[]MapQuest Open Aerial Tiles (zoom -
[]Google Satellite
[]Google Map

Layer order 21 Mode: navigation. Shift/rectangle or mouse wheel for zooming. Coordinate: -362278,635102(

Figural1.7: QGIS Web Client consuming the world.qgs project

If you click the Print button in QWC you can interactively create GetPrint requests. You can also click the ? icon
in the QWC to access the available help so that you can better discover the QWC possibilities.

11.2.7 In Conclusion

You learned how use QGIS Server to provide WMS Services.

11.2.8 What’s Next?

Next, you'll see how to use QGIS as a frontend for the famous GRASS GIS.
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Module: GRASS

GRASS (Sistema de Suporte para Andlise de Recursos Geogréficos) € um SIG conhecido de cédigo aberto com
uma grande variedade de fungdes tteis para SIG. Foi lancado em 1984, e teve muitas melhorias e funcionalidades
adicionais desde entdo. O QGIS permite que faca uso directamente das poderosas ferramentas do SIG GRASS.

12.1 Lesson: GRASS Setup

Using GRASS in QGIS requires you to think of the interface in a slightly different way. Remember that you’re not
working in QGIS directly, but working in GRASS via QGIS. Hence, make sure you have installed QGIS Desktop
with Grass support.

£7 To open a QGIS session with GRASS available on Windows you have to click on the QGIS Desktop with
GRASS icon.

The goal for this lesson: To begin a GRASS project in QGIS.

12.1.1 Follow Along: Start a New GRASS Session

To launch GRASS from within QGIS, you need to activate it as with any other plugin:
1. First, open a new QGIS project.
2. In the Plugin Manager, enable GRASS in the list:

363



QGIS Training Manual

Plugins | Installed (14)

| @ search

& _ MACOSX
<+ Coordinate Capture
% Not installed V| & DB Manager G RAS s 7 %
i eVis
[ Geometry Checker GRASS 7 (Geographic Resources Analysis Support System)
1 Georeferencer GDAL
£ GPS Tools
ﬁ Settings CARSGHAS N :
v/ @& MetaSearch Catalog Client
 OfflineEditing
v| £} Plugin Reloader
V| &¢ Processing
V| 4 QuickOsM
#¢ Topology Checker

This is a core plugin, so you can't uninstall it

Invalid

o

Install from ZIP .
SRR £ Category Plugins
Installed version Version 2.0

| ElHelp |

¥ Close

The GRASS toolbar and the GRASS panel will appear:

Figural2.1: GRASS toolbar

364 Capitulo 12. Module: GRASS



QGIS Training Manual

DALY Bosed L

Ko magaet i open. You can open & GRASS mapee! o the brower unng thae
mapiet e conlexl meany hon Jpen musgeed

Figural2.2: GRASS Panel

The GRASS panel is not active because, before you can use GRASS, you need to create a Mapset. GRASS always
works in a database environment, which means that you need to import all the data you want to use into a GRASS
database.

The GRASS database has a straightforward structure, even if at a first look it seems very complicated. The most
important thing you should know is that the upper level of the database is the Location. Each Location can
contain different Mapset: in every Mapset you will find the PERMANENT Mapset because it is created by default
by GRASS. Each Mapset contains the data (raster, vector, etc) in a particular structure, but don’t worry, GRASS
will take care of this for you.

Just remember: Location contains Mapset that contains the data. For more information visit the GRASS website.
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Database Location Mapset Maps
grassdata nc_spm PERMANENT
new_highway raster elevation
landcover
vector streets
buildings
3D raster soils
temporal landsat
wake_county
usa_albers
world_lat_lon
Figural2.3: GRASS database structure (from GRASS docs)
12.1.2 Follow Along: Start a New GRASS Project
1. Click on the Plugins » GRASS » New Mapset menu:

*Untitled Project - QGIS [tm]

Project Edit View Layer Settings |G Vector Raster Database Web Processing Help
BRERR |g‘ & & | f Manage and Install Plugins... s 5 S % I =P My
a
™ T | @, Python Console Cirl+Alt+P an- m a [T

RA ' Open Mapset
Layers 18 Op P S Tools
y

¢ I ®mTE-BHD Plugin Reloader

% Open GRASS Tools |

B

mapset is open. You can open a GRASS mapset from the browser using the
set item's cantext menu action Open mapset.

g

A GRASS Options [

EASHE

Ly,

‘ Layers | Browser

| @ Type to locate (Ctri+K) | Ready Coordinate|-0.405,1.194 |95 Scale|1:1692146 ~ | @ Magnifier|100% |2 Rotation [0.0°

2| ¥/ Render & EpsGia3ze @

You'll be asked to choose the location of the GRASS database.
2. Set it as the directory that will be used by GRASS to set up its database:
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New Mapset

GRASS Database

Database directory |jhn mefmatteo/exercise_data/grassdata Browse...

GRASS data are stored in tree directory structure. The GRASS database is the
top-level directory in this tree structure.

| Mext > | Cancel

3. Click Next.

GRASS needs to create a Locat ion, which describes the maximum extent of the geographic area you’ll be working
in, also known as Grass Region.

Nota: the Region is extremely important for GRASS because it describes the area in which all layers will be taken
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into account for GRASS. Everything that is outside will not be considered. Don’t worry, you can always change the
extent of the GRASS Region after the Location has been created

1. Call the new location SouthAfrica:
New Mapset

GRASS Location

® Create new location |SouthAfrica

The GRASS location is a collection of maps for a particular territory or project.

< Back Next > | Cancel

2. Click Next.

3. We'll be working with WGS 84, so search for and select this CRS:

368 Capitulo 12. Module: GRASS



QGIS Training Manual

New Mapset
Projection

) Not defined

(8 Projection

Filter | ©. 4326

Recently used coordinate reference systems

Coordinate Reference System Authority ID

i
Coordinate reference systems of the world

Coordinate Reference System Authority ID

ID
Hide deprecated CRSs

~ & Geographic Coordinate Sy...
WGSs 84 EPSG:4326

4

Selected CRS 'WGS 84

Extent: -180.00, -90.00, 180.00, 90.00
Projd: +proj=longlat +datum=WGS84
+no_defs

< Back |’ Next = l| Cancel

4. Click Next.

5. Now select the region South Africa from the dropdown and click Set:
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New Mapset

Default GRASS Region

North |-21.27 |

13.68 | West East |33.98 |

South |-35.9 |

Set current QGIS extent | || South Africa - | [ Set ]

The GRASS region defines a workspace for raster modules. The default region is
valid for one location. It is possible to set a different region in each mapset. It is
possible to change the default location region later.

<Back || Next> | Cancel |

6. Click Next.

7. Create a mapset, which is the map file that you’ll be working with.
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New Mapset

Mapset

New mapset

grass_mapset

The GRASS mapset is a collection of maps used by one user. A user can read maps
from all mapsets in the location but he can open for writing only his mapset
{owned by user).

= Back | Next > | Cancel

Once you’re done, you'll see a dialog asking with a summary of all the information entered.
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New Mapset

Create New Mapset

Database : /home/matteo/exercise_data/grassdata

Location : SouthAfrica

Mapset : grass_mapset

v Open new mapset

< Back | Finish | Cancel

8. Click Finish.

9. Click OK on the success dialog.

You will see that the GRASS Panel will become active and you can start to use all GRASS tools.
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12.1.3 Follow Along: Loading Vector Data into GRASS

You have now a blank map and before you can start to use all the GRASS tools you have to load data into the GRASS
database, specifically into the Mapset. You cannot use GRASS tools with layer that are not loaded into a GRASS
Mapset.

There are many different ways to load data in the GRASS database. Let’s start with the first one.

Follow Along: Load data using the QGIS Browser

In section 7]l The Browser Panel we saw that the easiest and quickest way to load the data in QGIS is the Browser
Panel.

GRASS data are recognized from the QGIS Browser as real GRASS data and you can notice it because you will see

the GRASS icon next to the GRASS Mapset. Moreover you will see the %% icon next to the Mapset that is opened.

Browser (&) (]
L &THO
d Favorites m
= B9 training manual
v B forms

~ B8 grass
~ B9 grassdata

v [ SouthAfrica
* & SouthAfrica
& grass_mapset
b PERMANENT

v [ postgis
v [ processing
v [ projected data
v [ ggis-server-tutorial-data

Nota: You will see a replication of the GRASS Location as normal folder: GRASS Mapset data are those within
the ¥ folder

You can easily drag and drop layers from a folder to the GRASS Mapset.
Let’s try to import the roads layer into the grass_mapset Mapset of the SouthAfrica Location.

Go to the Browser, and simply drag the roads layer from the t raining_data . gpkg GeoPackage file into the
grass_mapset Mapset.
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Browser (&) (]
LT ™O
Y |
* [ exercise data 1=
5 forms
v 5 grass

v [ grassdata
» 5 SouthAfrica
* 4 SouthAfrica

» ¢ grass_mapset
(= reclass_aspect.txt
(~ reclass_g_dem.kxt
network_analysis
plugins
poskgis
processing
projected data
qgis-server-tutorial-data
raster
school_property _photos
shapefile
styles
symbols
world

() example
» =l landuse.sqlite
* = training_data.gpkg

- buildings
= restaurankts

. roads = |

b . . . . . . .

FAR AR AR AR AR AW AN AW AN AW AN

v v

1 b

That’s it! If you expand the Mapset you will see the imported roads layer. You can now load in QGIS the imported
layer like all the other layers.

Dica: You can also load layers from the Layer Legend Panel to Mapset in the Browser Panel. This will speed up
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incredibly your workflow!

Follow Along: Load data using the GRASS Panel

We will use now the long method to load the rivers. shp layer into the same Mapset.

1. Load data into QGIS as usual. Use the rivers.shp dataset (found in the exercise_data/
shapefile/ folder)

2. Assoon as it is loaded, click on the Filter box of the GRASS Panel and find the vector import tool by entering
the term v.in.ogr.ggis:

Aviso: There are 2 similar tools: v.in.ogr.ggisand v.in.ogr.ggis.loc. We are looking for
the first one.

GRASS Tools: SouthAfrica/grass_mapset (&

Modules | Region [G]cClose mapset

: | Filter |v.in.ogr.ggis ’?|

* GRASS MODULES
+ (Create new GRASS location and transfer data into it
~ Create new GRASS location from vector data
/ .. v.in.ogr.ggis.loc
' Import loaded vector and create a fitted location
+ File management
+ Import into GRASS
+ Import vector into GRASS
/ .. Vv.in.ogr.ggis
' Import loaded vector

The v stands for vector, in means a function to import data into the GRASS database, ogr is the software
library used to read vector data, and ggis means that the tool will look for a vector from among the vectors
already loaded into QGIS.

3. Once you've found this tool, click on it to bring up the tool itself. Choose the rivers layer in the Loaded Layer
box and type and name it g_rivers to prevent confusion:
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GRASS Tools: SouthAfrica/grass mapset () (]

Modules = Region ¥ [G]close mapset

Module: v.in.ogr.qqgis

Options | Output = Manual

Loaded layer

rivers v

Password

Mame for output vector map

| g_fivers

Show advanced options >=

Run Close

Nota: Note the extra import options provided under Advanced Options. These include the ability to add a
WHERE clause for the SQL query used for importing the data.

4. Click Run to begin the import.
5. When it’s done, click the View output button to see the newly imported GRASS layer in the map.

6. Close first the import tool (click the Close button to the immediate right of View output), then close the GRASS
Tools window.

7. Remove the original rivers layer.

Now you are left with only the imported GRASS layer as displayed in your QGIS map.
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12.1.4 Follow Along: Loading Raster Data into GRASS

You can import a raster layer in the same ways we imported vector layers.

We are going to import in the GRASS Mapset the layer srtm_41_19_4326.t1if.

Nota: the raster layer is already in the correct CRS, WGS 84. If you have layers in different CRS you must reproject
them in the same CRS of the GRASS Mapset

1. Load the srtm_41_19_4326.t1if layerin QGIS
Open the GRASS Tools dialog again.
Click on the Modules List tab.

Search for r.in.gdal.ggis and double click the tool to open the tool’s dialog.

A

Set it up so that the input layer is srtm_41_19_4326.t1if and the output is g_dem.
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GRASS Tools: SouthAfrica/grass_mapset (=) (%)
Meodules  Region | T ¥ |@{:Inse mapset |

Module: r.in.gdal.qqgis

Options | Output ~ Manual

Loaded layer

|srtm_41_19_4326 - |

Password

Name for output raster map

|g_dem

'Show advanced options >>

Run | |View output| | Close |

6. Click Run.
7. When the process is done, click View output.

8. Close the current tab, and then Close the whole dialog.
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9. You may now remove the original srtm_41_19_4326.tif layer.

12.1.5 Try Yourself Add Layers to Mapset

Try to import in the GRASS Mapset the vector layers water.shp and places.shp from the
exercise_data/shapefile/ folder. As we did for rivers rename the imported layer as g_water and
g_places to avoid confusion

Answer

You can add layers (both vector and raster) into a GRASS Mapset by drag and drop them in the Browser (see 777
Follow Along: Load data using the QGIS Browser) or by usingthe v.in.gdal.ggis forvectorand r.in.gdal.
aggis for raster layers.

12.1.6 Open an existing GRASS Mapset

If you have an existing GRASS Mapset you can easily reopen it in another session of QGIS.
You have several method to open a GRASS Mapset, let’s explore some of them.

Let’s close the Mapset by clicking on the Close Mapset button of the GRASS Tools window.

Follow Along: Using the GRASS plugin

1. Click on the Plugins —> GRASS —> Open Mapset menu next to the Plugins —> GRASS —> New Mapset menu
that we saw in the previous section.

2. Browse to the GRASS database folder: be careful! You must choose the parent folder, not the GRASS Mapset
one. Indeed GRASS will read all the Locat ions of the database and all the Mapset s of each Location:
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Select GRASS Mapset

Gisdbase g manual data/grass/grassdata| | Browse...

Location | SouthAfrica -

Mapset grass_mapset -

@ Cancel @QK

3. Choose the Locat ion SouthAfrica and the Mapset grass_mapset that we have created before.

That’s it! The GRASS Panel will become active meaning that the Mapset has been correctly opened.

Follow Along: Using the QGIS Browser

Even faster and easier is opening a Mapset using the QGIS Browser:
1. Close the Mapset (if it is open) by clicking on the Close Mapset button of the GRASS Tools window.
2. In the QGIS Browser, browse to the folder of the GRASS database.
3. Right click on the Mapset (remember, the Mapset has the ' GRASS icon next to it). You will see some
options.

4. Click on Open mapset:
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Browser
L&ETHO
- Favorites
~ B9 training manual
v [ forms
~ B grass

-~ B9 grassdata
v [ SouthAfrica
* & SouthaAfrica

I:IF-EIEE [aalatalnlats

» & PERMA Add as a Favorite

[l postgis Properties...

EJ processing Hide from Browser
[l projected _data

[ qgis-server-tutor
B raster GRASS Options

5 s soper T S
[l shapefiles

Mew Point Layer

Fast Scan this Directory

b . . T . . . . .

B styles _

H symbols MNew Line Layer

[ world Mew Polygon Layer

() example N
» [ Home

» B/

v &% GeoPackage
£ SpatiaLite
@ Postais
B mssqL

The Mapset is now open and ready to use!

Dica: Right click on a GRASS Mapset offers you a lot of different settings. Try to explore them and see all the
useful options.
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12.1.7 In Conclusion
The GRASS workflow for ingesting data is somewhat different from the QGIS method because GRASS loads its data

into a spatial database structure. However, by using QGIS as a frontend, you can make the setup of a GRASS mapset
easier by using existing layers in QGIS as data sources for GRASS.

12.1.8 What’s Next?

Now that the data is imported into GRASS, we can look at the advanced analysis operations that GRASS offers.

12.2 Lesson: GRASS Tools

In this lesson we will present a selection of tools to give you an idea of the capabilities of GRASS.

12.2.1 Follow Along: Create an aspect map

1. Open the GRASS Tools tab
2. Load the g_dem raster layer from the grass_mapset Mapset
3. Look for the r.aspect module by searching for it in the Filter field of the Modules List tab

4. Open the tool and set it up like this and click on the Run button:
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GRASS Tools: SouthAfrica/grass_mapset (¥ %)
Modules Region @ M [G]close mapset
Module: r.aspect
Options | Qutput = Manual
Name of input elevation raster map
g_dem * ||
Mame for output aspect raster map
g_aspect |
Run Close
5. When the process is finished click on View Output to load the resulting layer in the canvas:
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The g_aspect layer is stored within the grass_mapset Mapset so you can remove the layer from the canvas and
reload it whenever you want.

12.2.2 Follow Along: Get basic statistic of raster layer

We want to know some basic statistics of the g_dem raster layer.
1. Open the GRASS Tools tab
2. Load the g_dem raster layer from the grass_mapset Mapset
3. Look for the r.info module by searching for it in the Filter field of the Modules List tab
4. Set up the tool like this and click on Run:
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GRASS Tools: SouthAfrica/grass_mapset

Modules Region i O

Module: r.info

Options | OQutput = Manual

Name of raster map

(& )

[G]close mapset

g_dem

Print raster history instead of info

Print extended metadata information in shell script style

Run

Close

5. Within the Output tab you will see some raster information printed, like the path of the file, the number of

rows and columns and other useful information:
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GRASS Tools: SouthAfricafgrass_mapset @ )
Modules Region i O [@]close mapset

Module: r.info

Options | Output | Manual

r.info map=g_dem@grass_mapset

| Map: g_dem@grass_mapset Date: Mon Aug 6 10:48:55 2018 |
| Mapset: grass _mapset Login of Creator: matteo |
| Location: SouthAfrica |
| DataBase: fhome/matteo/exercise datafgrass/grassdata |
| Title: g_dem |
| Timestamp: none |

Type of Map: raster Number of Categories: @
Data Type: FCELL

Rows : 619

Columns: 919

I I
I I
I I
I I
I I
| Total Cells: 568861 |
| Projection: Latitude-Longitude |
| M: 33:45:02.7900255 S: 34:16:12.8387725 Res: 0:80:03.01978 |
| E: 20:50:22.030235E W: 20:04:06.845095E Res: 0:88:03.01978 |
| Range of data: min = @ max = 1699 |
I I
| Data Description: |
| generated by r.in.gdal |
I I
I I
I I
I I
I I
I I

Comments:
r.in.gdal input="/home/matteo/lavori/miei/grant tm/0GIS-Training-Dath,

a/training manual data/raster/SRTM/srtm 41 19 4326.tif" output="g de\
m" memory=300 offset=0 num_digits=0

Successfully finished

12.2.3 Follow Along: The Reclass Tool

Reclassifying a raster layer is a very useful task. We just created the g_aspect layer from the g_dem one. The
value range gets from O (North) passing through 90 (East), 180 (South), 270 (West) and finally to 360 (North again).
We can reclassify the g_aspect layer to have just 4 categories following specific rules (North = 1, East = 2, South
=3 and West = 4).

Grass reclassify tool accepts a t xt file with the defined rules. Writing the rules is very simple and the GRASS Manual
contains very good description.

Dica: Each GRASS tool has its own Manual tab. Take the time to read the description of the tool you are using to
don’t miss some useful parameters

1. Load the g_aspect layer or, if you don’t have create it, go back to the ?J7[7] Follow Along: Create an aspect
map section.
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2. Look for the r.reclass module by searching for it in the Filter field of the Modules List tab

3. Open the tool and set it up like the following picture. The file containing the rules is in the exercise_data/
grass/ folder, named reclass_aspect.txt.
4. Click on Run and wait until the process is finished:

GRASS Tools: SouthAfrica/grass_mapset &
Modules  Region 4 1 [G]close mapset

Module: r.reclass

Options | OQutput = Manual

Name of raster map to be reclassified

g_aspect -1
File containing reclass rules
fhome/matteo/exercise_data/grass/reclass_aspect.txt
Name for output raster map
|g_reclassified
Run Close

5. Click on View Output to load the reclassified raster in the canvas

The new layer is made up by just 4 values (1, 2, 3, and 4) and it is easier to manage and to process.
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Dica: Open the reclass_aspect.txt with a text editor to see the rules and to start becoming used to them.
Moreover, take a deep look at the GRASS manual: a lot of different examples are pointed out.

12.2.4 Try Yourself Reclassify with your rules

Try to reclassify the g_ dem layer into 3 new categories:
¢ from 0 to 1000, new value = 1
¢ from 1000 to 1400, new value = 2

¢ from 1400 to the maximum raster value, new value = 3

Answer

To discover the maximum value of the raster run the r . info tool: in the console you will see that the maximum
value is 1699. You are now ready to write the rules.

1. Open a text editor and add the following rules:

0 thru 1000 = 1
1000 thru 1400 = 2
1400 thru 1699 = 3

2. Save the file as my_rules.txt file and close the text editor.
3. Runthe r.reclass tool: choose the g_dem layer and load the file containing the rules you just have saved.

4. Click on Run and then on View Output. You can change the colors and the final result should look like the
following picture:
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12.2.5 Follow Along: The Mapcalc Tool

The Mapcalc tools is similar to the Raster Calculator of QGIS. You can perform mathematical operation on one or
more raster layers and the final result will be a new layer with the calculated values.

The aim of

the next exercise is to extract the values greater than 1000 from the g_ dem raster layer.

1. Look for the r.mapcalc module by searching for it in the Filter field of the Modules List tab.

2. Start

the tool.

The Mapcalc dialog allows you to construct a sequence of analyses to be performed on a raster, or collection
of rasters. You will use these tools to do so:

B oy & » Iy 4

In order, they are:

Add map: Add a raster file from your current GRASS mapset.
Add constant value: Add a constant value to be used in functions, 1000 in this case

Add operator or function: Add an operator or function to be connected to inputs and outputs, we will use
the operator greater equals than

Add connection: Connect elements. Using this tool, click and drag from the red dot on one item to the
red dot on another item. Dots that are correctly connected to a connector line will turn gray. If the line
or dot is red, it is not properly connected!

Select item: Select an item and move selected items.

Delete selected item: Removes the selected item from the current mapcalc sheet, but not from the mapset
(if it is an existing raster)

Open: Open an existing file with the operation defined
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* Save: Save all the operation in a file

* Save as: Save all the operations as a new file on the disk.

3. Using these tools, construct the following algorithm:

GRASS Tools: SouthAfrica/grass_mapset

Modules ] Region ‘ = I

[G]close mapset

Module: r.-mapcalc

Options [ Output [ Manual l

B¢ soEEH

Output

Output |g_dem_1000

]

Run

] |View |:-ut|:n..t| [ Close ]

4. Click on Run and then on View output to see the output displayed in your map:
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This shows all the areas where the terrain is higher than 1000 meters.

Dica: You can also save the formula you have created and load it in another QGIS project by clicking on the last
button on the GRASS Mapcalc toolbar.

12.2.6 In Conclusion

In this lesson, we have covered only a few of the many tools GRASS offers. To explore the capabilities of GRASS
for yourself, open the GRASS Tools dialog and scroll down the Modules List. Or for a more structured approach, look
under the Modules Tree tab, which organizes tools by type.
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Module: Assessment

Use your own data for this section. You will need:
* a point vector dataset of points of interest, with point names and multiple categories
* aline vector dataset of roads
* a polygon vector dataset of land use (using property boundaries)
e avisual-spectrum image (such as an aerial photograph)

* a DEM (downloadable from the CGIAR-CSI if you don’t have your own)

13.1 Create a base map

Before doing any data analysis, you will need a base map, which will provide your analysis result with context.

13.1.1 Add the point layer

¢ Add in the point layer. Based on the level that you're doing the course at, do only what is listed in the appropriate
section below:

 Label the points according to a unique attribute, such as place names. Use a small font and keep the labels
inconspicuous. The information should be available, but shouldn’t be a main feature of the map.

¢ Classify the points themselves into different colors based on a category. For example, categories could include
«tourist destination», «police station», and «town center».
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¢ Do the same as the section.

* Classity the point size by importance: the more significant a feature, the larger its point. However, don’t exceed
the point size of 2. 00.

* For features that aren’t located at a single point (for example, provincial/regional names, or town names at a
large scale), don’t assign any point at all.

* Don’t use point symbols to symbolize the layer at all. Instead, use labels centered over the points; the point
symbols themselves should have no size.

» Use Data defined settings to style the labels into meaningful categories.

¢ Add appropriate columns to the attribute data if necessary. When doing so, don’t create fictional data - rather,
use the Field Calculator to populate the new columns, based on appropriate existing values in the dataset.

13.1.2 Add the line layer

* Add the road layer and then change its symbology. Don’t label the roads.

* Change the road symbology to a light color with a broad line. Make it somewhat transparent as well.

* Create a symbol with multiple symbol layers. The resulting symbol should look like a real road. You can use
a simple symbol for this; for example, a black line with a thin white solid line running down the center. It can
be more elaborate as well, but the resulting map should not look too busy.

« If your dataset has a high density of roads at the scale you want to show the map at, you should have two road
layers: the elaborate road-like symbol, and a simpler symbol at smaller scales. (Use scale-based visibility to
make them switch out at appropriate scales.)

* All symbols should have multiple symbol layers. Use symbols to make them display correctly.

¢ Do the same as in the section above.

¢ In addition, roads should be classified. When using realistic road-like symbols, each type of road should have
an appropriate symbol; for example, a highway should appear to have two lanes in either direction.
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13.1.3 Add the polygon layer

¢ Add the land use layer and change its symbology.

¢ Classify the layer according to land use. Use solid colors.

¢ Classify the layer according to land use. Where appropriate, incorporate symbol layers, different symbol types,
etc. Keep the results looking subdued and uniform, however. Keep in mind that this will be part of a backdrop!

 Use rule-based classification to classify the land use into general categories, such as «urban», «rural», «nature
reserve», etc.

13.1.4 Create the raster backdrop

¢ Create a hillshade from the DEM, and use it as an overlay for a classified version of the DEM itself. You could
also use the Relief plugin (as shown in the lesson on plugins).

13.1.5 Finalize the base map

» Using the resources above, create a base map using some or all of the layers. This map should include all the
basic information needed to orient the user, as well as being visually unified / «simple».

13.2 Analyze the data

* You are looking for a property that satisfies certain criteria.
* You can decide on your own criteria, which you must document.
* There are some guidelines for these criteria:
— the target property should be of (a) certain type(s) of land use
— it should be within a given distance from roads, or be crossed by a road

— it should be within a given distance from some category of points, like a hospital for example

13.2.1 /

¢ Include raster analysis in your results. Consider at least one derived property of the raster, such as its aspect or
slope.
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13.3 Final Map

» Use the Print Layout to create a final map, which incorporates your analysis results.

¢ Include this map in a document along with your documented criteria. If the map has become too visually busy
due to the added layer(s), deselect the layers which you feel are the least necessary.

* Your map must include a title and a legend.
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Module: Forestry Application

In modules 1 through 13, you have already learned quite a lot about QGIS and how to work with it. If you are
interested in learning about some basic forestry applications of GIS, following this module will give you the ability
to apply what you have learned and will show you some new useful tools.

European Union
European Regional Development Fund
European Social Fund

The development of this module has been sponsored by the European Union.

14.1 Lesson: Forestry Module Presentation

Following this module about a forestry application requires the knowledge you have learned through the modules 1
to 11 of this training manual. The exercises in the following lessons assume you are already capable of doing many
of the basic operations in QGIS and only tools that have not been used before are presented in more detail.

Nevertheless, the module follows a basic level throughout the lessons so that if you have previous experience with
QGIS, you can probably follow the instructions without problems.

Note that you need to download an additional data package for this module.
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14.1.1 Forestry Sample Data

Nota: The sample data used in this module is part of the training manual data set and is available in the
exercise_data\forestry)\ folder.

The forestry related sample data (forestry map, forest data), has been provided by the EVO-HAMK forestry school.
The datasets have been modified to adapt to the lessons needs.

The general sample data (aerial images, LIDAR data, basic maps) has been obtained from the National Land Survey
of Finland open data service, and adapted for the purposes of the exercises. The open data file download service can
be accessed in English here.

Aviso: As for the rest of the training manual, this module includes instructions on adding, deleting and altering
GIS datasets. We have provided training datasets for this purpose. Before using the techniques described here on
your own data, always ensure you have proper backups!

14.2 Lesson: Georeferencing a Map

A common forestry task would be the update of the information for a forestry area. It is possible that the previous
information for that area dates several years back and was collected analogically (that is, in paper) or perhaps it was
digitized but all you have left is the paper version of that inventory data.

Most likely you would like to use that information in your GIS to, for example, compare later with later inventories.
This means that you will need to digitize the information at hand using your GIS software. But before you can start
the digitizing, there is an important first step to be done, scanning and georeferencing your paper map.

The goal for this lesson: To learn to use the Georeferencer tool in QGIS.

14.2.1 Scan the map

The first task you will have to do is to scan your map. If your map is too big, then you can scan it in different parts
but keep in mind that you will have to repeat preprocessing and georeferencing tasks for each part. So if possible,
scan the map in as few parts as possible.

If you are going to use a different map that the one provided with this manual, use your own scanner to scan the map
as an image file, a resolution of 300 DPI will do. If your map has colors, scan the image in color so that you can
later use those colors to separate information from your map into different layers (for ex., forest stands, contour lines,
roads...).

For this exercise you will use a previously scanned map, you can find it as raut jarvi_map.t1if in the data folder
exercise_data/forestry
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14.2.2 Follow Along: Georeferencing the scanned map

1. Open QGIS and set the project’s CRS to EPSG:3067 — ETRS89 / TM35FIN(E,N) in Project »
Properties » CRS, which is the currently used CRS in Finland.

Project Properties — CRS X

Q

Project Coordinate Reference System (CRS)

\‘-....___ General

No CRS (or unknown/non-Earth projection)

E Metadata Filcer | &

Recently Used Coordinate Reference Systems

View Settings

Coordinate Reference System Authority ID
@ CRS ETRS89 / TM35FIN(E,N) EPSG:3067
. KKJ /Finland zone 2 EPSG:2392
#% Transformations NAD27 / Alaska Albers EPSG:2964
% Default Styles
[==]
B8 Data Sources ; .
EE Relations Predefined Coordinate Reference Systems Hide deprecated CRSs
Variabl Coordinate Reference System Authority ID =
ariasies ETRS89 / TM26 EPSG:3038
@ M ETRS89 / TM27 EPSG:3039
K acros :
~ ETRS89 / TM35FIN(E,N) EPSG:3067
=%, QGIS Server ETRS89 / TM35FIN(N,E) EPSG:3902 =
. L] 2
G‘ Temporal ETRS89 / TM35FIN(E,N) =
Properties . <
* Uniks: meters o
* Static (relies on a datum which is plate-fixed) P?_i-"

* Method: Universal Transverse Mercator %

@Help @~apply || Dcancel

2. Save the QGIS project as map_digitizing.qggs.

You will use the georeferencing tool from QGIS named Georeferencer. To georeference the map:

1. Open the georeference tool, Layer » jj: Georeferencer....
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Georeferencer - o &
File Edit View Settings
AU N '."_'\I
B> e 2%s UL LD
GCP table B
Rotation | 0.0 *® 2| Transform: Mot set 639,1 EPSG:

2. Add the map image file, raut jarvi_map.tif, as the image to georeference, File » Open raster.
3. Click OK.
Next you should define the transformation settings for georeferencing the map:
1. Open Settings » Transformation settings.
2. Set the Transformation type to Linear and the Resampling method to Nearest neighbour.
3. Press the 5:3}, Select CRS putton next to the Target SRS option and select the EPSG:2392 — KKJ / Finland
zone 2 CRS; it is the CRS that was used in Finland back in 1994 when this map was created.

4. Click the icon next to the Qutput raster box, go to the folder and create the folder exercise_data\
forestry\digitizing and name the file as raut jarvi_georef.tif.

5. Check ® Load in QGIS when done

6. Leave the rest of parameters as default.
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Transformation Settings X

Transformation Parameters

Transformation type | Linear b
Resampling method | Nearest neighbour -
Target SRS EPSG:2392 - KKJ / Finland zone 2 v || @

Output Settings

Output raster afForestry/digitizing/rautjarvi_georef.tif
Compression None v
Save GCP points
Create world file only (linear transforms)
Use 0 for transparency when needed

Set target resolution

Reports

Generate PDF map

Generate PDF report

¥| Load in QGIS when done

©Help ©cancel Qok

7. Click OK.

The map contains several cross-hairs marking the coordinates in the map, we will use those to georeference this image.
You can use the zooming and panning tools as you usually do in QGIS to inspect the image in the Georeferencer’s
window.

1. Zoom in to the left lower corner of the map and note that there is a cross-hair with a coordinate pair, X and Y,
that as mentioned before are in KKJ / Finland zone 2 CRS. You will use this point as the first ground
control point for the georeferencing your map.

2. Select the Add point tool and click in the intersection of the cross-hairs (pan and zoom as needed).

3. In the Enter map coordinates dialogue write the coordinates that appear in the map (X: 2557000 and Y:
6786000) and their CRS (EPSG:2392 — KKJ / Finland zone 2)

Enter Map Coordinates X

Enter X and Y coordinates (DMS (dd mm ss.ss), DD (dd.dd) or projected coordinates (mmmm.mm))
which correspond with the selected point on the image. Alternatively, click the button with icon of a
pencil and then click a corresponding point on map canvas of QGIS to Fill in coordinates of that point.

X /East 2557000
Y / North 6786000
EPSG:2392 - KKJ / Finland zone 2 v ||

v| Automatically hide georeferencer window

# From Map Canvas | | @Cancel QoK

4. Click OK.
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The first coordinate for the georeferencing is now ready.

5. Look for other black cross-hairs in the image, they are separated 1000 meters from each other both in North
and East direction. You should be able to calculate the coordinates of those points in relation to the first one.

6. Zoom out in the image and move to the right or the top until you find other cross-hair, and estimate how many
kilometres you have moved. Try to get ground control points as far from each other as possible.

7. Digitize at least three more ground control points in the same way you did the first one. You should end up
with something similar to this:

I

.7 Georeferencer - rautjarvi_map.tif iz o[22 |[g]
File Edit WView Settings Help
— o
B> 53658 @ 363038 OPL -~ fie~
GCP table
on/foff id src srcY dsty dsty d¥ [pixels] df [pixels]
» a 473,10 -4352.93 | 2557000.00 [&786000.00 7.65 4.95
»® 1 2838.78 | -3185.77 | 2559000.00 | &737000,00 5.58 -7.35
» 2 2849,87| -825.55 | 2559000,00 |&739000.00 -5.51 -6.06
o 3 438.49 | -811.03| 2557000.00 Largzlimi =173 3.45
| Translation (2, 5565%e+06, 6, 79222 +06) Scale (0.846165, 1.28642) Rotation: 0 Mez J875,-5025 |EI Yy
3

With already three digitized ground control points you will be able to see the georeferencing error as a red line coming
out of the points. The error in pixels can be seen also in the GCP table in the dX[pixels] and dY[pixels] columns. The
error in pixels should not be higher than 10 pixels. If it is, you should review the points you have digitized and the
coordinates you have entered to find what the problem is. You can use the image above as a guide.
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Once you are happy with your control points, you can save them for later use:
1. Go to File » Save GCP points as....

2. In the folder exercise_data\forestry\digitizing, name the file rautjarvi_map.tif.
points.

Finally, georeference your map:
1. Go to File » Start georeferencing.

2. Note that you named the file already as raut jarvi_georef.tif when you edited the Georeferencer
settings.

Now you can see the map in QGIS project as a georeferenced raster. Note that the raster seems to be slightly
rotated, but that is simply because the datais in KKJ / Finland zone 2 and your projectisin ETRS89
/ TM35FIN(E,N).

3. To check that your data is properly georeferenced, you can

1. Open the aerial image in the exercise_data\forestry folder, named raut jarvi_aerial.
tif.

2. Your map and this image should match quite well: set the map transparency to 50% and compare it to
the aerial image.
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4. Save the changes to your QGIS project, you will continue from this point for the next lesson.
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14.2.3 In Conclusion

You have now georeferenced a paper map, making it possible to use it as a map layer in QGIS.

14.2.4 What’s Next?

In the next lesson, you will digitize the forest stands in your map as polygons and add the inventory data to them.

14.3 Lesson: Vectorizacao de Povoamentos Florestais

Unless you are going to use your georeferenced map as a simple background image, the next natural step is to digitize
elements from it. You have already done so in the exercises about creating vector data in Lesson: Creating a New
Vector Dataset, when you digitized the school fields. In this lesson, you are going to digitize the forest stands” borders
that appear in the map as green lines but instead of doing it using an aerial image, you will use your georeferenced
map.

The goal for this lesson: Learn a technique to help the digitizing task, digitizing forest stands and finally adding the
inventory data to them.

14.3.1 Follow Along: Extracting the Forest Stands Borders

Open your map_digitizing.qggs project in QGIS, that you saved from the previous lesson.

Once you have scanned and georeferenced your map you could start to digitize directly by looking at the image as a
guide. That would most likely be the way to go if the image you are going to digitize from is, for example, an aerial
photograph.

If what you are using to digitize is a good map, as it is in our case, it is likely that the information is clearly displayed
as lines with different colors for each type of element. Those colors can be relatively easy extracted as individual
images using an image processing software like GIMP. Such separate images can be used to assist the digitizing, as
you will see below.

The first step will be to use GIMP to obtain an image that contains only the forest stands, that is, all those greenish
lines that you could see in the original scanned map:

1. Open GIMP (if you don’t have it installed yet, download it from the internet or ask your teacher).

2. Open the original map image, File » Open, raut jarvi_map.tif intheexercise_data/forestry
folder. Note that the forest stands are represented as green lines (with the number of the stand also in green
inside each polygon).
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3. Now you can select the pixels in the image that are making up the forest stands” borders (the greenish pixels):
1. Open the tool Select » By color.

2. With the tool active, zoom into the image (Ctr1 + mouse wheel) so that a forest stand line is close
enough to differentiate the pixels forming the line. See the left image below.

3. Click and drag the mouse cursor in the middle of the line so that the tool will collect several pixel color
values.

4. Release the mouse click and wait a few seconds. The pixels matching the colors collected by the tool will
be selected through the whole image.

5. Reduza o zoom para ver como os pixeis esverdeados foram seleccionadas em toda a imagem.
6. Se vocé ndo estd feliz com o resultado, repita o clique e operagdo de arrastar.

7. O pixel que seleccionou deve ser algo como a imagem mostra abaixo.
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4. Se ndo estd feliz com o resultado, repita o clique e operacdo de arrastar.
1. Copy (Ctr1+C or Edit » Copy) the selected pixels.

2. And paste the pixels directly as a new layer (Edit » Paste as » New Layer). GIMP will display the pasted
pixels as a new layer (Pasted Layer) in the Layers panel.

3. Click the «eye» icon next to the original image layer to switch it off, so that only the Pasted Layer is
visible:

[ X X ] *[rautjarvi_map] (imported)-6.0 (RGB color 8-bit gamma integer, GIMP built-in sRGB, 2 layers) 3507x4960 - GIMP

o
B/ Devices - Undo [l]lm-qss ]

[ ] e

@l ® - 150$PasheﬂLayer{4a4.ﬂMB} F m oA v B

>l
[
X
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5. Finally, select File » Export As..., set Select File Type (By Extension) as a TIFF image, select the digitizing
folder and name it raut jarvi_map_green.tif. Select no compression when asked.

You could do the same process with other elements in the image, for example extracting the black lines that represent
roads or the brown ones that represent the terrain” contour lines. But for us, the forest stands is enough.

14.3.2 Try Yourself Georeference the Green Pixels Image
As you did in the previous lesson, you need to georeference this new image to be able to use it with the rest of your
data.

Note that you don’t need to digitize the ground control points anymore because this image is basically the same image
as the original map image, as far as the Georeferencer tool is concerned. Here are some things you should remember:

¢ This image is also, of course, in KKJ / Finland zone 2 CRS.

* You should use the ground control points you saved, File » Load GCP points.

¢ Remember to review the Transformation settings.

* Name the output raster as raut jarvi_green_georef.tif inthe digitizing folder.

Check that the new raster is fitting nicely with the original map.

14.3.3 Follow Along: Creating Supporting Points for Digitizing

Having in mind the digitizing tools in QGIS, you might already be thinking that it would be helpful to snap to those
green pixels while digitizing. That is precisely what you are going to do next create points from those pixels to use
them later to help you follow the forest stands” borders when digitizing, by using the snapping tools available in QGIS.

1. Use the Raster » Conversion » Polygonize (Raster to Vector) tool to vectorize your green lines to polygons. If
you don’t remember how, you can review it in Lesson: Raster to Vector Conversion.

2. Save as raut jarvi_green_polygon. shp inside the digitizing folder.

3. Zoom in and see what the polygons look like. You will get something like this:
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4. Next option to get points out of those polygons is to get their centroids:
1. Open Vector » Geometry Tools » Centroids....

2. Set Input Layer to = rautjarvi_green_polygon (the polygon layer you have just created)

3. Set Centroids output to green_centroids. shp file within the folder digitizing

4. Check oA Open output file after running algorithm

5. Press Run. This will calculate the centroids for the polygons as a new layer and add it to the project.
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5. Now you can remove the L~ raut jarvi_green_polygon layer from the TOC.

6. Change the symbology of the centroids layer as follows:
[

1. Open the Layer Properties for = green_centroids.
2. Go to the Symbology tab.
3. Set Size to 1. 00 and choose Map Units

It is not necessary to differentiate points from each other, you just need them to be there for the snapping tools to use
them. You can use those points now to follow the original lines much easily than without them.
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14.3.4 Follow Along: Digitize the Forest Stands

Now you are ready to start with the actual digitizing work. You would start by creating a vector file of polygon type,
but for this exercise, there is a shapefile with part of the area of interest already digitized. You will just finish digitizing
the half of the forest stands that are left between the main roads (wide pink lines) and the lake:

Wiilinka

Hiémeenlinnaan

1. Go to the digitizing folder using your file manager browser.
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2. Drag and drop the forest_stands. shp vector file to your map.
3. Change the new layer’s symbology so that it will be easier to see the polygons that have already been digitized.
1. Set Fill color to green - and change the Opacity to 50%.
2. Select Simple Fill and set Stroke widthto 1 .00 mm.
Now, if you remember past modules, we have to set up and activate the snapping options:

1. Go to Project » Snapping options...

. Press @ Enable Snapping and select Advanced Configuration

. Check the green_centroids and forest_stands layers

2

3

4. Set Type for each layer to Vertex
5. Set Tolerance for each layer to 10
6

. Set Units for each layer to pixels
7. Check g Avoid Overlap for the forest_stands layer
8. Press | Topological editing

9. Choose @ Follow Advanced Configuration
10. Close the pop-up

Project Snapping Settings

| ‘% Advanced Configuration |[2 Disabled _  Topological Editing | ‘¥ Allow Overlap || Snapping on Intersection « Self-snapping
Layer Type Tolerance Units Avoid Overlap Min Scale Max Scale

vl ® green_centroids Vertex 10 pixels

v! [l forest_stands Vertex 10 pixels v

L Filter layers

With these snapping settings, whenever you are digitizing and get close enough to one of the points in the
centroids layer or any vertex of your digitized polygons, a pink square will appear on the point that will be
snapped to.

11. Finally, turn off the visibility of all the layers except forest_stands and rautjarvi_georef. Make sure that the
map image has not transparency any more.

A few important things to note before you start digitizing:
* Don't try to be too accurate with the digitizing of the borders.
« If a border is a straight line, digitize it with just two nodes. In general, digitize using as few nodes as possible.

e Zoom in to close ranges only if you feel that you need to be accurate, for example, at some corners or when
you want a polygon to connect with another polygon at a certain node.

* Use the mouse’s middle button to zoom in/out and to pan as you digitize.
« Digitize only one polygon at a time.
 After digitizing one polygon, write the forest stand id that you can see from the map.
Now you can start digitizing:
1. Locate the forest stand number 357 in the map window.

2. Select the forest_stands layer.
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3. Click the 5‘? Toggle Editing 1y,tton to enable editing

)
4. Select L Add Polyzon Feature 0]

5. Start digitizing the stand 357 by connecting some of the dots. Note the pink crosses indicating the snapping.

When you are done:
1. Right click to end digitizing that polygon.
2. Enter the forest stand /D within the form (in this case 357).
3. Click OK.

If a form did not appear when you finished digitizing the polygon, go to Settings » Options » Digitizing and make
sure that the Suppress attribute form pop-up after feature creation is not checked.

Your digitized polygon will look like this:
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Now for the second polygon, pick up the stand number 358. Make sure that i Avoid Overlap is checked for the
forest_stands layer (as shown above). This option ensures polygons do not overlap. So, if you digitize over an existing
polygon, the new polygon will be trimmed to meet the border of the existing polygons. You can use this option to
automatically obtain a common border.

1. Begin digitizing the stand 358 at one of the common corners with the stand 357.
2. Continue normally until you get to the other common corner for both stands.

3. Finally, digitize a few points inside polygon 357 making sure that the common border is not intersected. See
left image below.

4. Right click to finish editing the forest stand 358.
5. Enter the ID as 358.

6. Click OK. Your new polygon should have a common border with the stand 357 as you can see in the image
below.
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The part of the polygon that was overlapping the existing polygon has been automatically trimmed and you are left
with a common border - as you intended it to be.

14.3.5 Try Yourself Finish Digitizing the Forest Stands
Now you have two forest stands ready. And a good idea on how to proceed. Continue digitizing on your own until
you have digitized all the forest stands that are limited by the main road and the lake.

It might look like a lot of work, but you will soon get used to digitizing the forest stands. It should take you about 15
minutes.

During the digitizing you might need to edit or delete nodes, split or merge polygons. You learned about the necessary
tools in Lesson: Feature Topology, now is probably a good moment to go read about them again.

Remember that having Enable topological editing activated, allows you to move nodes common to two polygons so
that the common border is edited at the same time for both polygons.

Your result will look like this:
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14.3.6 Follow Along: Joining the Forest Stand Data

It is possible that the forest inventory data you have for you map is also written in paper. In that case, you would have
to first write that data to a text file or a spreadsheet. For this exercise, the information from the inventory for 1994
(the same inventory as the map) is ready as a comma separated text (csv) file.

1. Openthe raut jarvi_1994.csv file from the exercise_data\forestry directory in a text editor
and note that the inventory data file has an attribute called ID that has the numbers of the forest stands. Those
numbers are the same as the forest stands ids you have entered for your polygons and can be used to link
the data from the text file to your vector file. You can see the metadata for this inventory data in the file
rautjarvi_1994_legend.txt in the same folder.

2. Now add this file into the project:
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1. Use the ,ﬂ Add Delimited Text Layer 0] - This is accessed via Layer » Add Layer » Add Delimited Text

Layer....

2. Set details in the dialog as follows:

[ Browser
- g Vector Layer name |rautjarvi_1994
« Raster v File Format

2 \est
e ==l ® CSV (comma separated values)

4 Point Cloud

Regular expression delimiter

9, Delimited Text -
Custom delimiters

“4 GeoPackage

vm oo v Record and Fields Options
*

74 SpatiaLite Number of header lines to discard

4 PostgreSQL V! First record has field names

v| Detect field types

+ MSSQL Server

WA virtual Layer Custom boolean literals

& wvsmTs True
‘s WFS / OGC API - Features
& wes

XYz Point coordinates

v Geometry Definition

Vector Tile ‘Well known text (WKT)

ArcGIS REST Server ® No geometry (attribute only table)

& GeoNode » Layer Settings

Metadata Search Sample Data

1 |376 4
2 334 4
3 336 4
B Aide

1D Hab
1z3]nteger (32 bit) ~ | 123 Integer (32 bit) -

File name |/media/TRAVAIL/dev/github/QGIS-Training-Data/exercise_data/forestry/rautjarvi_1994.csv

Devl

ane Text (string) ~

Y1
S0

Data Source Manager — Delimited Text

Encoding |UTF-8

Decimal separator is comma

Trim fields

Discard empty fields

False
Age BA Vol MainSp MainPerc 5
123]nteger (32 bit) ~ | -2 Decimal (double) - | 123 Integer (32 bit) ~ | 12 Integer (32 bit) ~ | 122 Integer (32 bit) ~
0 0 0 0 0
15 74 54 1 100
0 0 0 1 0

3. Press Add to load the formatted csv file in the project.

v Add || @ Fermer

3. To link the data from the . csv file with the digitized polygons, create a join between the two layers:

1. Open the Layer Properties for the forest_stands layer.

2. Go to the Joins tab.

Set the Join field to ID
Set the Target field to ID

A

Click OK two times.

The data from the text file should be now linked to your vector file.

forest_stands layer and use =]

Select rautjarvi_1994.csv as the Join layer

Open Attribute Table

file are now linked to your digitized vector layer.

Click 71 Addnew join on the bottom of the dialog box.

To see what has happened, select the

. You can see that all the attributes from the inventory data

You will see that the field names are prefixed with raut jarvi_1994_. To change this:

1. Open the Layer Properties for the forest_stands layer.

2. Go to the Joins tab.

3. Select Join Layer rautjarvi_1994

4. Click the ¢/ Bditseleeted join 50 to enable editing

5. Under i Custom field name prefix remove the prefix name
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Add Vector Join

Join layer rautjarvi_1994 -
Join field 123 1D =
Target field abc ID -

v Cache join layer in memory
e ; FIou
Dynamic form

] Editable join layer
4 loined fields

w ¥ Custom field name prefix
i aide + Ok | & Annuler

The data from the . csv file is just linked to your vector file. To make this link permanent, so that the data is actually
recorded to the vector file you need to save the forest_stands layer as a new vector file. To do this:

1. Right click on forest_stands layer
. Choose Export » Save Features As...

2
3. Set Format to ESRI Shapefile
4

. Set file name to forest_stands_1994. shp under the forestry folder

5. To include the new file as a layer in the project, check oA Add saved file to map
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Save Vector Layer as...

Format ESRI Shapefile =
File name GIS-Training-Data/exercise_data/forestry/forest_stands_1994.shp &
Layer name

CRS EPSG:3047 - ETRS89 / UTM zone 35N (N-E) ik -

v Select fields to export and their export options

Name Export name Type Replace with displayed values
v/ 1D ID String
v/ Hab Hab integer Use Range
v| Devl Devl text
v Age Age integer Use Range
v/ BA BA double
v/ Vol Vol inteaer Use Ranae X
Select All Deselect All

Use aliases for exported name

Replace all selected raw field values by displayed values

¥| Persist layer metadata
» Geometry

» v Extent (current: layer)
» Layer Options

>

Custom Options

H Aide v Add saved file to map ~ Ok © Annuler

14.3.7 Try Yourself Adding Area and Perimeter

To finish gathering the information related to these forest stands, you might calculate the area and the perimeter of
the stands. You calculated areas for polygons in Lesson: Supplementary Exercise. Go back to that lesson if you need
to and calculate the areas for the forest stands. Name the new attribute Area and make sure that the values calculated
are in hectares. You could also do the same for the perimeter.

Now your forest_stands_1994 layer is ready and packed with all the available information.

Save your project to keep the current map layers in case you need to come back later to it.
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14.3.8 In Conclusion

It has taken a few clicks of the mouse but you now have your old inventory data in digital format and ready for use in
QGIS.

14.3.9 What’s Next?

You could start doing different analysis with your brand new dataset, but you might be more interested in performing
analysis in a dataset more up to date. The topic of the next lesson will be the creation of forest stands using current
aerial photos and the addition of some relevant information to your dataset.

14.4 Lesson: Updating Forest Stands

Now that you have digitized the information from the old inventory maps and added the corresponding information
to the forest stands, the next step is to create the inventory of the current state of the forest.

You will digitize new forest stands using an aerial photo. As with the previous lesson, you will use an aerial Color
Infrared (CIR) photograph. This type of imagery, where the infrared light is recorded instead of the blue light, is
widely used to study vegetated areas.

After digitizing the forest stands, you will add information such as new constraints given by conservation regulations.

The goal for this lesson: To digitize a new set of forest stands from CIR aerial photographs and add information
from other datasets.

14.4.1 Comparing the Old Forest Stands to Current Aerial Photographs

The National Land Survey of Finland has an open data policy that allows you downloading a variety of geographical
data like aerial imagery, traditional topographic maps, DEM, LiDAR data, etc. The service can be accessed in English
here. The aerial image used in this exercise has been created from two orthorectified CIR images downloaded from
that service (M4134F_21062012 and M4143E_21062012).

1. Open QGIS and set the project’s CRS to ETRS89 / ETRS-TM35FIN in Project » Properties... » CRS
2. Add the CIR image raut jarvi_aerial.tif to the project:

1. Gotothe exercise_data\forestry\ folder using your file manager browser

2. Drag and drop the file raut jarvi_aerial.tif onto your project
3. Save the QGIS project as digitizing_2012.ggs

The CIR images are from 2012. You can compare the stands that were created in 1994 with the situation almost 20
years later.

1. Add the forest_stands_1994. shp layer created in the previous lesson:
1. Gotothe exercise_data\forestry\ folder using your file manager browser
2. Drag and drop the file forest_stands_1994 . shp onto your project

2. Set the symbology for the layer so that you can see through your polygons:
1. Right click forest_stands_1994

2. Select Properties

3. Goto the “* Symbology tab

4. Set Fill color to transparent fill
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5. Set Stroke color to purple
6. Set Stroke widthto 0. 50 mm
3. Review how the old forest stands follow (or not) what you might visually interpret as an homogeneous forest.

4. Zoom and pan around the area. You probably will notice that some of the old forest stands might be still
corresponding with the image but others are not.

This is a normal situation, as some 20 years have passed and different forest operations have been carried
out (harvesting, thinning...). It is also possible that the forest stands looked homogeneous back in 1992 to
the person who digitized them but as time has passed some forest has developed in different ways. It is also
possible that that forest inventory priorities back then were different from those of today.

Next, you will create new forest stands for this image without using the old ones. Later you can compare them to see
the differences.

14.4.2 Interpreting the CIR Image

Let’s digitize the same area that was covered by the old inventory, limited by the roads and the lake. You don’t have
to digitize the whole area, as in the previous exercise you can start with a vector file that already contains most of the
forest stands.

1. Remove the layer '.. 3 forest_stands_1994
2. Add the file exercise_data\forestry\forest_stands_2012. shp to the project
3. Set the styling of this layer so that the polygons have no fill and the borders are visible

1. Open Properties dialog of the forest_stands_2012 layer

2. Go to the “* Symbology tab
3. Set Fill color to transparent fill
4. Set Stroke color to green

5. Set Stroke widthto 0.50 mm
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You can see that the northern section of the inventory area is still missing. Your task is to digitize the missing forest
stands.

Before you start, spend some time reviewing the forest stands already digitized and the corresponding forest in the
image. Try to get an idea about how the stands borders are decided, it helps if you have some forestry knowledge.

Some points to consider:

* Which forests have deciduous species (in Finland these are mostly birch forests) and which ones have conifers
(in this area these are pine or spruce)? In CIR images, deciduous species usually show up as a bright red color
whereas conifers show as a dark green color.
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* How old is the forest? The size of the tree crowns can be identified in the imagery.

e How dense are the different forest stands? A forest stand where a thinning operation has recently been done
would show spaces between the tree crowns and should be easy to differentiate from other forest stands around
it.

* Blueish areas indicate barren terrain, roads and urban areas, crops that have not started to grow etc.

* Don’t use zooms too close to the image when trying to identify forest stands. A scale between 1:3 000 and 1:5
000 should be enough for this imagery. See the image below (1:4000 scale):

14.4.3 Try Yourself Digitizing Forest Stands from CIR Imagery

When digitizing the forest stands, you should try to get forest areas that are as homogeneous as possible in terms of
tree species, forest age, stand density... Don’t be too detailed though, or you will end up making hundreds of small
forest stands - and that would not be useful at all. You should try to get stands that are meaningful in the context of
forestry, not too small (at least 0.5 ha) but not too big either (no more than 3 ha).

With these points in mind, you can now digitize the missing forest stands.
1. Set up the snapping and topology options:

1. Go to Project » Snapping options...

2. Press ‘é Enable Snapping and select Advanced Configuration

3. Check the ® forest_stands_2012 layer
1. Set Type to Vertex
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2. Set Tolerance to 10
3. Set Units to pixels
4. Check the box under Avoid Overlap

5. Press | Topological editing

6. Choose ‘g Follow Advanced Configuration
7. Close the pop-up

Project Snapping Settings

¥ % Advanced Configuration | [3 Disabled | Topological Editing | % Follow Advanced Configuration || Snapping on Intersection | :*Self-snapping
Layer Type Tolerance Units Avoid Overlap Min Scale Max Scale
v|[] forest_stands_2012 Vertex 10 pixels v

L Filter layers.

2. Select the forest_stands_2012 layer on the Layers list

3. Click the # Toegle Editing bytton to enable editing

4. Start digitizing using the same techniques as in the previous lesson. The only difference is that you don’t have
any point layer that you are snapping to. For this area you should get around 14 new forest stands. While
digitizing, fill in the St andID field with numbers starting at 901.

5. When you are finished your layer should look something like:
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Now you have a new set of polygons showing the different forest stands in 2012 - as interpreted from the CIR images.
However, you are missing the forest inventory data. For that you will need to visit the forest and get some sample
data that you will use to estimate the forest attributes for each of the forest stands. You will see how to do that in the
next lesson.

You can add some extra information about conservation regulations that need to be taken into account for this area.

14.4.4 Follow Along: Updating Forest Stands with Conservation Information
For the area you are working in, there are some conservation regulations that must be taken into account when doing
the forest planning:

* Two locations of a protected species of Siberian flying squirrel (Pteromys volans) have been identified.
According to the regulation, an area of 15 meters around the spots must be left untouched.

* A riparian forest of special interest that is growing along a stream in the area must be protected. In a visit to
the field, it was found that 20 meters to both sides of the stream must be protected.

You have a vector file containing the information about the squirrel locations and another containing the digitized
stream running from the North area towards the lake.

1. Fromthe exercise_data\forestry)\ folder, add the squirrel.shpand stream. shp files to the
project.

2. Use the Open Atribute Table 10] to view the squirrel layer
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You can see that there are two locations that are defined as Siberian flying squirrel, and that the area to be
protected is indicated by a distance of 15 meters from the locations.

Let’s more accurately delimitate that area to protect. We will create a buffer around the point locations, using the
protection distance.

1. Open Vector » Geoprocessing Tools w Buffer.

[
B

2. Set Input layer to = squirrel
3. Set Distance to 15 meters

4. Set Buffered to exercise_data\forestry\squirrel_15m.shp

5. Check Cf Open output file afer running algorithm
6. Click Run

7. Once the process is completed, click Close

L3
Parameters | Log Buffer
Input layer This algorithm computes a buffer
+* squirrel [EPSG:25835] - B Xy .|| |areafor all the features in an
input layer, using a fixed or
Selected features only dynamic distance.
Distance

The segments parameter

15,000000 * 'meters - | 45, | |controls the number of line
segments to use to approximate

Segments a quarter circle when creating

5 2|| |rounded offsets.

End cap style The end cap style parameter

Round . controls how line endings are
handled in the buffer.

Join style

The join style parameter specifies
Round || |whether round, miter or beveled
joins should be used when
offsetting cornersin aline.

Miter limit

2,000000 =

The miter limit parameter is only

applicable for miter join styles,

Buffered and controls the maximum
distance from the offset curve to

<[ |use when creating a mitered join.

Dissolve result

ning-Data/exercise_data/forestry/squirrel_15m.shp

v Open output file after running algorithm

0% Cance

i Aide Advanced -|| Run as Batch Process... ~ Run @ Fermer
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If you zoom in to the location in the northern part of the area, you will notice that the buffer area extends over two
neighbouring stands. This means that whenever a forest operation takes place in that stand, the protected location
should also be taken into account.

For the protection of the squirrels locations, you are going to add a new attribute (column) to your new forest stands that
will contain information about locations that have to be protected. This information will then be available whenever
a forest operation is planned, and the field team will be able to mark the area that has to be left untouched before the
work starts.

To join the information about the squirrels to your forest stands, you can use the Join attributes by location algorithm:

1. Open Vector » Data Management Tools » Join attributes by location.

2. Set Join to features in to ':-:' forest_stands_2012

3. In Geometric predicate, check i intersect
Set By comparing to to L~ squirrel_I15m
Set Join type as Take attributes of the first matching feature only (one-to-one)

Leave unchecked Discard records which could not be joined

N o v s

. Set Joined layer to exercise_data\forestry\stands_squirrel.shp

. Check i Open output file afer running algorithm
9. Click Run

[o ]

10. Once the process is completed, you can Close the dialog.
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Join Attributes by Location

Parameters | Log Join attributes by
Join to features in “ location
= forest_stands_2012 [EPSG:25835] -] @ X |..)| | |his algorithm takes an input

Selected features only vector layer and creates a new
g vector layer that is an extended
version of the input one, with

v intersect overlap additional attributes in its
attribute table.

Features they (geometric predicate)

contain are within
The additional attributes and

equal Cross their values are taken from a
second vector layer. A spatial

touch e .
criteria is applied to select the
By comparing to values from the second layer that
9 squirrel_15m [EPSG:25835] -| @) Xy |..[| | |areaddedtoeach feature from
— the first layer in the resulting
Selected features only one.
Fields to add (leave empty to use all fields) [optional]
||:jil fields selected || |
Join type
|Take attributes of the first matching feature only (one-to-one) =

Discard records which could not be joined

Joined field prefix [optional]

Joined layer [optional]

leGIS—Training—Data;’exercise_data!forestrylstands_squirrel.shp a || _|

v Open output file after running algorithm

\ 0% || cancel

| H Aide | | Advanced | | Run as Batch Process... ~ Ok | |9Eermer

Now you have a new forest stands layer, stands_squirrel. shp showing the protection information for the
Siberian flying squirrel.

1. Open the attribute table of the stands_squirrel layer

2. Sort the table by clicking on point_pr field in the table header.
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stands_squirrel — Features Total: 74, Filtered: 74, Selected: 0

/ € a7V ES P 2E = &E
idcalc StandID point_id point_pr * point_dist =
1 69 970 2 liito-orava 15
2 70 971 2 liito-orava 15
3 13 914 1 liito orava 15
4 15 916 1 liito orava 15
5 0 901 NULL|NULL NULL
6 1 902 NULL| NULL NULL
7 2 903 NULL|NULL NULL
8 5 904 NULL| NULL NULL
9 4 905 NULL|NULL NULL

~ Show All Features _

You can see that there are some forest stands that have the information about the protection locations. The
information in the forest stands data will indicate to the forest manager that there are protection considerations
to be taken into account. Then he or she can get the location from the squirrel dataset, and visit the area to
mark the corresponding buffer around the location so that the operators in the field can avoid disturbing the
squirrels environment.

14.45 Try Yourself Updating Forest Stands with Distance to the Stream
Following the same approach as for the protected squirrel locations you can now update your forest stands with
protection information related to the stream. A few points:

¢ Remember the buffer is 20 meters around the stream

* You want to have all the protection information in the same vector file, so use stands_squirrel.shp as
the base layer

* Name your output as forest_stands_2012_protect.shp

Once the process is completed, open the attribute table of the output layer and confirm that you have all the protection
information for the riparian forest stands associated with the stream.

‘When you are happy with the results, save your QGIS project.

14.4.6 In Conclusion

You have seen how to interpret CIR images to digitize forest stands. Of course it would take some practice to make
more accurate stands and usually using other information like soil maps would give better results, but you know now
the basis for this type of task. And adding information from other datasets resulted to be quite a trivial task.
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14.4.7 What’s Next?

The forest stands you digitized will be used for planning forestry operations in the future, but you still need to get
more information about the forest. In the next lesson, you will see how to plan a set of sampling plots to inventory
the forest area you just digitized, and get the overall estimate of forest parameters.

14.5 Lesson: Design da Amostragem Sistematica

Ja digitalizou um conjunto de poligonos que representam povoamentos florestais, mas ainda nio tem informacdes
sobre a floresta. Para esse efeito, pode projetar uma pesquisa para o inventdrio da drea de floresta e, em seguida,
estimar os seus pardmetros. Nesta licdo, vai criar um conjunto de pontos de amostragem sistematica.

Quando comecamos a planear um inventario florestal € importante definir claramente os objetivos, os tipos de parcelas
que vdo ser utilizados, e os dados que serdo recolhidos para atingir os objectivos. Para cada caso individual, ird
depender do tipo de gestio da floresta proposta; e deve ser cuidadosamente planeado por alguém com conhecimento na
area florestal. Nesta licdo, vai implementar um inventdrio tedrico baseado numa amostragem sistemética de parcelas.

**0O objetivo desta licdo:**Criar um esquema de parcelas de amostragem sistemdtica com o intuito de fazer o
levantamento da drea florestal.

14.5.1 Inventariar a Floresta

Existem diversos métodos de inventariar a floresta, cada um com diferentes condi¢des e propdsitos. Por exemplo,
de uma forma muito precisa para inventariar uma floresta (se considerar apenas espécies de drvores) seria visitar a
floresta e fazer uma lista de todas as arvores e as suas caracteristicas. Como pode imaginar este nio € geralmente
aplicavel excepto para dreas pequenas ou situacdes especiais.

The most common way to find out about a forest is by sampling it, that is, taking measurements in different locations
at the forest and generalizing that information to the whole forest. These measurements are often made in sample
plots that are smaller forest areas that can be easily measured. The sample plots can be of any size (for ex. 50 m2, 0.5
ha) and form (for ex. circular, rectangular, variable size), and can be located in the forest in different ways (for ex.
randomly, systematically, along lines). The size, form and location of the sample plots are usually decided following
statistical, economical and practical considerations. If you have no forestry knowledge, you might be interested in
reading this Wikipedia article.

14.5.2 Follow Along: Implementacao do design da amostragem sistematica

Para a floresta que estd a trabalhar, o gestor decidiu que o design da amostragem sisteméatica como o mais apropriado
para esta floresta decidindo que a distancia entre as parcelas seria fixa, com 80 metros entre as linhas de amostragem
visto que iria produzir resultados confidveis (para este caso, + - 5% de erro médio a uma probabilidade de 68%). Como
o método mais eficaz para este inventdrio decidiu-se que as parcelas teriam tamanho varidvel, para os povoamentos
em crescimento e maduros, para povoamentos jovens seriam usadas parcelas de raio fixo com 4 metros de raio.

Na pritica, necessita de simplesmente representar as parcelas de amostra como pontos que serdo usados pelas equipas
de campo posteriormente:

1. Open your digitizing_2012.qggs project from the previous lesson.
2. Remove all the layers except for forest_stands_2012.
3. Save your project now as forest_inventory.qgs

Agora necessita de criar uma grelha retangular de pontos separados por 80 metros um do outro:

ooooo
T
Baama

1. Open Vector » Research Tools =%t Regular points.
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. Press the drop-down button next to the Input extent field and from the Calculate from Layer menu, select

forest_stands_2012.

. In the Point spacing/count settings, enter 80 meters.
. Check the Use point spacing box to indicate that the value represents the distance between the points.

. Under Regular points, save the output as systematic_plots.shp in the forestry\sampling\

folder.

. Check Open output file after running algorithm.

. Press Run.

Nota: The suggested Regular points creates the systematic points starting in the upper-left corner of the extent of
the selected polygon layer. If you want to add some randomness to this regular points, you could use a randomly
calculated number between 0 and 80 (80 is the distance between our points), and then write it as the Initial inset from
corner (LH side) parameter in the tool’s dialog.

Percebe que a ferramenta usa toda a extensdo da sua camada de povoamentos para gerar uma grelha retangular de
pontos. Mas interessa-nos apenas esses pontos que estdo, na verdade, dentro da sua drea de floresta (veja as imagens
abaixo):

-~
From the Processing toolbox, open coh GDAL » Vector geoprocessing » Clip vector by mask layer.

Select systematic_plots as the Input layer.
Set forest_stands_2012 as the Mask layer.

Save the Clipped (mask) result as systematic_plots_clip.shp in the forestry\sampling\
folder.

Check Open output file after running algorithm.
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6. Press Run.

Tem agora os pontos que as equipas de campo vao usar para navegar até os locais das parcelas planeadas. Pode ainda
preparar estes pontos de modo a que eles sejam mais Uteis para o trabalho de campo. Pelo menos terd que adicionar
nomes significativos para os pontos e exportd-los para um formato que pode ser usado no seu aparelho de GPS.

Let’s start with the naming of the sample plots. If you check the Attribute table for the plots inside the forest area,
you can see that you have the default id field automatically generated by the Regular points tool. Label the points to
see them in the map and consider if you could use those numbers as part of your sample plot naming:

1. Open the Layer Properties » "2kl Labels for the systematic_plots_clip layer.
2. Turn the top menu into ‘2kcl Single Labels.

3. For the Value entry, select the field id.

4. Go to the abe Byffer tab, check the Draw fext buffer and set the buffer Size to 1.

5. Click OK.

Agora olhe para os rétulos do seu mapa. Pode verificar que os pontos foram criadas e numeradas primeiro de Ocidente
para o Oriente e, em seguida, do Norte para o Sul. Se olhar para a tabela de atributos de novo, vai notar que a ordem
na tabela também segue esse padrdo. Se pretender nomear por outras razdes as parcelas de uma forma diferente,
nomeando-os de uma forma Leste-Oeste / Norte-Sul segue uma ordem l6gica e € uma boa opgao.

Nevertheless, the number values in the id field are not so good. It would be better if the naming would be something
likep_1, p_2....Youcan create a new column for the systematic_plots_clip layer:

1. Go to the Attribute table for systematic_plots_clip.

2. Enable the ¥ edit mode.

3. Open the Field calculator .
1. Check Create a new field
2. Enter Plot_id as Output field name
3. Set the Output field type to Text (string).

4. Inthe Expression field, write, copy or construct this formula concat ('P_"', @rownum ). Remember
that you can also double click on the elements inside the Function list. The concat function can be found
under String and @ rownum is under the Variables and values group.

4. Click OK.
5. Desactive o modo de edigdo e guarde as alteracoes.

Now you have a new column with plot names that are meaningful to you. For the systematic_plots_clip
layer, change the field used for labeling to your new P1ot_1id field.
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14.5.3 Follow Along: Exportar a amostra de parcelas como formato GPX

The field teams will be probably using a GPS device to locate the sample plots you planned. The next step is to export
the points you created to a format that your GPS can read. QGIS allows you to save your point and line vector data
in GPS eXchange Format (GPX), which is an standard GPS data format that can be read by most of the specialized
software. You need to be careful with selecting the CRS when you save your data:

1. Right-click systematic_plots_clip layer and select Export » Save features as....

Save Vector Layer as... X

Format GPS eXchange Format [GPX] -
File name a/exercise_data/forestry/sampling/plots_wgs84.gpx
Layer name

CRS Default CRS: EPSG:4326 - WGS 84 v || &

Encoding

P Select fields to export and their export options
v| Persist layer metadata

b Geometry
B Extent (current: none)
P Datasource Options

b Layer Options
P Custom Options

@ Help v Add saved file to map | @cCancel @ok
2. Em Formato seleccione GPS eXchange Format [GPX].
3. Save the output File name as plots_wgs84 .gpx inthe forestry\sampling\ folder.
4. Em SRC selecionar Seleccionar SRC.
5. Browse for EPSG:4326 - WGS 84.
Nota: The GPX format accepts only this CRS, if you select a different one, QGIS will give no error but you
will get an empty file.
6. Click OK.

7. In the dialog that opens, select only the waypoints layer (the rest of the layers are empty).

The inventory sample plots are now in a standard format that can be managed by most of the GPS software. The field
teams can now upload the locations of the sample plots to their devices. That would be done by using the specific
devices own software and the plots_wgs84 . gpx file you just saved. Other option would be to use the GPS Tools
plugin but it would most likely involve setting the tool to work with your specific GPS device. If you are working with
your own data and want to see how the tool works you can find out information about it in the section working_gps
in the QGIS User Manual.

Guarde o seu projecto QGIS
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14.5.4 In Conclusion

Acabou de ver como podera criar facilmente um projeto de amostragem sistemdtica para ser usado num inventario
florestal. A criac@o de outros tipos de planos de amostragem envolve o uso de diferentes ferramentas dentro do QGIS,
folhas de calculo ou scripts para calcular as coordenadas das parcelas, mas a ideia geral permanece a mesma.

14.5.5 What’s Next?

Na préxima licdo verd como usar os recursos do atlas no QGIS para gerar automaticamente mapas detalhados que as
equipas de campo usam para navegar para as parcelas que lhes foram atribuidas.

14.6 Lesson: Creating Detailed Maps with the Atlas Tool

The systematic sampling design is ready and the field teams have loaded the GPS coordinates in their navigation
devices. They also have a field data form where they will collect the information measured at every sample plot.
To easier find their way to every sample plot, they have requested a number of detail maps where some ground
information can be clearly seen along with a smaller subset of sample plots and some information about the map area.
You can use the Atlas tool to automatically generate a number of maps with a common format.

The goal for this lesson: Learn to use the Atlas tool in QGIS to generate detailed printable maps to assist in the
field inventory work.

14.6.1 Follow Along: Preparing the Print Layout

Before we can automate the detailed maps of the forest area and our sampling plots, we need to create a map template
with all the elements we consider useful for the field work. Of course the most important will be a properly styled
but, as you have seen before, you will also need to add lots of other elements that complete the printed map.

1. Open the QGIS project from the previous lesson forest_inventory.qggs. You should have at least the
following layers:

e forest_stands_2012 (with a 50% transparency, green fill and darker green border lines)
e systematic_plots_clip
* rautjarvi_aerial

2. Save the project with a new name, map_creation.ggs.

To create a printable map, remember that you use the Layout Manager:

1. Open Project » |—\q Layout Manager....

2. In the Layout manager dialog:
1. Under New from template, press the Create... button next to the Empty layout entry
2. Name your print layout forest_map.
3. Press OK. A new print layout is created and opened, showing a blank paper.

3. In the print Layout window, ensure properties are set for an A4 paper:

1. Right-click over the paper and select Page properties. The Page properties panel is open on the right side
of the layout.

2. Check Size is A4.
3. Check Orientation is Landscape.

4. Enable the Layout tab next to the Page properties panel and set Export resolution to 300 dpi.
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Composing a map is easier if you make use of the canvas grid to position the different elements. Review the settings
for the layout grid:

1. In the Layout tab expand the Guides and Grid region.

2. Check that Grid spacing is set to 10 mm and that Snap folerance is set to 5 px.
You need to activate the use of the grid:

1. Open the View menu.

2. Check Show grid.

3. Check Snap to grid.

4

. Notice that options for using Guides are checked by default, which allows you to see guiding lines when you
are moving elements in the layout.

5. Now you can start to add elements to your layout. Add first a map element so you can review how the map
canvas looks as you will be making changes in the layers symbology:

1. Click on the IE Add Map pytton,

2. Click and drag a box on the canvas so that the map occupies most of it.

! forest_map [F=5 E=R=x3
Composer Edit View Layout AHas Settings
= P — I = = | 3 o)
RORCReBRREee 5P OPHR - ©-
Bl ¢> R
..FJ.....|....|1PEJ..|....|1.5(.J..|....|2.m.1..|....|2.5(.]..|....|3.0 Composition | _Item properties | Afas generation |
L= ‘Composition
. e (]
= W Paper and quality Ml
E Presets A4 (210297 mm}) =
= Width 297,00 =
= Height 210.00 =
E Units mm -
? Mumber of pages | 1 =
- 1 Orientation Landscape -
E Page background Change... |4
E Export resolution | 300 dpi =
. Frint as raster
R |3 World file on [ Map 0 | ']
EE
8- ¥ Grid @
4 | | [« ]r] . — =
|x: 304.661 mm ||y: 59,8506 mm ||page: 1 ” 40.6%: - ||1ibem selected ”:I y
2]

Notice how the mouse cursor snaps to the canvas grid. Use this function when you add other elements. If you want
to have more accuracy, change the grid Spacing setting. If for some reason you don’t want to snap to the grid at some
point, you can always check or uncheck it in the View menu.
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14.6.2 Follow Along: Adding Background Map

Leave the layout open but go back to the map. Let’s add some background data and create some styling so that the
map content is as clear as possible.

1. Add the background raster basic_map.tif that you can find in the exercise_data\forestry\
folder.

2. If prompted select the ETRS89 / ETRS-TM35FIN CRS for the raster.

As you can see the background map is already styled. This type of ready to use cartography raster is very
common. It is created from vector data, styled in a standard format and stored as a raster so that you don’t have
to bother styling several vector layers and worrying about getting a good result.

3. Now zoom to your sample plots, so that you can see only about four or five lines of plots.

The current styling of the sample plots is not the best:

While during the last exercises, the white buffer was OK on top of the aerial image, now that the background image
is mostly white you barely can see the labels. But how does it look in the print layout? Let’s check it:

1. Go to the print layout window.

AT
2. Use the h SelectMove item by tton to select the map element in the layout.

3. Go to the Item properties tab.
4. Click on @ Set map extent to match main canvas extent.

(|
5. If you need to refresh the element, click on % Update map preview.

Obviously this is not good enough; you want to make the plot numbers as clearly visible as possible for the field teams.

14.6.3 Try Yourself Changing the Symbology of the Layers

You have been working in Module: Creating and Exploring a Basic Map with symbology and in Module: Classifying
Vector Data with labeling. Go back to those modules if you need to refresh about some of the available options and
tools. Your goal is to get the plots locations and their name to be as clearly visible as possible but always allowing to
see the background map elements. You can take some guidance from this image:
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You will use later the the green styling of the forest_stands_2012 layer. In order to keep it, and have a
visualization of it that shows only the stand borders:

1. Right click on forest_stands_2012 and select Duplicate

2. You get a new layer named forest_stands_2012 copy that you can use to define a different style, for
example with no filling and red borders.

Now you have two different visualizations of the forest stands and you can decide which one to display for your
detail map.

3. Go back to the print layout window often to see what the map would look like. For the purposes of creating
detailed maps, you are looking for a symbology that looks good not at the scale of the whole forest area (left

image below) but at a closer scale (right image below). Remember to use W Update map preview 5 @ Set map
extent to match main canvas extent whenever you change the zoom in your map or the layout.

PPﬂPF“Pﬂ\mﬂmml@l‘mwvmv‘ﬂ\m\mwiﬂ b P OB B0 B B R LR, PP PR PR P P

s [N
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14.6.4 Try Yourself Create a Basic Map Template
1. Once you have a symbology you are happy with, you are ready to add some more information to your printed
map. Add at least the following elements:
« Title.
* A scale bar.
¢ Grid frame for your map.
» Coordinates on the sides of the grid.

2. You have created a similar layout already in Module: Laying out the Maps. Go back to that module as you need.
You can look at this example image for reference:

A forest map = = e =

Composer Edit View Layout Atlas Settings
EoOREReERReoe HA AR NPHBERE RS/ BB 906 86,
ELREE LY

T B P N R 2 OO M Y OO SO - O < N - PO = Co g
= E? Change item [=]
E 297000 297100 297200 287200 297400 297500
EE Rautjarvi Forest Area

Inventory 2012 D
E W : &
2 8 g eem deleted
B B
Composition | Item properti Atlas generati
Ttem properses

I

5787100
G787100

ol

s77m0
G770

Lzl

I

700
E7EEI00

el

o

E a e
FE 100

[ ] G

ez 0mm [lv: 191.132mm " |[page: 1 [s2.3% = |[atias feature 10 21

3. Export your map as an image and look at it.
1. Layout » Export as Image....
2. Use for example the JPG format.

That is what it will look like when printed.

14.6.5 Follow Along: Adding More Elements to the Print Layout

As you probably noticed in the suggested map template images, there are plenty of room on the right side of the
canvas. Lets see what else could go in there. For the purposes of our map, a legend is not really necessary, but an
overview map and some text boxes could add value to the map.

The overview map will help the field teams place the detail map inside the general forest area:
1. Add another map element to the canvas, right under the title text.

2. In the Item properties tab, open the Overview dropdown.
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3. Set the Overview frame to Map 0. This creates a shadowed rectangle over the smaller map representing the
extent visible in the bigger map.

4. Check also the Frame option with a black color and a Thickness of 0. 30.

! forest_map copy =] fole-/kE

Composer Edit View Layout Atlas Settings
BLLURAPReBARES? 2ppeR 0PHR LY Bk / BB 99
Bl ¢ >HBDRR

_|PH|\|\|HP|DH||HH \lH\lHlF\D\thHFloullulwllwolowl\lu\|1\2\0|||\|\|‘1|4R\|H||‘1\6|0\|\|H\|1\E\0\|M|\|P|D\DH|H\lP\ZPH\H||\|2\4\0\|M|||‘2|6\0|\|H\l‘Z\B\OH\HHPOD e

<empty>
Item deleted
Item deleted
| | Ttem deleted
Ttem deleted
Map added
N N Change item size
Rautjarvi Forest Area Change item size
Inventory 2012 Change item size
Y Item frame toggled

=

6787000
o700

Composition | Item properties | Atias generation
Item properties
Map

P Main properties

b Extents

[ 3 Controlled by atias

6785000
G78G900

> Show grid

¥ Overview

Overview frame Map 0 -
Overview style Change...

Overview blending mode | Normal -

Tnvert overview

67860
Gro0e0

% Center on overview

B Fosition and size

P Rotation

w (% Frame

@ color....

Thickness | 0.30 -

g P M Background —— g

[ [l

|;z3s‘sus om |l 6.307mm page: 1 [[s2.15 - [titem selected \U

Notice that your overview map is not really giving an overview of the forest area which is what you want. You
want this map to represent the whole forest area and you want it to show only the background map and the
forest_stands_2012 layer, and not display the sample plots. And also you want to lock its view so it does
not change anymore whenever you change the visibility or order of the layers.

p—

Go back to the map, but don’t close the Print Layout.

Right click the forest_stands_2012 layer and click on Zoom to Layer Extent.
Deactivate all layers except for basic_map and forest_stands_2012.

Expand the Manage map themes 6] on the Layers panel and select Add theme.
Name it basic_overview.

Go back to the print layout.

NS R » N

With the small map selected, click the Set map extent to match main canvas extent to set its extents to what you
can see in the map window.

8. Lock the view for the overview map by checking Follow map theme and selecting basic_overview under
Main properties.

Now your overview map is more what you expected and its view will not change anymore. But, of course, now your
detail map is not showing anymore the stand borders nor the sample plots. Let’s fix that:

1. Go to the map window again and select the layers you want to be visible (systematic_plots_clip,
forest_stands_2012 copy and Basic_map).

2. Zoom again to have only a few lines of sample plots visible.

3. Go back to the Print Layout window.
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4. Select the bigger map in your layout.
5. In Item properties click on Update preview and Set map extent to match main canvas extent.

Notice that only the bigger map is displaying the current map view, and the small overview map is keeping the same
view you had when you locked it.

Note also that the overview is showing a shaded frame for the extent shown in the detail map.

nna Eran i Bt an Fhn it et n ot it il E2 o it Pt B it e it et o i o

Rautjarvi Forest Area
Inventory 2012
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1
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BYE5900
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L

‘Detail map inventory zone:

120|‘.

6786800

Remarks:

B78EE00

140‘
i

160‘ .

6786700

{0

E786700

0 100 200 m

il

Your template map is almost ready. Add now two text boxes below the map, one containing the text “Detailed map
zone: “ and the other one “Remarks: “. Place them as you can see in the image above.

You can also add a North arrow to the overview map:

1. Select the AII Add North Arrow 6,05]
Click and drag a rectangle at the upper right corner of the overview map.
In Item properties Check SVG image

Browse SVG Browser » SVG Groups for an arrow image.

A

Under Image rotation, check the Sync with map and select Map 1 (the overview map).
6. Resize the arrow image to a size that looks good on the small map.

The basic map layout is ready, now you want to make use of the Atlas tool to generate as many detail maps in this
format as you consider necessary.
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14.6.6 Follow Along: Creating an Atlas Coverage

The Atlas coverage is just a vector layer that will be used to generate the detail maps, one map for every feature in
the coverage. To get an idea of what you will do next, here is a full set of detail maps for the forest area:

L (o
Ninen Raufiari, )

Pumppuamo |

The coverage could be any existing layer, but usually it makes more sense to create one for the specific purpose. Let’s
create a grid of polygons covering the forest area:

1. In the QGIS map view, open Vector » Research Tools » -+ Create grid.

2. Set the tool as shown in this image:

442
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-

Grid extent
forest_stands_2012

Align extents and resolution to selected raster layer

& Vector grid @

Update extents from layer

| Update extents from canvas

X Min | 397024, 141 Y Min | 6735465.69525
X Max 398082.827472 ¥ Max 6787173.746
Parameters

¥ | a00.0000000000
Lock 1:1 ratio

Ak Ak

Y| 300,0000000000
® Cutput grid as polygons

QOutput grid as lines

Output shapefile
cize_dataforestry fsampling/atlas_coverage.shp

X Add result to canvas

[ 0% | oK Close

3. Save the output as at las_coverage. shp.

4. Style the new atlas_coverage layer so that the polygons have no filling.

The new polygons are covering the whole forest area and they give you an idea of what each map (created from each

polygon) will contain.

14.6. Lesson: Creating Detailed Maps with the Atlas Tool
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14.6.7 Follow Along: Setting Up the Atlas Tool

The last step is to set up the Atlas tool:

1. Go back to the print

layout.

2. In the panel on the right, go to the Atlas generation tab.

3. Set the options as follows:

444
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Composition Item properties Atlas generation

Atlas generation
X Generate an atlas
w Configuration
Coverage layer atlas_coverage -

X Hidden coverage layer
Filter with

w Output

Qutput filename expression

|fieldmap| '||¢feature

Single file export when possible

Sortby |ID B3 D

That tells the Atlas tool to use the features (polygons) inside at 1as_coverage as the focus for every detail
map. It will output one map for every feature in the layer. The Hidden coverage layer tells the Atlas to not
show the polygons in the output maps.

One more thing needs to be done. You need to tell the Atlas tool what map element is going to be updated for every
output map. By now, you probably can guess that the map to be changed for every feature is the one you have prepared
to contain detail views of the sample plots, that is the bigger map element in your canvas:

1. Select the bigger map element (Map 0).
2. Go to the Item properties tab.

3. In the list, check Controlled by atlas.

4

. And set the Marging around feature to 10%. The view extent will be 10% bigger than the polygons, which
means that your detail maps will have a 10% overlap.
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Compaosition Item properties Atlas generation
[tem propertes

X

P Main properties

b Extents

w X Controlled by atlas

1k

® Margin around feature = 109

Fixed scale

B ¥ Show grid

B Overview

P Position and size

P Rotation

2 Frame g

Now you can use the preview tool for Atlas maps to review what your maps will look like:

1. Activate the Atlas previews using the button or if your Atlas toolbar is not visible, via Aflas » Preview
Atlas.

2. You can use the arrows in the Atlas tool bar or in the Aflas menu to move through maps that will be created.

Note that some of them cover areas that are not interesting. Let’s do something about it and save some trees by not
printing those useless maps.

14.6.8 Follow Along: Editing the Coverage Layer
Besides removing the polygons for those areas that are not interesting, you can also customize the text labels in your
map to be generated with content from the Attribute table of your coverage layer:

1. Go back to the map view.

2. Enable editing for the atlas_coverage layer.

3. Select the polygons that are selected (in yellow) in the image below.

4. Remove the selected polygons.

5. Disable editing and save the edits.
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You can go back to the print layout and check that the previews of the Atlas use only the polygons you left in the

layer.

The coverage layer you are using does not yet have useful information that you could use to customize the content of
the labels in your map. The first step is to create them, you can add for example a zone code for the polygon areas
and a field with some remarks for the field teams to have into account:

1.
2.

A

7.

Open the Attribute table for the atlas_coverage layer.

Enable editing.

Use the calculator to create and populate the following two fields.

Create a field named Zone of type Whole number (integer).

In the Expression box write/copy/construct $rownum.

Create another field named Remarks, of type Text (string) and a width of 255.

In the Expression box write 'No remarks. '. This will set all the default value for all the polygons.

The forest manager will have some information about the area that might be useful when visiting the area. For
example, the existence of a bridge, a swamp or the location of a protected species. The atlas_coverage layer is
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probably in edit mode still, add the following text in the Remarks field to the corresponding polygons (double click
the cell to edit it):

e For the Zone2: Bridge to the North of plot 19. Siberian squirrel between p_13
and p_14.

 For the Zone 6: Difficult to transit in swamp to the North of the lake."
e Forthe Zone7: Siberian squirrel to the South East of p_94.
* Disable editing and save your edits.

Almost ready, now you have to tell the Atlas tool that you want some of the text labels to use the information from
the atlas_coverage layer’s attribute table.

1. Go back to the Print Layout.
. Select the text label containing Detailed map.. ..
. Set the Font size to 12.

. Set the cursor at the end of the text in the label.

2
3
4
5. In the Item properties tab, inside the Main properties click on Insert or Edit an Expression....
6. In the Function list double-click on the field Zone under Field and Values.

7. Click OK.

8

. The text inside the box in the Item properties should show Detail map inventory zone: [$% "Zone"
%]1. Note that the [%$ "Zone" %] will be substituted by the value of the field Zone for the corresponding
feature from the layer atlas_coverage.

9. Test the contents of the label by looking at the different Atlas preview maps.

10. Do the same for the labels with the text Remarks: using the field with the zone information. You can leave a
break line before you enter the expression. You can see the result for the preview of zone 2 in the image below:
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11. Use the Atlas preview to browse through all the maps you will be creating soon and enjoy!

14.6.9 Follow Along: Printing the Maps

Last but not least, printing or exporting your maps to image files or PDF files. You can use the Atlas » Export Atlas
as Images... or Atlas » Export Atlas as PDF.... Currently the SVG export format is not working properly and will
give a poor result.

Lets print the maps as a single PDF that you can send to the field office for printing:

1.
2.

Go to the Atflas generation tab on the right panel.

Under the Output check the Single file export when possible. This will put all the maps together into a PDF file,
if this option is not checked you will get one file for every map.

. Open Layout » Export as PDF....

. Save the PDF file as inventory_2012_maps.pdf in your exercise_datal\forestry\

samplig\map_creation)\ folder.

. Open the PDF file to check that everything went as expected.

. You could just as easily create separate images for every map (remember to uncheck the single file creation),

here you can see the thumbnails of the images that would be created:

fieldmap_2,jpg fieldmap_4.jpg
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7. In the Print Layout, press Save in order to save your print layout changes in the project. This also saves the

project file. You can reopen the project at any time and run or edit the atlas.

It is also possible to save your map as a layout template as forestry_atlas.gpt in your
exercise_data\forestry\map_creation\ folder. Use Layout » Save as Template. You will be
able to use this template again and again in other projects.

8. Close the Print Layout and the project.

14.6.10 In Conclusion

You have managed to create a template map that can be used to automatically generate detail maps to be used in the
field to help navigate to the different plots. As you noticed, this was not an easy task but the benefit will come when
you need to create similar maps for other regions and you can use the template you just saved.
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14.6.11 What’s Next?

In the next lesson, you will see how you can use LiDAR data to create a DEM and then use it to enhance your data
and maps visibility.

14.7 Lesson: Calculating the Forest Parameters

Estimating the parameters of the forest is the goal of the forest inventory. Continuing the example from previous
lesson, you will use the inventory information gathered in the field to calculate the forest parameters, for the whole
forest first, and then for the stands you digitized before.

The goal for this lesson: Calculate forest parameters at general and stand level.

14.7.1 Follow Along: Adding the Inventory Results
The field teams visited the forest and with the help of the information you provided, gathered information about the
forest at every sample plot.

Most often the information will be collected into paper forms in the field, then typed to a spreadsheet. The sample
plots information has been condensed into a . csv file that can be easily open in QGIS.

Continue with the QGIS project from the lesson about designing the inventory, you probably named it
forest_inventory.ggs.

First, add the sample plots measurements to your QGIS project:
1. Go to Layer » Add Layer » Add Delimited Text Layer....

2. Browse to the file systematic_inventory_results.csv located in exercise_data/
forestry/results/.

Garanta que a op¢do Coordenadas de Pontos esta activada .
Set the fields for the coordinates to the X and Y fields.

Clique OK.

When prompted, select ETRS89 / ETRS-TM35FIN as the CRS.

N o AW

Abra a nova Tabela de atributos da camada e dé uma vista de olhos nos dados.

You can read the type of data that is contained in the sample plots measurements in the text file
legend_2012_inventorydata.txt located in the exercise_data/forestry/results/ folder.

The systematic_inventory_results layer you just added is actually just a virtual representation of the
text information in the . csv file. Before you continue, convert the inventory results to a real spatial dataset:

1. Right click on the systematic_inventory_results layer.
2. Browse to exercise_data/forestry/results/ folder.
3. Name the file sample_plots_results.shp.

4. Active a opg¢o Adicionar ficheiro guardado ao mapa.

5

. Remove the systematic_inventory_results layer from your project.
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14.7.2 Follow Along: Whole Forest Parameters Estimation

You can calculate the averages for this whole forest area from the inventory results for the some interesting
parameters, like the volume and the number of stems per hectare. Since the systematic sample plots represent

equal areas, you can directly calculate the averages of the volumes and number of stems per hectare from the
sample_plots_results layer.

You can calculate the average of a field in a vector layer using the Basic statistics tool:
1. Open Vector » Analysis Tools » Basic statistics for Fields.
2. Select sample_plots_results as the Input Vector Layer.
3. Select Vol as Target field.
4. Clique OK.

The average volume in the forestis 135.2 m3/ha.

You can calculate the average for the number of stems in the same way, 2745 stems/ha.

! Basics statistics @] ! Basics statistics @]
Input Vector Layer Input Vector Layer
sample_plots_results v sample_plots_results v
Use only selected features Use only selected features
Target field Target field
Vol v iStems v
Statistics output Statistics output
Parameter Value !ﬂ | Parameter Value !ﬂ
Mean 135.153153153 \\ Mean 2744.65765766 \\’
StdDev 69.966941769 StdDev 2775.63980935
Sum 15002.0 Sum 304657.0
Min 15.0 m Min 167.0 m
a a
Max 333.0 E] Max 11400.0 E]
Press Ctrl+C to copy results to the clipboard Press Ctrl+C to copy results to the clipboard
0 0% ] [ o Close 0 0% ] [ o Close
7 4

14.7.3 Follow Along: Estimating Stand Parameters

You can make use of those same systematic sample plots to calculate estimates for the different forest stands you
digitized previously. Some of the forest stands did not get any sample plot and for those you will not get information.
You could have planned some extra sample plots when you planned the systematic inventory, so that the field teams
would have measured a few extra sample plots for this purpose. Or you could send a field team later to get estimates

of the missing forest stands to complete the stand inventory. Nevertheless, you will get information for a good number
of stands just using the planned plots.

What you need is to get the averages of the sample plots that are falling within each of the forest stands. When you
want to combine information based on their relative locations, you perform a spatial join:

1. Open the Vector » Data Management » Join attributes by location tool.
. Set forest_stands_2012 as the Target vector layer. The layer you want the results for.

. Set sample_plots_results as the Join vector layer. The layer you want to calculate estimates from.

2
3
4. Check Take summary of intersecting features.
5

. Active apenas a op¢ao para calcular a Média.

14.7.
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6. Name the result as forest_stands_2012_results.shp and save it in the exercise_data/
forestry/results/ folder.

7. Finalmente seleccione Manter todos os registos..., para que possa verificar mais tarde os povoamentos que nao
tinham informacio.

8. Clique OK.
9. Aceite adicionando a nova camada ao seu projecto assim que solicitado.
10. Feche a ferramenta Juntar atributos por localizagdo .

Open the Attribute table for forest_stands_2012_results and review the results you got. Note that a number of forest
stands have NULL as the value for the calculations, those are the ones having no sample plots. Select them all and
view them in the map, they are some of the smaller stands:
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Let’s calculate now the same averages for the whole forest as you did before, only this time you will use the averages
you got for the stands as the bases for the calculation. Remember that in the previous situation, each sample plot
represented a theoretical stand of 80x80 m. Now you have to consider the area of each of the stands individually
instead. That way, again, the average values of the parameters that are in, for example, m3/ha for the volumes are
converted to total volumes for the stands.

You need to first calculate the areas for the stands and then calculate total volumes and stem numbers for each of
them:

1. Na Tabela de atributos active a edi¢ao.

2. Abra a Calculadora de campos.
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Create a new field called area.
Set the Output field type to Decimal number (real).

Set the Precision to 2.

A

In the Expression box, write Sarea / 10000. This will calculate the area of the forest stands in ha.
7. Clique OK.

Agora calcule o campo com o volume total e o nimeros de drvores para cada povoamento:
1. Name the fields s_vol and s_stem.
2. Os campos podem ser nimeros inteiros mas pode usar igualmente os nimeros reais.

3. Use the expressions "area" * "MEANVol" and "area" * "MEANStems" for total volumes and total
stems respectively.

4. Guarde as edi¢oes quando terminar.
5. Desactive a edigao.

Na situag@o anterior, as dreas representadas por cada parcela de amostra eram as mesmas, portanto, era suficiente
para calcular a média das parcelas de amostra. Agora, para calcular as estimativas, precisa de dividir a soma dos
volumes dos povoamentos ou o nimero de arvores pela soma das areas dos povoamentos que contém informacdes.

1. In the Aftribute table for the forest_stands_2012_results layer, select all the stands containing
information.

Open Vector » Analysis Tools » Basic statistics for fields.

Select the forest_stands_2012_results as the Input layer.
Select area as Field to calculate statistics on.

Check the Selected features only

Clique OK.

SAE I
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1 Basics statistics R
Input Vector Layer
forest_stands_2012_results -

X Use only selected features
Target field

dlred o

Statistics output

Parameter Value
Mean 0.971161764706
StdDev 0.688308297253
Sum 06,039

Min 0.181 E
Maw 3. 726
Press Cirl+C to copy results to the dipboard

i o |

As you can see, the total sum of the stands” areas is 66.04 ha. Note that the area of the missing forest stands is
only about 7 ha.

In the same way, you can calculate that the total volume for these stands is 8908 m3/ha and the total number of
stems is 179594 stems.

Usando a informag@o dos povoamentos florestais, em vez de usar directamente das parcelas de amostragem iremos
ter as seguintes médias estimadas:

e 184.9 m3/haand
e 2719 stems/ha.

Save your QGIS project, forest_inventory.qggs.

14.7.4 In Conclusion

You managed to calculate forest estimates for the whole forest using the information from your systematic sample
plots, first without considering the forest characteristics and also using the interpretation of the aerial image into
forest stands. And you also got some valuable information about the particular stands, which could be used to plan
the management of the forest in the coming years.
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14.7.5 What’s Next?

Na licdo seguinte, ird primeiro criar um fundo com um mapa de sombras a partir de um conjunto de dados LiDAR
que ird usar para preparar a apresentacdo do mapa com os resultados da floresta que acabou de calcular.

14.8 Lesson: DEM from LiDAR Data

You can improve the look of your maps by using different background images. You could use the basic map or the
aerial image you have been using before, but a hillshade raster of the terrain will look nicer in some situations.

You will use LAStools to extract a DEM from a LiDAR dataset and then create a hillshade raster to use in your map
presentation later.

The goal for this lesson: Install LAStools and calculate a DEM from LiDAR data and a hillshade raster.

14.8.1 Follow Along: Installing Lastools
Managing LiDAR data within QGIS is possible using the Processing framework and the algorithms provided by
LAStools.

You can obtain a digital elevation model (DEM) from a LiDAR point cloud and then create a hillshade raster that is
visually more intuitive for presentation purposes. First you will have to set up the Processing framework settings to
properly work with LAStools:

* Close QGIS, if you have already started it.

¢ An old lidar plugin might be installed by default in your system in the folder C: /Program Files/QGIS
Valmiera/apps/ggis/python/plugins/processing/.

¢ If you have a folder named 1idar, delete it. This is valid for some installations of QGIS 2.2 and 2.4.
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e Go to the exercise_data\forestry\lidar\ folder,
QGIS_2_2_toolbox.zip. Open it and extract the 1 idar folder to replace the one you just deleted.

there you can find the file

* If you are using a different QGIS version, you can see more installation instructions in this tutorial.

Now you need to install the LAStools to your computer. Get the newest lastools version here and extract the content of
the lastools. zip file into a folder in your system, for example, C: \lastools\. The path tothe lastools

folder cannot have spaces or special characters.

Nota: Read the LICENSE. txt file inside the 1lastools folder. Some of the LAStools are open source and other
are closed source and require licensing for most commercial and governmental use. For education and evaluation
purposes you can use and test LAStools as much as you need to.

The plugin and the actual algorithms are now installed in your computer and almost ready to use, you just need to set

up the Processing framework to start using them:

¢ Open a new project in QGIS.

¢ Set the project’s CRS to ETRS89 / ETRS-TM35FIN.

 Save the project as forest_lidar.ggs.

To setup the LAStools in QGIS:

¢ Go to Processing » Options and configuration.

¢ In the Processing options dialog, go to Providers and then to Tools for LiDAR data.

¢ Check Activate.

 For LASto0ls folder set c: \1lastools\ (or the folder you extracted LAStools to).
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iy Processing options

Search...

Setting Value |
-- General
Iiﬂ Maodels
Ei Providers
& & GDAL/OGR
-y GRASS commands
“|&] GeoServer/PostGIS tools
- o Modeler-only toals
ﬁ Orfeo Toclbox (Image analysis)
- ﬁ QGIS geealgorithms
'ﬁ' R scripts
& SAGA
-- TauDEM (hydrolegic analysis)
- ¥, Tools for LiDAR data
¥, Activate b

----- k Fusion folder

- 3 LAStools folder Ci\lastools

B |E Scripts

14.8.2 Follow Along: Calculating a DEM with LAStools
You have already used the Processing toolbox in Lesson: Spatial Statistics to run some SAGA algorithms. Now you
are going to use it to run LAStools programs:

¢ Open Processing » Toolbox.

¢ In the dropdown menu at the bottom, select Advanced interface.

* You should see the Tools for LiDAR data category.

458 Capitulo 14. Module: Forestry Application



QGIS Training Manual

- -

Processing Toolbox

Search. ..

&

Recently used algorithms

GDAL/OGR. [32 geoalgorithms]

-y GRASS commands [157 geoalgorithms]

* = GeoServer [PostGIS tools [8 geoalgorithms]

r-ﬂ Models [12 geoalgorithms]

g Orfeo Toolbox (Image analysis) [76 geoalgorithms]
QGIS geoalgorithms [67 geoalgorithms]

% SAGA [243 geoalgorithms]
Scripts [11 geoalgorithms]

k Tools for LIDAR. data [55 geoalgorithms]

Advanced interface

&l

Simplified interface
II

* Expand it to see the tools available, and expand also the LASfools category (the number of algorithms may

vary).
¢ Scroll down until you find the lasview algorithm, double click it to open.
e At Input LAS/LAZ file, browse to exercise_data\forestry\lidar\ and select the
rautjarvi_lidar.laz file.
o . - lasclip
& lasview @ —|ascolar
- lasduplicate
Parameters | Log | Help - lasgrid
- - lasground
- lasheight
verbose - lagindex
- lasinfo
o v - lasmerge
. - lasnoise
input LAS/LAZ file - |asoverage
C:\qais_forestry\exercise_data\forestrylidaryrautiarvi_lidar.laz I] |35WEF_|B_I:'
- laspredision
- |lasguery
- lassort
- lassplit
- lasthin
- lastile
- lasvalidate
- lasview
[I 0% ] - laszip
- shp2las
Run Close Cancel bt 2l
e Click Run.
Now you can see the LIDAR data in the just a little LAS and LAZ viewer dialog window:
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1 just a little LAS and LAZ viewer =N B ==

pan

There are many things you can do within this viewer, but for now you can just click and drag on the viewer to pan
the LiIDAR point cloud to see what it looks like.

Nota: If you want to know further details on how the LAStools work, you can read the README text files about
each of the tools, in the C: \1lastools\bin\ folder. Tutorials and other materials are available at the Rapidlasso
webpage.

* Close the viewer when you are ready.

Creating a DEM with LAStools can be done in two steps, first one to classify the point cloud into ground and no
ground points and then calculating a DEM using only the ground points.

¢ Go back to the Processing Toolbox.
¢ Note the Search... box, write 1asground.

* Double click to open the lasground tool and set it as shown in this image:
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r

g lasground @

Parameters Log Help

verbose
Mo -
input LAS/LAZ file
Ci\qois_forestry\exerdse_data\forestryVidar\rautjarvi_lidar.laz :]
horizontal feet
Mo -
vertical feet
Mo -
airborne LIDAR
Yes -
terrain type
wilderness -
preprocessing
default - =]
il
u o )

Run Close Cancel

* The output file is saved to the same folder where the raut jarvi_lidar.laz is located and it is named
rautjarvi_lidar_1.las.

You can open it with lasview if you want to check it.
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7 just a little LAS and LAZ viewer eS|

pan

The brown points are the points classified as ground and the gray ones are the rest, you can click the letter g to
visualize only the ground points or the letter u to see only the unclassified points. Click the letter a to see all the
points again. Check the lasview_README. txt file for more commands. If you are interested, also this tutorial
about editing LiDAR points manually will show you different operations within the viewer.

* Close the viewer again.
¢ In the Processing Toolbox, search for 1as2demn.

* Open the las2dem tool and set it as shown in this image:
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- =

M las2dem @

Parameters Log Help

S

verbose

Mo -
input LAS/LAZ file

C:\gois_forestry\exerdse_data\forestryllidarrautjarvi_lidar _1.1as [:]
filter (by return, dassification, flags)

——— -

step size [ pixel size

1000000 = E]
Attribute
elevation -
Product
actual values -
Cutput raster file

C:fqais_forestryfexerdse_datafforestryfresults frautjarvi_dem. tif

% Open output file after running algorithm

[ 0% )

ncel

i1

Run Close

The result DEM is added to your map with the generic name Output raster file.

Nota: The lasground and las2dem tools require licensing. You can use the unlicensed tool as indicated in the license
file, but you get the diagonals you can appreciate in the image results.

14.8.3 Follow Along: Creating a Terrain Hillshade

For visualization purposes, a hillshade generated from a DEM gives a better
visualization of the terrain:

¢ Open Raster » Terrain analysis » Hillshade.

¢ As the Output layer, browse to exercise_data\forestry\lidar\ and name the file hillshade.
tif.

 Leave the rest of parameters with the default settings.
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' Hillshade ="
Elevation layer rautjarvi_dem -
COutput layer 2stry flidar frautjarvi_hillshade. tif E]
QOutput format GeoTIFF -

Z factor 1

X Add result to project

Tlumination
Azimuth (haorizontal angle) 300.00 :
vertical angle 40.00 :

* Select ETRS89 / ETRS-TM35FIN as the CRS when prompted.

Despite the diagonal lines remaining in the hillshade raster result, you can clearly see an accurate relief of the area.
You can even see the different soil drains that have been dug in the forests.
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14.8.4 In Conclusion

Using LiDAR data to get a DEM, specially in forested areas, gives good results with not much effort. You could also
use ready LiDAR derived DEMs or other sources like the SRTM 9m resolution DEMs. Either way, you can use them
to create a hillshade raster to use in your map presentations.
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14.8.5 What’s Next?

In the next, and final step in this module, lesson you will use the hillshade raster and the forest inventory results to
create a map presentation of the results.

14.9 Lesson: Map Presentation

In the previous lessons you have imported an old forest inventor as a GIS project, updated it to the current
situation, designed a forest inventory, created maps for the field work and calculated forest parameters from the
field measurements.

It is often important to create maps with the results of a GIS project. A map presenting the results of the forest
inventory will make it easier for anyone to have a good idea of what the results are in a quick glance, without looking
at the specific numbers.

The goal for this lesson: Create a map to present the inventory results using a hillshade raster as background.

14.9.1 Follow Along: Preparing the Map Data
Open the QGIS project from the parameters calculations lesson, forest_inventory.qggs. Keep at least the
following layers:

e forest_stands_2012_results.

* basic_map.

* rautjarvi_aerial.

* lakes (if you don’t have it, add it from the exercise_data\forestry\ folder).

You are going to present the average volumes of your forest stands in a map. If you open the Attribute table for the
forest_stands_2012_results layer, you can see the NULL values for the stands without information. To
be able to get also those stands into your symbology you should change the NULL values to, for example, —999,
knowing that those negative numbers mean there is no data for those polygons.

For the forest_stands_2012_results layer:
* Open the Attribute table and enable editing.
¢ Select the polygons with NULL values.
* Use the calculator to update the values of the MEANVo1 field to —999 only for the selected features.
» Disable editing and save the changes.
Now you can use a saved style for this layer:
¢ Go to the Symbology tab.
¢ Click on Style » Load Style....

e Select the forest_stands_2012_results.gml from the exercise_datal\forestry\
results\ folder.

* Click OK.
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/1 Layer Properties - forest_stands_2012_results | Style

W Layer rendering

Layer transparency ¥; =
Layer blending mode Hard light ~ | Feature blending mode Mormal -
* Graduated -
Column MEANp_vol - | E.
Rendering
Symbol . Change... Classes | 7 =
Display
Color ramp - [source] - Invert Mode | Natural Breaks (Jenks) -
Actions
Symbal | Value | Label |
-299,0000 - 0.0000 Mo data
0.0000 - 15.0000 0-15
15.0000 - 25.0000  15-25
25,0000 - 50,0000 25-50
50,0000 - 100.0000 50 - 100
100.0000 - 150.00... 100 - 150
150.0000 - 300.00... 150 - 300
Classify Add dass Delete Delete all Advanced ~
Load Style ... Save As Default Restore Default Style Save Style =
OK Cancel Apply Help

Your map will look something like this:
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! QGIS 2.2.0-Valmiera - lidar
Project Edit
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I, Mo data
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14.9.2 Try Yourself Try Different Blending Modes

The style you loaded:
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/' Layer Properties - forest_stands_2012_results | Style
W Layer rendering
Layer transparency ¥; =
Layer blending mode Hard light ~ | Feature blending mode Mormal -
€ Labels
* Graduated -
B Fields
- Column MEANp_vol - | E.
§ Rendering
Symbol . Change... Classes | 7 =
- Display
Color ramp - [source] - Invert Mode | Natural Breaks (Jenks) -
G’ Actions -
- Symbol | Value | Label |
+ 4 10ins -393,0000 - 0.0000  No data
0.0000 - 15.0000 0-15
IER Diagrams 15,0000 - 25,0000 15-25
25,0000 - 50,0000 25-50
(i' Metadata 50,0000 - 100.0000 50 - 100
100.0000 - 150.00... 100 - 150
150.0000 - 300.00... 150 - 300
Classify Add dass Delete Delete all Advanced ~
Load Style ... Save As Default Restore Default Style Save Style =
OK Cancel Apply Help

is using the Hard 1light mode for the Layer blending mode. Note that the different modes apply different filters
combining the underlying and overlying layers, in this case the hillshade raster and your forest stands are used. You

can read about these modes in the User Guide.

Try with different modes and see the differences in your map. Then choose the one you like better for your final map.

14.9.3 Try Yourself Using a Layout Template to Create the Map result

Use a template prepared in advanced to present the results. The template forest_map.gpt is located in the
exercise_data\forestry\results\ folder. Load it using the Project » Layout Manager... dialog.
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Create unigue print composer title
(titte generated if left empty)

| results -

w New from template

sroise_data/forestryfresults fforest_map.gpt

Open template directory LIsEer default

Shaw Duplicate Remove Rename Cloze

Ve

Open the print layout and edit the final map to get a result you are happy with.

The map template you are using will give a map similar to this one:
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RAUTIJARVI FOREST
- INVENTORY RESULTS 2012 -

397000 397500 FHE000

Stand Results

Stand Volume (m3/ha)

I no data
[ ]0-15
[]15-25
I 25-50
B s0- 100
Bl 100 - 150
Il 150 - 300

397500

- Results for the whole forest area -

Using Systematic Sample plots Using Stand Sample Plots Averages
Total area: 72.9 Total area: 72.9
Total volume (m3): 9856 Total volume (m3): 13479
Average volume (m3/ha): 135.2 Average volume (m3/ha); 184.9

Save your QGIS project for future references.
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14.9.4 In Conclusion

Through this module you have seen how a basic forest inventory can be planned and presented with QGIS. Many
more forest analysis are possible with the variety of tools that you can access, but hopefully this manual has given you
a good starting point to explore how you could achieve the specific results you need.
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Module: Conceitos de Base de Dados com PostgreSQL

Bases de dados relacionais sdo uma parte importante de qualquer sistema SIG. Neste médulo, ird aprender sobre
conceitos de Sistema de Gestido de Bases de Dados Relacionais (RDBMS) e vai usar o PostgreSQL para criar uma
nova base de dados para armazenar dados, bem como aprender sobre outras fungdes tipicas de RDBMS.

15.1 Lesson: Introduction to Databases

Before using PostgreSQL, let’s make sure of our ground by covering general database theory. You will not need to
enter any of the example code; it’s only there for illustration purposes.

The goal for this lesson: To understand fundamental database concepts.

15.1.1 What is a Database?

A database consists of an organized collection of data for one or more uses, typically in digital form. - Wikipedia

A database management system (DBMS) consists of software that operates databases, providing storage, access,
security, backup and other facilities. - Wikipedia

15.1.2 Tabelas

In relational databases and flat file databases, a table is a set of data elements (values) that is organized using a model
of vertical columns (which are identified by their name) and horizontal rows. A table has a specified number of
columns, but can have any number of rows. Each row is identified by the values appearing in a particular column
subset which has been identified as a candidate key. - Wikipedia

id | name | age
S PR
1 | Tim | 20
2 | Horst | 88

(2 rows)

In SQL databases a table is also known as a relation.
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15.1.3 Columns / Fields

A column is a set of data values of a particular simple type, one for each row of the table. The columns provide
the structure according to which the rows are composed. The term field is often used interchangeably with column,
although many consider it more correct to use field (or field value) to refer specifically to the single item that exists at
the intersection between one row and one column. - Wikipedia

A column:

15.1.4 Records

A record is the information stored in a table row. Each record will have a field for each of the columns in the table.

[2 | Horst | 88 <—-— one record J

15.1.5 Datatypes

Datatypes restrict the kind of information that can be stored in a column. - Tim and Horst
There are many kinds of datatypes. Let’s focus on the most common:

e String - to store free-form text data

e Integer - to store whole numbers

e Real - to store decimal numbers

* Date - to store Horst’s birthday so no one forgets

* Boolean - to store simple true/false values

You can tell the database to allow you to also store nothing in a field. If there is nothing in a field, then the field
content is referred to as a “null” value:

insert into person (age) wvalues (40);

select * from person;

Result
id | name | age
T f—
1 | Tim | 20
2 | Horst | 88
4 | | 40 <—-- null for name
(3 rows)

There are many more datatypes you can use - check the PostgreSQL manual!
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15.1.6 Modelling an Address Database

Let’s use a simple case study to see how a database is constructed. We want to create an address database.

Try Yourself

Write down the properties which make up a simple address and which we would want to store in our database.

Answer

For our theoretical address table, we might want to store the following properties:

House Number
Street Name
Suburb Name
City Name
Postcode
Country

When creating the table to represent an address object, we would create columns to represent each of these properties
and we would name them with SQL-compliant and possibly shortened names:

house_number
street_name
suburb

city
postcode
country

Address Structure

The properties that describe an address are the columns. The type of information stored in each column is its datatype.
In the next section we will analyse our conceptual address table to see how we can make it better!

15.1.7 Database Theory

The process of creating a database involves creating a model of the real world; taking real world concepts and
representing them in the database as entities.

15.1.8 Normalisation
One of the main ideas in a database is to avoid data duplication / redundancy. The process of removing redundancy
from a database is called Normalisation.

Normalization is a systematic way of ensuring that a database structure is suitable for general-purpose querying and
free of certain undesirable characteristics - insertion, update, and deletion anomalies - that could lead to a loss of data
integrity. - Wikipedia

There are different kinds of normalisation “forms”.

Let’s take a look at a simple example:

Table "public.people"
Column \ Type | Modifiers

(continues on next page)
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id | integer | not null default
| | nextval ('people_id_seq'::regclass)
\ |

name | character varying(50) |

address | character varying(200) | not null

phone_no | character varying |

Indexes:

"people_pkey" PRIMARY KEY, btree (id)

select * from people;

id | name | address | phone_no
e F Fm
1 | Tim Sutton | 3 Buirski Plein, Swellendam | 071 123 123
2 | Horst Duester | 4 Avenue du Roix, Geneva | 072 121 122

(2 rows)

Imagine you have many friends with the same street name or city. Every time this data is duplicated, it consumes
space. Worse still, if a city name changes, you have to do a lot of work to update your database.

15.1.9 Try Yourself

Redesign the theoretical people table above to reduce duplication and to normalise the data structure.

You can read more about database normalisation here

Answer

The major problem with the people table is that there is a single address field which contains a person’s entire address.
Thinking about our theoretical address table earlier in this lesson, we know that an address is made up of many
different properties. By storing all these properties in one field, we make it much harder to update and query our
data. We therefore need to split the address field into the various properties. This would give us a table which has the
following structure:

id | name | house_no | street_name | city | phone_no

——te e e o ——— e
1 | Tim Sutton | 3 | Buirski Plein | Swellendam | 071 123 123

2 | Horst Duester | 4 | Avenue du Roix | Geneva | 072 121 122

In the next section, you will learn about Foreign Key relationships which could be used in this example to further
improve our database’s structure.

15.1.10 Indexes

A database index is a data structure that improves the speed of data retrieval operations on a database table. -
Wikipedia
Imagine you are reading a textbook and looking for the explanation of a concept - and the textbook has no index!

You will have to start reading at one cover and work your way through the entire book until you find the information
you need. The index at the back of a book helps you to jump quickly to the page with the relevant information:

[create index person_name_idx on people (name);

Now searches on name will be faster:
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Table "public.people"

Column | Type | Modifiers
,,,,,,,,,, e
id | integer | not null default
| | nextval ('people_id_seq'::regclass)
\ |
name | character varying(50) |
address | character varying(200) | not null
phone_no | character varying |
Indexes:

"people_pkey" PRIMARY KEY, btree (id)
"person_name_idx" btree (name)

15.1.11 Sequences

A sequence is a unique number generator. It is normally used to create a unique identifier for a column in a table.

In this example, id is a sequence - the number is incremented each time a record is added to the table:

id | name | address | phone_no
———e o o ———
1 | Tim Sutton | 3 Buirski Plein, Swellendam | 071 123 123
2 | Horst Duster | 4 Avenue du Roix, Geneva | 072 121 122

15.1.12 Entity Relationship Diagramming

In a normalised database, you typically have many relations (tables). The entity-relationship diagram (ER Diagram) is
used to design the logical dependencies between the relations. Consider our non-normalised people table from earlier
in the lesson:

select * from people;

id | name | address | phone_no
———e— o o ———
1 | Tim Sutton | 3 Buirski Plein, Swellendam | 071 123 123
2 | Horst Duster | 4 Avenue du Roix, Geneva | 072 121 122

(2 rows)

With a little work we can split it into two tables, removing the need to repeat the street name for individuals who live
in the same street:

select * from streets;

id | name
e
1 | Plein Street
(1 row)

and:

select * from people;

id | name | house_no | street_id | phone_no
B Fom e ——— fomm fom
1 | Horst Duster | 4 | 1 ] 072 121 122

(1 row)
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We can then link the two tables using the “keys” streets.id and people.streets_id.

If we draw an ER Diagram for these two tables it would look something like this:

People > Streets

The ER Diagram helps us to express “one to many” relationships. In this case the arrow symbol show that one street
can have many people living on it.

Try Yourself

Our people model still has some normalisation issues - try to see if you can normalise it further and show your thoughts
by means of an ER Diagram.

Answer

Our people table currently looks like this:

id | name | house_no | street_id | phone_no
e fom fom fom
1 | Horst Duster | 4 | 1 | 072 121 122

The street_id column represents a “one to many” relationship between the people object and the related street object,
which is in the streets table.

One way to further normalise the table is to split the name field into first_name and last_name:

id | first_name | last_name | house_no | street_id | phone_no

1 ] Horst | Duster | 4 | 1 | 072 121 122

We can also create separate tables for the town or city name and country, linking them to our people table via “one
to many” relationships:

id | first_name | last_name | house_no | street_id | town_id | country_id

An ER Diagram to represent this would look like this:
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Streets

People > Towns

Countries

15.1.13 Constraints, Primary Keys and Foreign Keys
A database constraint is used to ensure that data in a relation matches the modeller’s view of how that data should be
stored. For example a constraint on your postal code could ensure that the number falls between 1000 and 9999.

A Primary key is one or more field values that make a record unique. Usually the primary key is called id and is a
sequence.

A Foreign key is used to refer to a unique record on another table (using that other table’s primary key).
In ER Diagramming, the linkage between tables is normally based on Foreign keys linking to Primary keys.

If we look at our people example, the table definition shows that the street column is a foreign key that references the
primary key on the streets table:

Table "public.people"

Column | Type | Modifiers

,,,,,,,,,,, e
id | integer | not null default

| | nextval ('people_id_seq'::regclass)

name | character varying (50)

house_no | integer | not null

street_id | integer | not null

phone_no | character varying |

Indexes:

"people_pkey" PRIMARY KEY, btree (id)
Foreign-key constraints:
"people_street_id_fkey" FOREIGN KEY (street_id) REFERENCES streets (id)
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15.1.14 Transactions

When adding, changing, or deleting data in a database, it is always important that the database is left in a good state if
something goes wrong. Most databases provide a feature called transaction support. Transactions allow you to create
a rollback position that you can return to if your modifications to the database did not run as planned.

Take a scenario where you have an accounting system. You need to transfer funds from one account and add them
to another. The sequence of steps would go like this:

» remove R20 from Joe
e add R20 to Anne
If something goes wrong during the process (e.g. power failure), the transaction will be rolled back.

15.1.15 In Conclusion

Databases allow you to manage data in a structured way using simple code structures.

15.1.16 What’s Next?

Now that we’ve looked at how databases work in theory, let’s create a new database to implement the theory we’ve
covered.

15.2 Lesson: Implementing the Data Model
Now that we’ve covered all the theory, let’s create a new database. This database will be used for our exercises for

the lessons that will follow afterwards.

The goal for this lesson: To install the required software and use it to implement our example database.

15.2.1 Install PostgreSQL

Nota: You can find PostgreSQL packages and installation instructions for your operating system at https://www.
postgresql.org/download/. Please note that the documentation will assume users are running QGIS under Ubuntu.

Under Ubuntu:

[sudo apt install postgresqgl-9.1 }

You should get a message like this:

[sudo] password for ggis:

Reading package lists... Done

Building dependency tree

Reading state information... Done

The following extra packages will be installed:
postgresgl-client-9.1 postgresgl-client-common postgresgl-common
Suggested packages:

oidentd ident-server postgresgl-doc-9.1

The following NEW packages will be installed:

postgresqgl-9.1 postgresgl-client-9.1 postgresgl-client-common postgresgl-common
0 upgraded, 4 newly installed, 0 to remove and 5 not upgraded.
Need to get 5,012kB of archives.

(continues on next page)
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After this operation, 19.0MB of additional disk space will be used.
Do you want to continue [Y/n]?

Press Y and Enter and wait for the download and installation to finish.

15.2.2 Ajuda

PostgreSQL has very good online documentation.

15.2.3 Create a database user

Under Ubuntu:

After the installation is complete, run this command to become the postgres user and then create a new database user:

[sudo su — postgres }

Type in your normal log in password when prompted (you need to have sudo rights).

Now, at the postgres user’s bash prompt, create the database user. Make sure the user name matches your unix login
name: it will make your life much easier, as postgres will automatically authenticate you when you are logged in as
that user:

[createuser -d -E -i -1 -P -r -s ggis J

Enter a password when prompted. You should use a different password to your login password.

What do those options mean?

-d, —-—-createdb role can create new databases

-E, ——encrypted encrypt stored password

-i, ——-inherit role inherits privileges of roles it is a member of (default)
-1, —-login role can login (default)

-P, ——pwprompt assign a password to new role

-r, ——createrole role can create new roles

-s, ——superuser role will be superuser

Now you should leave the postgres user’s bash shell environment by typing:

(nie 1

15.2.4 Verify the new account

(ot 1 ]

Should return something like this:

Name |  Owner | Encoding | Collation | Ctype |
—————————— A e
postgres | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
templateO0 | postgres | UTFS8 | en_ZA.utf8 | en_ZA.utf8 |
templatel | postgres | UTFS8 | en_ZA.utf8 | en_ZA.utf8 |
(3 rows)

Type Q to exit.
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15.2.5 Create a database

The createdb command is used to create a new database. It should be run from the bash shell prompt:

[createdb address -0 ggis J

You can verify the existence of your new database by using this command:

EE ]

Which should return something like this:

Name | Owner | Encoding | Collation | Ctype | Access privileges
—————————— Rt ettt S i
address | ggis | UTFS8 | en_ZA.utf8 | en_ZA.utf8 |

postgres | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |

templateO | postgres | UTFS8 | en_ZA.utf8 | en_ZA.utf8 | =c/postgres:.
—postgres=CTc/postgres

templatel | postgres | UTFS8 | en_ZA.utf8 | en_ZA.utf8 | =c/postgres:._
—postgres=CTc/postgres

(4 rows)

Type Q to exit.

15.2.6 Starting a database shell session

You can connect to your database easily like this:

[psql address

To exit out of the psql database shell, type:

E

For help in using the shell, type:

[\2

For help in using sql commands, type:

[\help

To get help on a specific command, type (for example):

[\help create table

See also the Psql cheat sheet.

15.2.7 Make Tables in SQL

Let’s start making some tables! We will use our ER Diagram as a guide. First, connect to the address db:

[psql address

Then create a st reet s table:

[create table streets (id serial not null primary key, name varchar (50));
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serial and varchar are data types. serial tells PostgreSQL to start an integer sequence (auto-number) to
populate the id automatically for every new record. varchar (50) tells PostgreSQL to create a character field of
50 characters in length.

You will notice that the command ends with a ; - all SQL commands should be terminated this way. When you press
Enter, psql will report something like this:

NOTICE: CREATE TABLE will create implicit sequence "streets_id_ seq"
for serial column "streets.id"

NOTICE: CREATE TABLE / PRIMARY KEY will create implicit index
"streets_pkey" for table "streets"

CREATE TABLE

That means your table was created successfully, with a primary key st reets_pkey using streets.id.

Note: If you hit return without entering a ; , then you will get a prompt like this: address—#. This is because PG
is expecting you to enter more. Enter ; to run your command.

To view your table schema, you can do this:

[\d streets

Which should show something like this:

Table "public.streets"

Column | Type | Modifiers
________ S
id | integer | not null default
| | nextval ('streets_id_seq'::regclass)
name | character varying(50) |

Indexes:
"streets_pkey" PRIMARY KEY, btree (id)

To view your table contents, you can do this:

[select * from streets;

Which should show something like this:

(0 rows)

As you can see, our table is currently empty.

Try Yourself

Use the approach shown above to make a table called people:

Add fields such as phone number, home address, name, etc. (these aren’t all valid names: change them to make them
valid). Make sure you give the table an ID column with the same data-type as above.

Answer

The SQL required to create the correct people table is:

create table people (id serial not null primary key,
name varchar (50),
house_no int not null,
street_id int not null,
phone_no varchar null );

The schema for the table (enter \\d people) looks like this:
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Table "public.people"

name
house_no
street_id
phone_no
Indexes:

"people_pkey" PRIMARY KEY, btree (id)

Modifiers

not null default

nextval ('people_id_seq'::regclass)
character varying(50)
integer

integer

character varying

not null
not null

For illustration purposes, we have purposely omitted the fkey constraint.

15.2.8 Create Keys in SQL

The problem with our solution above is that the database doesn’t know that people and streets have a logical
relationship. To express this relationship, we have to define a foreign key that points to the primary key of the

streets table.

People P Streets

There are two ways to do this:

* Add the key after the table has been created

* Define the key at time of table creation

Our table has already been created, so let’s do it the first way:

alter table people
add constraint people_streets_fk foreign key (street_id) references streets(id);

That tells the people table that its st reet_ id fields must match a valid street id from the st reet s table.

The more usual way to create a constraint is to do it when you create the table:

\d people

create table people (id serial not null primary key,

name varchar (50),

house_no int not null,

street_id int references streets(id) not null,
phone_no varchar null);

After adding the constraint, our table schema looks like this now:

Table "public.people"

Column \ Type \ Modifiers
77777777777 +77777777777777777777777,{,777777777777777777777777777777777

id | integer | not null default

\ | nextval ('people_id_seq'::regclass)
name | character varying (50)
(continues on next page)

484 Capitulo 15. Module: Conceitos de Base de Dados com PostgreSQL




QGIS Training Manual

(continuac@o da pégina anterior)

house_no | integer | not null
street_id | integer | not null
phone_no | character varying |

Indexes:

"people_pkey" PRIMARY KEY, btree (id)
Foreign-key constraints:
"people_streets_fk" FOREIGN KEY (id) REFERENCES streets (id)

15.2.9 Create Indexes in SQL

‘We want lightning fast searches on peoples names. To provide for this, we can create an index on the name column

of our people table:

create index people_name_idx on people (name) ;

\d people

‘Which results in:

Table "public.people"

Foreign-key constraints:
"people_streets_fk" FOREIGN KEY (id) REFERENCES streets (id)

Column | Type \ Modifiers
,,,,,,,,,,, o
id | integer | not null default nextval
| | ('people_id_seq'::regclass)

name | character varying(50)

house_no | integer | not null

street_id | integer | not null

phone_no | character varying |
Indexes:

"people_pkey" PRIMARY KEY, btree (id)

"people_name_idx" btree (name) <-— new index added!

15.2.10 Dropping Tables in SQL

If you want to get rid of a table you can use the drop command:

[drop table streets;

In our current example, the above command would not work. Why not?

Answer

The reason the DROP command would not work in this case is because the people table has a Foreign Key constraint
to the streets table. This means that dropping (or deleting) the streets table would leave the people table with references

to non-existent streets data.

It is possible to “force” the streets table to be deleted by using the CASCADE command, but this would also delete the

people and any other table which had a relationship to the streets table. Use with caution!

If you used the same drop table command on the people table, it would be successful:

{drop table people;
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Nota: If you actually did enter that command and dropped the people table, now would be a good time to rebuild
it, as you will need it in the next exercises.

15.2.11 A word on pgAdmin Ill

We are showing you the SQL commands from the psql prompt because it’s a very useful way to learn about databases.
However, there are quicker and easier ways to do a lot of what we are showing you. Install pgAdmin IIT and you can
create, drop, alter etc tables using “point and click” operations in a GUIL.

Under Ubuntu, you can install it like this:

[sudo apt install pgadmin3 }

pgAdmin III will be covered in more detail in another module.

15.2.12 In Conclusion

You have now seen how to create a brand new database, starting completely from scratch.

15.2.13 What’s Next?

Next you’ll learn how to use the DBMS to add new data.

15.3 Lesson: Adding Data to the Model

The models we’ve created will now need to be populated with the data they’re intended to contain.

The goal for this lesson: To learn how to insert new data into the database models.

15.3.1 Insert statement

How do you add data to a table? The sql INSERT statement provides the functionality for this:

[insert into streets (name) values ('High street'); ]

A couple of things to note:

» After the table name (st reets), you list the column names that you will be populating (in this case only the
name column).

o After the values keyword, place the list of field values.
* Strings should be quoted using single quotes.
» Note that we did not insert a value for the id column; this is because it is a sequence and will be auto-generated.
* If you do manually set the id, you may cause serious problems with the integrity of your database.
You should see INSERT 0 1 if it is successful.

You can see the result of your insert action by selecting all the data in the table:

[select * from streets;
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Result:

select * from streets;
id | name
e

1 | High street
(1 row)

Try Yourself

Use the INSERT command to add a new street to the st reet s table.

Answer

The SQL command you should use looks like this (you can replace the street name with a name of your choice):

[insert into streets (name) values ('Low Road');

15.3.2 Sequencing Data Addition According to Constraints

15.3.3 Try Yourself

Try to add a person object to the people table with the following details:

Name: Joe Smith
House Number: 55
Street: Main Street
Phone: 072 882 33 21

Nota: Recall that in this example, we defined phone numbers as strings, not integers.

At this point, you should have an error report if you try to do this without first creating a record for Main Street in
the st reets table.

You should have also noticed that:
* You can’t add the street using its name
* You can’t add a street using a street id before first creating the street record on the streets table

Remember that our two tables are linked via a Primary/Foreign Key pair. This means that no valid person can be
created without there also being a valid corresponding street record.

Using the above knowledge, add the new person to the database.

Answer

Here is the correct SQL statement:

insert into streets (name) values('Main Road');
insert into people (name,house_no, street_id, phone_no)
values ('Joe Smith',55,2,'072 882 33 21"');

If you look at the streets table again (using a select statement as before), you’ll see that the id for the Main Road
entry is 2.

That’s why we could merely enter the number 2 above. Even though we’re not seeing Main Road written out fully
in the entry above, the database will be able to associate that with the street_id value of 2.
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If you have already added a new street object, you might find that the new Main Road has an id of 3 not 2.

15.3.4 Select data

We have already shown you the syntax for selecting records. Let’s look at a few more examples:

[select name from streets; }
[select * from streets; ]
[select * from streets where name='Main Road'; ]

In later sessions we will go into more detail on how to select and filter data.

15.3.5 Update data

What if you want to make a change to some existing data? For example, a street name is changed:

[update streets set name='New Main Road' where name='Main Road'; }

Be very careful using such update statements - if more than one record matches your WHERE clause, they will all be
updated!

A better solution is to use the primary key of the table to reference the record to be changed:

[update streets set name='New Main Road' where id=2; J

It should return UPDATE 1.

Nota: the WHERE statement criteria are case sensitive Main Road is not the same as Main road

15.3.6 Delete Data

In order to delete an object from a table, use the DELETE command:

[delete from people where name = 'Joe Smith'; ]

Let’s look at our people table now:

address=# select * from people;

id | name | house_no | street_id | phone_no
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15.3.7 Try Yourself

Use the skills you have learned to add some new friends to your database:

name | house_no | street_id | phone_no
————————————————— B S et
Joe Bloggs | 3 ] 2 | 072 887 23 45
Jane Smith | 55 | 3 | 072 837 33 35
Roger Jones | 33 | 1 | 072 832 31 38
Sally Norman | 83 | 1 | 072 932 31 32

15.3.8 In Conclusion

Now you know how to add new data to the existing models you created previously. Remember that if you want to
add new kinds of data, you may want to modify and/or create new models to contain that data.

15.3.9 What’s Next?

Now that you’ve added some data, you’ll learn how to use queries to access this data in various ways.

15.4 Lesson: Queries

When you write a SELECT ... command it is commonly known as a query - you are interrogating the database
for information.

The goal of this lesson: To learn how to create queries that will return useful information.

Nota: If you did not do so in the previous lesson, add the following people objects to your people table. If you
receive any errors related to foreign key constraints, you will need to add the “Main Road” object to your streets table
first

insert into people (name,house_no, street_id, phone_no)
values ('Joe Bloggs',3,2,'072 887 23 45'");
insert into people (name,house_no, street_id, phone_no)
values ('Jane Smith',55,3,'072 837 33 35'");
insert into people (name,house_no, street_id, phone_no)
values ('Roger Jones',33,1,'072 832 31 38');
insert into people (name,house_no, street_id, phone_no)
values ('Sally Norman',83,1,'072 932 31 32'");

15.4.1 Ordering Results

Let’s retrieve a list of people ordered by their house numbers:

[select name, house_no from people order by house_no; ]
Result:
name | house_no
______________ +__________
Joe Bloggs | 3
Roger Jones | 33

(continues on next page)
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Jane Smith | 55
Sally Norman | 83
(4 rows)

You can sort the results by the values of more than one column:

[select name, house_no from people order by name, house_no; }
Result:
name | house_no

,,,,,,,,,,,,,, T

Jane Smith | 55

Joe Bloggs | 3

Roger Jones | 33

Sally Norman | 83

(4 rows)

15.4.2 Filtering

Often you won’t want to see every single record in the database - especially if there are thousands of records and you
are only interested in seeing one or two.

Here is an example of a numerical filter which only returns objects whose house_no is less than 50:

select name, house_no from people where house_no < 50;
name | house_no
,,,,,,,,,,,,, o
Joe Bloggs | 3
Roger Jones | 33
(2 rows)
J

You can combine filters (defined using the WHERE clause) with sorting (defined using the ORDER BY clause):

select name, house_no from people where house_no < 50 order by house_no;

name | house_no
,,,,,,,,,,,,, o
Joe Bloggs | 3
Roger Jones | 33
(2 rows)

You can also filter based on text data:

select name, house_no from people where name like

name | house_no
_____________ o
Joe Bloggs | 3
Roger Jones | 33
(2 rows)

J

Here we used the LIKE clause to find all names with an s in them. You'll notice that this query is case-sensitive, so
the Sally Norman entry has not been returned.

If you want to search for a string of letters regardless of case, you can do a case in-sensitive search using the ILIKE
clause:
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select name, house_no from people where name ilike

name | house_no
,,,,,,,,,,,,,, e
Roger Jones | 33
Sally Norman | 83

(2 rows)

That query returned every people object with an r or R in their name.

15.4.3 Joins

What if you want to see the person’s details and their street’s name instead of the ID? In order to do that, you need
to join the two tables together in a single query. Lets look at an example:

select people.name, house_no, streets.name
from people, streets
where people.street_id=streets.id;

Nota: With joins, you will always state the two tables the information is coming from, in this case people and streets.
You also need to specify which two keys must match (foreign key & primary key). If you don’t specify that, you will
get a list of all possible combinations of people and streets, but no way to know who actually lives on which street!

Here is what the correct output will look like:

name | house_no | name
,,,,,,,,,,,,,, B
Joe Bloggs | 3 | Low Street
Roger Jones | 33 | High street
Sally Norman | 83 | High street
Jane Smith | 55 | Main Road

(4 rows)

We will revisit joins as we create more complex queries later. Just remember they provide a simple way to combine
the information from two or more tables.

15.4.4 Sub-Select

Sub-selections allow you to select objects from one table based on the data from another table which is linked via a
foreign key relationship. In our case, we want to find people who live on a specific street.

First, let’s do a little tweaking of our data:

insert into streets (name) wvalues ('QOGIS Road');
insert into streets (name) wvalues ('OGR Corner');
insert into streets (name) wvalues ('Goodle Square');
update people set street_id = 2 where id=2;

update people set street_id = 3 where id=3;

Let’s take a quick look at our data after those changes: we can reuse our query from the previous section:

select people.name, house_no, streets.name
from people, streets
where people.street_id=streets.id;

Result:
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name | house_no | name
______________ B
Roger Jones | 33 | High street
Sally Norman | 83 | High street
Jane Smith | 55 | Main Road
Joe Bloggs | 3 | Low Street
(4 rows)

Now let’s show you a sub-selection on this data. We want to show only people who live in st reet_id number 1:

select people.name
from people, (
select *
from streets
where id=1
) as streets_subset
where people.street_id = streets_subset.id;

Result:

Roger Jones
Sally Norman
(2 rows)

J

Although this is a very simple example and unnecessary with our small data-sets, it illustrates how useful and important
sub-selections can be when querying large and complex data-sets.

15.4.5 Aggregate Queries

One of the powerful features of a database is its ability to summarise the data in its tables. These summaries are
called aggregate queries. Here is a typical example which tells us how many people objects are in our people table:

[select count (*) from people; ]

Result:

If we want the counts to be summarised by street name we can do this:

select count (name), street_id
from people
group by street_id;

Result:
count | street_id
,,,,,,, o
2 | 1
1 3
1 2
(3 rows)

Nota: Because we have not used an ORDER BY clause, the order of your results may not match what is shown here.
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Try Yourself

Summarise the people by street name and show the actual street names instead of the street_ids.

Answer

Here is the correct SQL statement you should use:

select count (people.name), streets.name
from people, streets

where people.street_id=streets.id

group by streets.name;

Result:

count | name

,,,,,, o
1 | Low Street
2 | High street
1 | Main Road

(3 rows)

You will notice that we have prefixed field names with table names (e.g. people.name and streets.name). This needs
to be done whenever the field name is ambiguous (i.e. not unique across all tables in the database).

15.4.6 In Conclusion

You’ve seen how to use queries to return the data in your database in a way that allows you to extract useful information
from it.

15.4.7 What’s Next?

Next you’ll see how to create views from the queries that you’ve written.

15.5 Lesson: Views

When you write a query, you need to spend a lot of time and effort formulating it. With views, you can save the
definition of an SQL query in a reusable “virtual table”.

The goal for this lesson: To save a query as a view.
15.5.1 Creating a View

You can treat a view just like a table, but its data is sourced from a query. Let’s make a simple view based on the
above:

create view roads_count_v as
select count (people.name), streets.name
from people, streets where people.street_id=streets.id
group by people.street_id, streets.name;

As you can see the only change is the create view roads_count_v as part at the beginning. We can now
select data from that view:
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[select * from roads_count_v; J

Result:

Main Road
High street
Low Street

15.5.2 Modifying a View

A view is not fixed, and it contains no “real data”. This means you can easily change it without impacting on any data
in your database:

CREATE OR REPLACE VIEW roads_count_v AS
SELECT count (people.name), streets.name
FROM people, streets WHERE people.street_id=streets.id
GROUP BY people.street_id, streets.name
ORDER BY streets.name;

(This example also shows the best practice convention of using UPPER CASE for all SQL keywords.)

You will see that we have added an ORDER BY clause so that our view rows are nicely sorted:

select * from roads_count_v;
count | name
,,,,,,, e

2 | High street

1 | Low Street

1 | Main Road
(3 rows)

J

15.5.3 Dropping a View

If you no longer need a view, you can delete it like this:

[drop view roads_count_v; }

15.5.4 In Conclusion

Using views, you can save a query and access its results as if it were a table.

15.5.5 What’s Next?

Sometimes, when changing data, you want your changes to have effects elsewhere in the database. The next lesson
will show you how to do this.
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15.6 Lesson: Rules

Rules allow the «query tree» of an incoming query to be rewritten. One common usage is to implement views,
including updatable view. - Wikipedia

The goal for this lesson: To learn how to create new rules for the database.

15.6.1 Creating a logging rule

Say you want to log every change of phone_no in your people table in to a people_log table. So you set up a new
table:

[create table people_log (name text, time timestamp default NOW());

In the next step, create a rule that logs every change of a phone_no in the people table into the people_log table:

create rule people_log as on update to people
where NEW.phone_no <> OLD.phone_no
do insert into people_log values (OLD.name) ;

To test that the rule works, let’s modify a phone number:

[update people set phone_no = '082 555 1234' where id = 2;

Check that the people table was updated correctly:

select * from people where id=2;
id | name | house_no | street_id | phone_no

2 | Joe Bloggs | 3 | 2 | 082 555 1234
(1 row)

Now, thanks to the rule we created, the people_1og table will look like this:

select * from people_log;

name | time
,,,,,,,,,,,, e
Joe Bloggs | 2014-01-11 14:15:11.953141
(1 row)

Nota: The value of the t ime field will depend on the current date and time.

15.6.2 In Conclusion

Rules allow you to automatically add or change data in your database to reflect changes in other parts of the database.
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15.6.3 What’s Next?

The next module will introduce you to Spatial Database using PostGIS, which takes these database concepts and
applies them to GIS data.
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Module: Conceitos sobre Base de Dados Espaciais com PostGIS

Spatial Databases allow the storage of the geometries of records inside a Database as well as providing functionality
for querying and retrieving the records using these Geometries. In this module we will use PostGIS, an extension to
PostgreSQL, to learn how to setup a spatial database, import data into the database and make use of the geographic
functions that PostGIS offers.

While working through this section, you may want to keep a copy of the PostGIS cheat sheet available from Boston
GIS user group. Another useful resource is the online PostGIS documentation.

There are also some more extensive tutorials on PostGIS and Spatial Databases created by Boundless that are now
hosted on the PostGIS’s website:

e Introduction to PostGIS
* PostGIS Database Tips and Tricks
See also PostGIS In Action.

16.1 Lesson: PostGIS Setup

Setting up PostGIS functions will allow you to access spatial functions from within PostgreSQL.

The goal for this lesson: To install spatial functions and briefly demo their effects.

Nota: We will assume the use of PostGIS version 2.1 or newer in this exercise. The installation and database
configuration are different for older versions, but the rest of this material in this module will still work. Consult the
documentation for your platform for help with installation and database configuration.
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16.1.1 Installing under Ubuntu

Postgis is easily installed from apt.

$ sudo apt install postgresql
$ sudo apt install postgis

Really, it’s that easy. ..

Nota:  The exact versions that will be installed depend on which version of Ubuntu you are using and
which repositories you have configured. After installing you can check the version by issuing a select
PostGIS_full_version () ; query with psql or another tool.

To install a specific version (eg, PostgreSQL version 13 and PostGIS 3), you can use the following commands.

$ sudo apt install wget ca-certificates

S sudo lsb_release -a

$ wget —-—quiet -O - https://www.postgresqgl.org/media/keys/ACCC4CF8.asc | sudo apt-
—key add -

$ sudo sh —c 'echo "deb http://apt.postgresqgl.org/pub/repos/apt/ "lsb_release —-cs -
—pgdg main" >> /etc/apt/sources.list.d/pgdg.list’

$ sudo apt-get update

$ sudo apt install postgis postgresqgl-13-postgis-3

16.1.2 Installing under Windows

Installing on Windows can be done from binary packages using a normal Windows installation dialogs.
First Visit the download page. Then follow this guide.

More information about installing on Windows can be found on the PostGIS website.

16.1.3 Installing on Other Platforms

The PostGIS website download has information about installing on other platforms including macOS and on other
Linux distributions

16.1.4 Configuring Databases to use PostGIS

Once PostGIS is installed, you will need to configure your database to use the extensions. If you have installed
PostGIS version > 2.0, this is as simple as issuing the following command with psql using the address database from
our previous exercise.

[$ psgl -d address —-c "CREATE EXTENSION postgis;"

Nota: Depending on your version, you could find more instructions on how to spatially enable a database at https:
/Ipostgis.net/docs/postgis_administration.html#create_spatial_db.
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16.1.5 Looking at the installed PostGIS functions

PostGIS can be thought of as a collection of in-database functions that extend the core capabilities of PostgreSQL so
that it can deal with spatial data. By “deal with”, we mean store, retrieve, query and manipulate. In order to do this,
a number of functions are installed into the database.

Our PostgreSQL address database is now geospatially enabled, thanks to PostGIS. We are going to delve a lot
deeper into this in the coming sections, but let’s give you a quick little taster. Let’s say we want to create a point
from text. First we use the psql command to find functions relating to point. If you are not already connected to the
address database, do so now. Then run:

[\df “o@imie }

This is the command we’re looking for: st_point fromtext. To page through the list, use the down arrow, then
press Q to quit back to the psql shell.

Try running this command:

[select st_pointfromtext ('POINT (1 1)"'"); }

Result:

st_pointfromtext

0101000000000000000000F03F000000000000F03F
(1 row)

Three things to note:
* We defined a point at position 1,1 (EPSG:4326 is assumed) using POINT (1 1),
* We ran an sql statement, but not on any table, just on data entered from the SQL prompt,
¢ The resulting row does not make much sense.

The resulting row is in the OGC format called “Well Known Binary” (WKB). We will look at this format in detail in
the next section.

To get the results back as text, we can do a quick scan through the function list for something that returns text:

[\df *text }

The query we’re looking for now is st_astext. Let’s combine it with the previous query:

[select st_astext (st_pointfromtext ("POINT (1 1)")); }

Result:

st_astext

POINT (1 1)
(1 row)

Here, we entered the string POINT (1, 1), turned it into a point using st_pointfromtext (), and turned it
back into a human-readable form with st_astext (), which gave us back our original string.

One last example before we really get into the detail of using PostGIS:

{select st_astext (st_buffer (st_pointfromtext ('"POINT (1 1)"),1.0)); ]

What did that do? It created a buffer of 1 degree around our point, and returned the result as text.
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16.1.6 Spatial Reference Systems

In addition to the PostGIS functions, the extension contains a collection of spatial reference system (SRS) definitions
as defined by the European Petroleum Survey Group (EPSG). These are used during operations such as coordinate
reference system (CRS) conversions.

We can inspect these SRS definitions in our database as they are stored in normal database tables.

First, let’s look at the schema of the table by entering the following command in the psql prompt:

[\d spatial_ref_sys }

The result should be this:

Table "public.spatial_ref sys"

Column \ Type | Modifiers
,,,,,,,,,,, B
srid | integer | not null
auth_name | character varying (256) |
auth_srid | integer |
srtext | character varying (2048) |

projd4text | character varying(2048) |

Indexes:

"spatial_ref_ sys_pkey" PRIMARY KEY, btree (srid)

J

You can use standard SQL queries (as we have learned from our introductory sections), to view and manipulate this
table - though its not a good idea to update or delete any records unless you know what you are doing.

One SRID you may be interested in is EPSG:4326 - the geographic / lat lon reference system using the WGS 84
ellipsoid. Let’s take a look at it:

[select * from spatial_ref_ sys where srid=4326; }
Result:
srid 4326

\
auth_name | EPSG
auth_srid | 4326
srtext | GEOGCS["WGS 84",DATUM["WGS_1984", SPHEROID ["WGS
84",6378137,298.257223563, AUTHORITY ["EPSG","7030"]], TOWGS84 [0,
0,0,0,0,0,0],AUTHORITY["EPSG","6326"]],PRIMEM["Greenwich", 0,
AUTHORITY["EPSG","8901"]],UNIT["degree",0.01745329251994328,
AUTHORITY["EPSG","9122"]],AUTHORITY["EPSG","4326"]]

projd4text | +proj=longlat +ellps=WGS84 +datum=WGS84 +no_defs

The srtext is the projection definition in well known text (you may recognise this from .prj files in your shapefile
collection).

16.1.7 In Conclusion

You now have PostGIS functions installed in your copy of PostgreSQL. With this you’ll be able to make use of
PostGIS” extensive spatial functions.
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16.1.8 What’s Next?

Next you’ll learn how spatial features are represented in a database.

16.2 Lesson: Simple Feature Model

How can we store and represent geographic features in a database? In this lesson we’ll cover one approach, the Simple
Feature Model as defined by the OGC.

The goal for this lesson: To learn what the SFS Model is and how to use it.

16.2.1 What is OGC

The Open Geospatial Consortium (OGC), an international voluntary consensus standards organization, originated
in 1994. In the OGC, more than 370+ commercial, governmental, nonprofit and research organizations worldwide
collaborate in an open consensus process encouraging development and implementation of standards for geospatial
content and services, GIS data processing and data sharing. - Wikipedia

16.2.2 What is the SFS Model

The Simple Feature for SQL (SES) Model is a non-topological way to store geospatial data in a database and defines
functions for accessing, operating, and constructing these data.

Geometry | 0..* SpatialReferenceSystem
.-'?x
[ A I 1
Paint Curve Surface | GeometryCollection |
2-.l
R A L’% Eﬁ
N |
LineString Polygon ) .
1= = MultiSurface MultiCurve T
= ) 1
[;} 0 J1.» ZF. _
4 MultiPolygon MultiLineString
Line LinearRing

The model defines geospatial data from Point, Linestring, and Polygon types (and aggregations of them to Multi
objects).

For further information, have a look at the OGC Simple Feature for SQL standard.
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16.2.3 Add a geometry field to table

Let’s add a point field to our people table:

[alter table people add column the_geom geometry; J

16.2.4 Add a constraint based on geometry type

You will notice that the geometry field type does not implicitly specify what type of geometry for the field - for that
we need a constraint:

alter table people
add constraint people_geom_point_chk
check (st_geometrytype (the_geom) = 'ST_Point'::text
OR the_geom IS NULL) ;

This adds a constraint to the table so that it will only accept a point geometry or a null value.

16.2.5 Try Yourself

Create a new table called cities and give it some appropriate columns, including a geometry field for storing polygons
(the city boundaries). Make sure it has a constraint enforcing geometries to be polygons.

Answer

create table cities (id serial not null primary key,
name varchar (50),
the_geom geometry not null);
alter table cities
add constraint cities_geom_point_chk
check (st_geometrytype(the_geom) = 'ST_Polygon'::text );

16.2.6 Populate geometry_columns table

At this point you should also add an entry into the geometry_columns table:

insert into geometry_columns values
("', 'public', '"people', 'the_geonm',2,4326, "POINT') ;

Why? geometry_columns is used by certain applications to be aware of which tables in the database contain
geometry data.

Nota: If the above INSERT statement causes an error, run this query first:

[select * from geometry_columns; ]

If the column f_table_name contains the value people, then this table has already been registered and you
don’t need to do anything more.

The value 2 refers to the number of dimensions; in this case, two: X and Y.

The value 4 32 6 refers to the projection we are using; in this case, WGS 84, which is referred to by the number 4326
(refer to the earlier discussion about the EPSG).
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Try Yourself

Add an appropriate geometry_columns entry for your new cities layer

Answer

insert into geometry_columns values
('"','public', 'cities', 'the_geom',2,4326, '"POLYGON") ;

16.2.7 Add geometry record to table using SQL

Now that our tables are geo-enabled, we can store geometries in them:

insert into people (name,house_no, street_id, phone_no, the_geom)
values ('Fault Towers',
34,
3/
'072 812 31 28°',
'SRID=4326;POINT (33 -33)"');

Nota: In the new entry above, you will need to specify which projection (SRID) you want to use. This is because
you entered the geometry of the new point using a plain string of text, which does not automatically add the correct
projection information. Obviously, the new point needs to use the same SRID as the data-set it is being added to, so
you need to specify it.

If at this point you were using a graphical interface, for example, specifying the projection for each point would be
automatic. In other words, you usually won’t need to worry about using the correct projection for every point you
want to add if you’ve already specified it for that data-set, as we did earlier.

Now is probably a good time to open QGIS and try to view your people table. Also, we should try editing / adding
/ deleting records and then performing select queries in the database to see how the data has changed.

To load a PostGIS layer in QGIS, use the Layer » Add PostGIS Layers menu option or toolbar button:
p

This will open the dialog:
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800 Add PostCIS Table(s)
Connections
Connect |[ New || Edit Delete l Load ] l Save ]
Schema v Table Column Data Type Spatial Type SRID

[ | Also list tables with no geometry

-
[ | Search options

[(Help ] = Add Set Filter | Close |

Click on the New button to open this dialog:
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.8 .0 6 Create a New PostGIS connection
Connection Information

Name |

Service |

Host |

Port |5432

Database |
551 mode I disable

Username |

Password |

| | Save Username

| | Save Password l Test Connect

| | Only look in the layer registries

| | Don't resclve type of unrestricted columns (GEOMETRY)
| | Only look in the 'public’ schema

| | Also list tables with no geometry

| | Use estimated table metadata

| Help | | Cancel | [

Then define a new connection, e.g.:

Name: myPG
Service:

Host: localhost
Port: 5432
Database: address
User:

Password:

J

To see whether QGIS has found the address database and that your username and password are correct, click
Test Connect. If it works, check the boxes next to Save Username and Save Password. Then click OK to create this
connection.

Back in the Add PostGIS Layers dialog, click Connect and add layers to your project as usual.
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Try Yourself

Formulate a query that shows a person’s name, street name and position (from the the_geom column) as plain text.

Answer

select people.name,

streets.name as street_name,

st_astext (people.the_geom) as geometry
from streets, people
where people.street_id=streets.id;

Result:

High street
High street
Main Road

Roger Jones
Sally Norman
Jane Smith

Joe Bloggs Low Street
Fault Towers Main Road POINT (33 —33)
(5 rows)

As you can see, our constraint allows nulls to be added into the database.

16.2.8 In Conclusion

You have seen how to add spatial objects to your database and view them in GIS software.

16.2.9 What’s Next?

Next you’ll see how to import data into, and export data from, your database.

16.3 Lesson: Import and Export

Of course, a database with no easy way to migrate data into it and out of it would not be of much use. Fortunately,
there are a number of tools that will let you easily move data into and out of PostGIS.

16.3.1 shp2pgsql

shp2pgsql is a commandline tool to import ESRI Shapefile to the database. Under Unix, you can use the following
command for importing a new PostGIS table:

shp2pgsgl —-s <SRID> -c -D -I <path to shapefile> <schema>.<table> | \
psgl -d <databasename> -h <hostname> -U <username>

Under Windows, you have to perform the import process in two steps:

shp2pgsgl -s <SRID> -c -D -I <path to shapefile> <schema>.<table> > import.sqgl
psqgl psgl -d <databasename> -h <hostname> -U <username> -f import.sqgl

You may encounter this error:
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ERROR: operator class "gist_geometry_ops" does not exist for access method
" : "
gist

This is a known issue regarding the creation in sifu of a spatial index for the data you’re importing. To avoid the error,
exclude the —I parameter. This will mean that no spatial index is being created directly, and you’ll need to create it
in the database after the data have been imported. (The creation of a spatial index will be covered in the next lesson.)

16.3.2 pgsql2shp

pgsql2shp is a commandline tool to export PostGIS Tables, Views or SQL select queries. To do this under Unix:

pgsql2shp —-f <path to new shapefile> —-g <geometry column name> \
—-h <hostname> -U <username> <databasename> <table | view>

To export the data using a query:

pgsgl2shp —f <path to new shapefile> —-g <geometry column name> \
—h <hostname> -U <username> "<query>"

16.3.3 ogr2ogr

ogr2ogr is a very powerful tool to convert data into and from postgis to many data formats. ogr2ogr is part of the
GDAL library and has to be installed separately. To export a table from PostGIS to GML, you can use this command:

ogr2ogr —-f GML export.gml PG:'dbname=<databasename> user=<username>
host=<hostname>' <Name of PostGIS-Table>

16.3.4 Gestor BD

You may have noticed another option in the Database menu labeled DB Manager. This is a tool that provides a
unified interface for interacting with spatial databases including PostGIS. It also allows you to import and export
from databases to other formats. Since the next module is largely devoted to using this tool, we will only briefly
mention it here.

16.3.5 In Conclusion

Importing and exporting data to and from the database can be done in many various ways. Especially when using
disparate data sources, you will probably use these functions (or others like them) on a regular basis.

16.3.6 What’s Next?

Next we'll look at how to query the data we've created before.
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16.4 Lesson: Spatial Queries

Spatial queries are no different from other database queries. You can use the geometry column like any other database
column. With the installation of PostGIS in our database, we have additional functions to query our database.

The goal for this lesson: To see how spatial functions are implemented similarly to «normal» non-spatial functions.

16.4.1 Spatial Operators

When you want to know which points are within a distance of 2 degrees to a point(X,Y) you can do this with:

select *
from people
where st_distance (the_geom, 'SRID=4326;POINT (33 -34)"') < 2;
Result:
N
id | name | house_no | street_id | phone_no | the_geom
e e Fm————————— Fmm——————— Fmm e — e —
6 | Fault Towers | 34 | 3 | 072 812 31 28 | 01010008040C0
(1 row)

Nota: the_geom value above was truncated for space on this page. If you want to see the point in human-readable
coordinates, try something similar to what you did in the section «View a point as WKT», above.

How do we know that the query above returns all the points within 2 degrees? Why not 2 meters? Or any other unit,
for that matter?

Answer

The units being used by the example query are degrees, because the CRS that the layer is using is WGS 84. This
is a Geographic CRS, which means that its units are in degrees. A Projected CRS, like the UTM projections, is in
meters.

Remember that when you write a query, you need to know which units the layer’s CRS is in. This will allow you to
write a query that will return the results that you expect.

16.4.2 Spatial Indexes

We also can define spatial indexes. A spatial index makes your spatial queries much faster. To create a spatial index
on the geometry column use:

CREATE INDEX people_geo_idx
ON people
USING gist
(the_geom) ;

\d people

Result:

Table "public.people"

Column \ Type Modifiers

not null default
nextval ('people_id_seq'::regclass)

(continues on next page)
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name | character wvarying (50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character wvarying |
the_geom | geometry |

Indexes:

"people_pkey" PRIMARY KEY, btree (id)
"people_geo_idx" gist (the_geom) <-- new spatial key added
"people_name_idx" btree (name)

Check constraints:
"people_geom_point_chk" CHECK (st_geometrytype (the_geom) = 'ST_Point'::text
OR the_geom IS NULL)

Foreign-key constraints:
"people_street_id_fkey" FOREIGN KEY (street_id) REFERENCES streets (id)

16.4.3 Try Yourself

Modify the cities table so its geometry column is spatially indexed.

Answer

CREATE INDEX cities_geo_idx
ON cities
USING gist (the_geom);

16.4.4 PostGIS Spatial Functions Demo

In order to demo PostGIS spatial functions, we’ll create a new database containing some (fictional) data.

To start, create a new database (exit the psql shell first):

{createdb postgis_demo ]

Remember to install the postgis extensions:

[psql —-d postgis_demo —-c "CREATE EXTENSION postgis;" ]

Next, import the data provided in the exercise_data/postgis/ directory. Refer back to the previous lesson
for instructions, but remember that you’ll need to create a new PostGIS connection to the new database. You can
import from the terminal or via DB Manager. Import the files into the following database tables:

e points.shpintobuilding
¢ lines.shpinto road
e polygons.shp into region

Load these three database layers into QGIS via the Add PostGIS Layers dialog, as usual. When you open their attribute
tables, you'll note that they have both an id field and a gid field created by the PostGIS import.

Now that the tables are imported, we can use PostGIS to query the data. Go back to your terminal (command line)
and enter the psql prompt by running:

[psql postgis_demo }

We’ll demo some of these select statements by creating views from them, so that you can open them in QGIS and see
the results.
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Select by location

Get all the buildings in the KwaZulu region:

SELECT a.id, a.name, st_astext (a.the_geom) as point
FROM building a, region b
WHERE st_within(a.the_geom, b.the_geom)

AND b.name = 'Kwazulu';

Result

id | name | point

S o
30 | York | POINT(1622345.23785063 6940490.65844485)
33 | York | POINT(1622495.65620524 6940403.87862489)
35 | York | POINT(1622403.09106394 6940212.96302097)
36 | York | POINT(1622287.38463732 6940357.59605424)
40 | York | POINT(1621888.19746548 6940508.01440885)
(5 rows)

Or, if we create a view from it:

CREATE VIEW vw_select_location AS
SELECT a.gid, a.name, a.the_geom
FROM building a, region b
WHERE st_within(a.the_geom, b.the_geom)
AND b.name = 'Kwazulu';

Add the view as a layer and view it in QGIS:
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Select neighbors

Show a list of all the names of regions adjoining the Hokkaido region:

SELECT b.name
FROM region a, region b
WHERE st_touches (a.the_geom, b.the_geom)
AND a.name = 'Hokkaido';

Result:

Missouri
Saskatchewan
Wales

(3 rows)

As a view:

CREATE VIEW vw_regions_adjoining_hokkaido AS
SELECT b.gid, b.name, b.the_geom
FROM region a, region b
WHERE st_touches (a.the_geom, b.the_geom)
AND a.name = 'Hokkaido';

0666 QGIS 2.0.1-Dufour
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°
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Germania
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S DHBINANS

1619011.83,6936223.12 : 1626836.32,6041240.73 [&] Coordinate: | 1625604,6937291 Scale (133565585 [+ [SY] (& Render EPSG:4326 ()] (4] |

Note the missing region (Queensland). This may be due to a topology error. Artifacts such as this can alert us to
potential problems in the data. To solve this enigma without getting caught up in the anomalies the data may have,
we could use a buffer intersect instead:

CREATE VIEW vw_hokkaido_buffer AS
SELECT gid, ST_BUFFER(the_geom, 100) as the_geom

(continues on next page)
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(continuagdo da pagina anterior)
FROM region
WHERE name = 'Hokkaido';

This creates a buffer of 100 meters around the region Hokkaido.

The darker area is the buffer:
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Select using the buffer:

CREATE VIEW vw_hokkaido_buffer_select AS
SELECT b.gid, b.name, b.the_geom
FROM
(
SELECT * FROM
vw_hokkaido_buffer

) al

region b

WHERE ST_INTERSECTS (a.the_geom, b.the_geom)
AND b.name != 'Hokkaido';

J

In this query, the original buffer view is used as any other table would be. It is given the alias a, and its geometry field,
a.the_geom, is used to select any polygon in the region table (alias b) that intersects it. However, Hokkaido
itself is excluded from this select statement, because we don’t want it; we only want the regions adjoining it.

In QGIS:
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It is also possible to select all objects within a given distance, without the extra step of creating a buffer:

CREATE VIEW vw_hokkaido_distance_select AS
SELECT b.gid, b.name, b.the_geom
FROM region a, region b
WHERE ST_DISTANCE (a.the_geom, b.the_geom) < 100
AND a.name = 'Hokkaido'
AND b.name != 'Hokkaido';

This achieves the same result, without need for the interim buffer step:
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Select unique values

Show a list of unique town names for all buildings in the Queensland region:

SELECT DISTINCT a.name
FROM building a, region b
WHERE st_within(a.the_geom, b.the_geom)
AND b.name = 'Queensland';

Result:

Beijing
Berlin
Atlanta
(3 rows)

Further examples ...

CREATE VIEW vw_shortestline AS
SELECT b.gid AS gid,
ST_ASTEXT (ST_SHORTESTLINE (a.the_geom, b.the_geom)) as text,
ST_SHORTESTLINE (a.the_geom, b.the_geom) AS the_geom
FROM road a, building b
WHERE a.id=5 AND b.id=22;

CREATE VIEW vw_longestline AS
SELECT b.gid AS gid,
ST_ASTEXT (ST_LONGESTLINE (a.the_geom, b.the_geom)) as text,
ST_LONGESTLINE (a.the_geom, b.the_geom) AS the_geom
FROM road a, building b
WHERE a.id=5 AND b.id=22;

CREATE VIEW vw_road_centroid AS
SELECT a.gid as gid, ST_CENTROID (a.the_geom) as the_geom
FROM road a
WHERE a.id = 1;

CREATE VIEW vw_region_centroid AS
SELECT a.gid as gid, ST_CENTROID (a.the_geom) as the_geom
FROM region a
WHERE a.name = 'Saskatchewan';

SELECT ST_PERIMETER (a.the_geom)
FROM region a
WHERE a.name='Queensland';

SELECT ST_AREA (a.the_geom)
FROM region a
WHERE a.name='Queensland';

CREATE VIEW vw_simplify AS
SELECT gid, ST_Simplify(the_geom, 20) AS the_geom
FROM road;

CREATE VIEW vw_simplify_more AS
SELECT gid, ST_Simplify(the_geom, 50) AS the_geom
FROM road;
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CREATE VIEW vw_convex_hull AS
SELECT
ROW_NUMBER () over (order by a.name) as id,
a.name as town,
ST_CONVEXHULL (ST_COLLECT (a.the_geom)) AS the_geom
FROM building a
GROUP BY a.name;

16.4.5 In Conclusion

You have seen how to query spatial objects using the new database functions from PostGIS.

16.4.6 What’s Next?

Next we’re going to investigate the structures of more complex geometries and how to create them using PostGIS.

16.5 Lesson: Geometry Construction

In this section we are going to delve a little deeper into how simple geometries are constructed in SQL. In reality, you
will probably use a GIS like QGIS to create complex geometries using their digitising tools; however, understanding

how they are formulated can be handy for writing queries and understanding how the database is assembled.

The goal of this lesson: To better understand how to create spatial entities directly in PostgreSQL/PostGIS.

16.5.1 Creating Linestrings

Going back to our address database, let’s get our streets table matching the others; i.e., having a constraint on the

geometry, an index and an entry in the geometry_columns table.

16.5.2 Try Yourself

* Modify the st reet s table so that it has a geometry column of type ST_LineString.
¢ Don’t forget to do the accompanying update to the geometry columns table!
 Also add a constraint to prevent any geometries being added that are not LINESTRINGS or null.

* Create a spatial index on the new geometry column

Answer

alter table streets add column the_geom geometry;
alter table streets add constraint streets_geom_point_chk check

(st_geometrytype (the_geom) = 'ST_LineString'::text OR the_geom IS NULL) ;
insert into geometry_columns values ('', 'public', 'streets', 'the_geom',2,4326,
'LINESTRING') ;

create index streets_geo_idx
on streets
using gist
(the_geom) ;

Now let’s insert a linestring into our streets table. In this case we will update an existing street record:
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update streets
set the_geom = 'SRID=4326; LINESTRING (20 -33, 21 -34, 24 -33)'
where streets.id=2;

Take a look at the results in QGIS. (You may need to right-click on the streets layer in the “Layers” panel, and choose
“Zoom to layer extent”.)

Now create some more streets entries - some in QGIS and some from the command line.

16.5.3 Creating Polygons

Creating polygons is just as easy. One thing to remember is that by definition, polygons have at least four vertices,
with the last and first being co-located:

insert into cities (name, the_geom)
values ('Tokyo', 'SRID=4326;POLYGON( (10 -10, 5 -32, 30 -27, 10 -10))");

Nota: A polygon requires double brackets around its coordinate list; this is to allow you to add complex polygons
with multiple unconnected areas. For instance

insert into cities (name, the_geom)
values ('Tokyo Outer Wards',
'SRID=4326; POLYGON ( (20 10, 20 20, 35 20, 20 10),
(-10 -30, -5 0, -15 -15, -10 -30))"
)

If you followed this step, you can check what it did by loading the cities dataset into QGIS, opening its attribute table,
and selecting the new entry. Note how the two new polygons behave like one polygon.

16.5.4 Exercise: Linking Cities to People

For this exercise you should do the following:
* Delete all data from your people table.
* Add a foreign key column to people that references the primary key of the cities table.
¢ Use QGIS to capture some cities.
» Use SQL to insert some new people records, ensuring that each has an associated street and city.

Your updated people schema should look something like this:

\d people

Table "public.people"

Column | Type | Modifiers
___________ T

id | integer | not null

| | default nextval ('people_id_seq'::regclass)

name | character varying(50) |

house_no | integer | not null

street_id | integer | not null

phone_no | character varying |

the_geom | geometry |

city_id | integer | not null
Indexes:

"people_pkey" PRIMARY KEY, btree (id)
"people_name_idx" btree (name)
(continues on next page)
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Check constraints:
"people_geom_point_chk" CHECK (st_geometrytype (the_geom) =
'ST_Point'::text OR the_geom IS NULL)
Foreign-key constraints:
"people_city_id_fkey" FOREIGN KEY (city_id) REFERENCES cities (id)
"people_street_id_fkey" FOREIGN KEY (street_id) REFERENCES streets (id)

Answer

delete from people;
alter table people add column city_id int not null references cities(id);

(capture cities in QGIS)

insert into people (name,house_no, street_id, phone_no, city_id, the_geom)

values ('Faulty Towers',
34,
3/
'072 812 31 28",
1!

'SRID=4326;POINT (33 33)"'");

insert into people (name,house_no, street_id, phone_no, city_id, the_geom)
values ('IP Knightly',
32,
1I
'071 812 31 28",
1,F
"SRID=4326;POINT (32 —-34)"');

insert into people (name,house_no, street_id, phone_no, city_id, the_geom)
values ('Rusty Bedsprings',
39,
lr
'071 822 31 28",
ll
"SRID=4326;POINT (34 —-34)"');

If you're getting the following error message:

ERROR: insert or update on table "people" violates foreign key constraint
"people_city_id_fkey"
DETAIL: Key (city_id)=(1) is not present in table "cities".

J

then it means that while experimenting with creating polygons for the cities table, you must have deleted some of

them and started over. Just check the entries in your cities table and use any id which exists.
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16.5.5 Looking at Our Schema

By now our schema should be looking like this:

cities people
Hid Oid streets
Hhame Oname E icd
Othe_geom O house_no - |- r?hame
Ostreet_id M— B_geom
O phone_no
Othe_geom
Ocity_id

16.5.6 Try Yourself

Create city boundaries by computing the minimum convex hull of all addresses for that city and computing a buffer
around that area.

16.5.7 Access Sub-Objects

With the SFS-Model functions, you have a wide variety of options to access sub-objects of SFS Geometries. When
you want to select the first vertex point of every polygon geometry in the table myPolygonTable, you have to do this
in this way:

* Transform the polygon boundary to a linestring:

[select st_boundary (geometry) from myPolygonTable; }

¢ Select the first vertex point of the resultant linestring:

select st_startpoint (myGeometry)

from (
select st_boundary (geometry) as myGeometry
from myPolygonTable) as foo;

16.5.8 Data Processing

PostGIS supports all OGC SFS/MM standard conform functions. All these functions start with ST_.

16.5.9 Clipping

To clip a subpart of your data you can use the ST_INTERSECT () function. To avoid empty geometries, use:

[where not st_isempty(st_intersection(a.the_geom, b.the_geom))
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select st_intersection(a.the_geom, b.the_geom), b.*

from clip as a, road_lines as b

where not st_isempty(st_intersection(st_setsrid(a.the_geom,32734),
b.the_geom)) ;

/

rﬂj;r 'ﬁff.}-—‘- :

—— U L,
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16.5.10 Building Geometries from Other Geometries

From a given point table, you want to generate a linestring. The order of the points is defined by their 1d. Another
ordering method could be a timestamp, such as the one you get when you capture waypoints with a GPS receiver.

@10

@9

©8

o7
06
o5
04

©3

02

°1

To create a linestring from a new point layer called “points”, you can run the following command:

select ST_LineFromMultiPoint (st_collect (the_geom)), 1 as id
from (

select the_geom

from points

order by id
) as foo;

To see how it works without creating a new layer, you could also run this command on the “people” layer, although
of course it would make little real-world sense to do this.

520 Capitulo 16. Module: Conceitos sobre Base de Dados Espaciais com PostGIS



QGIS Training Manual

10

16.5.11 Geometry Cleaning

You can get more information for this topic in this blog entry.

16.5.12 Differences between tables

To detect the difference between two tables with the same structure, you can use the PostgreSQL keyword EXCEPT:

select * from table_a
except
select * from table_b;

As the result, you will get all records from table_a which are not stored in table_b.
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16.5.13 Tablespaces

You can define where postgres should store its data on disk by creating tablespaces:

[CREATE TABLESPACE homespace LOCATION '/home/pg'; }

When you create a database, you can then specify which tablespace to use e.g.:

[createdb ——tablespace=homespace t4a }

16.5.14 In Conclusion

You’ve learned how to create more complex geometries using PostGIS statements. Keep in mind that this is mostly to
improve your tacit knowledge when working with geo-enabled databases through a GIS frontend. You usually won’t
need to actually enter these statements manually, but having a general idea of their structure will help you when using
a GIS, especially if you encounter errors that would otherwise seem cryptic.
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Guia de Processamento QGIS

Este médulo teve os contributos de Victor Olaya e Paolo Cavallini.

Conteudos:

17.1 Introducao

This guide describes how to use the QGIS processing framework. It assumes no previous knowledge of the Processing
framework or any of the applications that it rely on. It assumes basic knowledge of QGIS. The chapters about scripting
assume you have some basic knowledge of Python and maybe the QGIS Python APIL.

This guide is designed for self-study or to be used for running a processing workshop.
Examples in this guide use QGIS 3.4. They might not work or not be available in versions other than that one.

This guide is comprised of a set of small exercises of progressive complexity. If you have never used the processing
framework, you should start from the very beginning. If you have some previous experience, feel free to skip lessons.
They are more or less independent of each other, and each one introduces some new concept or some new element,
as indicated in the chapter title and the short introduction at the beginning of each chapter. That should make it easy
to locate lessons dealing with a particular topic.

For a more systematic description of all the framework components and their usage, it is recommended to check the
corresponding chapter in the user manual. Use it as a support text along with this guide.

All the exercises in this guide use the same free dataset used throughout the training manual and referenced at section
Data. The zip file to download contains several folders corresponding to each one of the lessons in this guide. In each
of them you will find a QGIS project file. Just open it and you will be ready to start the lesson.

Enjoy!
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17.2 Aviso importante antes de comecar

Just like the manual of a word processor doesn’t teach you how to write a novel or a poem, or a CAD tutorial doesn’t
show you how to calculate the size of a beam for a building, this guide will not teach you spatial analysis. Instead, it
will show you how to use the QGIS Processing framework, a powerful tool for performing spatial analysis. It is up
to you to learn the required concepts that are needed to understand that type of analysis. Without them, there is no
point in using the framework and its algorithms, although you might be tempted to try.

Let’s show this more clearly with an example.

Given a set of points and a value of a given variable value at each point, you can calculate a raster layer from them
using the Kriging geoalgorithm. The parameters dialog for that module is like the following one.

Ordinary Kriging

Parameters | Log

Points =
points [EPSG:27700] v | e[| @

Attribute

123 |d =

Type of Quality Measure

v Logarithmic Transformation

v Block Kriging

Block Size

100.000000 -
Maximum Distance

-1.000000 =
Lag Distance Classes

100 v
Skip

1 a
Variogram Model

at+b*x

Output extent (xmin, xmax, ymin, ymax) [optional]

[Leave blank to use min covering extent]

Cellsize

1.000000 =
Fit

Search Range

0%

Run as Batch Process...  Close | Run |

It looks complex, right?

By reading this manual, you will learn things such as how to use that module, how to run it in a batch process to create
raster layers from hundreds of points layers in a single run, or what happens if the input layer has some points selected.
However, the parameters themselves are not explained. A seasoned analyst with a good knowledge of geostatistics
will have no problem understanding those parameters. If you are not one of them and sill, range, or nugget are not
familiar concepts to you, then you should not use the Kriging module. More than that, you are far from being ready to
use the Kriging module, since it requires learning about concepts such as spatial autocorrelation or semivariograms,
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which probably you also haven’t heard before, or at least haven’t studied long enough. You should first study and
understand them, and then come back to QGIS to actually run it and perform the analysis. Ignoring this will result in
wrong results and poor (and most likely useless) analysis.

Although not all algorithms are as complex as kriging (but some of them are even more complex!), almost all of them
require understanding the fundamental analysis ideas that they are based on. Without that knowledge, using them
will most likely lead to poor results.

Using geoalgorithms without having a good foundation of spatial analysis is like trying to write a novel without
knowing anything about grammar or syntax, and having no knowledge about storytelling. You might get a result, but
it is likely to have no value at all. Please, don’t fool yourself and think that after reading this guide you are already
capable of performing spatial analysis and get sound results. You need to study spatial analysis as well.

Here is a good reference that you can read to learn more about spatial data analysis.

Geospatial Analysis (3rd Edition): A Comprehensive Guide to Principles, Techniques and Software Tools Michael
John De Smith, Michael F. Goodchild, Paul A. Longley

It is available online here

17.3 Setting-up the processing framework

The first thing to do before using the processing framework is to configure it. There is not much to set-up, so this is
an easy task.

Later on we will show how to configure the external applications that are used for extending the list of available
algorithms, but for now we are just going to work with the framework itself.

The processing framework is a core QGIS plugin, which means that it should already be installed in your system,
since it is included with QGIS. In case it is active, you should see a menu called Processing in your menu bar. There
you can access all the framework components.

Processing aEs]

i Toolbox Ctrl+Alt+T
#: Graphical Modeler... Ctrl+Alt+M
(L) History... Ctrl+Alt+H
= Results Viewer Ctri+Alt+R

Edit Features In-Place

If you cannot find that menu, you have to enable the plugin by going to the plugin manager and activating it.
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Plugins | Installed (36)

| @ processing a |

* Processing This is a core plugin, so you can't uninstall it

Processing
2% Upgradeable
* New Spatial data processing framework for QGIS
¥ Install from ZIP Spatial data processing framework for QGIS

£ settings

Category Analysis
More info homepage bug tracker code repository
Author Victor Olaya

Installed version 2.12.99

| Upgrade All |

| [@Help | | # Close |

The main element that we are going to work with is the toolbox. Click on the corresponding menu entry and you will
see the toolbox docked at the right side of the QGIS window.
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Processing Toolbox S
ey & E B

» (Y Recently used
Cartography
Database

File tools
Graphics
Interpolation
Layer tools
MWetwork analysis
Raster analysis
Raster terrain analysis
Raster tools

Vector analysis
Vector creation
Vector general
Vector geometry
Vector overlay
Vector selection
Vector table

GDAL

GRASS

» ¥ Models

ERDDDDDDDDDDDLDDDDL

Browser | Processing Toolbox

The toolbox contains a list of all the available algorithms, divided in groups called Providers. Providers can be
(de)activated in the Settings » Options » Processing. We will discuss that dialog later in this manual.

By default, only providers that do not rely on third-party applications (that is, those that only require QGIS elements
to be run) are active. Algorithms requiring external applications might need additional configuration. Configuring
providers is explained in a later chapter in this manual.

If you have reached this point, now you are ready to use geoalgorithms. There is no need to configure anything else
by now. We can already run our first algorithm, which we will do in the next lesson.

17.4 Running our first algorithm. The toolbox

Nota: In this lesson we will run our first algorithm, and get our first result from it.

As we have already mentioned, the processing framework can run algorithms from other applications, but it also
contains native algorithms that need no external software to be run. To start exploring the processing framework,
we are going to run one of those native algorithms. In particular, we are going to calculate the centroids of set of
polygons.

17.4. Running our first algorithm. The toolbox 527



QGIS Training Manual

First, open the QGIS project corresponding to this lesson. It contains just a single layer with two polygons

Now go to the text box at the top of the toolbox. That is the search box, and if you type text in it, it will filter the list
of algorithms so just those ones containing the entered text are shown. If there are algorithms that match your search
but belong to a provider that is not active, an additional label will be shown in the lower part of the toolbox.

Type centroids and you should see something like this.

centroids|

El- Recently used algorithms
g8 Polygon centroids

# Field calculator
- 4% Rasterize vector layer

£ Close aaps
- 48 Watershed from DEM and threshold
. Clip grid with palygon
E- ﬂ' Geoalgorithms

= 48 vector

El- D Polygons

----- g8 Polygon centroids

The search box is a very practical way of finding the algorithm you are looking for. At the bottom of the dialog, an
additional label shows that there are algorithms that match your search but belong to a provider that is not active. If
you click on the link in that label, the list of algorithms will also include results from those inactive providers, which
will be shown in light gray. A link to activate each inactive provider is also shown. We'll see later how to activate
other providers.

528 Capitulo 17. Guia de Processamento QGIS



QGIS Training Manual

Processing Toolbox =
|centroid |

¥ % GRASS GIS 7 commands [314 geoalgorithms]
v Vector (v.*)
¢ v.delaunay - Creates a Delaunay triangulation from an input vector map containing points or centroids.
¢ v.what.rast.centroids - Uploads raster values at positions of vector centroids to the table.
v # QGIS geoalgorithms [116 geoalgorithms]
v Vector analysis tools
# Generate points (pixel centroids) along line
# Generate points (pixel centroids) inside polygons
¥ Vector geometry tools
¥ % GRASS commands Activate
v Veckor (v.*)
¢ v.delaunay - Creates a Delaunay triangulation from an input vector map containing points or centroids.

You can add more algorithms to the toolbox

To execute an algorithm, you just have to double-click on its name in the toolbox. When you double-click on the
Polygon centroids algorithm, you will see the following dialog.

(i Polygon centroids X

Parameters Log Help

Input layer

’pdmons [EPSG: 23030] |v“ I
Cutput layer
[ [Save to temparary file] ” I

[%| Open output file after running algorithm

[ 0% )

Run || dose || concel |

All algorithms have a similar interface, which basically contains input parameters that you have to fill, and outputs
that you have to select where to store. In this case, the only input we have is a vector layer with polygons.

Select the Polygons layer as input. The algorithm has a single output, which is the centroids layer. There are two
options to define where a data output is saved: enter a filepath or save it to a temporary filename

In case you want to set a destination and not save the result in a temporary file, the format of the output is defined by
the filename extension. To select a format, just select the corresponding file extension (or add it if you are directly
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typing the filepath instead). If the extension of the filepath you entered does not match any of the supported ones, a
default extension (usually . dbf for tables, . t if for raster layers and . shp for vector ones) will be appended to the
filepath and the file format corresponding to that extension will be used to save the layer or table.

In all the exercises in this guide, we will be saving results to a temporary file, since there is no need to save them for
a later use. Feel free to save them to a permanent location if you want to.

Aviso: Temporary files are deleted once you close QGIS. If you create a project with an output that was saved
as a temporary output, QGIS will complain when you try to open back the project later, since that output file will
not exist.

Once you have configured the algorithm dialog, press Run to run the algorithm.

You will get the following output.

The output has the same CRS as the input. Geoalgorithms assumes all input layers share the same CRS and do not
perform any reprojection. Except in the case of some special algorithms (for instance, reprojection ones), the outputs
will also have that same CRS. We will see more about this soon.

Try yourself saving it using different file formats (use, for instance, shp and geojson as extensions). Also, if you
do not want the layer to be loaded in QGIS after it is generated, you can check off the checkbox that is found below
the output path box.
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17.5 Mais algoritmos e tipo de dados

Nota: In this lesson we will run three more algorithms, learn how to use other input types, and configure outputs to
be saved to a given folder automatically.

For this lessons we will need a table and a polygons layer. We are going to create a points layer based on coordinates
in the table, and then count the number of points in each polygon. If you open the QGIS project corresponding to
this lesson, you will find a table with X and Y coordinates, but you will find no polygons layer. Don’t worry, we will
create it using a processing geoalgorithm.

The first thing we are going to do is to create a points layer from the coordinates in the table, using the Points layer from
table algorithm. You now know how to use the search box, so it should not be hard for you to find it. Double—click
on it to run it and get to its following dialog.

This algorithm, like the one from the previous lesson, just generates a single output, and it has three inputs:
* Table: the table with the coordinates. You should select here the table from the lesson data.

* X and fields: these two parameters are linked to the first one. The corresponding selector will show the name
of those fields that are available in the selected table. Select the XCOORD field for the X parameter, and the
YYCOORD field for the Y parameter.

* CRS: Since this algorithm takes no input layers, it cannot assign a CRS to the output layer based on them.
Instead, it asks you to manually select the CRS that the coordinates in the table use. Click on the button on the
left-hand side to open the QGIS CRS selector, and select EPSG:4326 as the output CRS. We are using this
CRS because the coordinates in the table are in that CRS.

Your dialog should look like this.

{} Points layer from table x|

T T ——
Parameters | Log | Help |

Input layer

table R
¥ field

| XCOORD R
¥ field

| YCOORD d
Target CRS

[EPSG:4326 ” I

Qutput layer

[ [Save to temparary file] ” l

[%| Open output file after running algorithm

[l 0% ]

Rn || Cose || concel |

Now press the Run button to get the following layer (you may need to zoom full to reenter the map around the newly
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created points):

The next thing we need is the polygon layer. We are going to create a regular grid of polygons using the Create grid
algorithm, which has the following parameters dialog.
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{} Create grid

[Save to temporary file]

x|

Aviso: The options are simpler in recent versions of QGIS; you just need to enter min and max for X and Y
(suggested values: -5.696226,-5.695122,40.24742,40.248171)

The inputs required to create the grid are all numbers. When you have to enter a numerical value, you have two
options: typing it directly on the corresponding box or clicking the button on the right—hand side to get to a dialog
like the one shown next.
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{} Enter number or expression 7| x|

Enter expression in the text field.
Double didk on elements in the tree to add their values to the expression.

E-iyalyes from data lavers extents
i Values from raster layers statistics
- Yalues from QEIS map canvas

[ [Enter your formula here] ]

The dialog contains a simple calculator, so you can type expressions such as 11 * 34.7 + 4.6, and the result
will be computed and put in the corresponding text box in the parameters dialog. Also, it contains constants that you
can use, and values from other layers available.

In this case, we want to create a grid that covers the extent of the input points layer, so we should use its coordinates to
calculate the center coordinate of the grid and its width and height, since those are the parameters that the algorithm
takes to create the grid. With a little bit of math, try to do that yourself using the calculator dialog and the constants
from the input points layer.

Select Rectangles (polygons) in the Type field.

As in the case of the last algorithm, we have to enter the CRS here as well. Select EPSG:4326 as the target CRS, as
we did before.

In the end, you should have a parameters dialog like this:
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{J Create grid

0.000904

0.000551

[Save to tempaorary file]

x|

(Better add one spacing on the width and height: Horizontal spacing: 0.0001, Vertical spacing: 0.0001, Width:
0.001004, Height: 0.000651, Center X: -5.695674, Center Y: 40.2477955) The case of X center is a bit tricky, see:
-5.696126+(( -5.695222+ 5.696126)/2)

Press Run and you will get the graticule layer.
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The last step is to count the points in each one of the rectangles of that graticule. We will use the Count points in
polygons algorithm.

x

Parameters Log Help

Polygons

[pol'mons [EP5G:4328] |'” I
Points

[points [EPSG:4326] H[ l
Count field name

| NUMPOINTS ]
Result

[ [5ave to temparary file] ” l
(3| Open output file after running algorithm

Rn || Cose || concel |

Now we have the result we were looking for.
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Before finishing this lesson, here is a quick tip to make your life easier in case you want to persistently save your
data. If you want all your output files to be saved in a given folder, you do not have to type the folder name each
time. Instead, go to the processing menu and select the Options and configuration item. It will open the configuration
dialog.

[ |

|Setting |'u’a|ue |
- ¥ General

iﬁ Models

- 3% Providers

- & scripts

E--E-E-5

ok || Ccaneel

In the Output folder entry that you will find in the General group, type the path to your destination folder.
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21x
[ |

|Setting |'u'a|ue |
Bl 8 General
- 8k Keep dialog open after running an algorithm x
- $8 Dutput folder C:\processing_output
{§} Post-execution script
ﬁ'? Pre-execution script
- 8% Run algorithms in a new thread
-~ 8% Show extra info in Log panel {threaded execution only)
- % Show layer CRS definition in selection boxes
- Show recently executed algorithms
- §8 Show tabledike parameter panels
- Style for line layers
- G Style for point layers
- Style for polygon layers
- g8k Style for raster layers
-~ % Use flename as layer name
-~ 8% Use only selected features x
- @8 Warn before executing if layer CRS's do not match x
-ﬁ Models
- 4% Providers
- |8 scripts

£

@E-E

QK ] [ Cancel

Now when you run an algorithm, just use the filename instead of the full path. For instance, with the configuration
shown above, if you enter graticule. shp as the output path for the algorithm that we have just used, the result
will be saved in D: \processing_output\graticule.shp. You can still enter a full path in case you want
a result to be saved in a different folder.

Try yourself the Create grid algorithm with different grid sizes, and also with different types of grids.

17.6 SRC. Reprojetar

Nota: In this lesson we will discuss how Processing uses CRSs. We will also see a very useful algorithm: reprojecting.

CRS’s are a great source of confusion for QGIS Processing users, so here are some general rules about how they are
handled by geoalgorithms when creating a new layer.

* If there are input layers, it will use the CRS of the first layer. This is assumed to be the CRS of all input layers,
since they should have the same one. If you use layers with unmatching CRS’s, QGIS will warn you about it.
Notice that the CRS of input layers is shown along with its name in the parameters dialog.

Elevation

raster [EPSG: 23030]

« If there are no input layer, it will use the project CRS, unless the algorithm contains a specific CRS field (as it
happened in the last lesson with the graticule algorithm)
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Open the project corresponding to this lesson and you will see two layers named 23030 and 4326. They both contain
the same points, but in different CRSs (EPSG:23030 and EPSG:4326). They appear in the same place because QGIS
is reprojecting on the fly to the project CRS (EPSG:4326), but they are not actually the same layer.

Open the Export/Add geometry columns algorithm.

{} Export/Add geometry columns x|

Parameters | Log | Help |

Input layer

14326 [EPSG:4326] R I
Calculate using

Layer CRS -
Output layer

Save to temporary file]

R Open output file after running algorithm

[l 0% ]
Run Close

This algorithm add new columns to the attributes table of a vector layer. The content of the columns depend on the
type of geometry of the layer. In the case of points, it adds new columns with the X and Y coordinates of each point.

In the list of available layers that you will find in the input layer field, you will see each one with its corresponding
CRS. That means that, although they appear in the same place in your canvas, they will be treated differently. Select
the 4326 layer.

The other parameter of the algorithm allows to set how the algorithm uses coordinates to calculate the new value
that it will add to the resulting layers. Most algorithms do not have an option like that, and just use the coordinates
directly. Select the Layer CRS option to just use coordinates as they are. This is how almost all geoalgorithms work.

You should get a new layer with exactly the same points as the other two layers. If you right click on the name of the
layer and open its properties, you will see that it shares the same CRS of the input layer, that is, EPSG:4326. When
the layer is loaded into QGIS, you will not be asked to enter the CRS of the layer, since QGIS already knows about
it.

If you open the attributes table of the new layer you will see that it contains two new fields with the X and Y coordinates
of each point.
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D 5 PT_MUM_A PT_ST_A xcoord yeoord
0 1 1.100000 |a -5.695425 40.248071
1 2 2.200000 | b -5.695885 40.247622
2 3 3.300000 | c -5.695406 40,247520
3 4 4,400000 | a -5.695222 40,247694
a 5 5.500000 |b -5.695642 40.,248030
5 3 6.500000 | a -5.695855 40.248067
6 7 7.700000 |b -5.696043 40.248023
7 ) 8.800000 | ¢ -5.696126 40,247629
8 9 9.900000 | a -5.695961 40,247736
9 10 11.000000 |b -5.695353 40,247929
10 11 12.100000 |a -5.695595 40,247739
11 12 13.200000 | b -5.695779 40,247896

Those coordinate values are given in the layer CRS, since we chose that option. However, even if you choose another
option, the output CRS of the layer would have been the same, since the input CRS is used to set the CRS of the
output layer. Choosing another option will cause the values to be different, but not the resulting point to change or
the CRS of the output layer to be different to the CRS of the input one.

Now do the same calculation using the other layer. You should find the resulting layer rendered exactly in the same
place as the other ones, and it will have the EPSG:23030 CRS, since that was the one of the input layer.

If you go to its attribute table, you will see values that are different to the ones in the first layer that we created.

ID ) PT_NUM_A PT_ST_A xcoord ycoord
0 1 1100000 |a 270839.655869 | 4458983, 162670
1 2 2,200000 |b 270799.116425| 4458934.552874
2 3 3.300000 | 270839.468187| 4458921.978139
3 4 4,400000 |a 270855.745301| 4458940.799487
4 5 5.500000 |b 270821.164389 | 4458979173980
5 8 6.600000 |a 270803.157564| 4458983.848803
& 7 7.700000 |b 270786.542791| 4458980.047841
7 8 8.800000 |c 270778.601980 | 4458935.968837
a3 9 9,900000 |a 270793.142411| 4458952931700
a9 10 11.000000 |b 270845.414756 | 4458967.311298
10 11 12.100000 |a 270824.166376 | 4458946, 784250
11 12 13.200000 |b 270809.035643| 4458964.649799

This is because the original data is different (it uses a different CRS), and those coordinates are taken from it.

What should you learn from this? The main idea behind these examples is that geoalgorithms use the layer as it is in
its original data source, and completely ignore the reprojections that QGIS might be doing before rendering. In other
words, do not trust what you see in the canvas, but always have in mind that the original data will be used. That is not
so important in this case, since we are just using one single layer at a time, but in an algorithm that needs several of
them (such as a clip algorithm), layers that appear to match or overlay might be very far one from each other, since
they might have different CRSs.

Algorithms performs no reprojection (except in the reprojection algorithm that we will see next), so it is up to you to
make sure that layers have matching CRS’s.

An interesting module that deals with CRS’s is the reprojection one. It represents a particular case, since it has an
input layer (the one to reproject), but it will not use its CRS for the output one.
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Open the Reproject layer algorithm.

x

Parameters Log Help

Input layer

[2303(: [EPSG:23030] |'” I

Target CRS

[EF‘SG:4326 H l

Reprojected layer

[ [Save to temporary file] ” l

(3| Open output file after running algorithm

[l 0% ]

Rn || Cose || concdl |

Select any of the layers as input, and select EPSG:23029 as the destination CRS. Run the algorithm and you will
get a new layer, identical to the input one, but with a different CRS. It will appear on the same region of the canvas,
like the other ones, since QGIS will reproject it on the fly, but its original coordinates are different. You can see that
by running the Export/Add geometry columns algorithm using this new layer as input, and veryfing that the added
coordinates are different to the ones in the attribute tables of both of the two layers that we had computed before.

17.7 Seleccao

Nota: In this lesson we will see how processing algorithms handle selections in vector layers that are used as inputs,
and how to create a selection using a particular type of algorithm.

Unlike other analysis plugins in QGIS, you will not find in processing geoalgorithms any «Use only selected features»
checkbox or similar. The behaviour regarding selection is set for the whole plugin and all its algorithms, and not for
each algorithm execution. Algorithms follow the following simple rules when using a vector layer.

« If the layer has a selection, only selected features are used.
¢ If there is no selection, all features are used.

Please note that you can change this behaviour by unselecting the relevant option in the Processing » Options »
General menu.

You can test that yourself by selecting a few points in any of the layers that we used in the last chapter, and running
the reprojection algorithm on them. The reprojected layer that you will obtain will contain only those points that
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were selected, unless there was no selection, which will cause the resulting layer to contain all points from the original
layer.

To make a selection, you can use any of the available methods and tools in QGIS. However, you can also use a
geoalgorithm to do so. Algorithms for creating a selection are found in the toolbox under Vector/Selection

- & General tools
- '.' Geometry operations
- Overlay

Open the Random selection algorithm.

{} Random selection

Leaving the default values, it will select 10 points from the current layer.
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You will notice that this algorithm does not produce any output, but modifies the input layer (not the layer itself, but
its selection). This is an uncommon behaviour, since all the other algorithms will produce new layers and not alter
the input layers.

Since the selection is not part of the data itself, but something that only exist within QGIS, these selection algorithms
only must be used selecting a layer that is open in QGIS, and not with the file selection option that you can find in the
corresponding parameter value box.

The selection we have just made, like most of the ones created by the rest of the selection algorithms, can also be
done manually from QGIS, so you might be wondering what is the point on using an algorithm for that. Although
now this might not make much sense to you, we will later see how to create models and scripts. If you want to make
a selection in the middle of a model (which defines a processing workflow), only a geoalgorithm can be added to a
model, and other QGIS elements and operations cannot be added. That is the reason why some processing algorithms
duplicate functionality that is also available in other QGIS elements.

By now, just remember that selections can be made using processing geoalgorithms, and that algorithms will only use
the selected features if a selection exists, or all features otherwise.

17.8 A correr algoritmo externo

Nota: In this lesson we will see how to use algorithms that depend on a third-party application, particularly SAGA,
which is one of the main algorithm providers.

All the algorithms that we have run so far are part of processing framework. That is, they are native algorithms
implemented in the plugin and run by QGIS just like the plugin itself is run. However, one of the greatest features of
the processing framework is that it can use algorithms from external applications and extend the possibilities of those
applications. Such algorithms are wrapped and included in the toolbox, so you can easily use them from QGIS, and
use QGIS data to run them.

Some of the algorithms that you see in the simplified view require third party applications to be installed in your
system. One algorithm provider of special interest is SAGA (System for Automated Geospatial Analysis). First, we
need to configure everything so QGIS can correctly call SAGA. This is not difficult, but it’s important to understand
how it works. Each external application has its own configuration, and later in this same manual we will talk about
some of the other ones, but SAGA is going to be our main backend, so we will discuss it here.

If you are on Windows, the best way to work with external algorithms is to install QGIS using the standalone installer.
It will take care of installing all the needed dependencies, including SAGA, so if you have used it, there is nothing
else to do. You can open the settings dialog and go to the Providers/SAGA group.
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{} Processing options 21|

| Setting

| Value B

El- 4 Providers
- & GDALjoGR
& GRASS commands
- [& GeoServer PostGIS tools
-ﬁ Modeler-only tools
? Orfeo Toolbox (Image analysis)
- ¥ QGIS geoalgorithms
- @ R scripts
- §& SAGA (2.1)
& Activate
- #@ Enable SAGA 2.0.8 compatibility
Log consale output
Log execution commands

&

@ Resampling region cellsize
&
&

B
.
=]

Resampling region max x
Resampling region max y
Resampling region min x

@ Use min covering grid system for resampling
TauDEM (hydrologic analysis)
- 3%, Tools for LIDAR data
- & scripts

Resampling region min y 0.0
Cilsagall

x

x

10
1000.0
1000.0
0.0

(]

QK ] [ Cancel

The SAGA path should already be configured and pointing to the folder where SAGA is installed.

If you have installed QGIS not using the standalone installer, then you must enter the path to your SAGA installation
(which you must have installed separately) there. The required version is SAGA 2.1 [this is changing according to

the releases of SAGA].

In case you are using Linux, you do not have to set the path to your SAGA installation in the processing configuration.
Instead, you must install SAGA and make sure that the SAGA folder is in PATH, so it can be called from the console
(just open a console and type saga_cmd to check it). Under Linux, the target version for SAGA is also 2.1, but in
some installations (such as the OSGeo Live DVD) you might have just 2.0.8 available. There are some 2.1 packages
available, but they are not commonly installed and might have some issues, so if you prefer to use the more common
and stable 2.0.8, you can do it by enabling 2.0.8 compatibility in the configuration dialog, under the SAGA group.
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{} Processing options 21|

Setting | Value li]

El- 4 Providers
E- § GDAL/OGR —
-y GRASS commands

i=| GeoServer/PostGIS tools

-ﬁ Modeler-only tools

? Orfeo Toolbox (Image analysis)

J#! QGIS geoalgorithms

R scripts

= @ SAGA {2 1)

»
/ 8 compatibility M
@ Log consale output k
@ Log execution commands x
ii @ Resampling region cellsize 1.0
@ Resampling region max x 1000.0
- @ Resampling region max y 1000.0
@ Resampling region min x 0.0
: @ Resampling region min y 0.0
- 8% SAGA folder C:lsaga2l
@ Use min covering grid system for resampling x

& . TauDEM (hydrologic analysis)
- 92 Tools for LIDAR. data

E- E Scripts

]

ok || Ccaneel

Once SAGA is installed, you can launch a SAGA algorithm double clicking on its name, as with any other algorithm.
Since we are using the simplified interface, you do not know which algorithms are based on SAGA or in another
external application, but if you happen to double—click on one of them and the corresponding application is not
installed, you will see something like this.

x

Missing dependency.This algorithm cannot be run :-(

This algorithm requires SAGA to be run.Unfortunately, it seems that SAGA is not installed in your
system, or itis not correctly configured to be used from QGIS

Click here to know more about how to install and configure SAGA to be used with QGIS

In our case, and assuming that SAGA is correctly installed and configured, you should not see this window, and you
will get to the parameters dialog instead.
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Let’s try with a SAGA-based algorithm, the one called Split shapes layer randomly.

0y split shapes layer randomly x|

Parameters Log Help

Shapes

points [EPSG:4326] FL - 9]

Relation B [ A

E [—

Group A

[ [Save to temporary file] ” l

(3| Open output file after running algorithm
Group B

[ [Save to temporary file] ” l

[%| Open output file after running algarithm

(] 0% ]
[ J [ oo J [ oz ]

Use the points layer in the project corresponding to this lesson as input, and the default parameter values, and you
will get something like this (the split is random, so your result might be different).

The input layer has been split in two layers, each one with the same number of points. This result has been computed
by SAGA, and later taken by QGIS and added to the QGIS project.

If all goes fine, you will not notice any difference between this SAGA-based algorithm and one of the others that we
have previously run. However, SAGA might, for some reason, not be able to produce a result and not generate the
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file that QGIS is expecting. In that case, there will be problems adding the result to the QGIS project, and an error
message like this will be shown.

{} Problem loading output layers ﬂ

Oooops! The following output layers could not be open

* Graticule: C:
\WUsers‘\VolayehippDetehLocel\Temp\processing'\0elfl1£410£8594225bE5SbAf 72418 T4
ZWERATICULE. shp

The above files could not be opened, which probably indicates that they were not correctly produced by the
executed algorithm

Checking the log information might help you see why those layers were not created as expected

This algorithm requires SAGA to be run, A test to chedk if SAGA is correctly installed and configured in your system
has been performed, with the following result:

FAGA seems fo he correcty instaled and configured

Close

This kind of problems might happen, even if SAGA (or any other application that we are calling from the processing
framework) is correctly installed, and it is important to know how to deal with them. Let’s produce one of those error
messages.

Open the Create graticule algorithm and use the following values.
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{§ Create graticule |

Parameters Log Help

Extent

Dotscecte] FL - 2]
Output extent(xmin, xmax, ymin, ymax)

0,1,0,1 |
Division Width

2 [
Division Height

2 [
Type

| [0] Lines -]

Graticule

[ [Save to temporary file] ” l

[%| Open output file after running algarithm

[ 0% )

Run || Cose | | Concdl |

We are using width and height values that is larger than the specified extent, so SAGA cannot produce any output. In
other words, the parameter values are wrong, but they are not checked until SAGA gets them and tries to create the
graticule. Since it cannot create it, it will not produce the expected layer, and you will see the error message shown
above.

Nota: In SAGA >=2.2.3, the command will adjust automatically wrong input data, so you’ll not get an error. To
provoke an error, use negative values for division.

Understanding this kind of problems will help you solve them and find an explanation to what is happening. As
you can see in the error message, a test is performed to check that the connection with SAGA is working correctly,
indicating you that there might be a problem in how the algorithm was executed. This applies not only to SAGA, but
also to other external applications as well.

In the next lesson we will introduce the processing log, where information about commands run by geoalgorithms is
kept, and you will see how to get more detail when issues like this appear.
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17.9 Registo de processamento

Nota: This lesson describes the processing log.

All the analysis performed with the processing framework is logged in QGIS logging system. This allows you to know
more about what has been done with the processing tools, to solve problems when they happen, and also to re-run
previous operations, since the logging system also implements some interactivity.

To open the log, click on the balloon at the bottom right, on the QGIS status bar. Some algorithms might leave
here information about their execution. For instance, those algorithms that call an external application usually log the
console output of that application to this entry. If you have a look at it, you will see that the output of the SAGA
algorithm that we just run (and that fail to execute because input data was not correct) is stored here.

This is helpful to understand what is going on. Advanced users will be able to analyze that output to find out why
the algorithm failed. If you are not an advanced user, this will be useful for others to help you diagnose the problem
you are having, which might be a problem in the installation of the external software or an issue with the data you
provided.

Even if the algorithm could be executed, some algorithms might leave warnings in case the result might not be right.
For instance, when executing an interpolation algorithm with a very small amount of points, the algorithm can run
and will produce a result, but it is likely that it will not be correct, since more points should be used. It’s a good idea
to regularly check for this type of warnings if you are not sure about some aspect of a given algorithm.

From the Processing menu, under the History section, you'll find Algorithms. All algorithms that are executed, even
if they are executed from the GUI and not from the console (which will be explained later in this manual) are stored
in this section as a console call. That means that everytime you run an algorithm, a console command is added to the
log, and you have the full history of your working session. Here is how that history looks like:

| INFO B

: | WARNIMG
B- |l ALGDF‘.I’I’I—IM

[Sun Aug 25 2013 13:22:20] processing.runalg(“saga:splitshapeslayerrandomly™, "C:\\User. .
[Sun Aug 25 2013 13:22:11] processing.runalg(“saga:splitshapeslayerrandomly™, "T:igith. ..
[Sun Aug 25 2013 13:21:41] processing.runalg(“saga:splitshapeslayerrandomly™, "T:igith. ..
[Sun Aug 25 2013 13:16:36] processing.runalg(“saga:splitshapeslayerrandomly™, "D igith. ..
] : [Sun Aug 25 2013 13:16:07] processing. runalg(“saga:splitshapeslayerrandomly”®, "D \aith....
[Sun Aug 25 2013 13:15:29] processing.runalg(“saga:splitshapeslayerrandomly™, "T:igith. ..
[Sun Aug 25 2013 13:13:16] processing.runalg(“saga: thiessenpolygons™, "C:\\UsersYivolay. .
[Sun Aug 25 2013 13:13:16] processing.runalg(“saga:splitshapeslayerrandomly™, "C:\\User. .
[Sun Aug 25 2013 13:12:48] processing.runalg(“saga:splitshapeslayerrandomly™, "D igith. ..
[Sun Aug 25 2013 11:46:19] processing.runalg("ggis:reprojectiayer®, D: fgithub/sextante-. ..
[Sun Aug 25 2013 11:44:27] processing.runalg(“saga:dipgridwithpolygon®, "C:\\UsersYval...
[Sun Aug 25 2013 11:43:51] processing. runalg{'saga dosegaps®, 'C \,\JJsers‘n,‘n,'l.l'nlaya‘n,‘nﬁ.pp ..

[Com Aus 75 20113 11:47.71] orocs

processing. runalg(“saga: splitshapeslayerrandomly™, "D \aithub\sextante-
manual\\data\\first_saga_alaY\points.shp™, 50,Mone, Mone)

Clear ] [ Close
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This can be very useful when starting working with the console, to learn about the syntax of algorithms. We will use
it when we discuss how to run analysis commands from the console.

The history is also interactive, and you can re-run any previous algorithm just by double—clicking on its entry. This
is an easy way of replicating the work we already did before.

For instance, try the following. Open the data corresponding to the first chapter of this manual and run the algorithm
explained there. Now go to the log dialog and locate the last algorithm in the list, which corresponds to the algorithm
you have just run. Double—click on it an a new result should be produced, just like when you run it using the normal
dialog and calling it from the toolbox.

17.9.1 Advanced

You can also modify the algorithm. Just copy it, open the Plugins » Python console, click on Import class » Import
Processing class, then paste it to re-run the analysis; change the text at will. To display the resulting file, type i face.
addVectorLayer ('/path/filename.shp', 'Layer name in legend', 'ogr'). Otherwise,
you can use processing.runandload.

17.10 The raster calculator. No-data values

Nota: In this lesson we will see how to use the raster calculator to perform some operations on raster layers. We
will also explain what are no—data values and how the calculator and other algorithms deal with them

The raster calculator is one of the most powerful algorithms that you will find. It’s a very flexible and versatile
algorithm that can be used for many different calculations, and one that will soon become an important part of your
toolbox.

In this lesson we will be performing some calculation with the raster calculator, most of them rather simple. This
will let us see how it is used and how it deals with some particular situations that it might find. Understanding that is
important to later get the expected results when using the calculator, and also to understand certain techniques that
are commonly applied with it.

Open the QGIS project corresponding to this lesson and you will see that it contains several raster layers.

Now open the toolbox and open the dialog corresponding to the raster calculator.
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{§ Raster calculator x|

Parameters Log Help

Raster layers

0 elements selected :]

Formula

[ |

Result

[ [Save to temporary file] ” l

(3| Open output file after running algaorithm

u 0% ]

Nota: The interface is different in recent versions.

The dialog contains 2 parameters.

¢ The layers to use for the analysis. This is a multiple input, that meaning that you can select as many layers
as you want. Click on the button on the right-hand side and then select the layers that you want to use in the
dialog that will appear.

e The formula to apply. The formula uses the layers selected in the above parameter, which are named using
alphabet letters (a, b, c...)orgl, g2, g3... asvariable names. That is, the formulaa + 2 *
bisthe same as g1 + 2 * g2 and will compute the sum of the value in the first layer plus two times the
value in the second layer. The ordering of the layers is the same ordering that you see in the selection dialog.

Aviso: The calculator is case sensitive.

To start with, we will change the units of the DEM from meters to feet. The formula we need is the following one:

[h‘ = h * 3.28084

Select the DEM in the layers field and type a * 3.28084 in the formula field.

Aviso: For non English users: use always «.», not «,».

Click Run to run the algorithm. You will get a layer that has the same appearance of the input layer, but with different
values. The input layer that we used has valid values in all its cells, so the last parameter has no effect at all.
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Let’s now perform another calculation, this time on the accflow layer. This layer contains values of accumulated flow,
a hydrological parameter. It contains those values only within the area of a given watershed, with no—data values
outside of it. As you can see, the rendering is not very informative, due to the way values are distributed. Using the
logarithm of that flow accumulation will yield a much more informative representation. We can calculate that using
the raster calculator.

Open the algorithm dialog again, select the accflow layer as the only input layer, and enter the following formula:
log(a).

Here is the layer that you will get.

If you select the Identify tool to know the value of a layer at a given point, select the layer that we have just created,
and click on a point outside of the basin, you will see that it contains a no—data value.
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Feature £ | value
-0 log_layer
EH log_layer
& {Derived)
“Band 1 no data

33 (3] Lo [ rep

For the next exercise we are going to use two layers instead of one, and we are going to get a DEM with valid elevation
values only within the basin defined in the second layer. Open the calculator dialog and select both layers of the project
in the input layers field. Enter the following formula in the corresponding field:

[a/a * b ]

a refers to the accumulated flow layer (since it is the first one to appear in the list) and b refers to the DEM. What we
are doing in the first part of the formula here is to divide the accumulated flow layer by itself, which will result in a
value of 1 inside the basin, and a no—data value outside. Then we multiply by the DEM, to get the elevation value in
those cells inside the basin (DEM * 1 = DEM) and the no—data value outside (DEM * no_data = no_data)

Here is the resulting layer.

This technique is used frequently to mask values in a raster layer, and is useful whenever you want to perform
calculations for a region other that the arbitrary rectangular region that is used by raster layer. For instance, an
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elevation histogram of a raster layer doesn’t have much meaning. If it is instead computed using only values
corresponding to a basin (as in he case above), the result that we obtain is a meaningful one that actually gives
information about the configuration of the basin.

There are other interesting things about this algorithm that we have just run, apart from the no—data values and how
they are handled. If you have a look at the extents of the layers that we have multiplied (you can do it double—clicking
on their names of the layer in the table of contents and looking at their properties), you will see that they are not the
same, since the extent covered by the flow accumulation layer is smaller that the extent of the full DEM.

That means that those layers do not match, and that they cannot be multiplied directly without homogenizing those
sizes and extents by resampling one or both layers. However, we did not do anything. QGIS takes care of this situation
and automatically resamples input layers when needed. The output extent is the minimum covering extent calculated
from the input layers, and the minimum cell size of their cellsizes.

In this case (and in most cases), this produces the desired results, but you should always be aware of the additional
operations that are taking place, since they might affect the result. In cases when this behaviour might not be the
desired, manual resampling should be applied in advance. In later chapters, we will see more about the behaviour of
algorithms when using multiple raster layers.

Let’s finish this lesson with another masking exercise. We are going to calculate the slope in all areas with an elevation
between 1000 and 1500 meters.

In this case, we do not have a layer to use as a mask, but we can create it using the calculator.

Run the calculator using the DEM as only input layer and the following formula

[ifelse(abs(a*1250) < 250, 1, 0/0) }

As you can see, we can use the calculator not only to do simple algebraic operations, but also to run more complex
calculation involving conditional sentences, like the one above.

The result has a value of 1 inside the range we want to work with, and no-data in cells outside of it.

The no-data value comes from the 0/0 expression. Since that is an undetermined value, SAGA will add a NaN (Not a
Number) value, which is actually handled as a no-data value. With this little trick you can set a no-data value without
needing to know what the no—data value of the cell is.

Now you just have to multiply it by the slope layer included in the project, and you will get the desired result.

All that can be done in a single operation with the calculator. We leave that as an exercise for the reader.
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17.11 Calculadora vetorial

Nota: In this lesson we will see how to add new attributes to a vector layer based on a mathematical expression,
using the vector calculator.

We already know how to use the raster calculator to create new raster layers using mathematical expressions. A
similar algorithm is available for vector layers, and generates a new layer with the same attributes of the input layer,
plus an additional one with the result of the expression entered. The algorithm is called Field calculator and has the
following parameters dialog.

4 Field calculator x|

Parameters Log Help

™
Input layer

[cam_botmdaﬁes [USER.: 100001] | > " o ]

Result field name

[ ]
Field type

[ Float | - ]
Field length

10 =
Field predsion

5 =
Farmula

[ ]
Qutput layer

[ [Save to temporary file] ][ ]

(3| Open output file after running algaorithm

Nota: In newer versions of Processing the interface has changed considerably, it’s more powerful and easier to use.

Here are a few examples of using that algorithm.

First, let’s calculate the population density of white people in each polygon, which represents a census. We have two
fields in the attributes table that we can use for that, namely WHITE and SHAPE_AREA. We just have to divide them
and multiply by one million (to have density per square km), so we can use the following formula in the corresponding
field

[( "WHITE" / "SHAPE_AREA" ) * 1000000 J

The parameters dialog should be filled as shown below.
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@ Field calculator x|

Parameters | Log Help

)

Input layer

[cam_botndaﬁes [USER: 100001] H[ ]
Result field name

| WHITE_DENS |
Field type

Float -]
Field length

Farmula

|WHITE / SHAPE_AREA |
Qutput layer

[ [Save to temporary file] ][ ]

[%¢| Open output file after running algarithm

KD

This will generate a new field named WHITE_DENS

Now let’s calculate the ratio between the MALES and FEMALES fields to create a new one that indicates if male
population is numerically predominant over female population.

Enter the following formula

["MZ—\LES "/ "FEMALES"

This time the parameters window should look like this before pressing the OK button.
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@ Field calculator x|

Parameters Log Help

[*]

Input layer

[cam_bomdaﬁes [USER.: 100001] | - " ]
Result field name

|RATIO |
Field type

Foat -
Field length

10 =]
Field predsion

E =]
Formula

| float{MALES) /FEMALES |
Output layer

[ [5ave to temparary file] ][ ]

(3| Open output file after running algorithm

EIDf

100%

(o [ cow [ cons |

In earlier version, since both fields are of type integer, the result would be truncated to an integer. In this case the
formula shouldbe: 1.0 * "MALES" / "FEMALES", to indicate that we want floating point number a result.

We can use conditional functions to have a new field with male or female text strings instead of those ratio value,
using the following formula:

[CASE WHEN "MALES" > "FEMALES" THEN 'male' ELSE 'female' END

The parameters window should look like this.
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@ Field calculator x|

Parameters Log Help

Input layer

| [

[cams_bowwdaﬁes [USER.: 100001]

L @]

Result field name

|PREDOMIN

Field type

String

Field length

Formula

['male' if MALES = FEMALES elze 'female’

Qutput layer

[ [Save to temporary file]

[%¢| Open output file after running algarithm

[«

100%

(o [ cow [ cons |

A python field calculator is available in the Advanced Python field calculator, which will not be detailed here
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{} Advanced Python field calculator x|

Parameters | Log Help

Input layer

census_boundaries [USER: 100001] H )
Result field name

[NewFieId l
Field type

Integer -]
Field length

Global expression

Formula

value =

Qutput layer
[ [Save to temporary file] ”

[%| Open output file after running algorithm

Rn || Cose || concel |

17.12 Defining extents

Nota: In this lesson we will see how to define extents, which are needed by some algorithms, especially raster ones.

Some algorithms require an extent to define the area to be covered by the analysis they perform, and usually to define
the extent of the resulting layer.

When an extent is required, it can be defined manually by entering the four values that define it (min X, min Y, max
X, max Y), but there are other more practical and more interesting ways of doing it as well. We will see all of them
in this lesson.

First, let’s open an algorithm that requires an extent to be defined. Open the Rasterize algorithm, which creates a
raster layer from a vector layer.
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{§ shapes to grid x|

Parameters Log Help

Shapes

| union [EPSG:23030] | v]
Attribute

b -]
Method for Multiple Values

| [o] first [~
Method for Lines

[0] tin M
Preferred Target Grid Type

| [0] Integer (1 byte) -]

Qutput extent{xmin, xmax, ymin, ymax)

[ [Leave blank to use min covering extent] ” I

Cellsize

Ex [—

Grid

[ [Save to temporary file] ” l

[%¢| Open output file after running algarithm

All the parameters, except for the last two ones, are used to define which layer is to be rasterized, and configure how
the rasterization process should work. The two last parameters, on the other hand, define the characteristics of the
output layer. That means that they define the area that is covered (which is not necessarily the same area covered by
the input vector layer), and the resolution/cellsize (which cannot be inferred from the vector layer, since vector layers
do not have a cellsize).

The first thing you can do is to type the 4 defining values explained before, separated by commas.

Cutput extent{xmin, xmax, ymin, ymax)

0,90,0,90 ”

That doesn’t need any extra explanation. While this is the most flexible option, it is also the less practical in some
cases, and that’s why other options are implemented. To access them, you have to click on the button on the right-hand
side of the extent text box.

Use layer fcanvas extent h

Select extent on canvas

IUse min convering extent from input layers

Let’s see what each one of them does.

The first option is Use layer/canvas extent, which will show the selection dialog shown below.
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i Select extent

IUse extent from

Use canvas extent

Here you can select the extent of the canvas (the extent covered by the current zoom), or the extension any of the
available layers. Select it and click on OK, and the text box will be automatically filled with the corresponding values.

The second option is Select extent on canvas. In this case, the algorithm dialog disappears and you can click and drag
on the QGIS canvas to define the desired extent.

Once you release the mouse button, the dialog will reappear and the text box will already have the values corresponding
to the defined extent.

The last option is Use min covering extent from input layers, which is the default option. This will compute the min
covering extent of all layers used to run the algorithm, and there is no need to enter any value in the text box. In the
case of a single input layer, as in the algorithm we are running, the same extent can be obtained by selecting that same
input layer in the Use layer/canvas extent that we already saw. However, when there are several input layers, the min
covering extent does not correspond to any of the input layer extent, since it is computed from all of them together.

‘We will use this last method to execute our rasterization algorithm.

Fill the parameters dialog as shown next, and press OK.
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{§ shapes to grid x|

Parameters Log Help

Shapes

 watersheds [EPSG:23030] - ]
Attribute

b -]
Method for Multiple Values

| [o] first [~
Method for Lines

[0] tin M
Preferred Target Grid Type

| [3] Floating Point (4 byte) -]

Qutput extent{xmin, xmax, ymin, ymax)

[ [Leave blank to use min covering extent] ” I

Cellsize

2 [N

Grid

[ [Save to temporary file] ” l

[%¢| Open output file after running algarithm

100%

(o [ cow [ cous |

Nota: In this case, better use an Integer (I byte) instead of a Floating point (4 byte), since the NAME is an integer
with maximum value=64. This will result in a smaller file size and faster computations.

You will get a rasterized layer that covers exactly the area covered by the original vector layer.
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In some cases, the last option, Use min covering extent from input layers, might not be available. This will happen in
those algorithm that do not have input layers, but just parameters of other types. In that case, you will have to enter
the value manually or use any of the other options.

Notice that, when a selection exist, the extent of the layer is that of the whole set of features, and the selection is not
used to compute the extent, even though the rasterization is executed on the selected items only. In that case, you
might want to actually create a new layer from the selection, and then use it as input.

17.13 HTML outputs

Nota: In this lesson we learn how QGIS handles outputs in HTML format, which are used to produce text outputs
and graphs.

All the outputs we have produced so far were layers (whether raster or vector). However, some algorithms generate
outputs in the form of text and graphics. All this outputs are wrapped in HTML files and displayed in the so—called
Results viewer, which is another element of the processing framework.

Let’s see one of those algorithms to understand how they work.

Open the project with the data to be used in this lesson and then open the Basic statistics for numeric fields algorithm.
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(i Basic statistics for numeric fields

[Save to tempaorary file]

The algorithm is rather simple, and you just have to select the layer to use and one of its field (a numeric one). The
output is of type HTML, but the corresponding box works exactly like the one that you can find in the case of a raster
or vector output. You can enter a filepath or leave it blank to save to a temporary file. In this case, however, only the
html and htm extensions are allowed, so there is no way of altering the output format by using a different one.

Run the algorithm selecting the only layer in the project as input, and the POP2000 field, and a new dialog like the
one shown next will appear once the algorithm is executed and the parameters dialog is closed.
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G resuits 2|

Statistics for numeric field Count: 485

Unique values: 403

Minimum value: 0.0

Maximum value: 3198.0

Range: 3198.0

Sum: 554636.0

Mean value: 114357938144

Median value: 1074.0

Standard deviation: 527 408287222
Coefficient of Variation: 0.461190797753

This is the Results viewer. It keeps all the HTML result generated during the current session, easily accessible, so you
can check them quickly whenever you need it. As it happens with layers, if you have saved the output to a temporary
file, it will be deleted once you close QGIS. If you have saved to a non-temporary path, the file will remain, but it
will not appear in the Results viewer the next time you open QGIS.

Some algorithms generate text that cannot be divided into other more detailed outputs. That is the case if, for instance,
the algorithm captures the text output from an external process. In other cases, the output is presented as text, but
internally is divided into several smaller outputs, usually in the form of numeric values. The algorithm that we have
just executed is one of them. Each one of those values is handled as a single output, and stored in a variable. This
has no importance at all now, but once we move to the model designer, you will see that it will allow us to use those
values as numeric inputs for other algorithms.
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17.14 First analysis example

Nota: In this lesson we will perform some real analysis using just the toolbox, so you can get more familiar with the
processing framework elements.

Now that everything is configured and we can use external algorithms, we have a very powerful tool to perform spatial
analysis. It is time to work out a larger exercise with some real-world data.

We will be using the well-known dataset that John Snow used in 1854, in his groundbreaking work (https://en.
wikipedia.org/wiki/John_Snow_%?28physician%29), and we will get some interesting results. The analysis of this
dataset is pretty obvious and there is no need for sophisticated GIS techniques to end up with good results and
conclusions, but it is a good way of showing how these spatial problems can be analyzed and solved by using different
processing tools.

The dataset contains shapefiles with cholera deaths and pump locations, and an OSM rendered map in TIFF format.
Open the corresponding QGIS project for this lesson.

P

The first thing to do is to calculate the Voronoi diagram (a.k.a. Thiessen polygons) of the pumps layer, to get the
influence zone of each pump. The Voronoi Diagram algorithm can be used for that.
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{} voronoi Diagram

[Save to temporary file]
%

Pretty easy, but it will already give us interesting information.
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Clearly, most cases are within one of the polygons

To get a more quantitative result, we can count the number of deaths in each polygon. Since each point represents a
building where deaths occured, and the number of deaths is stored in an attribute, we cannot just count the points.
We need a weighted count, so we will use the Count points in polygon (weighted) tool.
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{} Count points in polygon{weighted)

Save to temporary file]

The new field will be called DEATHS, and we use the COUNT field as weighting field. The resulting table clearly
reflects that the number of deaths in the polygon corresponding to the first pump is much larger than the other ones.
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Another good way of visualizing the dependence of each point in the Cholera_deaths layer with a point in the
Pumps layer is to draw a line to the closest one. This can be done with the Distance to nearest hub tool, and using
the configuration shown next.
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{} Distance to nearest hub

[Save to tempaorary file]
|

O resultado € parecido com isto:
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Although the number of lines is larger in the case of the central pump, do not forget that this does not represent the
number of deaths, but the number of locations where cholera cases were found. It is a representative parameter, but
it is not considering that some locations might have more cases than other.

A density layer will also give us a very clear view of what is happening. We can create it with the Kernel density
algorithm. Using the Cholera_deaths layer, its COUNT field as weight field, with a radius of 100, the extent and
cellsize of the streets raster layer, we get something like this.
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Remember that, to get the output extent, you do not have to type it. Click on the button on the right-hand side and
select Use layer/canvas extent.
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{3 Kernel density estimation x|

Parameters Log Help

Paints

| Cholera_Deaths [USER: 100000] - ]
Weight

|counr -
Radius

| 100 =)
Kernel

[ [0] quartic kernel | = ]
Target Grid

| [0] user defined ~

Output extent{xmin, xmax, ymin, ymax)

[ [Leave blank to use min covering extent] H

yerfcanvas extent

Cellsize
Select extent on canvas k
[ 1 ][ - Use min convering extent from input layers
Grid B
[:_c” 1l 1 L‘
I 0% l
[ Run l [ Close l ’ Cancel ]

Select the streets raster layer and its extent will be automatically added to the text field. You must do the same with
the cellsize, selecting the cellsize of that layer as well.

Combining with the pumps layer, we see that there is one pump clearly in the hotspot where the maximum density
of death cases is found.

17.15 Clipping and merging raster layers

Nota: In this lesson we will see another example of spatial data preparation, to continue using geoalgorithms in
real-world scenarios.

For this lesson, we are going to calculate a slope layer for an area surrounding a city area, which is given in a vector
layer with a single polygon. The base DEM is divided in two raster layers that, together, cover an area much larger
than that around the city that we want to work with. If you open the project corresponding to this lesson, you will see
something like this.
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These layers have two problems:

» They cover an area that is too large for what we want (we are interested in a smaller region around the city
center)

* They are in two different files (the city limits fall into just one single raster layer, but, as it’s been said, we want
some extra area around it).

Both of them are easily solvable with the appropriate geoalgorithms.

First, we create a rectangle defining the area that we want. To do it, we create a layer containing the bounding box
of the layer with the limits of the city area, and then we buffer it, so as to have a raster layer that covers a bit more
that the strictly necessary.

To calculate the bounding box , we can use the Polygon from layer extent algorithm
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{} Polygon from layer extent

[Save to tempaorary file]

x|

To buffer it, we use the Fixed distance buffer algorithm, with the following parameter values.

I} Fixed distance buffer

[Save to temporary file]

x|
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Aviso: Syntax changed in recent versions; set both Distance and Arc vertex to .25

Here is the resulting bounding box obtained using the parameters shown above

It is a rounded box, but we can easily get the equivalent box with square angles, by running the Polygon from layer
extent algorithm on it. We could have buffered the city limits first, and then calculate the extent rectangle, saving one
step.

You will notice that the rasters has a different projection from the vector. We should therefore reproject them before
proceeding further, using the Warp (reproject) tool.
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i warp (reproject)

[Save to temporary file]

x|

Nota: Recent versions have a more complex interface. Make sure at least one compression method is selected.

With this layer that contains the bounding box of the raster layer that we want to obtain, we can crop both of the
raster layers, using the Clip raster with polygon algorithm.
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{¢ dip Grid with Polygon

[Save to temporary file]

t3

Once the layers have been cropped, they can be merged using the SAGA Mosaic raster layers algorithm.

j Merge raster layers x|

[Save to temporary file]
1
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Nota: You can save time merging first and then cropping, and you will avoid calling the clipping algorithm twice.
However, if there are several layers to merge and they have a rather big size, you will end up with a large layer than it
can later be difficult to process. In that case, you might have to call the clipping algorithm several times, which might
be time consuming, but don’t worry, we will soon see that there are some additional tools to automate that operation.
In this example, we just have two layers, so you shouldn’t worry about that now.

With that, we get the final DEM we want.

Now it is time to compute the slope layer.

A slope layer can be computed with the Slope, Aspect, Curvature algorithm, but the DEM obtained in the last step is
not suitable as input, since elevation values are in meters but cellsize is not expressed in meters (the layer uses a CRS
with geographic coordinates). A reprojection is needed. To reproject a raster layer, the Warp (reproject) algorithm
can be used again. We reproject into a CRS with meters as units (e.g. 3857), so we can then correctly calculate the
slope, with either SAGA or GDAL.

With the new DEM, slope can now be computed.
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{} Slope, Aspect, Curvature

[Save to temporary file]

[Save to temporary file]

[Save to temparary file]

[5ave to temparary file]

[Save to temporary file]

And here is the resulting slope layer.
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The slope produced by the Slope, Aspect, Curvature algorithm can be expressed in degrees or radians; degrees are a
more practical and common unit. In case you calculated it in radians, the Metric conversions algorithm will help us
to do the conversion (but in case you didn’t know that algorithm existed, you could use the raster calculator that we
have already used).
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i Metric Conversions x|

Parameters Log Help

e S —

Conversion

[ [0] radians to degree | - l

Converted Grid

[ [Save to temporary file] ” l

(3| Open output file after running algaorithm

Reprojecting the converted slope layer back with the Reproject raster layer, we get the final layer we wanted.

Aviso: todo: Add image

The reprojection processes might have caused the final layer to contain data outside the bounding box that we
calculated in one of the first steps. This can be solved by clipping it again, as we did to obtain the base DEM.

17.16 Analise hidrolégica

Nota: In this lesson we will perform some hydrological analysis. This analysis will be used in some of the following
lessons, as it constitutes a very good example of an analysis workflow, and we will use it to demonstrate some advanced
features.

Objectives: Starting with a DEM, we are going to extract a channel network, delineate watersheds and calculate some
statistics.

1. The first thing is to load the project with the lesson data, which just contains a DEM.
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2. The first module to execute is Catchment area (in some SAGA versions it is called Flow accumulation (Top
Down)). You can use any of the others named Catchment area. They have different algorithms underneath,
but the results are basically the same.

3. Select the DEM in the Elevation field, and leave the default values for the rest of the parameters.
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{} Catchment Area (Parallel)

Some algorithms calculate many layers, but the Catchment Area layer is the only one we will be using. You can
get rid of the other ones if you want.

The rendering of the layer is not very informative.
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To know why, you can have a look at the histogram and you will see that values are not evenly distributed (there
are a few cells with very high value, those corresponding to the channel network). Use the Raster calculator

algorithm to calculate the logarithm of the catchment value area and you will get a layer with much more
information
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4. The catchment area (also known as flow accumulation) can be used to set a threshold for channel initiation.
This can be done using the Channel network algorithm.

e Initiation grid: use the catchment area layer and not the logarithm one.
e [nitiation threshold: 10.000.000

e [nitiation type: Greater than

{§ Channel Network

10000000|

[Save to temparary file]

[5ave to temparary file]

[Save to tempaorary file]

If you increase the Initiation threshold value, you will get a more sparse channel network. If you decrease it,
you will get a denser one. With the proposed value, this is what you get.
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The image above shows just the resulting vector layer and the DEM, but there should be also a raster layer with
the same channel network. That raster will be, in fact, the layer we will be using.

5. Now, we will use the Watersheds basins algorithm to delineate the subbasins corresponding to that channel
network, using as outlet points all the junctions in it. Here is how you have to set the corresponding parameters
dialog.
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i watershed Basins x|
Parameters Help

Elevation

o H
Channel Network

| Channel Network - . ]
Sink Route

Dtz o
Min. Size

0 =

Watershed Basins

[ [Save to temporary file] ” l

(3| Open output file after running algaorithm

And this is what you will get.
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6. This is a raster result. You can vectorise it using the Vectorising grid classes algorithm.

{§ Vectorising Grid Classes

[Save to temparary file]
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Now, let’s try to compute statistics about the elevation values in one of the subbasins. The idea is to have a layer that
just represents the elevation within that subbasin and then pass it to the module that calculates those statistics.

1. First, let’s clip the original DEM with the polygon representing a subbasin. We will use the Clip raster with
polygon algorithm. If we select a single subbasin polygon and then call the clipping algorithm, we can clip the
DEM to the area covered by that polygon, since the algorithm is aware of the selection.

1. Select a polygon
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2. Call the clipping algorithm with the following parameters:

Parameters Log Help

{} Clip grid with polygon

Input

| dem25 [EPSG:23030]

Polygons

[Pdmons [EPSG: 23030]

Output

[ [5ave to temparary file]

(3| Open output file after running algorithm

|

Rn || Cose || concdl |
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The element selected in the input field is, of course, the DEM we want to clip.

You will get something like this.

2. This layer is ready to be used in the Raster layer statistics algorithm.
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{§ Raster layer statistics x|

Parameters Log Help

Input layer
e 2030 H
Statistics

[ [Save to temporary file] ” l

Run || Cose || concdl |

The resulting statistics are the following ones.

21X

Valid cells: 24155

No-data cells: 14573

Minimum value: 771.0

Maximum value: 2080.0

Sum: 29923203.3423

Mean value: 1236.79955878
Standard deviation: 271.406236765

We will use both the basin calculations procedure and the statistics calculation in other lessons, to find out how other
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elements can help us automate both of them and work more effectively.

17.17 Starting with the model designer

Nota: In this lesson we will use the model designer, a powerful component that we can use to define a workflow and
run a chain of algorithms.

A normal session with the processing tools includes more than running a single algorithm. Usually several of them
are run to obtain a result, and the outputs of some of those algorithms are used as input for some of the other ones.

Using the model designer, that workflow can be put into a model, which will run all the necessary algorithms in a
single run, thus simplifying the whole process and automating it.

To start this lesson, we are going to calculate a parameter named Topographic Wetness Index. The algorithm that
computes it is called Topographic wetness index (twi).

{} Topographic wetness index (bwi) x|

Parameters Log Help

Slope

| dem25 [EPSG:23030] M
Catchment Area

[dem25 [EPSG:23030] |v][ ]

Transmissivity
Dot selected] M.

Area Conversion

[ [0] no conversion (areas already given as spedific catchment area) | - l
Method (TWI)
| [0] Standard d

Topographic Wetness Index

[ [Save to temporary file] ” l

(3| Open output file after running algorithm

[ 0% )

wn ] [_ome | [ o |

As you can see, there are two mandatory inputs: Slope and Catchment area. There is also an optional input, but we
will not be using it, so we can ignore it.

The data for this lesson contains just a DEM, so we do not have any of the required inputs. However, we know how
to calculate both of them from that DEM, since we have already seen the algorithms to compute slope and catchment
area. So we can first compute those layers and then use them for the TWI algorithm.

Here are the parameter dialogs that you should use to calculate the 2 intermediate layers.
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Nota: Slope must be calculated in radians, not in degrees.

{} Slope, aspect, curvature

[Save to temporary file]

[Save to temporary file]

[5ave to temparary file]

[Save to tempaorary file]
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{} Catchment area (recursive)

And this is how you have to set the parameters dialog of the TWI algorithm.
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{} Topographic wetness index (bwi) x|

Parameters l Log | Help

Slope

[Tmng'idic\l‘n‘ehmlndﬂ [EPSG:23030] | - ” e I
Catchment Area

| Catchment Area [EPSG:23030] = - ]

Transmissivity

Dotsckeczg B ——
Area Conversion

|[1] 1/ cell size {pseudo spedific catchment area) R
Method (TWI)

| [0] Standard I~
Topographic Wetness Index

[ [Save to temporary file] ” . I
(3| Open output file after running algorithm

This is the result that you will obtain (the default singleband pseudocolor inverted palette has been used for rendering).
You can use the twi .gml style provided.
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What we will try to do now is to create an algorithm that calculates the TWI from a DEM in just one single step.
That will save us work in case we later have to compute a TWI layer from another DEM, since we will need just one
single step to do it instead of the three above. All the processes that we need are found in the toolbox, so what we
have to do is to define the workflow to wrap them. This is where the model designer comes in.

1. Open the modeler by selecting its menu entry in the processing menu.

€ Processing modeler =] 3|
Inputs Algorithms [Enter model name here] [Enter group name here] ]
El-Parameters

i Boolean

-~ Table field
= Vector layer

RN - [III]E
|Edtmodelhelp| | Run || Open || Save || Saveas.. || Close |

Two things are needed to create a model: setting the inputs that it will need, and defining the algorithm that

it contains. Both of them are done by adding elements from the two tabs in the left-hand side of the modeler
window: Inputs and Algorithms.

Let’s start with the inputs. In this case we do not have much to add. We just need a raster layer with the DEM,
and that will be our only input data.

3. Double click on the Raster layer input and you will see the following dialog.

¥} Parameter definition ed

Parameter namel I

Reguired [Yes | - ]

4. Here we will have to define the input we want:
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1. Since we expect this raster layer to be a DEM, we will call it DEM. That’s the name that the user of the
model will see when running it.

2. Since we need that layer to work, we will define it as a mandatory layer.

Here is how the dialog should be configured.

} Parameter definition 7| x|

Parameter name I DEM I

Required [‘f’es | v]

5. Click on OK and the input will appear in the modeler canvas.

R=E
Inputs Algorithms [Enter model name here] [Enter group name here] ]
El- Parameters
Boolean
‘4}' DEM §|
(1 1D
’Edjtmodelhelp] [ Run l [ Open l [ Save ] [ Save as ... l [ Close l

6. Now let’s move to the Algorithms tab.

7. The first algorithm we have to run is the Slope, aspect, curvature algorithm. Locate it in the algorithm list,
double-click on it and you will see the dialog shown below.
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t§ slope, aspect, curvature 21x

Parameters Help

Elevation

|DEM [~]
Method

[ [0] Maximum Slope (Travis et al, 1975) | v]
Slope <QutputRaster =

[ [Enter name if this is a final result] ]
Aspect<OutputRaster >

[ [Enter name if this is a final result] ]

Curvature <OutputRaster =

[ [Enter name if this is a final result] ]

Plan Curvature <OutputRaster =

[ [Enter name if this iz a final result] ]

Profile Curvature <OutputRaster =

[ [Enter name if this is a final result] ]

Parent algorithms

0 elements selected I]

Lo ] el

KD

This dialog is very similar to the one that you can find when running the algorithm from the toolbox, but
the element that you can use as parameter values are not taken from the current QGIS project, but from the
model itself. That means that, in this case, we will not have all the raster layers of our project available for the
Elevation field, but just the ones defined in our model. Since we have added just one single raster input named
DEM, that will be the only raster layer that we will see in the list corresponding to the Elevation parameter.

Output generated by an algorithm are handled a bit differently when the algorithm is used as a part of a model.
Instead of selecting the filepath where you want to save each output, you just have to specify if that output is
an intermediate layer (and you do not want it to be preserved after the model has been executed), or it is a final
one. In this case, all layers produced by this algorithm are intermediate. We will only use one of them (the
slope layer), but we do not want to keep it, since we just need it to calculate the TWI layer, which is the final
result that we want to obtain.

When layers are not a final result, you should just leave the corresponding field. Otherwise, you have to enter a
name that will be used to identify the layer in the parameters dialog that will be shown when you run the model
later.

8. There is not much to select in this first dialog, since we do not have but just one layer in our model (The DEM
input that we created). Actually, the default configuration of the dialog is the correct one in this case, so you
just have to press OK. This is what you will now have in the modeler canvas.
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€} Processing modeler
Inputs Algorithms

=10l x|
[Enter model name here] [Enter group name here]
slope a ]
FJ-- Geoalgorithms
El- Domain specific & %
% Hydrology DEM
@ Upslope Area
B- Terrain analysis and geomorphometry
@ Downslope distance gradient
@ Dtm filter (slope-based) ——aIn
i @ Relative heights and slope positions x
-5 Slope length ‘@ Slope, aspect, curvature 9|
iSlope, aspect, curvature
oY Cut [+
E|--- Images Y =
B Image analysis
@ ‘egetation index[slope based]
< 1D
[Edtmodelhep| | Run |

o | [ s | smem. | | aoe

]

9. The second algorithm we have to add to our model is the catchment area algorithm. We will use the algorithm

named Catchment area (Paralell). We will use the DEM layer again as input, and none of the ouputs it produces
are final, so here is how you have to fill the corresponding dialog.
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{} Catchment area (parallel)

Now your model should look like this.
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_ioix]
Inputs Algorithms [Enter model name here] [Enter group name here]
catch a l -
(= Geoalgorithms
Ek Domain spedific
. 4% Hyd?:;gy ‘4}- DEM 5‘
i @ Catchment area (flow tracing)
>@ Catchment ara (recursive) ——2In \
low width and specdific catchment a...
@ ’ i " ‘@ Slope, aspect, curvature 5‘
Out
In
‘@ Catchment area (parallel) g
Cut
“ @I]E
[Editmodelheb] l Run ] [ Open ] [ Save ] [ Save as ... l [ Close ]
10. The last step is to add the Topographic wetness index algorithm, with the following configuration.
{} Topographic wetness index (bwi) ed
Parameters Help
Slope
[Slope from algorithm 0(Slope, aspect, curvature) | vl
Catchment Area
[Eatd"rna'lt Area from algorithm 1(Catchment area (parallel)) | vl
Transmissivity
' [Not selected] d
Area Conversion
[[1]1Iceﬂsize{pseudospedﬁcmtd'mta'ea} |"l
Method (TWI)
| [0] Standard R
Topographic Wetness Index <QutputRaster =
[T |

Parent algorithms

0 elements selected

Ok

|| Conc

In this case, we will not be using the DEM as input, but instead, we will use the slope and catchment area layers
that are calculated by the algorithms that we previously added. As you add new algorithms, the outputs they
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produce become available for other algorithms, and using them you link the algorithms, creating the workflow.

11. In this case, the output TWI layer is a final layer, so we have to indicate so. In the corresponding textbox, enter
the name that you want to be shown for this output.

Now our model is finished and it should look like this.

{§ Processing modeler [l ]
Inputs Algarithms TWI from DEM My Models

[ Parameters -
;- Boolean

i Extent

i File:

- Number ‘q}.. DEM e

£

- Table field
Vector layer T eln
In

e
& slope, aspect, curvature "'\‘ x
‘ pe, aspech &£ ‘@ Catchment area (parallel) 69

Out

.
G Topographic wetness inde...‘;

Out

[Edtmodeine| | mn || open || save || saveas.. || Cose |

12. Enter a name and a group name in the upper part of the model window.

| TWI from DEM [y Mogels

38

o DEM

T

13. Save it clicking on the Save button. You can save it anywhere you want and open it later, but if you save it in
the models folder (which is the folder that you will see when the save file dialog appears), your model will also
be available in the toolbox as well. So stay on that folder and save the model with the filename that you prefer.

14. Now close the modeler dialog and go to the toolbox. In the Models entry you will find your model.

- Geoalgorithms
ﬁﬂ Maodels

EH My Models

[Example models]
[Test models]

B saipts

TWI from DEM
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15. You can run it just like any normal algorithm, double-clicking on it.

x

Parameters | Log | Help |

DEM

raster [EPSG:23030] - I}

TWI

Save to temporary file]

R Open output file after running algorithm

[l 0% ]
Run Close

As you can see, the parameters dialog, contain the input that you added to the model, along with the outputs
that you set as final when adding the corresponding algorithms.

16. Run it using the DEM as input and you will get the TWI layer in just one single step.

17.18 Modelos mais complexos

Nota: In this lesson we will work with a more complex model in the model designer.

The first model that we created in the previous chapter was a very simple one, with just one input and three algorithms.
More complex models can be created, with different types of inputs and containing more steps. For this chapter we
will work with a model that creates a vector layer with watersheds, based on a DEM and a threshold value. That
will be very useful for calculating several vector layers corresponding to different thresholds, without having to repeat
each single step each time.

This lesson does not contain instructions about how to create your model. You already know the necessary steps
(we saw them in a previous lesson) and you have already seen the basic ideas about the modeler, so you should try it
yourself. Spend a few minutes trying to create your model, and don’t worry about making mistakes. Remember: first
add the inputs and then add the algorithms that use them to create the workflow.

Nota: In case you could not create the full model yourself and you need some extra help, the data folder
corresponding to this lesson contains an “almost” finished version of it. Open the modeler and then open the model
file that you will find in the data folder. You should see something like this.
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} Processing modeler ol x|
Inputs Algorithms Watershed from DEM and threshold [Example models]

[ Parameters re
i Boolean

~Extent

-File x
-~ Mumber ‘q}l =3 Q‘
- Raster Layer
- 5tring
- Table | In
~Table field
Vector layer n ‘@ Watershed basins &
Out
‘@ Fill Sinks g‘
Out .
n
‘@ Vectorising grid classes %‘
—a1In Out

G Catchment area (parallel) §‘

Cut ‘X
In

‘@ Channel network &
out me—

< [DI]@

Edtmodelhep| | mm || open || sae || saveas.. || coe |

This model contains all the steps needed to complete the calculation, but it just has one input: the DEM. That means
that the threshold for channel definition uses a fixed value, which makes the model not as useful as it could be. That
is not a problem, since we can edit the model, and that is exactly what we will do.

1. First, let’s add a numerical input. That will ask the user for a numerical input that we can use when such a
value is needed in any of the algorithms included in our model.

2. Click on the Number entry in the Inputs tree, and you will see the corresponding dialog.
3. Fill it with the following values.
* Parameter name: Threshold for channel definition

* Default value: 1,000,000

{} Parameter definition d |

Parameter name [Threshnld for channel definition ]
Min Max 'u'alues[ 0 ][ ]
Default value | 1000000] |

Now your model should look like this.
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{3 Processing modeler (] 75
Inputs Algorithms Watershed from DEM and threshold [Example models]
El- Parameters -
- Boolean
-~ Extent = x
- File
e |%}- DEM £| |%- Thresheld for channel def... £|
- Raster Layer
- String
Table In
+ Table field
- Vector layer In |G Watershed basins $|
|$ Fill Sinks out
Out
In
& - . o
Vectorising grid classes &
—& In
Cut
|G Catchment area (parallel) ‘§|
Out
(1‘ Watersheds |
In
|@ Channel network |§|
out me—"
| [+
[Edtmodelheb] [ Run ] [ Open ] [ Save ] [ Save as ... ] [ Close ]

The input that we have just added is not used, so the model hasn’t actually changed. We have to link that input
to the algorithm that uses it, in this case the Channel network one. To edit an algorithm that already exists in
the modeler, just click on the pen icon on the corresponding box in the canvas.

4. Click on the Channel network algorithm and you will see something like this.

) Channel network

Parameters Help

Elevation

| DEM

Flow Direction

' [Not selected]

Initiation Grid

[Catd’rnent Area from algorithm 1(Catchment area (parallel))

Initiation Type

' [2] Greater than

Initiation Threshold

| 1000000

Divergence

' [Not selected]

Tracing: Max. Divergence

|10

Tracing: Weight

' [Not selected]

Min. Segment Length

10
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The dialog is filled with the current values used by the algorithm. You can see that the Initiation threshold
parameter has a fixed value of 1,000,000 (this is also the default value of the algorithm, but any other value
could be put in there). However, you might notice that the parameter is not entered in a common text box, but
in a drop-down menu.

5. Unfold the threshold parameter menu and you will see something like this.

{j Channel network 2l x|
Parameters | Help

Elevation B
|DEM [~]
Flow Direction
' [Not selected] B
Initiation Grid
| Catchment Area from algorithm 1(Catchment area (parallel)) v
Initiation Type
[ [2] Greater than | ,]
Initiation Thresheld

1000000
| [Not selected] -
Tracing: Max. Divergence
Lo )
Tracing: Weight
' [Not selected] B
Min. Segment Length "
10 |~ E

ok || cancel |

The input that we added is there and we can select it. Whenever an algorithm in a model requires a numerical
value, you can hardcode it and directly type it, or you can use any of the available inputs and values (remember
that some algorithms generate single numerical values. We will see more about this soon). In the case of a
string parameter, you will also see string inputs and you will be able to select one of them or type the desired
fixed value.

6. Select the Threshold for channel definition inputin the Initiation threshold parameter.

7. Click on OK to apply the changes to your model. Now the design of the model should look like this.
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¥ Processing modeler =1l x|
Inputs Watershed from DEM and threshold [Example models]
= Parameters e
; ean
Extent
i File
i Mumber
- Raster Layer
- String
i+ Table
i Table field
- Vector layer
& Fill sinks ‘G Watershed basins g‘

Out

In

—#In ‘G ectorising grid classes &

G Catchment area (parallel) g‘ Qut Ehey

‘G Channel network §|
out —

ﬂ ¥ watersheds |

&

(1)

[T S . — -

8. The model is now complete. Run it using the DEM that we have used in previous lessons, and with different
threshold values.

Below you have a sample of the result obtained for different values. You can compare with the result for the
default value, which is the one we obtained in the hydrological analysis lesson.

Figural7.1: Threshold = 100,000
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Figural7.2: Threshold = 1,0000,000

17.19 Numeric calculations in the modeler

Aviso: Beware, this chapter is not well tested, please report any issue; images are missing

Nota: In this lesson we will see how to use numeric outputs in the modeler

For this lesson, we are going to modify the hydrological model that we created in the last chapter (open it in the
modeler before starting), so we can automate the calculation of a valid threshold value and we do not have to ask the
user to enter it. Since that value refers to the variable in the threshold raster layer, we will extract it from that layer,
based on some simple statistical analysis.

Starting with the aforementioned model, let’s do the following modifications:

First, calculate statistics of the flow accumulation layer using the Raster layer statistics algorithm.
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{} Raster layer statistics

[Enter name if this is a final result]

This will generate a set of statistical values that will now be available for all numeric fields in other algorithms.

If you edit the Channel network algorithm, as we did in the last lesson, you will see now that you have other options
apart from the numeric input that you added.
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{} Channel network
Parameters Help

Elevation

DM -]
Flow Direction

| INot selected] [~]
Initiation Grid

| Catchment Area from algorithm 1(Catchment area (parallel)) v
Initiation Type

[ [2] Greater than | v]

Initiation Threshold
Threshald for channel definition

Threshold for channel definition

Minimum value from algorithm S{Raster layer statistics)
Maximum value from algorithm S5{Raster layer statistics)
Sum from algorithm S(Raster layer statistics)

Mean value from algorithm 5{Raster layer statistics)

valid cells count from algorithm 5{Raster layer statistics)
Mo-data cells count from algorithm 5{(Raster layer statistics)
Standard deviation from algorithm 5{Raster layer statistics)

| [Not selected] -]

Min. Segment Length -

|10 v E
o | conal_

However, none of this values is suitable for being used as a valid threshold, since they will result in channel networks
that will not be very realistic. We can, instead, derive some new parameter based on them, to get a better result. For

instance, we can use the mean plus 2 times the standard deviation.

To add that arithmetical operation, we can use the calculator that you will find in the Geoalgorithms/modeler/modeler-

tools group. This group contains algorithms that are not very useful outside of the modeler, but that provid
useful functionality when creating a model.

The parameters dialog of the calculator algorithm looks like this:

€ some
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) Calculator

‘fou can refer to model values in you formula, using singledetter variables, as follows:

a->Threshold for channel definition
b-=Minimum value from algorithm S{R.aster layer statistics)
c->=Maximum value from algorithm 5(Raster layer statistics)
d-=5um from algorithm S(Raster layer statistics)

e-=Mean value from algorithm 5(Raster layer statistics)
f-=valid cells count from algorithm S(Raster layer statistics)
g-=Mo-data cells count from algorithm 5(Raster layer statistics)
h-=5Standard deviation from algorithm S(Raster layer statistics)

[e+27H|

|| Conel

As you can see, the dialog is different to the other ones we have seen, but you have in there the same variables that
were available in the Threshold field in the Channel network algorithm. Enter the above formula and click on OK to

add the algorithm.

€ Processing modeler o =]}
Inputs Algorithms Watershed from DEM and threshold [Example models] ]
El- 4 Geoalgorithms —In In In
ER Domain spedfic 3 Wl
. B Terrain analysis and geomorphometry ‘@ Catchment area (parallel) 5 & Channel network 9‘ & ve
&% Real area calaulation -—
Lo Cut [+ Out o]
E| Modeler ! & u_
E|--- Modeler tools
38 Caloulator
& Raster
E|--- General tools
; - && Raster calculator %
B 8 vector 4F Threshold for channel def... %
B- Table tools
Advanced Python field calculator
- - In
Field calculator
B Raster layer statistics 5‘
Cut = In
Statistics x
Minimum value B caloulator &
Maximum value out
Sum Y
Mean value
valid cells count
No-data cells count
Standard deviation
< [T
’Ed'tmodelheb] [ Run l [ Open ] [ Save ] [ SEVE a5 ... ] [ Close ]

If you expand the outputs entry, as shown above, you will see that the model is connected to two of the values, namely
the mean and the standard deviation, which are the ones that we have used in the formula.

Adding this new algorithm will add a new numeric value. If you go again to the Channel network algorithm, you can
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now select that value in the Threshold parameter.

{§ Channel network

© |z
X
0 |z

Click on OK and your model should look like this.
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i Channel network 21x

Parameters Help

Elevation

|DEM [~]

Flow Direction

' [Not selected] v

Initiation Grid

[Cabchment Area from algorithm 1({Catchment area (parallel)) | v]

Initiation Type

[ [2] Greater than | v]
Initiation Thresheld

[Threshold for channel definition | v]
Thresheld for channel definition L

Minimum value from algorithm S{Raster layer statistics)
Maximum value from algorithm S5{Raster layer statistics)
Sum from algorithm S(Raster layer statistics)

Mean value from algorithm 5{Raster layer statistics)

valid cells count from algorithm 5{Raster layer statistics)
Mo-data cells count from algorithm 5{(Raster layer statistics)
Standard deviation from algaorithm S{Raster layer statistics]
Result from algorithm 6(Calculator)
[ . ]

Min. Segment Length E
10 -l Iz

We are not using the numeric input that we added to the model, so it can be removed. Right—click on it and select
Remove

Aviso: todo: Add image

Our new model is now finished.

17.20 A model within a model

Aviso: Beware, this chapter is not well tested, please report any issue; images are missing

Nota: In this lesson we will see how to use a model within a bigger model.

We have already created a few models, and in this lesson we are going to see how we can combine them on a single
bigger one. A model behaves like any other algorithm, which means that you can add a model that you have already
created as part of another one that you create after that.

In this case, we are going to expand our hydrological model, by adding the mean TWI value in each of the basins that
it generates as result. To do that, we need to calculate the TWI, and to compute the statistics. Since we have already
created a model to calculate TWI from a DEM, it is a good idea to reuse that model instead of adding the algorithms
it contains individually.
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Let’s start with the model we used as starting point for the last lesson.

Aviso: todo: Add image

First, we will add the TWI model. For it to be available, it should have been saved on the models folder, since
otherwise it will not be shown in the toolbox or the algorithms list in the modeler. Make sure you have it available.

Add it to the current model and use the input DEM as its input. The output is a temporary one, since we just want
the TWI layer to compute the statistics. The only output of this model we are creating will still be the vector layer
with the watersheds.

Here is the corresponding parameters dialog:

Aviso: todo: Add image

Now we have a TWI layer that we can use along with the watersheds vector layer, to generate a new one which
contains the values of the TWI corresponding to each watershed.

This calculation is done using the Grid statistics in polygons algorithm. Use the layers mentioned above as input, to
create the final result.

Aviso: todo: Add image

The output of the Vectorize grid classes algorithm was originally our final output, but now we just want it as an
intermediate result. To change that, we have to edit the algorithm. Just double—click on it to see its parameters
dialog, and delete the name of the output. That will make it a temporary output, as it is by default.

Aviso: todo: Add image

This is how the final model should look like:

Aviso: todo: Add image

As you see, using a model in another model is nothing special, and you can add it just like you add another algorithm,
as long as the model is saved in the models folder and is available in the toolbox.

17.21 Using modeler-only tools for creating a model

Nota: This lesson shows how to use some algorithms that are only available in the modeler, to provide additional
functionality to models.

The goal of this lesson is to use the modeler to create an interpolation algorithm that takes into account the current
selection, not just to use only selected features, but to use the extent of that selection to create the interpolated raster
layer.

The interpolation process involves two steps, as it has been already explained in previous lessons: rasterizing the
points layer and fill the no-data values that appear in the rasterized layer. In case the points layer has a selection, only
selected points will be used, but if the output extent is set to be automatically adjusted, the full extent of the layer will
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be used. That is, the extent of the layer is always considered to be the full extent of all features, not the one computed
from just the selected ones. We will try to fix that by using some additional tools into our model.

Open the modeler and start the model by adding the required inputs. In this case we need a vector layer (restricted
to points) and an attribute from it, with the values that we will use for rasterizing.

iy Processing modeler - B

BR &M B
4 Parameters rasterize (considering selection) workshop

4F Boolean ~
dF Extent
dF File
HF Mumber 5
dF Raster layer P points & o field
4k String
4 Table
dF Table field
4k Table multiple field
a9k Vector layer
4F Point

R

Inputs Algorithms < >

The next step is to compute the extent of the selected features. That’s where we can use the model-only tool called
Vector layer bounds. First, we will have to create a layer that has the extent of those selected features. Then, we can
use this tool on that layer.

An easy way of creating a layer with the extent of the selected features is to compute a convex hull of the input points
layer. It will use only the selected point, so the convex hull will have the same bounding box as the selection. Then we
can add the Vector layer bounds algorithm, and use the convex hull layer as input. It should look this in the modeler
canvas:
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o Processing modeler = =

B B | = M|

4 Parameters rasterize {considering selection) workshop
4F Boolean -
oF Extent
oF File
F Number
oF Raster layer
oF String
dF Table
dh Table field
oF Table multiple field
oF Vector layer
oF Point

10!
“r_k

5F points P field o

g

In

D convex hull &

Out

B vector layer bounds &

Qut

Inputs Algorithms < N

The result from the Vector layer bounds is a set of four numeric values and a extent object. We will use both the
numeric outputs and the extent for this exercise.

In

B vector layer bounds

X

Ot =
min
max x
min ¥
max Y
Extent

We can now add the algorithm that rasterizes the vector layer, using the extent from the Vector layer bounds algorithm
as input.

Fill the parameters of the algorithm as shown next:
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4

Parameters Help

Rasterize

Description |Rasterize

Shapes

points <]
Attribute

| field v]
Method for Multiple Values

[4] mean v
Method for Lines

0] thin v
Preferred Target Grid Type

|[3] Floating Point (4 byte) -]
Qutput extent{xmin, xmax, ymin, ymax)

| 'Extent’ from algorithm "ector layer bounds| W |
Cellsize

| 100.0 v
Grid <OutputRaster >

| [Enter name if this is a final result]

Parent algorithms
0 elements selected

The canvas should now look like.

¥

DR RWH[B| &

Processing modeler

4 Parameters
4F Boolean
dF Extent
dF File
HF Mumber
dF Raster layer
4k String
4 Table
dF Table field
4k Table muttiple field
a9k Vector layer
4k Point

rasterize (considering selection)

”workshop

In
‘ Conwvex hull s
Out
In

B vector layer bounds

out o

In

‘ 6 Rasterize

Out
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Finally, fill the no-data values of the raster layer using the Close gaps algorithm.

L | e i

G

Search...

=]

> @ GeoServer tools ~
> W& Modeler-only tools
> & QGIS geoalgorithms
4 & SAGA (21.2)
> Geostatistics
> Image analysis
> Image tools
> Raster analysis
> Raster calculus
> Raster creation tools
> Raster filter
4 Raster tools
@ Aggregate
@ Close gaps
@ Close gaps with spline
@ Close one cell gaps
@ Convert data storage type
@ Crop to data
@ Invert data/no-data
@ Mosaic raster layers
@ Patching
@ Proximity raster
@ Raster buffer
@ Raster cell index
@ Raster masking
@ Raster orientation
@ Raster proximity buffer
@ Reclassify values
& Reclassify values (simple)
@ Resampling

|l & Shrnkandewand %]

Inputs Algorithms

Processing modeler = &
rasterize (considering selection) example
-~
aF points o a field o
In In
@ convex hull .’5); & Rasterize .’5)\’
Out Out
In In
 vector layer bounds .;); & Close gaps ;\;
s
Cut Out
¥ out
w
£ >

The algorithm is now ready to be saved and added to the toolbox. You can run it and it will generate a raster layer
from interpolating the selected points in the input layer, and the layer will have the same extent as the selection.

Here’s an improvement to the algorithm. We have used a harcoded value for the cellsize when rasterizing. This value
is fine for our test input layer, but might not be for other cases. We could add a new parameter, so the user enters the
desired value, but a much better approach would be to have that value automatically computed.

We can use the modeler-only calculator, and compute that value from the extent coordinates. For instance, to create
a layer with a fixed width of 100 pixels, we can use the following formula in the calculator.
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vl

g

Calculator

You can refer to model values in your formula, using single-letter variables, as follows:

a-='min X' from algorithm "Vector layer bounds'
b-='max X' from algorithm "Vector layer bounds'
c-='min ¥ from algorithm "“vector layer bounds'
d-='max " from algorithm "Vector layer bounds'

(b -a)/100]

ok || Cancel |

Now we have to edit the rasterize algorithm, so it uses the output of the calculator instead of the hardcoded value.

The final algorithm should look like this:

& Processing modeler = B
mB R 2B
4 Parameters rasterize (considering selection) ”Example|
4F Boolean ~
db Extent
4 File
=F Mumber . F 3
<k Raster layer T points £|
db String
4 Toble 2
4k Table field 2
4 Table multiple field
gk Vector layer
4k Point
In
@ convex hull
Cut
|6 Rasterize $|
In
B vector layer bounds n
Out
|6 Close gaps $|
Out
In
B Calculator §| ‘* out |
Cut =]
Resulte—"
v
Inputs Algarithms < >
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17.22 Interpolacao

Nota: This chapter shows how to interpolate point data, and will show you another real example of performing
spatial analysis

In this lesson, we are going to interpolate points data to obtain a raster layer. Before doing it, we will have to do some
data preparation, and after interpolating we will add some extra processing to modify the resulting layer, so we will
have a complete analysis routine.

Open the example data for this lesson, which should look like this.

The data correspond to crop yield data, as produced by a modern harvester, and we will use it to get a raster layer of
crop yield. We do not plan to do any further analysis with that layer, but just to use it as a background layer for easily
identifying the most productive areas and also those where productivity can be improved.

The first thing to do is to clean—up the layer, since it contains redundant points. These are caused by the movement
of the harvester, in places where it has to do a turn or it changes its speed for some reason. The Points filter algorithm
will be useful for this. We will use it twice, to remove points that can be considered outliers both in the upper and
lower part of the distribution.

For the first execution, use the following parameter values.
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{} Points filter

Now for the next one, use the configuration shown below.
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{} Points filter

Notice that we are not using the original layer as input, but the output of the previous run instead.

The final filter layer, with a reduced set of points, should look similar to the original one, but it contains a smaller
number of points. You can check that by comparing their attribute tables.

Now let’s rasterize the layer using the Rasterize algorithm.
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{} shapes to grid

[Leave blank to use min covering extent]

save to temporary file]

The Filtered points layer refers to the resulting one of the second filter. It has the same name as the one produced by
the first filter, since the name is assigned by the algorithm, but you should not use the first one. Since we will not be
using it for anything else, you can safely remove it from your project to avoid confusion, and leave just the last filtered
layer.

The resulting raster layer looks like this.
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It is already a raster layer, but it is missing data in some of its cells. It only contain valid values in those cells that
contained a point from the vector layer that we have just rasterized, and a no—data value in all the other ones. To fill
the missing values, we can use the Close gaps algorithm.

17.22. Interpolacao 627



QGIS Training Manual

{} Close gaps

[Save to temporary file]

The layer without no—data values looks like this.
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To restrict the area covered by the data to just the region where crop yield was measured, we can clip the raster layer
with the provided limits layer.
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{3 Clip grid with polygon

[Save to temporary file]

t3

And for a smoother result (less accurate but better for rendering in the background as a support layer), we can apply
a Gaussian filter to the layer.
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x

Parameters Log Help

Grid
Clopes 75 o
Standard Deviation

3 =

Search Mode

| [1] Cirdle d
Search Radius

| 250 =
Filtered Grid

[ [Save to temporary file] ” l

(3| Open output file after running algaorithm

100%

(o [ cow [ cons |

With the above parameters you will get the following result
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17.23 More interpolation

Nota: This chapter shows another practical case where interpolation algorithms are used.

Interpolation is a common technique, and it can be used to demonstrate several techniques that can be applied using
the QGIS processing framework. This lesson uses some interpolation algorithms that were already introduced, but
has a different approach.

The data for this lesson contains also a points layer, in this case with elevation data. We are going to interpolate it
much in the same way as we did in the previous lesson, but this time we will save part of the original data to use it
for assessing the quality of the interpolation process.

First, we have to rasterize the points layer and fill the resulting no—data cells, but using just a fraction of the points
in the layer. We will save 10% of the points for a later check, so we need to have 90% of the points ready for the
interpolation. To do so, we could use the Split shapes layer randomly algorithm, which we have already used in a
previous lesson, but there is a better way to do that, without having to create any new intermediate layer. Instead of
that, we can just select the points we want to use for the interpolation (the 90% fraction), and then run the algorithm.
As we have already seen, the rasterizing algorithm will use only those selected points and ignore the rest. The selection
can be done using the Random selection algorithm. Run it with the following parameters.
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x

Parameters Log Help

Input layer

' points [EPSG:23030] d
Method

[Paca'ﬂzge of selected features | "]
Mumber jpercentage of selected features

190 =]

That will select 90% of the points in the layer to rasterize
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The selection is random, so your selection might differ from the selection shown in the above image.

Now run the Rasterize algorithm to get the first raster layer, and then run the Close gaps algorithm to fill the no—data
cells [Cell resolution: 100 m].

To check the quality of the interpolation, we can now use the points that are not selected. At this point, we know the
real elevation (the value in the points layer) and the interpolated elevation (the value in the interpolated raster layer).
We can compare the two by computing the differences between those values.

Since we are going to use the points that are not selected, first, let’s invert the selection.
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The points contain the original values, but not the interpolated ones. To add them in a new field, we can use the Add
raster values to points algorithm

{} Add grid values to points x|
Parameters | Log | Help |

Points

points [EPSG: 23030]

Grids

1 elements selected
Interpolation

[4] B-Spline Interpolation
Result

[Save

a

e Flal

» termporary file

Cu

R Open output file after running algorithm

Run Close
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The raster layer to select (the algorithm supports multiple raster, but we just need one) is the resulting one from the
interpolation. We have renamed it to interpolate and that layer name is the one that will be used for the name of the
field to add.

Now we have a vector layer that contains both values, with points that were not used for the interpolation.

=10/ x|

AR R B EEEEREE

D ! VALUE interpolate -
i ©| 1516.0000000000 | 1452,5041504000
3 10| 2096.0000000000 | 2073, 7648926000
4 12| 532.0000000000 555.31542960900
a 20| 343.0000000000 | 863.3750000000
71 04| 2224.0000000000 | 21365.8433387000
24 66| 749.0000000000 | 753.2322265600
eiz] 29| 15635.0000000000 | 1644.0615234000
29 75| 726.0000000000 | 704.6588134300
6 95| 9270000000000 | 935.9505004300
7| 101 1320.0000000000 | 1305.3083496000
39 102 | 2170.0000000000 | 2155.5400391000
a0 106 | 549.0000000000 544.8675757800
47 105 | 641.0000000000 | 648.3961151600
a7 113 | 1534.0000000000 | 1525.2607422000
54 141 775.0000000000 757.4203451200

62 158 | 1915.0000000000 | 1924,1274414000 :

ki d show al Features _

Now, we will use the fields calculator for this task. Open the Field calculator algorithm and run it with the following
parameters.
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(} Field calculator x|

Parameters | Log Help

|»

Input layer

[Rzg_.it [EP5G:23030] |"“ ]

Result field name

[errcr ]
Field type

Foat -
Field length

|10 =]
Field predsion

E =]
Formula

[abs{'u'ALUE - interpolat) ]
Output layer

[ [5ave to temparary file] ][ ]

(3| Open output file after running algorithm

KDk

If your field with the values from the raster layer has a different name, you should modify the above formula
accordingly. Running this algorithm, you will get a new layer with just the points that we haven’t used for the
interpolation, each of them containing the difference between the two elevation values.

Representing that layer according to that value will give us a first idea of where the largest discrepancies are found.
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{} Attribute table - Output layer = Features totak 703, filtered: 703, selected:

=10l x|

/18] )| (8 (=) (=) ()[R [2)| (E) [z (E)
jin] = VALUE interpolat error -

0 4107| 1243.0000000000 | 1199,6501465000 43,34985

1 &| 1516.0000000000 | 1452,5041504000 £3.49585

2 4112| 1594.0000000000 | 1590,4835205000 3.51648

3 10| 2096.0000000000 | 2073.7648926000 22,23511

4 12| 582.0000000000| 555.3154296900 2668457

5 4121| 1101.0000000000 | 1103.0323486000 2.03235

6 6176| 1258.0000000000 | 1260,9846191000 2.98462

7 4125| 1241.0000000000 | 1225,0878906000 15.91211

3 20| 843.0000000000| 8633750000000 20,37500

a £179| 1195.0000000000 | 1198,4991455000 3.49915

10 2075| 1786.0000000000 | 1799,5468750000 13.54688

11 4133| 1196.0000000000 | 1156.2314453000 39.76855

12 6188| 1720.0000000000| 1724.4638672000 4,46387

i3 £189| 1497.0000000000 | 1498,2706299000 1.27063

14 £191| 1349,0000000000| 1347.5555420000 1,44446

i5 2086 | 1277.0000000000 | 1296,1885986000 19, 18860 E

’ﬂﬂmﬁlFeah.rfsvl

Interpolating that layer will get you a raster layer with the estimated error in all points of the interpolated area.
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You can also get the same information (difference between original point values and interpolated ones) directly with
GRASS » v.sample.

Your results might differ from these ones, since there is a random component introduced when running the random
selection, at the beginning of this lesson.

17.24 lterative execution of algorithms

Nota: This lesson shows a different way of executing algorithms that use vector layers, by running them repeatedly,
iterating over the features in an input vector layer

We already know the model designer, which is one way of automating processing tasks. However, in some situations,
the modeler might not be what we need to automate a given task. Let’s see one of those situations and how to easily
solve it using a different functionality: the iterative execution of algorithms.

Open the data corresponding to this chapter. It should look like this.

L

-

You will recognize our well-known DEM from previous chapters and a set of watersheds extracted from it. Imagine
that you need to cut the DEM into several smaller layers, each of them containing just the elevation data corresponding
to a single watershed. That will be useful if you later want to calculate some parameters related to each watershed,
such as its mean elevation or it hypsographic curve.

This can be a lengthy and tedious task, especially if the number of watersheds is large. However, it is a task that can
be easily automated, as we will see.

The algorithm to use for clipping a raster layer with a polygon layer is called Clip raster with polygons, and has the
following parameters dialog.
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{} dip grid with polygon x|

Parameters Log Help

Input
[dem25 [EPSG:23030] |v][ ]

Polygons

| watersheds [EPSG:23030] B ]
Qutput
[ [Save to temporary file] ” l

[%| Open output file after running algorithm
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As you can see, the area covered by all the watershed polygons is used.

You can have the DEM clipped with just a single watershed by selecting the desired watershed and then running the
algorithm as we did before.

_——.

Since only selected features are used, only the selected polygon will be used to crop the raster layer.

17.24. lterative execution of algorithms 641



QGIS Training Manual

Doing this for all the watersheds will produce the result we are looking for, but it doesn’t look like a very practical
way of doing it. Instead, let’s see how to automate that select and crop routine.

First of all, remove the previous selection, so all polygons will be used again. Now open the Clip raster with polygon
algorithm and select the same inputs as before, but this time click on the button that you will find in the right-hand
side of the vector layer input where you have selected the watersheds layer.

{} Clip grid with polygon x|

Parameters Log Help

Input

‘dem35 [EPSG:23030] - ][ ]
Polygons

[watersheds [EPSG:23030] | - “ l
Output k

” [Tterate aver this layer|
"' ]

[ [Save to temparary file]

[%¢| Open output file after running algorithm

This button will cause the selected input layer to be split into as many layer as feature are found in it, each of them
containing a single polygon. With that, the algorithm will be called repeatedly, one for each one of those single-
polygon layers. The result, instead of just one raster layer in the case of this algorithm, will be a set of raster layers,
each one of them corresponding to one of the executions of the algorithm.

Here’s the result that you will get if you run the clipping algorithm as explained.
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For each layer, the black and white color palette, (or whatever palette you are using), is adjusted differently, from its
minimum to its maximum values. That’s the reason why you can see the different pieces and the colors do not seem
to match in the border between layers. Values, however, do match.

If you enter an output filename, resulting files will be named using that filename and a number corresponding to each
iteration as suffix.

17.25 More iterative execution of algorithms

Nota: This lesson shows how to combine the iterative execution of algorithms with the modeler to get more
automation.

The iterative execution of algorithms is available not just for built-in algorithms, but also for the algorithms that you
can create yourself, such as models. We are going to see how to combine a model and the iterative execution of
algorithms, so we can obtain more complex results with ease.

The data the we are going to use for this lesson is the same one that we already used for the last one. In this case, instead
of just clipping the DEM with each watershed polygon, we will add some extra steps and calculate a hypsometric
curve for each of them, to study how elevation is distributed within the watershed.

Since we have a workflow that involves several steps (clipping + computing the hypsometric curve), we should go to
the modeler and create the corresponding model for that workflow.

You can find the model already created in the data folder for this lesson, but it would be good if you first try to create
it yourself. The clipped layer is not a final result in this case, since we are just interested in the curves, so this model
will not generated any layers, but just a table with the curve data.

The model should look like this:
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BER 2PLPH bl B P
Model Properties -
Name |Hypso g DTM i 2 Polygon layer &
Group |/mymodels

Algorithms “@n +
Q search...

% Clip raster by mask layer *

Cartography - out . Use % of area instead...

Database Step

File tools @ Boundary layer

Graphics © DEM to analyze
Interpolation In =

Layer tools 3 ‘

Modeler tools Hypsometric curves
Network analysis Out +8
Raster analysis

1 Raster terrain analysis

Inputs | Algorithms

.

ofooRoNofofofokolo

1

‘l$ hypsometry tables dir...

§ &

Variables

Variable Value
¥ Model V...

Add the model to you models folder, so it is available in the toolbox, and execute it.
Select the DEM and watersheds basins.
The algorithm will generate tables for all the basins and place them in the output directory.

‘We can make this example more complex by extending the model and computing some slope statistics. Add the Slope
algorithm to the model, and then the Raster statistics algorithm, which should use the slope output as its only input.

BEERR 2P H kklyplkk B P
Model Properties -
Name  HypsoSlope =t Polygon layer i & DTM &

Group \/mymodels

Algorithms *n * @ in *
. statistics

& Clip raster by mask layer ~ ‘ ‘ Slope ’ ‘
~ (2 Raster analysis = out

Raster layer statistics

Raster layer unique val...
Raster layer zonal stati... ‘.@. Hypsometric curves : ‘ ‘ Raster layer statistics - ‘
Zonal histogram
Zonal statistics Out e Out
* (2 Vector analysis - - B3
Z Basic statistics for Fields ‘E’ hypsometry tables dir... f‘ ‘E’ setsne
2 Statistics by categories
v @ Vector general -

Inputs | Algorithms

+E Out +e

@ In + & In T

+®

Variables

Variable Value
¥ Model V...

If you now run the model, apart from the tables you will get a set of pages with statistics. These pages will be available
in the results dialog.
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17.26 O interface do processamento em lote

Nota: This lesson introduces the batch processing interface, which allows to execute a single algorithm with a set
of different input values.

Sometimes a given algorithm has to be executed repeatedly with different inputs. This is, for instance, the case when
a set of input files have to be converted from one format to another, or when several layers in a given projection must
be converted into another projection.

In that case, calling the algorithm repeatedly on the toolbox is not the best option. Instead, the batch processing
interface should be used, which greatly simplifies performing a multiple execution of a given algorithm. To run an
algorithm as a batch process, find it in the toolbox, and instead of double—clicking on it, right—click on it and select
Run as batch process.

&

= Raster
- % General tools

----- {J‘é} Reproject raster layer

ng -

eneral tools

Reproject layeg )

Execute as batch process

Edit rendering styles for outputs

For this example, we will use the Reproject algorithm, so find it and do as described above. You will get to the
following dialog.

{} Batch Processing - Reproject layer il

Parameters

| Input layer Target CRS Reprojected layer Load in QGIS |
EPSG:4325 /= Yes |-
EPSG:4326 | Yes |-
EP5G:4326 [ Yes |~
I 0% ]
’ Run ] [ Add row ] [ Delete row ] [ Close l ’ Cancel ]

If you have a look at the data for this lesson, you will see that it contains a set of three shapefiles, but no QGIS project
file. This is because, when an algorithm is run as a batch process, layer inputs can be selected either from the current
QGIS project or from files. That makes it easier to process large amounts of layers, such as, for instance, all the layers
in a given folder.
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Each row in the table of the batch processing dialog represents a single execution of the algorithm. Cells in a row
correspond to the parameter needed by the algorithm, which are not arranged one above the other, as in the normal
single—execution dialog, but horizontally in that row.

Defining the batch process to run is done by filling the table with the corresponding values, and the dialog itself
contains several tools to make this task easier.

Let’s start filling the fields one by one. The first column to fill is the Input layer one. Instead of entering the names
of each one of the layers we want to process, you can select all of them and let the dialog put one in each row. Click
on the button in the upper-left cell, and in the file selection dialog that will popup, select the three files to reproject.
Since only one of them is needed for each row, the remaining ones will be used to fill the rows underneath.

ﬂ

Parameters

Input layer Target CRS

D:\batch_conversion'ptl.shp [ EPSG:4326

D:\batch_conversion'pt2.shp EPSG:4326

D:\batch_conversion'pt3.shp EPSG:4326 e |-
( 0% )

[ Run l [ Add row l [ Delete row l [ Close l l Cancel ]

The default number of rows is 3, which is exactly the number of layers we have to convert, but if you select more
layers, new rows will be added automatically. If you want to fill the entries manually, you can add more rows using
the Add row button.

We are going to convert all those layers to the EPSG:23029 CRS, so we have to select that CRS in the second field.
We want the same on for all rows, but we do not have to do it for every single row. Instead, set that CRS for the first
row (the one at the top) using the button in the corresponding cell, and then double click on the column header. That
causes all the cells in the column to be filled using the value of the top cell.

646 Capitulo 17. Guia de Processamento QGIS



QGIS Training Manual

x
Parameters
Input layer Target CRS Load in QGIS
D:\batch_conversion'ptl.shp EPSG:23029 Yes
D:\batch_conversion'pt2.shp EPSG: 23029 Yes
D:\batch_conversion'pt3.shp EPSG: 23029 ‘Yes -
( 0% )
l Run ] [ Add row l [ Delete row l [ Close l l Cancel ]

Finally, we have to select an output file for each execution, which will contain the corresponding reprojected layer.
Once again, let’s do it just for the first row. Click on the button in the upper cell and, in a folder where you want to
put your output files, enter a filename (for instance, reprojected. shp).

Now, when you click OK on the file selection dialog, the file does not automatically gets written to the cell, but an
input box like the following one is shown instead.

Autofil mode [Dc not autofil | v]
Parameter to use [Ir'lput layer | v]
ok || cancel |

If you select the first option, only the current cell will be filled. If you select any of the other ones, all the rows below
will be filled with a given pattern. In this case, we are going to select the Fill with parameter value option, and then
the Input Layer value in the drop down menu below. That will cause the value in the Input Layer (that is, the layer
name) to be added to the filename we have added, making each output filename different. The batch processing table
should now look like this.
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zl
Parameters
Input layer Target CRS Reprojected layer
D:\batch_conversion'ptl.shp e EPSG:23029 e D joutputs freprojectedpt 1.shp
D:\batch_conversion'pt2.shp vee EPSG: 23029 s D foutputs freprojectedpt 2. shp
D:\batch_conversion'pt3.shp vee EPSG: 23029 s D foutputs freprojectedpt 3. shp s ‘Yes | -
( 0% )
l Run ] [ Add row l [ Delete row l [ Close l l Cancel ]

The last column sets whether or not to add the resulting layers to the current QGIS project. Leave the default Yes
option, so you can see your results in this case.

Click on OK and the batch process will be run. If everything went fine, all your layers will have been processed, and
3 new layers would have been created.

17.27 Models in the batch processing interface

Aviso: Beware, this chapter is not well tested, please report any issue; images are missing

Nota: This lesson shows another example of the batch processing interface, but this time using a model instead of
a built-in algorithm

Models are just like any other algorithm, and they can be used in the batch processing interface. To demonstrate that,
here is a brief example that we can do using our already well-known hydrological model.

Make sure you have the model added to your toolbox, and then run it in batch mode. This is what the batch processing
dialog should look like.

Aviso: todo: Add image

Add rows up to a total of 5. Select the DEM file corresponding to this lesson as the input for all of them. Then enter
5 different threshold values as shown next.
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Aviso: todo: Add image

As you see the batch processing interface can be run not just to run the same process on different datasets but also
on the same dataset with different parameters.

Click on OK and you should get 5 new layers with watersheds corresponding to the specified 5 threshold values.

17.28 Pré- e pos-execucao de encaixe da script

Nota: This lesson shows how to use pre- and post-execution hooks, which allow to perform additional operations
before and after actual processing.

Pre- and post-execution hooks are Processing scripts that run before and after actual data processing is performed.
This can be used to automate tasks that should be performed whenever an algorithm is executed.

The syntax of the hooks is identical to the syntax of Processing scripts, see the corresponding chapter in the QGIS
User Guide for more details.

In addition to all scripts features, in hooks you can use a special global variable named a1g, which represents the
algorithm that has just been (or is about to be) executed.

Here is an example post-execution script. By default, Processing stores analysis results in temporary files. This script
will copy outputs to a specific directory, so they won’t be deleted after closing QGIS.

import os
import shutil
from processing.core.outputs import OutputVector, OutputRaster, OutputFile

MY_DIRECTORY = '/home/alex/outputs'

for output in alg.outputs:
if isinstance (output, (OutputVector, OutputRaster, OutputFile)):
dirname = os.path.split (output.value) [0]
shutil.copytree (dirname, MY_DIRECTORY)

In the first two lines we import the required Python packages: os — for path manipulations, e.g. extracting file name,
and shut il — for various filesystem operations like copying files. In the third line we import Processing outputs.
This will be explained in more detail later in this lesson.

Then we define a MY_DIRECTORY constant, which is the path to the directory where we want to copy analysis
results.

At the end of the script, we have the main hook code. In the loop we iterate over all algorithm outputs and check if
this output is a file-based output and can be copied. If so, we determine top-level directory in which output files are
located and then copy all files to our directory.

To activate this hook we need to open the Processing options, find the entry named Post-execution script file in the
General group, and specify the filename of the hook script there. the specified hook will be executed after each
Processing algorithm.

In a similar way, we can implement pre-execution hooks. For example, let’s create a hook to check input vectors for
geometry errors.

from ggis.core import QgsGeometry, QgsFeatureRequest
from processing.core.parameters import ParameterVector

for param in alg.parameters:
(continues on next page)
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(continuac@o da pégina anterior)
if isinstance (param, ParameterVector) :

layer = processing.getObject (param.value)
for f in layer.getFeatures (QgsFeatureRequest () .setSubsetOfAttributes ([])) :

errors = f.geometry () .validateGeometry ()

if len(errors) > 0:

progress.setInfo('One of the input vectors contains invalid.
—geometries!"')

As in the previous example, first we import required QGIS and Processing packages.

Then we iterate over all the algorithm parameters and if a ParameterVector parameter is found, we get the
corresponding vector layer object from it. We loop over all the features of the layer and check them for geometry
errors. If at least one feature contains an invalid geometry, we print a warning message.

To activate this hook we need enter its filename in the Pre-execution script file option in the Processing configuration
dialog. The hook will be executed before running any Processing algorithm.

17.29 Outros programas

Module contributed by Paolo Cavallini - Faunalia

Nota: This chapter shows how to use additional programs from inside Processing. To complete it, you must have
installed, with the tools of your operating system, the relevant packages.

17.29.1 GRASS

GRASS is a free and open source GIS software suite for geospatial data management and analysis, image processing,
graphics and maps production, spatial modeling, and visualization.

It is installed by default on Windows through the OSGeo4W standalone installer (32 and 64 bit), and it is packaged
for all major Linux distributions.

17.29.2 R

R is a free and open source software environment for statistical computing and graphics.

It has to be installed separately, together with a few necessary libraries (LIST). To enable the use of R in QGIS, the
Processing R Provider plugin must also be installed.

The beauty of Processing implementation is that you can add your own scripts, simple or complex ones, and they
may then be used as any other module, piped into more complex workflows, etc.

Test some of the preinstalled examples, if you have R already installed (remember to activate R modules from the
General configuration of Processing).
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17.29.3 Others

LASTools is a set of mixed, free and proprietary commands to process and analyze LiDAR data. Availability in
various operating system varies.

More tools are available through additional plugins, e.g.:
* LecoS: a suite for land cover statistics and landscape ecology
* lwgeom: formerly part of PostGIS, this library brings a few useful tools for geometry cleanup
* Animove: tools to analyse the home range of animals.

More will come.

17.29.4 Comparison among backends
Buffers and distances

Let’s load points. shp and type buf in the filter of the Toolbox, then double click on:
e Fixed distance buffer: Distance 10000
* Variable distance buffer: Distance field SIZE
 v.buffer.distance: distance 10000
* v.buffer.column: bufcolumn SIZE
* Shapes Buffer: fixed value 10000 (dissolve and not), attribute field (with scaling)
See how speed is quite different, and different options are available.
Exercise for the reader: find the differences in geometry output between different methods.
Now, raster buffers and distances:

« first, load and rasterize the vector rivers. shp with GRASS » v.to.rast.value; beware: cell size must be set
to 100 m, otherwise the computation time will be enormous; resulting map will have 1 and NULLs

* same, with SAGA » Shapes to Grid » COUNT (resulting map: 6 to 60)

* then, proximity (value= 1 for GRASS, a list of rivers ID for SAGA), r.buffer with parameters 1000,2000,3000,
r.grow.distance (the first of the two maps; the second will show the areas pertaining to each river, if done on
the SAGA raster).

Dissolve

Dissolve features based on a common attribute:
¢ GRASS » v.dissolvemunicipalities.shp on PROVINCIA
¢ QGIS » Dissolve municipalities.shp on PROVINCIA
* OGR » Dissolve municipalities.shp on PROVINCIA

e SAGA » Polygon Dissolve municipalities.shp on PROVINCIA (NB: Keep inner boundaries must be
unselected)

Nota: The last one is broken in SAGA <=2.10

Exercise for the reader: find the differences (geometry and attributes) between different methods.
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17.30 Interpolation and contouring

Module contributed by Paolo Cavallini - Faunalia

Nota: This chapter shows how to use different backends to calculate different interpolations.

17.30.1 Interpolacao

The project shows a gradient in rainfall, from south to north. Let’s use different methods for interpolation, all based
on vector points. shp, parameter RAIN:

Aviso: Set cell size to 500 for all analyses.

e GRASS » v.surf.rst
e SAGA » Multilevel B-Spline Interpolation

SAGA w» Inverse Distance Weighted [Inverse distance to a power; Power: 4; Search radius: Global; Search
range: all points]

GDAL w» Grid (Inverse Distance to a power) [Power:4]
GDAL w» Grid (Moving average) [Radius1&2: 50000]

Then measure variation among methods and correlate it with distance to points:
* GRASS » r.series [Unselect Propagate NULLs, Aggregate operation: stddev]
¢ GRASS » v.to.rast.value on points.shp
e GDAL w» Proximity

* GRASS » r.covar to show the correlation matrix; check the significance of the correlation e.g. with http:
/Ivassarstats.net/rsig.html.

Thus, areas far from points will have less accurate interpolation.

17.30.2 Contour

Various methods to draw contour lines [always step= 10] on the stddev raster:
* GRASS » r.contour.step
e GDAL » Contour
* SAGA » Contour lines from grid [NB: in some older SAGA versions, output shp is not valid, known bug]
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17.31 Vector simplification and smoothing

Module contributed by Paolo Cavallini - Faunalia

Nota: This chapter shows how simplify vectors, and smooth out sharp corners.

Sometimes we need a simplified version of a vector, to have a smaller file size and get rid of unnecessary details.
Many tools do this in a very rough way, and miss the adjacency and sometimes the topological correctness of polygons.
GRASS is the ideal tool for this: being a topological GIS, adjacency and correctness are preserved even at very high
simplification levels. In our case, we have a vector resulting from a raster, thus showing a «saw» pattern at borders.
Applying a simplification results in straight lines:

* GRASS » v.generalize [Maximal tolerance value: 30 m]
We can also do the reverse, and make a layer more complex, smoothing out sharp corners:
¢ GRASS » v.generalize [method: chaiken]

Try to apply this second command both to original vector and to the one from the first analysis, and see the difference.
Note that adjacency is not lost.

This second option can be applied e.g. to contour lines resulting from a coarse raster, to GPS tracks with sparse
vertices, etc.

17.32 Planning a solar farm

Module contributed by Paolo Cavallini - Faunalia

Nota: This chapter shows how to use several criteria to locate the areas suitable for installing a photovoltaic power
station

First of all, create an aspect map from DTM:
* GRASS » r.aspect [Data type: int; cell size:100]

In GRASS, aspect is calculated in degrees, counterclockwise starting from East. To extract only South facing slopes
(270 degrees +- 45), we can reclassify it:

e GRASS » r.reclass

with the following rules:

225 thru 315 = 1 south
* = NULL

You can use the text file reclass_south.txt provided. Note that with these simple text files we can create also
very complex reclassifications.

We want to build a large farm, so we select only large (> 100 ha) contiguous areas:
¢ GRASS » r.reclass.greater

Finally, we convert to a vector:
* GRASS » r.to.vect [Feature type: area; Smooth corners: yes]

Exercise for the reader: repeat the analysis, replacing GRASS commands with analogous from other programs.
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17.33 Utilize as scripts R no Processing

Module contributed by Matteo Ghetta - funded by Scuola Superiore Sant’Anna

Processing (with the Processing R Provider plugin) makes it possible to write and run R scripts inside QGIS.

Aviso: R has to be installed on your computer and the PATH has to be correctly set up. Moreover Processing
just calls the external R packages, it is not able to install them. So be sure to install external packages directly in
R. See the related chapter in the user manual.

Nota: If you have package problems, it may be related to missing mandatory packages required by Processing, like
sp, rgdal and raster.

17.33.1 Adicionar scripts

Adding a script is simple. The easiest way is to open the Processing toolbox and choose Create new R script... from
the R menu (labelled with an R icon) at the top of the Processing Toolbox. You can also create the script in for
instance a text editor and save it in your R scripts folder (processing/rscripts). When it has been saved
there, it will be available for editing by right-clicking on the script name in the processing toolbox and then choose
Edit Script...).

r_intro - QGIS x

Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help

DheBRLREX Oepre "RPP RS @c --5-0EHE%E = T
14 = o = R 20 PERHQ0O L
Layers BE ° ° Processing Toolbox Bx
o il & 7 &~ » # !

- sample_points

Create New R Script...

» (@ Network analysis =

» () Raster analysis

o © » @ Raster terrain anal...
el o © » () Raster tools

» () Vector analysis

» G} Vector creation

» () Vector general

» (@ Vector geometry

o » @ Vector overlay

» () Vector selection

» G} Vector table

EXNSD S

B
o

(=] p
° <] b o GDAL
5 ° ° » & GRASS
o ° » ®R -
Log Messages B Tile Scale B
General %
Q Type to locate (Ctrl+K) Coordinate | -5.696332,40.248148 % Scale 1:487 ~ | @ Magnifier| 100% | Rotation |0,0° | | Render & EPSCi4326 @

Nota: If you cannot see R in Processing, you have to activate it in Processing w Options » Providers

It opens a script editor window in which you have to specify some parameters before you can add the script body.
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SR P 28 ©6 QA A

17.33.2 Creating plots

In this tutorial we are going to create a boxplot of a vector layer field.

Open the r_intro.qggs QGIS project under the exercise_data/processing/r_intro/ folder.

Script parameters

Open the editor and start writing at the beginning of it.
You must specify some parameters before the script body:

1. The name of the group (plots in this case) in which you want to put your script (if the group does not exist, it
will be created):

[##plots:group }

You will find your script in the plots R group in the Processing toolbox.

2. You have to tell Processing that you want to display a plot (in this example):

[##showplots ]

You will then find a link to the plot in the Result Viewer panel (can be turned on / off in View » Panels and
with Processing » Results Viewer).

3. You also need to tell Processing about your input data. In this example we want to create a plot from a field of
a vector layer:

[##Layerivector }

Processing now knows that the input is a vector. The name Layer is not important, what matters is the vector
parameter.

4. Finally, you have to specify the input field of the vector layer (using the name you have provided above - Layer):

[##X:Field Layer J

Processing now knows that you need a field of Layer, and that you will call it X.

5. Itis also possible to define the name of your script using name:

[##My box plot script=name }

If not defined, the file name will be used as the name of the script.
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Script body

Now that you have set up the heading of the script you can add the function:

[boxplot(Layer[[X]]) J

boxplot is the name of the R function, the parameter Layer is the name that you have defined for the input dataset
and X is the name you have defined for the field of that dataset.

Aviso: The parameter X has to be within double square brackets ([ []]).

The final script looks like this:

##Vector processing=group
##showplots
##Layer=vector

##X=Field Layer

boxplot (Layer[[X]])

TBERE P g (E 6 Q A+ A

1 ##\Vector processing=group

----------

##X=Field Layer

s boxplot/{Layer[[X]11)]

Save the script in the default path suggested by Processing (processing/rscripts). If you have not defined a name in
the script heading, the file name you choose will become the name of the script in the Processing toolbox.

Nota: You can save the script wherever you like, but Processing will then not be able to include it in the processing
toolbox automatically, so you have to upload it manually.

Now just run it using the button on the top of the editor window:
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*Untitled Script - R Script Editor

s ':”’g o o Q A+ A-

1 ##Vector processing=group
2 ##showplots

3 #ilLayer=vector

4 ##¥X=Field Layer

5 boxplot(Layer[[X]1)]

1 »
Once the editor window has been closed, use the text box of Processing to find your script:
Project Edit View Layer Settings Plugins Vector Raster Database Web Progessing Help
CoERERY Qepp BPR EFEEMS & -N-5-588%I =-¢ [0

4 = 5 R 2O TN B0

Layers ® o o Processing Toolbox ®
B avnvra-3 el TN
@ . < boxp a

o . -
~ (2} Graphics

\j; ° ° ° @ # Box plot
A o © v @R

oo

© ° o © ¥ Vector processing
ﬁ 2 boxplot
o

o <]
<]
e ©
o
o <] o
° o
Log Messages BE Tile scale =l
General ¥
Q Type to locate (Ctrl+K) Coordinate|-5.696441,40.247994 | 9 Scale| 1:487 ~ | @ Magnifier| 100% | Rotation |0,0° < |V/Render < gpsGi4326 (@

You can now fill the parameters required in the Processing algorithm window:
« for Layer choose sample_points
« for the X field choose value

Click on Run.
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boxplot
Parameters | Log | Help |
Layer
Isampl.e_points [EPSG:4326] |v‘ a8
X
|vaL|..|e |v|
R Plots
I[Save to temporary file] H_]

m

(e )

The Result window should be automatically opened, if not, just click on Processing » Result Viewer....

Click on the link in the viewer and you will see:

658 Capitulo 17. Guia de Processamento QGIS




QGIS Training Manual

Results

)R Plots
| R Plots
] R Plots o

=+
=] R Plots s —
| R Plots

= —

(35

(=

[a¥]

[=]

o S R

Close

Nota: You can open, copy and save the image by right clicking on the plot.

17.33.3 Create a vector

You can also create a vector layer and have it automatically loaded into QGIS.

The following example has been taken from the Random sampling grid script that can be found in the online
collection of R scripts (the scripts in this online collection can be found in https://github.com/qgis/QGIS-Processing/
tree/master/rscripts).

The aim of this exercise is to create a random point vector layer using an input vector layer to restrict the extent using
the spsample function of the sp package.
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Script parameters

As before we have to set some parameters before the script body:

1. Specify the name of the group in which you want to put your script, in this case Point pattern analysis:

[##Point pattern analysis=group ]

2. Define an input parameter (a vector layer) that will constrain the placement of the random points:

[##Layerzvector }

3. Set an input parameter for the number of points that are going to be created (Size, with a default value of
10):

[##Sizeinumber 10 }

Nota: Since a default value (10) is defined, the user can change this number or can leave the parameter
without a number.

4. Specify that there is an output vector layer (called Output):

[##Output:output vector }

Script body

Now you can add the body of the function:

1. Use the spsample function:

[pts:spsample(Layer, Size, type="random") ]

The function uses the Layer to constrain the placement of the points (if it is a line layer, a points will have to
be on one of the lines in the layer, if it is a polygon layer, a point will have to be within a polygon). The number
of points is taken from the Size parameter. The sampling method is random.

2. Generate the output (the Output parameter):

[Output:SpatialPointsDataFrame(pts, as.data.frame (pts)) }

The final script looks like this:

##Point pattern analysis=group

##Layer=vector

##Size=number 10

##Output=output vector

pts=spsample (Layer, Size, type="random")
Output=SpatialPointsDataFrame (pts, as.data.frame (pts))
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*Untitled Scripk - R Script Editor
. P <EF B 6 & QA A

1 ##Point pattern analwelszgrmum

2 ##lLayer=vector

3 #Size=number 10

4 ##0utput=output vector

5 pts=spsample(Layer, Size, type="random")

6 Qutput=SpatialPointsDataFrame(pts, as.data.frame(pts))
]

Save it and run it, clicking on the run button.

In the new window type in the right parameters:

Random sampling grid

Parameters | Leg | Help

Layer

sample_points [EPSG:4326] vi.. ||
Size

10.000000 "
Qutput

[Save to temporary file]

~ Open output file after running algorithm

[l 0%

Close Run

and click on run.

The result layer will be added to the table of contents and its points will be displayed on the map canvas:
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17.33.4 Text and graph output from R - syntax

Processing (with the Processing R Provider plugin) uses special syntax to get the results out of R:

e > before your command, asin >1illie.test (Layer[[Field]]) means the result should be sent to
R output (Result viewer)

e + after a plot enables overlay plots. For example plot (Layer[[X]], Layer[[Y]]) +
abline (h=mean (Layer[[X]]))

17.34 Predicting landslides

Module contributed by Paolo Cavallini - Faunalia

Nota: This chapter shows how to create an oversimplified model to predict the probability of landslides.

First, we calculate slope (choose among various backends; the interested reader can calculate the difference between
the outputs):

¢ GRASS » r.slope
e SAGA » Slope, Aspect, Curvature
e GDAL Slope
Then we create a model of predicted rainfall, based on the interpolation of rainfall values at meteo stations:
e GRASS » v.surf.rst (resolution: 500 m)

The probability of a landslide will be very roughly related to both rainfall and slope (of course a real model will use
more layers, and appropriate parameters), let’s say (rainfall * slope ) /100:

¢ SAGA w» Raster calculator rain, slope: (a*b) /100 (or: GRASS » r.mapcalc)

* then let’s calculate what are the municipalities with the greatest predicted risk of rainfall: SAGA » Raster
statistics with polygons (the parameters of interest are Maximum and Mean)
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Module: Usando Bases de Dados Espaciais no |qg|

Neste mdédulo, ird aprender como usar bases de dados espaciais no QGIS para gerir, visualizar e manipular dados
na base de dados assim como fazer andlise através de pesquisas. Iremos usar principalmente PostgreSQL e PostGIS
(que foram falado em secg¢des anteriores), mas 0s mesmos conceitos aplicam-se a outras implementagdes de bases de
dados incluindo o Spatialite.

18.1 Lesson: Working with Databases in the QGIS Browser

In the previous 2 modules we looked at the basic concepts, features and functions of relational databases as well as
extensions that let us store, manage, query and manipulate spatial data in a relational database. This section will dive
deeper into how to effectively use spatial databases in QGIS.

The goal for this lesson: To learn how to interact with spatial databases using the QGIS Browser interface.

18.1.1 Follow Along: Adding Database Tables to QGIS using the Browser
We have already briefly looked at how to add tables from a database as QGIS layers, now lets look at this in a bit more
detail and look at the different ways this can be done in QGIS. Lets start by looking at the new Browser interface.

* Start a new empty map in QGIS.

* Open the Browser by clicking the Browser tab at the bottom of the Layer Panel

¢ Open the PostGIS portion of the tree and you should find your previously configured connection available (you
may need to click the Refresh button at the top of the browser window).
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0006 Qais

VAR & @, E B E o T, BN

4./ 85 R 6>

** points
=) > polygons
> / Spatialite
@[> Qom
@ wes
9. |> ©ws
S| @®wus

Tavers MEEEA
Table retrieval finished. %] Coordinate: 1619291,6940265 Scale [1:15360 |+ (%] ¥ Render EPSG:32733 (@] (4] y

* Double clicking on any of the table/layers listed here will add it to the Map Canvas.

 Right Clicking on a table/layer in this view will give you a few options. Click on the Properties item to look at
the properties of the layer.

000 Layer Properties

Display Name lines
Layer Source pg:/postgis_demo/public/lines

Provider postgres

Metadata

General

Storage type of this layer

PostgreSQL database with PostGIS extension
Description of this provider
PostgreSQL/PostGIS provider

PostgreSQL 9.3.1 on xB6_64-apple-darwin12.5.0, compiled by i686-apple-darwin11-llvm-gce-4.2 (GCC) 4.2.1 (Based on Apple
Inc. build 5658) (LLVM build 2336.11.00), 64-bit
PostGIS 2.1 USE_GEOS=1 USE_PROJ=1 USE_STATS=1

Saurce for this layer

dbname='postgis_demo' host=localhost port=5432 ssimode=disable key="id_0' srid=32733 type=MULTILINESTRING
table="public"."lines" (geom) sql=

Geometry type of the features in this layer

Line
Primary key attributes
id_0
NOTICE: Layer srs set from project (EPSG:32733) E

/'
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Nota: Of course you can also use this interface to connect to PostGIS databases hosted on a server external to your
workstation. Right clicking on the PostGIS entry in the tree will allow you to specify connection parameters for a

new connection.

18.1.2 Follow Along: Adding a filtered set of records as a Layer

Now that we have seen how to add an entire table as a QGIS layer it might be nice to learn how to add a filtered set

of records from a table as a layer by using queries that we learned about in previous sections.

« Start a new empty map with no layers

¢ Click the Add PostGIS Layers button or select Layer » Add PostGIS Layers from the menu.
* In the Add PostGIS Table(s) dialog that comes up, connect to the postgis_demo connection.

* Expand the public schema and you should find the three tables we were working with previously.

* Click the 1ines layer to select it, but instead of adding it, click the Ser Filter button to bring up the Query

Builder dialog.
» Construct the following expression using the buttons or by entering it directly:
[" roadtype" = 'major'
8 n0e Query Builder
lines
Fields Values

id minor

NULL

id_0 | major |

| Sample || All

Use unfiltered layer

w Operators

T = ][ < J[ > J[ uke |[ % |[ N |[ NOTIN |
<= |[ »>= |[ 1= |[ wke |[ AND |[ OR |[ NOT |

Provider specific filter expression

"roadtype” = 'major’

| Help | | Test | | Clear | | Cancel | [ OK |

18.1. Lesson: Working with Databases in the QGIS Browser
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* Click OK to complete editing the filter and click Add to add the filtered layer to your map.
e Rename the 1ines layer in the tree to roads_primary.

You will notice that only the Primary Roads have been added to your map rather than the entire layer.

18.1.3 In Conclusion

You have seen how to interact with spatial databases using the QGIS Browser and how to add layers to your map
based on a query filter.

18.1.4 What’s Next?

Next you'll see how to work with the DB Manager interface in QGIS for a more complete set of database management
tasks.

18.2 Lesson: Using DB Manager to work with Spatial Databases in
QGIS

We have already seen how to perform many database operations with QGIS as well as with other tools, but now it’s
time to look at the DB Manager tool which provides much of this same functionality as well as more management
oriented tools.

The goal for this lesson: To learn how to interact with spatial databases using the QGIS DB Manager.

18.2.1 Follow Along: Managing PostGIS Databases with DB Manager

You should first open the DB Manager interface by selecting Database —> DB Manager —> DB Manager on the menu
or by selecting the DB Manager icon on the toolbar.

=3

You should already see the previous connections we have configured and be able to expand the myPG section and its
public schema to see the tables we have worked with in previous sections.

The first thing you may notice is that you can now see some metadata about the Schemas contained in your database.
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06.6.6 DB Manager
& = &
Tree | .E: Table | Preview |
T
¥ % PostGIS -
¥ postgis_demo publlc
Schema details
Owner: george
Comment: standard public schema
Privileges

User has privileges:

* create new objects
* access objects

Schemas are a way of grouping data tables and other objects in a PostgreSQL database and a container for permissions
and other constraints. Managing PostgreSQL schemas is beyond the scope of this manual, but you can find more
information about them in the PostgreSQL documentation on Schemas. You can use the DB Manager to create new
Schemas, but will need to use a tool like pgAdmin III or the command line interface to manage them effectively.

DB Manager can also be used to manage the tables within your database. We have already looked at various ways to
create and manage tables on the command line, but now lets look at how to do this in DB Manager.

First, its useful to just look at a table’s metadata by clicking on its name in tree and looking in the Info tab.
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06.6.6 £ DB Manager
g L = &
Tree 'Eﬂ Table  Preview |
v % PostGIS I.
¥ postgis_demo II'Ies
v @ public

geography_columns

geometry_columns General info

I . = Relation type: Table
+% points Owner: george
& polygons Pages: 1
ges:

rasterfmlun"rns Rows (estimation): 7

rastelr_overwews Rows (counted): 7

E spatial_ref_sys Privileges: select, insert, update, delete
PostGIS
Column: geom
Geometry: MULTILINESTRING
Dimension: 2
Spatial ref: WGS 84 /| UTM zone 335 (32733)
Estimated extent: 1620551.12500, 6936774.00000 - 1624197.25000, 6940707.00000
Extent: (unknown) (find out

A No spatial index defined {create it)

Fields
# Name Type Length Null Default
1 id O int4 4 N nextval(lines_id_0_seq":regclass)
2 geom geometry Y

(MultiLineString,32733)

/f

In this panel you can see the General Info about the table as well the information that the PostGIS extension maintains
about the geometry and spatial reference system.

If you scroll down in the Info tab, you can see more information about the Fields, Constraints and Indexes for the table
you are viewing.
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EB DB Manager

g N e ®

Tree ' Table  Preview
v % PostGIS Rows (counted): 7
¥ postgis_demo Privileges: select, insert, update, delete
v & public

geography_columns
geometry_columns PostGIS

' lines

i+ points Column: geom

] polygens Ceometry: MULTILINESTRING

raster_columns Dimension: 2

raster_overviews Spatial ref: WGS 84 / UTM zone 335 (32733)

spatia._[ ref_sys Estimated extent: 1620551.12500, 6936774.00000 - 1624197.25000, 6940707.00000
- Extent: (unknown) (find out

& No spatial index defined (create it)

Fields
# Name Type Length Null Default
1 id 0 int4 4 N nextval(lines_id_0_seq'::regclass)
2 geom geomet Y
(MultiLineString,32733)
3 id int4 4 Y
4 roadtype wvarchar (5) Y
Constraints
Name Type Column(s)

lines_pkey Primary key id_0

Its also very useful to use DB Manager to simply look at the records in the database in much the same way you might
do this by viewing the attribute table of a layer in the Layer Tree. You can browse the data by selecting the Table tab.

066 3 DB Manager
2 N & &
Tree ! | Info Preview |
v % PostGIS id_0 geom id roadtype
¥ postgis_demo
v @public 11 MULTILINES... |1 NULL
geography_columns /5 3 MULTILINES... |2 minor
geometry_columns
S TES— MULTILNES... |3 wu
% points
& polygons 4 4 MULTILINES... | 4 major
raster_columns 55 MULTILINES... | 5 minor
raster_overviews
spatial_ref_sys 6 6 MULTILINES... |6 major
77 MULTILINES... | 8 minor

j'
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There is also a Preview tab which will show you the layer data in a map preview.
Right-clicking on a layer in the tree and clicking Add to Canvas will add this layer to your map.

So far we have only been viewing the database its schemas and tables and their metadata, but what if we wanted to
alter the table to add an additional column perhaps? DB Manager allows you to do this directly.

1. Select the table you want to edit in the tree

2. Select Table » Edit Table from the menu, to open the Table Properties dialog.

006 EA Table properties

Constraints Indexes J'

Table columns:

Name Type Null | Default

id_0 int4 False nextval(lines_id_0_seq':regclass)
geom geometry (MultiLineString,32733) True

id int4 True

roadtype varchar (5) True

b—“ﬂ-hnl-d [ Add geometry column ] [ Edit column | [ Delete column ]

| Close |

You can use this dialog to Add Columns, Add geometry columns, edit existing columns or to remove a column
completely.

Using the Constraints tab, you can manage which fields are used as the primary key or to drop existing constraints.
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Columns mﬂﬂ Indexes

Primary, foreign keys, unique and check constraints:

Name | Type | Column(s)
lines_pkey Primary key id_0

[ Add primary key [ unique J [ Delete constraint ]

The Indexes tab can be used to add and delete both spatial and normal indexes.

18.2. Lesson: Using DB Manager to work with Spatial Databases in QGIS 673



QGIS Training Manual

8.0.8 EA Table properties

[ Columns Constraints m

Indexes defined for this table:

| Addindex | | Add spatial index | | Delete index |

[ Close |

18.2.2 Follow Along: Creating a New Table
Now that we have gone through the process of working with existing tables in our database, let’s use DB Manager to
create a new table.

1. If it is not already open, open the DB Manager window, and expand the tree until you see the list of tables
already in your database.

From the menu select Table —> Create Table to bring up the Create Table dialog.
Use the default Pub1ic schema and name the table places.
Add the id, place_name, and elevation fields as shown below

Make sure the id field is set as the primary key.

A

Click the checkbox to Create geometry column and make sure it is set to a POINT type and leave it named
geom and specify 4326 as the SRID.

7. Click the checkbox to Create spatial index and click Create to create the table.
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000 Create Table
Schema | public 4|
Name Iplaces |
Name Type Nul
1 id serial ] Delete field
2 place_name text ]
3 elevation integer ]
Up
Down
Primary key | id o
[2] Create geometry column | POINT D |
Name |geom |
Dimensions |2 I|§|
SRID 4326 |
[E‘] Create spatial index
| Create | | Close |

8. Dismiss the dialog letting you know that the table was created and click Close to close the Create Table Dialog.

You can now inspect your table in the DB Manager and you will of course find that there is no data in it. From here
you can Toggle Editing on the layer menu and begin to add places to your table.

18.2.3 Follow Along: Basic Database Administration

The DB Manager will also let you do some basic database administration tasks. It is certainly not a substitute for a
more complete database administration tool, but it does provide some functionality that you can use to maintain your
database.

Database tables can often become quite large and tables which are being modified frequently can end up leaving
around remnants of records that are no longer needed by PostgreSQL. The VACUUM command takes care of doing
a kind of garbage collection to compact and optional analyze your tables for better performance.

Let us take a look at how we can perform a VACUUM ANALYZE command from within DB Manager.
1. Select one of your tables in the DB Manager Tree
2. Select Table » Run Vacuum Analyze from the menu

PostgreSQL will now perform the operation. Depending on how big your table is, this may take some time to
complete.

You can find more information about the VACUUM ANALYZE process in the PostgreSQL Documentation on
VACUUM ANALYZE.
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18.2.4 Follow Along: Executing SQL Queries with DB Manager

DB Manager also provides a way for you to write queries against your database tables and to view the results. We

have
1.
2.

3.

already seen this type of functionality in the Browser panel, but lets look at it again here with DB Manager.
Select the 1ines table in the tree.

Select the SOL window button in the DB Manager toolbar.

Compose the following SOL query in the space provided:

[select * from lines where roadtype = 'major';

4. Click the Execute (F5) button to run the query.

5. You should now see the records that match in the Result panel.

O o0 3 O

0006 SQL window - postgis_demo [PostGlS]

SQL query: | || +| | Store | | Delete |

select * from lines where roadtype = "'major';

@ 2 rows, 0.0 seconds | Clear |

Result:

id_0 geom id roadtype
14 0105000020DD7F00000... | 4 major
2 6 0105000020DD7F00000... | 6 major

[] Load as new layer

| Close |

. Click the checkbox for Load as new layer to add the results to your map.
. Select the 1d column as the Column with unique integer values and the geom column as the Geometry column.
. Enter roads_primary as the Layer name (prefix).

. Click Load now! to load the results as a new layer into your map.
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006 SOL window - postgis_demo [PostGIS]
SQL query: | N 4| | Store | | Delete |
select * from lines where roadtype = "major';
2 rows, 0.0 seconds | Clear |
Result:
id_Q geom id roadtype
14 ‘ 0105000020DD7F0O0000... | 4 ‘ major ‘
2 6 | 0105000020DD7E00000... | 6 | major |
™ Load as new layer
Column with unique .~ 1~ laeom v Retrieve
h id - | Geometry column |geom v |
integer values columns
Layer name (prefix) Iroads_primaw{ | | Load now! |
["] Avoid selecting by feature id
| Close |

The layers that matched your query are now displayed on your map. You can of course use this query tool to execute
any arbitrary SQL command including many of the ones we looked at in previous modules and sections.

18.2.5 Importing Data into a Database with DB Manager

We have already looked at how to import data into a spatial database using command line tools, so now let’s learn

how to use DB Manager to do imports.

1. Click the Import layer/file button on the toolbar in the DB Manager dialog.

(

Click the Update Options button to pre-fill some of the form values.
Make sure that the Create new table option is selected
Specify the Source SRID as 32722 and the Target SRID as 4326

Enable the checkbox to Create Spatial Index

A T o

Click OK to perform the import

Select the urban_33S. shp file from exercise_data/projected_data as the input dataset

18.2. Lesson: Using DB Manager to work with Spatial Databases in QGIS
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8.0.6 s import vector layer

Input |1I,|r exercise_data/projected_data/urban_335.shp |:|

[ Update options ]

Output table

Schema [ public

Table |urban_3 38

Action

(=) Create new table

|_| Drop existing one
() Append data to table
Options

|| Primary key

|| Geometry column

M Source SRID 32722 (M Target SRID (4326

|| Encoding UTF-8

|| Create single-part geometries instead of multi-part
™ Create spatial index

[ Cancel ] E—O\V—]

8. Dismiss the dialog letting you know that the import was successful
9. Click the Refresh button on the DB Manager Toolbar

You can now inspect the table in your database by clicking on it in the Tree. Verify that the data has been reprojected
by checking that the Spatial ref: is listed as WGS 84 (4326).
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000 DB Manager
& & &
i .m: Table = Preview |
v
¥ % PostGIS
¥ postgis_demo urban_sss
v @ public
|5] geography_columns .
[E] geometry_columns General info
E’i‘ e Relation type: Table
:: pla_ces Owner: george
i points Pages: 2
& polygons Rows (estimation): 6
=] raster_colun"lns Rows (counted): 6
] las(ell_overv\ews Privileges: select, insert, update, delete
[ spatial_ref_sys
PostGIS
Column: geom
Geometry: MULTIPOLYCON
Dimension: 2
Spatial ref: WGS B4 (4326)
Extent: {unknown) (find out
Fields
# Name Type Length Null Default
1 id int4 4 N nextval("urban_33S_id_seq""::regclass
)
2 geom geometry Y
(MultiPolygon,43
26)
3 ag_cad_id numeric Y
Z

Right clicking on the table in the Tree and a selecting Add to Canvas will add the table as a layer in your map.

18.2.6 Exporting Data from a Database with DB Manager

Of course DB Manager can also be used to export data from your spatial databases, so lets take a look at how that is

done.

1. Select the 1ines layer in the Tree and click the Export to File button on the toolbar to open the Export to

vector file dialog.

2. Click the ..
urban_4326.

3. Set the Target SRID as 4326.
4. Click OK to initialize the export.

. button to select the Output file and save the data to your exercise_data directory as

18.2. Lesson: Using DB Manager to work with Spatial Databases in QGIS
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Output file |,|’ docs/training_manual/exercise_data/urban_4326.shp

Action

(») Create new file

|| Drop existing one

() Append data to file

Options

[ | Source SRID 32733

(M Target SRID

(| Encoding | System

Cancel ] M

5. Dismiss the dialog letting you know the export was successful and close the DB Manager.

You can now inspect the shapefile you created with the Browser panel.

-

S e TR e W e

[xJo] Browser
& |Qadd ||P| @
¥ @ source
¥ o docs

» [ documentation_guidelines
» [0 gentle_gis_introduction
» 1 pyqgis_developer_cookbook
¥ (0 training_manual

(3 answers

(1 appendix

() assessment

(0 basic_map

() complete_analysis

(0 create_vector_data
(1 database_concepts
(3 databases

@ exercise_data

[0 epsg4326

2 forms

3 plugins

1 postgis

(0 projected_data

(0 raster

(2 residential_development
(2 school_property_photos
[ styles

(3 symbols

2 world

(2 land_use.db

|~ urban_4326.shp
(2 foreword

(0 grass

(3 i18n

(2 introduction

(3 linfiniti-sphinx-theme
(1 map_composer

(2 online_resources

(3 planning_docs

(2 python

(3 qgis_plugins

[ rasters

(2 resources

(0 spatial_databases

(0 vector_analysis

(0 vector_classification

AYYvYYVYVYYY

YYYYYYYVYYVYY

YYYYYVYVYVYVYVYVYYVYVYY

B index.rst

.86.0.6 Layer rties.

Display Name  urban_4326.shp
Layer Source  is/QGIS-Documentation/source/docs/training_manual/exercise_data/urban_4326.shp

Provider ogr

Metadata

General

Storage type of this layer
ESRI Shapefile
Description of this provider

'OGR data provider (compiled against GDAL/OGR library version 1.10.1, running against GDAL/OGR library
version 1.10.1)

‘Source for this layer

Nolumes/Drobolsites/agis/QGIS-
Documentation’: i i | 4326.shp

Geometry type of the features in this layer
Line

The number of features in this layer

7

Editing capabilities of this layer
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18.2.7 In Conclusion

You have now seen how to use the DB Manager interface in QGIS to manage your spatial databases, to execute SQL
queries against your data and how to import and export data.

18.2.8 What’s Next?

Next, we will look at how to use many of these same techniques with SpatiaLite databases.

18.3 Lesson: Working with SpatialLite databases in QGIS

While PostGIS is generally used on a server to provide spatial database capabilities to multiple users at the same
time, QGIS also supports the use of a file format called SpatiaLite that is a lightweight, portable way to store an entire
spatial database in a single file. Obviously, these 2 types of spatial databases should be used for different purposes,
but the same basic principles and techniques apply to both. Let’s create a new SpatiaLite database and explore the
functionality provided to work with these databases in QGIS.

The goal for this lesson: To learn how to interact with SpatiaLite databases using the QGIS Browser interface.

18.3.1 Follow Along: Creating a SpatialLite database with the Browser

Using the Browser panel, we can create a new SpatiaLite database and get it setup for use in QGIS.
1. Right click on the SpatiaLite entry in the Browser tree and select Create Database.
2. Specify where on your filesystem you want to store the file and name it ggis-sl.db.

3. Again right click on the SpatiaLite entry in the Browser tree and now select the New Connection item. Find the
file you created in the last step and open it.

Now that you have configured your new database you will find that the entry in Browser tree has nothing underneath
it and the only thing you can do at this point is to delete the connection. This is of course because we haven’t added
any tables to this database. Let’s go ahead and do that.

1. Find the button to create a new layer and use the dropdown to create a new SpatiaL.ite layer, or select Layer »
New » f New SpatiaLite Layer.

Select the database we created in the previous steps in the drop down.

Give the layer the name places.

Tick the checkbox next to Create an auto-incrementing primary key.

Add two attributes as shown in below

Click OK to create the table.

A
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Database [ [Volumes {Drobo/sites/qqgis/QGI5S-Docume :J

Layer name |place5

Geometry column | geometry
Type

(=) Point () Line () Polygon
() MultiPoint () Multiline () Multipolygon

EPSG:4326 - WGS 84 | Specify CRS |

E Create an autoincrementing primary key
New attribute

Name | |

Type [ Whole number = ]

- Add to attributes list

Attributes list

Name | Type
place_name real
elevation integer

- Remove attribute

[ Cancel ] i—ﬂ—q

7. Click the refresh button at the top of the Browser and you should now see your places table listed.
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< ||BAdd ||T||[F

Browser

= Home
Favourites
=
. [Volumes
P MssQL
@ PostGIS
#° SpatialLite
v [ ggis-sl.sglite
o places
P ) OWS
& WCS
= & WFS
& WMS

b

4 7

You can right click on the table and view its properties as we did in the previous exercise.

From here you can start an editing session and start adding data to your new database directly.

We also learned about how to import data into a database using the DB Manager and you can use this same technique

to import data into your new SpatiaLite DB.

18.3.2 In Conclusion

You have seen how to create SpatiaLite databases, add tables to them and use these tables as layers in QGIS.

18.3. Lesson: Working with SpatiaLite databases in QGIS
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Appendix: Contributing To This Manual

To add materials to this course, you must follow the guidelines in this Appendix. You are not to alter the conditions
in this Appendix except for clarification. This is to ensure that the quality and consistency of this manual can be
maintained.

19.1 Downloading Resources

The source of this document is available at GitHub. Consult GitHub.com for instructions on how to use the git version
control system.

19.2 Manual Format

This manual is written using Sphinx, a Python document generator using the reStructuredText markup language.
Instructions on how to use these tools are available on their respective sites.

19.3 Adding a Module

e To add a new module, first create a new directory (directly under the top-level of the
ggis—-training-manual directory) with the name of the new module.

* Under this new directory, create a file called index . rst. Leave this file blank for now.

* Open the index. rst file under the top-level directory. Its first lines are:

. toctree::
:maxdepth: 2

foreword/index
introduction/index

You will note that this is a list of directory names, followed by the name index. This directs the top-level index
file to the index files in each directory. The order in which they are listed determines the order they will have in the
document.
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¢ Add the name of your new module (i.e., the name you gave the new directory), followed by /index, to this
list, wherever you want your module to appear.

* Remember to keep the order of the modules logical, such that later modules build on the knowledge presented
in earlier modules.

¢ Open your new module’s own index file ([module name]/index.rst).
* Along the top of the page, write a line of 80 asterisks (*). This represents a module heading.

* Follow this with a line containing the markup phrase |MOD | (which stands for «module»), followed by the
name of your module.

* End this off with another line of 80 asterisks.
» Leave a line open beneath this.
* Write a short paragraph explaining the purpose and content of the module.

 Leave one line open, then add the following text:

toctree::
:maxdepth: 2

lessonl
lesson?2

... where lessonl, lesson2, etc., are the names of your planned lessons.

The module-level index file will look like this:

L R I i b I b I b b i I IR I I b b I b b b I b b b b I I b I I I b I I b b I e b b b b b I R b i I e b b I I b b b

|[MOD| Module Name

AR R AR A A A AR A A A A A A A A A A A A AR A AR A AR AR A A A A A AR A AR AR A AR A AR A AR A AR A AR A A A A AR A AR AR A AR A ARk kA kK

Short paragraph describing the module.
toctree::

:maxdepth: 2

lessonl
lesson2

19.4 Adding a Lesson

To add a lesson to a new or existing module:
¢ Open the module directory.
* Open the index. rst file (created above in the case of new modules).
* Ensure that the name of the planned lesson is listed underneath the t oct ree directive, as shown above.
* Create a new file under the module directory.

¢ Name this file exactly the same as the name you provided in the module’s index.rst file, and add the
extension . rst.

Nota: For editing purposes, a . rst file works exactly like a normal text file (. txt).

 To begin writing the lesson, write the markup phrase | LS |, followed by the lesson name.
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¢ In the next line, write a line of 80 equal signs (=).

» Leave a line open after this.

* Write a short description of the lesson’s intended purpose.

¢ Include a general introduction to the subject matter. See the existing lessons in this manual for examples.

* Beneath this, start a new paragraph, beginning with this phrase:

[**The goal for this lesson:**

* Briefly explain the intended outcome of completing this lesson.

* If you can’t describe the goal of the lesson in one or two sentences, consider breaking the subject matter up
into multiple lessons.

Each lesson will be subdivided into multiple sections, which will be addressed next.

19.5 Adding a Section

There are two types of sections: «follow along» and «try yourself>».

* A «follow along» section is a detailed set of directions intended to teach the reader how to use a given aspect
of QGIS. This is typically done by giving click-by-click directions as clearly as possible, interspersed with
screenshots.

* A «try yourself» section gives the reader a short assignment to try by themselves. It is usually associated with
an entry in the answer sheet at the end of the documentation, which will show or explain how to complete the
assignment, and will show the expected outcome if possible.

Every section comes with a difficulty level. An easy section is denoted by | basic|, moderate by |moderate|,
and advanced by |hard|.

19.5.1 Adding a «follow along» section

* To start this section, write the markup phrase of the intended difficulty level (as shown above).
¢ Leave a space and then write | FA | (for «follow along»).

» Leave another space and write the name of the section (use only an initial capital letter, as well as capitals for
proper nouns).

¢ In the next line, write a line of 80 minuses/dashes (—). Ensure that your text editor does not replace the default
minus/dash character with a long dash or other character.

¢ Write a short introduction to the section, explaining its purpose. Then give detailed (click-by-click) instructions
on the procedure to be demonstrated.

¢ In each section, include internal links, external links and screenshots as needed.

¢ Try to end each section with a short paragraph that concludes it and leads naturally to the next section, if
possible.
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19.5.2 Adding a «try yourself» section

To start this section, write the markup phrase of the intended difficulty level (as shown above).
Leave a space and then write | TY | (for «try yourself»).

In the next line, write a line of 80 minuses/dashes (-). Ensure that your text editor does not replace the default
minus/dash character with a long dash or other character.

Explain the exercise that you want the reader to complete. Refer to previous sections, lessons or modules if
necessary.

Include screenshots to clarify the requirements if a plain textual description is not clear.

In most cases, you will want to provide an answer regarding how to complete the assignment given in this section. To
do so, you will need to add an entry in the answer sheet.

* First, decide on a unique name for the answer. Ideally, this name will include the name of the lesson and an

incrementing number.

¢ Create a link for this answer:

[

:ref: Check your results <answer-name>

¢ Open the answer sheet (answers/answers.rst).

* Create a link to the «try yourself» section by writing this line:

[ .. _answer—name:

* Write the instructions on how to complete the assignment, using links and images where needed.

¢ To end it off, include a link back to the «try yourself» section by writing this line:

[

:ref: Back to text <backlink—-answer—-name>"

¢ To make this link work, add the following line above the heading to the «try yourself» section:

8

_backlink-answer—-name:

)

Remember that each of these lines shown above must have a blank line above and below it, otherwise it could cause
errors while creating the document.

19.6 Add a Conclusion

* To end a lesson, write the phrase | IC| for «in conclusion», followed by a new line of 80 minuses/dashes (-).

Write a conclusion for the lesson, explaining which concepts have been covered in the lesson.

19.7 Add a Further Reading Section

* This section is optional.

¢ Write the phrase FR for «further reading», followed by a new line of 80 minuses/dashes (-).

¢ Include links to appropriate external websites.
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19.8 Add a What’s Next Section

* Write the phrase | WN | for «what’s next», followed by a new line of 80 minuses/dashes (-).
» Explain how this lesson has prepared students for the next lesson or module.

* Remember to change the «what’s next» section of the previous lesson if necessary, so that it refers to your new
lesson. This will be necessary if you have inserted a new lesson among existing lessons, or after an existing
lesson.

19.9 Using Markup

To adhere to the standards of this document, you will need to add standard markup to your text.

19.9.1 New concepts

* If you are explaining a new concept, you will need to write the new concept’s name in italics by enclosing it in
asterisks (*).

[This sample text shows how to introduce a *new concept*.

19.9.2 Emphasis

* To emphasize a crucial term which is not a new concept, write the term in bold by enclosing it in double
asterisks (* *).

¢ Use this sparingly! If used too much, it can seem to the reader that you are shouting or being condescending.

This sample text shows how to use **emphasis** in a sentence. Include the
punctuation mark if it is followed by a **comma, ** or at the **end of the
sentence.**

19.9.3 Images

¢ When adding an image, save it to the folder _static/lesson_name/.

¢ Include it in the document like this:

figure:: img/image_file.extension
ralign: center

* Remember to leave a line open above and below the image markup.

19.9.4 Internal links

* To create an anchor for a link, write the following line above the place where you want the link to point to:

[.. _link-name: }

¢ To create a link, add this line:

[:ref:‘Descriptive link text <link-name>" }

* Remember to leave a line open above and below this line.
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19.9.5 External links

¢ To create an external link, write it out like this:

[‘Descriptive link text <link-url>"_

* Remember to leave a line open above and below this line.

19.9.6 Using monospaced text

¢ When you are writing text that the user needs to enter, a path name, or the name of a database element such
as a table or column name, you must write it in monospaced text. For example:

[Enter the following path in the text box: :kbd: path/to/file’.

19.9.7 Labeling GUI items

e If you are referring to a GUI item, such as a button, you must write its name in the GUI label format. For
example:

[To access this tool, click on the :guilabel: Tool Name  button.

* This also applies if you are mentioning the name of a tool without requiring the user to click a button.

19.9.8 Menu selections

* If you are guiding a user through menus, you must use the menu » selection » format. For example:

To use the :guilabel: Tool Name  tool, go to :menuselection: Plugins —->
Tool Type —-> Tool Name' .

19.9.9 Adding notes

* You might need to a note in the text, which explains extra details that can’t easily be made part of the flow of
the lesson. This is the markup:

[Normal paragraph.]

note:: Note text.
New line within note.

New paragraph within note.

[Unindented text resumes normal paragraph.]

L
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19.9.10 Adding a sponsorship/authorship note

If you are writing a new module, lesson or section on behalf of a sponsor, you must include a short sponsor message
of their choice. This must notify the reader of the name of the sponsor and must appear below the heading of the
module, lesson or section that they sponsored. However, it may not be an advertisement for their company.

If you have volunteered to write a module, lesson or section in your own capacity, and not on behalf of a sponsor,
you may include an authorship note below the heading of the module, lesson or section that you authored. This must
take the form This [module/lesson/section] contributed by [author name]. Do not add
further text, contact details, etc. Such details are to be added in the «Contributors» section of the Foreword, along
with the name(s) of the part(s) you added. If you only made enhancements, corrections and/or additions, list yourself
as an editor.

19.10 Thank You!

Thank you for contributing to this project! By so doing, you are making QGIS more accessible to users and adding
value to the QGIS project as a whole.
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A preparar os dados do exercicio

Nota: Este processo destina-se a coordenadores de curso, ou a utilizadores de QGIS avancados que desejem criar
conjuntos de dados de amostra localizados para o seu curso. Os conjuntos de dados prédefinidos sao fornecidos com
0 Manual de Formac@o, mas pode seguir estas instrugcoes se desejar substituir os conjuntos de dados prédefinidos.

Os dados de amostra fornecidos <data_downloadlink> :ref: com o Manual de Formagio referem-se a cidade
Swellendam e suas imediacdes. A Swellendam localiza-se a 2 horas a oriente da Cidade do Cabo no Cabo Ocidental
da Africa do Sul. O conjunto de dados nomes de elementos em Inglés e Afrikaans.

Todos podem utilizar este conjunto de dados sem dificuldade, mas podera desejar utilizar dados do seu pais ou cidade.
Se o fizer, os seus dados localizados serdo utilizados em todas as aulas do Mdédulo 3 ao Mddulo 7.2. Os mdédulos
posteriores utilizam fontes de dados mais complexas que poderdo ou nio estar disponiveis na sua regiao.

Nota: Estas instrucdes pressupdem que tem bons conhecimentos de QGIS e ndo se destinam a serem utilizados
como material de ensino.

20.1 Try Yourself Create OSM based vector files

Se desejar substituir os conjuntos de dados prédefinidos por localizados no seu curso, isto pode ser facilmente efetuado
com ferramentas existentes no QGIS. A regido que escolher utilizador devera ter uma boa mistura de areas urbanas
e rurais, contendo estradas diferenciadas, fronteiras de 4rea (tais como reservas naturais ou quintas) e dguas de
superficie, tais como ribeiros e rios.

1. Abrir um novo projeto QGIS
2. Selecione Layer » Data Source Manager para abrir a caixa de didlogo Data Source Manager

3. No separador Browser, expanda o menu pendente XYZ Tiles e clique duas vezes no item OpenStreetMap.
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Data Source Manager | Browser 0

[ Browser “ Browser
T LevTe
LA Favorites
» [& Home
& Raster =y
% pesh @ GeoPackage
= # SpatiaLite
Delimited W@ PostGis
#* Text » MSSQL
Nrf GeoPackage @ ps2
¥ @ WMS/WMTS
#4 spatiaLite ~ @ XYZTiles
4 PostgresQL & Wes
WFS
& MssQL ows
ArcGisMapServer
'm», bB2 & ArcGisFeatureServer

si¢ GeoNode

m Virtual Layer
KQ WMS/WMTS

E wes

& WFS
&5 ArcGIs Map
:A Server

ArcGIs
% Feature Server|

Um mapa mundo estd agora visivel na janela do mapa.
4. Feche a caixa de didlogo Data Source Manager

5. Mova a drea que deseja utilizar como drea de estudo

foreword - QGIS

Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help

DEERREY Q2S8R PPASRBNE &6

RE VAW # /BRI AT 00 "4ERNETBDE R A
Layers [E]E]
o ] ® T &, - & & 0
~ v/ ' |OpenStreetMa [ L ve
g
e Sweellendam &

g B
Buliogriir e N \t

.‘\H‘/f S \\w\

r ~ ]
N\ J ( ) o | |
et 7 e —f
A —.
A
1 Bontebak
National
Pork
Layers | Browser
S Extents: | 2263757.1,-4040043.6 : 2291750.0,-40269203 |{2)| Scale | 1:100000 |~ | & Magnifier| 100% =| Rotation |0.0° < [vIRender @ EpsG38sT @

Agora temos a drea da qual iremos extrair os dados, vamos ativar as ferramentas de extrac@o.
1. VA a Plugins » Manage/Install Plugins. ..

2. No separador :All, digite QuickOSM na caixa de pesquisa

3. Selecione o médulo QuickOSM, prima Install Plugin e, de seguida, a caixa de didlogo Close.
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Plugins | All (259)

L quic a
Y # EasyCustomLabeling -
E7 installed = QuickOSM
Not installed # Indicatrix mapper @?
X L Download OSM data thanks to the Overpass API. You can also open local
Install from # Quick Attribution OSM or PBF files. A special parser, on top of OGR, is used to let you see all OSM
“ zip # QuickMapServices keys available.
i uickMultiAttributeEdit3
* SR #Q - Execute customs Overpass queries in QGIS to get OSM data.
3 QuickOSM
# QuickPrink s 144 rating vote(s), 234125 downloads
& QuickWKT
# Species Explorer Tags openstreetmap.pbf.modeler,processing.remote,osmdownload,overpass.download,josm,osm
More info homepage bug tracker code repository
Author Etienne Trimaille
Available version 1.11.0
Install plugin
@Help % Close

Execute o novo médulo a partir do menu Vector » QuickOSM » QuickOSM...
No separador Quick query, selecione building no menu pendente Key
Deixe o campo Value vazio, para pesquisar todos os edificios.

Selecione Canvas Extent no menu pendente seguinte

® NS s

Expanda o grupo Advanced abaixo e anule a sele¢do de todos os tipos de geometria a direita exceto
Multipolygons.

9. Prima Run query

QuickOsSM
ﬁ Sleslan Help with key/value

' Query Key building .
' OSM File Value Query on all values -
&, Canvas Extent ~
Parameters
w Advanced

* About Node v Points

Way v Lines

Relation ¥ Multilinestrings

Multipolygons v
Timeout |25 -

Directory |Save to temporary file
File prefix

Show query Run query

Successful query

100%

Uma camada building nova € adicionada ao painel, mostrando os edificios na extensao selecionada.

10. Proceda como acima indicado para extrair outros dados:

1. Tipo de geometria Key landuse e Multipolygons.

2. Tipo de geometria Key boundary,Value = protected_areaeMultipolygons.

3. Tipo de geometria Key natural,Value = watereMultipolygons.
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4. Key = highway e selecione os tipos de geometria Lines e Multilines.
5. Key = waterway,Value = river e selecione os tipos de geometria Lines Multilines.
6. Key = place e tipo de geometria Points.

Este processo adiciona camadas como ficheiros temporarios (indicados pelo icone I::I ao lado do seu nome).

foreword - QGIS
Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help

DEoARREN V2P ALALRDNR EH¥Zm-o M-

BV AR P /B SR ZTxEEB6d “"AEAAAETRFTD KA X
Layers o
¢ @@ TE-BAL ’

v @ place

v — waterway_river

v — highway

v [l building

v natural_water
v! 7] boundary_protected_area
v| [ landuse

GO000000

‘ Layers | Browser Y

|2 | Extents:| 2263757.1,-4040043.6 : 2291750.0,-4026920.3 |§\ Scale|1:100000 |~ | @ Magnifier| 100% \:\ Rotation |0.0° \:I V| Render & gpsG3ssT @

Pode exemplificar os dados que a sua regido contém para ver que tipo de resultados a sua regido ird apresentar.

Agora precisamos de guardar os dados apresentados para utilizar durante o curso. Iremos utilizar os formatos ESRI
Shapefile, GeoPackage e SpatiaLite dependendo dos dados.

Para converter a camada tempordria place para outro formato:

1. Clique no icone I::j ao lado da camada place para abrir a caixa de didlogo Save Scratch Layer.

Nota: Se necessitar de alterar quaisquer propriedades da camada temporaria (CRS, exyensdo, campos...),
utilize 0 menu de contexto Export » Save Features as..., e assegure-se que a opcdo Add saved file to map esta
selecionada. Isto adiciona uma nova camada.

2. Selecione o formato ESRI Shapefile

3. Utilize o botdo ... para navegar para a pasta exercise_data/shapefile/ e guarde o ficheiro como
places.shp.
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Save Scratch Layer o

Format ESRI Shapefile -
File name 3ining-Data/exercise_data/shapefile/places.shp

Layer name

Encoding |UTF-8 -
w Layer Options

RESIZE | NO A

SHPT A

b Custom Options

@Help % Cancel  OK

4. Prima OK

No painel Layers, a camada tempordria place € substituida pela camada shapefile places e o icone temporario
ao seu lado € removido.

5. Clique duas vezes na camada para abrir o seu separador Layer Properties » Source e atualizar a propriedade
Layer name para corresponder ao nome do ficheiro.

6. Repita o processo para outras camadas, atribuindo os respetivos nomes da seguinte forma:
* natural_water para water
* waterway_river pararivers
* boundary_protected_area paraprotected_areas
Cada conjunto de dados resultante deverd ser guardado no diretério exercise_data/shapefile/.

O passo seguinte € a criagdo de um ficheiro GeoPackage a partir da camada building para utilizar durante o curso:

1. Clique no icone I:::j ao lado da camada building
2. Selecione o formato GeoPackage
3. Guarde o ficheiro como training_data.gpkg na pasta exercise_data/

4. Por prédefinicao, Layer name aparece como nome do ficheiro. Substitua-o por™buildings™.
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Save Scratch Layer >

Format GeoPackage -
File name -Training-Data/exercise_data/training_data.gpkg @

Layer name | buildings

Encoding

¥ Layer Options
DESCRIPTION
FID fid
GEOMETRY_NAME |geom
IDENTIFIER

SPATIAL_INDEX YES ~

[»] Custom Options

@Help *® cancel

5. Prima OK
6. Mude o nome da camada na sua caixa de didlogo de propriedades

7. Repita o prossesso com a camada highway, guardando-a como roads na mesma base de dados do
GeoPackage.

O 1ltimo passo € mudar o nome do ficheiro temporario como um ficheiro Spatial.ite.

1. Clique no icone l::j ao lado da camada landuse
2. Selecione o formato SpatiaLite

3. Guarde o ficheiro como landuse.sglite na pasta exercise_data/. Por prédefinicio, Layer name
aparece como nome do ficheiro. Nao altere.
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Save Scraktch Layer

Format | SpatiaLite - |

File name i—[)aI:afexercise_data,!landuse.sqlite a ||_|

Layer name |landuse |

Encoding
w Datasource Options

INIT_WITH_EPSG | YES -

METADATA |YES -

¥ Layer Options

COMPRESS_COLUMNS | |

COMPRESS_GEOM | NO -
LAUNDER | YES ~ |
SPATIAL_INDEX | YES ~ |
SRID | |

b Custom Options

| @Help | | % cancel |’ «/ oK ]

4. Prima OK

Devera ter agora um mapa mais ou menos com o seguinte aspeto (a simbologia deverd ser certamente bastante
diferente, uma vez que o QGIS atribui aleatoriamente cores sempre que sio adicionadas camadas ao mapa):

foreword - QGIS
Project Edit View Layer Settings Plugins Vector Raster Database Web Progessing Help

IEERRRY NLPLAHNPPALABEINS 0&-Eie- = @% -0 0
WGV, AR /BT BTGB "amagagagesy @& W

Layers
Tl GUTER- 3= ) ’

¥ = places
V! — rivers

= = | i I / 2 e ;
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O importante € que tenha 7 camadas de vetor correspondendo as acima mostradas e que todas essas camadas tenham
os mesmos dados.
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20.2 Try Yourself Create SRTM DEM tiff files

Para os médulos Module: Creating Vector Data € Module: Rasters, também ird necessitar de imagens matriciais
(SRTM DEM) que abrangem a regido que selecionou para o seu curso.

O CGIAR-CGI disponibiliza alguns MDE SRTM que pode fazer download de https://srtm.csi.cgiar.org/srtmdata/.
Ird necessitar de imagens que abrangam toda a regido que escolheu. Para encontrar as coordenadas da extensdo,

Ty
no QGIS , em b‘ “ amplie para a extensdo da camada maior e escolha os valores na caixa @ Extents da barra de
estado. Mantenha o formato GeoTiff. Assim que o formuldrio esteja preenchido, clique no botido Click here to
Begin Search >> e transfira o(s) ficheiro(s).

Assim que tenha transferido o(s) ficheiro(s) necessarios, deverd guardi-lo(s) nas subpastas exercise_data
directory, under raster/SRTM.

20.3 Try Yourself Create imagery tiff files

No médulo Module: Creating Vector Data, a ligao [7]7] Follow Along: Data Sources mostra imagens aproximadas de
trés campos de desporto que os alunos devem digitalizar. Devera entdo reproduzir estas imagens utilizando o(s) seu(s)
novo(s) ficheiro(s) tiff SRTM DEM. Nao € obriga¢do utilizar campos de desporto escolares: podem ser utilizados
quaisquer uns dos trés tipos de territério escolar (por exemplo, edificios escolares, recreios ou estacionamento
automével).

Para referéncia, a imagem nos dados de amostra é:
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20.4 Try Yourself Replace tokens

Having created your localized dataset, the final step is to replace the tokens in the substitutions.txt file so
that the appropriate names will appear in your localized version of the Training Manual.

Os tokens que necessita de substituir sdo os seguintes:

* majorUrbanName: passa para a prédefini¢io «Swellendam». Substitua pelo nome da principal cidade da
sua regido.

* schoolAreaTypel: passa para a prédefinicdo «athletics field». Substitua pelo nome do tipo de 4rea da
maior escola da sua regido.

¢ largeLandUseArea: passa para a prédefinicio «Bontebok National Park». Substitua pelo nome do maior
poligono de territério da sua regido.

* srtmFileName: passa para a prédefini¢do srtm_41_19.tif. Substitua pelo nome do ficheiro do seu
ficheiro SRTM DEM.

¢ localCRS: passa para a prédefinicio WGS 84 / UTM 34S. Devera substituir pelo CRS correto da sua
regido.
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